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Chapter 1. Solution overview

Smarter water management means enabling water utilities to better manage their water and assets by
using insights from the water network, the environment, and from stakeholders. In particular, the success
of a water enterprise is dependent on having a fully functioning and productive asset base, reducing
operational and maintenance costs, minimizing outages, and ensuring a high quality of service.

IBM® Intelligent Operations for Water is a product in the IBM Intelligent Water Family from the IBM
Smarter Cities® Software Solutions portfolio, which is a collection of industry solutions software designed
for effective supervision and coordination of operations.

IBM Intelligent Operations for Water provides an intelligent dashboard for a water management
organization. It displays information on water infrastructure and events. Underlying the solution is a set
of carefully constructed variability points, including programming and data models, that can be
programmed and configured to meet the needs of different types of water management scenarios and
organizations.

IBM Intelligent Operations for Water is built on concepts of visualization, information services, and data
integration. The application integrates the Water Information Hub asset with IBM Intelligent Operations
Center and leverages multiple components from IBM Intelligent Operations Center. With IBM Intelligent
Operations for Water, input data is ingested from external SCADA systems via WebSphere® Message
Broker and is stored in an operational (and historical) database. IBM Intelligent Operations for Water
provides executives and managers with real-time and historical views into the status of a set of domains.
The domain views enable you to anticipate events and optimize operations.

IBM Intelligent Operations for Water can extend its semantic model to cater to different data models
ingested from varying customers. IBM Intelligent Operations for Water interacts with underlying
operation and information systems through gateways, maintaining separation of roles and responsibilities
for the domains of an organization.

Based on the water organization's requirements, key performance indicators and custom reports can be
generated from the real-time data and historical data. IBM Intelligent Operations for Water uses water
industry frameworks and data from Enterprise Asset Management (EAM) systems, water consumption
databases, and Geographical Information Systems (GIS), to provide the following benefits:
v Single view to monitor asset and infrastructure data.
v Visualization of current and historical asset system data.
v Integration of data from disparate water systems.
v Filtering display results.
v Targeted monitoring of the health of the water network. An interactive heat map enables you to

monitor the overall health of the water network and drill down on water key performance indicators.
v Provides stakeholder collaboration, notification, and operational management capabilities.

IBM Intelligent Operations for Water can help provide a common view of operations that transcends
individual systems, devices and departments, aggregating and integrating data from various sources.
Once data is reconciled and collated, water operational and executive personnel can visualize information
in an intuitive fashion to quickly identify anomalies, trends, and patterns. Personnel can view information
about a map that shows critical events and monitors key resources.

IBM Intelligent Operations for Water runs on top of the IBM Intelligent Operations Center, which is a
software solution designed for effective supervision and coordination of operations. IBM Intelligent
Operations Center provides the base platform for IBM Intelligent Operations for Water.
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IBM Intelligent Operations for Water can be deployed in two ways, either on premise or as a cloud-based
offering. IBM Intelligent Operations for Water can also be integrated with other products in the IBM
Smarter Cities Software Solutions portfolio.

What's new in version 1.6
IBM Intelligent Operations for Water 1.6 introduces useful new features for the administrator, installer,
developer and the user.

IBM Intelligent Operations for Water 1.6 is designed with water and waste water operations and
Integrated Water Resource Management in mind. The solution optimizes operations and creates new
opportunities for innovation and business value. It delivers insights into public and private water and
wastewater organizations' infrastructure, assets, and operations while also being a powerful platform that
delivers situational awareness for integrated water resource management across disparate systems at the
regional and national level.

This version brings features and functions that improve the usability, reduce the complexity, and enhance
the mobility of the solution. This version implements changes to architecture and carries significant
performance and visualization improvements.

What's new for the user
In IBM Intelligent Operations for Water 1.6, you can enjoy an improved user experience. Built on IBM
Intelligent Operations Center 1.6, the new dashboard incorporates intuitive design concepts and many
performance and operational improvements.

Filtering data on the maps and in the list

Use the new filter panel to filter data for the page and role.
v Data is displayed on a geospatial map or in a list. System map improvements and filter options enable

you to traverse base maps, asset and sensor layers, pipeline layers and zones. Operational and
measurement details are disclosed as information is required.

v Filters are configurable. Samples are provided for date and time, location, asset, pipe network, event,
named area and other defined categories

v Filter settings can be saved and easily reapplied later.

Viewing the semantic model in the logical map

Use the Logical Map tab in the content panel to display a standard based model view of entities in a
location. You can view relationships between, for example, water assets and equipment. You can filter,
rank, aggregate or perform impact analysis on model entities.

Viewing asset and work order details

Use the new drill down panel to get more detail on a specific asset. The drill down panel has predefined
panes where you can view asset and equipment details, including measurement details and aggregated
report information in a chart or grid.

Filtering data in reports

You can view reports of events as either graphs, tables, or bar charts. You can customize the data that is
displayed in the reports by setting the appropriate options in the filter panel.
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What's new for the administrator
In version 1.6, the Solution Administration view provides a new graphical user interface for configuring
water solutions, water applications and water views.

Managing the solution

You can use a graphical user interface to create and manage water solutions:
v Define a water solution
v Assign different types of applications to the solution

Modifying water solution configuration

You can use a graphical user interface to modify a water solution:
v Assign a page to the water solution
v Manage the models in the solution
v Add REST services to the solution
v View user groups that can access the solution
v Set properties for applications that are included in the solution.

Configuring water applications

You can use a graphical user interface to configure a water application.
v Create a water application; examples of applications include a Water Conservation or Leak

Management application.
v Associate user interface extensions to the application.
v Create, modify, and delete configurations that inform the system of programmatic extensions to UI

elements.
v Map the application to a REST activity that sends a call to a REST service

REST APIs

IBM Intelligent Operations for Water 1.6 provides an updated set of APIs that are implemented using
Representational State Transfer (REST) Services. The REST services provide a set of uniform resource
identifiers (URIs) that you can use to access and edit data in IBM Intelligent Operations for Water
components.

What's new for the installer
IBM Intelligent Operations for Water 1.6 provides installation enhancements and additional environment
support.

Installation options

IBM Intelligent Operations for Water 1.6 provides a command line installer.

The command line installer provides greater configuration flexibility during the installation process. You
can select your chosen installation path from an available list of water solutions and water applications
depending on your need.

Standard environment configuration

IBM Intelligent Operations for Water 1.6 can be installed in a standard environment.
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What's new for the developer
IBM Intelligent Operations for Water 1.6 provides enhancements and new functionality for use by
application and solution developers.

SDK extensions

IBM Intelligent Operations for Water 1.6 has migrated and improved the SDK offered in the 1.5 release.
The SDK has been improved and provides a more flexible rendering and data access service to support
both visualization and KPI and policy migration
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Publications library
You can access additional product documentation from the IBM Support Portal.
v IBM Intelligent Water Family: IBM Intelligent Operations for Water documentation library
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Chapter 2. Installing the solution

IBM Intelligent Operations for Water is a solution that runs on top of the IBM Intelligent Operations
Center. IBM Intelligent Operations for Water provides a manual deployment that installs the package into
the existing IBM Intelligent Operations Center and underlying environment. After deploying the IBM
Intelligent Operations for Water package, some additional configuration is required.

Preparing for installation
Before deploying IBM Intelligent Operations for Water, understand the system configuration and ensure
that the prerequisites are met for the environment.

System configuration
IBM Intelligent Operations for Water is installed on IBM Intelligent Operations Center.

Before you begin

Ensure that IBM Intelligent Operations Center 1.6.0.1. is installed and operational and that your
environment meets both the hardware and software requirements for IBM Intelligent Operations Center.
Ensure the IBM Intelligent Operations Center APARs listed in the related topic are installed.
Related information:

Intelligent Operations Center interim fix PO01119

Intelligent Operations Center interim fix PO02683

Intelligent Operations Center interim fix PO02803
IBM Intelligent Operations Center hardware requirements
IBM Intelligent Operations Center software requirements

Preparing the IBM Intelligent Operations Center servers
Before you start the deployment of IBM Intelligent Operations for Water, you must first prepare the
existing IBM Intelligent Operations Center environment.

About this task

The IBM Intelligent Operations Center must be running during the installation of IBM Intelligent
Operations for Water. Some of the IBM Intelligent Operations Center services are automatically restarted
by the installer. To avoid a disruption in service, it is recommended that users of the IBM Intelligent
Operations Center be logged off the system during the IBM Intelligent Operations for Water installation
period.

Procedure
1. Make sure that all of the IBM Intelligent Operations Center servers are started. Use the platform

control tool in IBM Intelligent Operations Center to control the services.
2. Query the status of all of the IBM Intelligent Operations Center servers to ensure that they are started

before the installation begins. If any of the IBM Intelligent Operations Center components are not
started, the installation of IBM Intelligent Operations for Water does not complete successfully.

3. Verify the status of each server by logging on to the analytics server, and running the following
command.
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su - ibmadmin
IOCControl -a status -c all -p <password>

For example: /opt/IBM/ISP/mgmt/scripts/IOCControl -a status -c all -p ibmioc16

4. Verify that you can access the IBM Intelligent Operations Center portal by logging on as the
administrator using the following URL:
http://web_server_hostname/wps/myportal

In the IBM Intelligent Operations Center portal you can see the Intelligent Operations Center link on
the top navigation bar.

Related information:
Installing the IBM Intelligent Operations Center
Starting the components in a standard environment

Checking IBM Security Identity Manager is operational
Before you start the deployment of IBM Intelligent Operations for Water, you must ensure that IBM
Security Identity Manager is operational.

Procedure
1. Log on to the application server.
2. Run the command: /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/stopServer.sh server1

3. Start a terminal session and login with your username and password for WebSphere.
4. Run the command: /opt/IBM/WebSphere/AppServerv7/profiles/isim1/bin/startServer.sh server1

Deploying the solution manually
Use the command line utility to deploy the IBM Intelligent Operations for Water solution.

Procedure
1. Download the IBM Intelligent Operations for Water 1.6 package.
2. Place the build package on the web server which was used for IBM Intelligent Operations Center

1.6.0.1.
3. Create a folder named /iow16 under the folder where IBM Intelligent Operations Center 1.6.0.1 was

installed. For example:
mkdir -p /installHome/iow16

Place the IBM Intelligent Operations for Water build and scripts.zip file in the created folder.
4. Extract the scripts, and place the download package and script files in a folder under the iow16 folder.

cd /installHome/iow16
unzip scripts.zip

5. Start a terminal session and run the following command.

Note: In the following command, installHome is a sample folder. The path is typically
/opt/ibm/IOC16install/iow16 and is available after you have created folder iow16 in step 3 above.
cd /installHome/iow16
chmod +x *.*

6. Import the IBM Intelligent Operations for Water solution.
./preinstall-iow-std.sh -p <topology password> -b <ioc16 install folder> -d
<ioc1601 install folder>

For example:
./preinstall-iow-std.sh -p ibmioc16 -b /installHome/ioc16 -d
/installHome/ioc1601/
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Alternatively, you can use the following command for an ioc1601 environment that has not been
updated from ioc16 by installing the required APAR.
./preinstall-iow-std.sh -p ibmioc16 -b /installHome/ioc16 -d
/installHome/ioc16/

7. Install the IBM Intelligent Operations for Water solution.
./install-iow-std.sh -p <topology password>

Select from the available installation options and press enter.

Selection Installation option

1 All applications

2 Base platform and sample data

3 Maximo integration

4 Water Conservation Portal

5 Combined Sewer Overflow Management

The installation process begins.
8. If an error is displayed, run install-iow16-std.sh once again. Check the install.log file for details

if the installation fails at /installHome/iow16/log. Correct any errors and rerun the command.
Related concepts:
“Known problems and solutions” on page 259
Some common problems with IBM Intelligent Operations for Water are documented, along with their
solutions or workarounds. If you have a problem with IBM Intelligent Operations for Water, review the
problem-solution topics to determine if a solution is available to the problem that you are experiencing.
The problem-solution topics are categorized according to the type of issue.
Related information:

IBM Intelligent Operations for Water Passport Advantage download page

IBM Intelligent Operations for Water system requirements

IBM Intelligent Operations Center system requirements

Post-installation configuration
After installing IBM Intelligent Operations for Water, post-installation configuration steps need to be done
to complete the installation.

Configuring source data for event filtering
Source data is required for events. After installing, sample data is made available but you must make that
data available from the data server and use the Water solution administration capabilities to configure
data sources so that the event data is displayed in the interface.

Before you begin

Log in to the WebSphere Application Server console and go to Servers > Server Types > Webshere
application servers to check that enterprise application resources (EARs) have started. Download the
sample data for the event filter that is made available in the sample folder. Run the following commands:
1. Copy the sample data to a folder on the data server. For example: /home/BVT.

Note: /home/BVT is provided as a sample only. The folder is created manually and can be any folder
that db2inst2 can access.

2. Open a terminal window on the data server and complete the following commands:
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# cd /home/BVT
# unzip 911\ sample\ data.zip
# cd 911\ sample\ data.
# chmod +x InstallAll.sh
# su db2inst2
# ./InstallAll.sh

Note: Running the command may affect the Portal, so ensure that the Portal is on and the application
has started.

Procedure
1. To access the data sources configuration tool, click Administration > Solution Administration >

Configuration Tools > Data Sources.
2. To start the wizard that guides you through the steps to create a data source, click Create.
3. On the Acquire tab, choose the following data source acquisition method and enter the information

that is required to connect to the data source

Connect to a database
Enter the host name or IP, port, user ID, password, database name, and database table.
v Enter host name or IP ioc16-db.
v Enter the port number 50002.
v Enter User ID db2inst2.
v Enter the password.
v Enter database name MNP.
v Enter database table MNP.BOHEMIAN.

4. Click Next to go to the Basics tab.
5. Supply the basic information that is required for your data source. Enter a data source label (for

example BOHEMIAN) name and a unique identifier (BOHEMIAN). A description is optional. Accept the
defaults, or change the settings in the general information fields. For more information about basic
settings, see the related link at the end of the topic.

6. Click Next to go to the Minimal Properties tab.
7. In each of the minimal property fields, select a property from your data source to assign to the

minimal property that is required by the system. Change the default settings as appropriate for your
data source. Set the following minimal property settings.
v Select the Name and Location tab. In the Name field, select NAME. In the Location Properties

panel, click the Shape button in the Location format field, and select LOCATION in the Shape
field.

v Select the Time & Date tab. In the Start date and time panel, select field type Timestamp and
select STARDATETIME. In the End date and time panel, select field type Timestamp and select
ENDDATIME. In the Last update date and time panel, select LASTUPDATEDATETIME

v Select the Time Zone & Other tab. In the Time zone offset field, select TIMEZONEOFFSET.
Check the label in the interfaceto ensure the value has the same text as the corresponding link.

8. Click Next to go to the Key & Full Properties tab.
9. From your data source properties list, select the properties that you want to define as key properties.

Define other property characteristics as appropriate for your data source.
10. Complete the fields in the Property Details box as required, or accept the defaults. For more

information about defining key and full properties, see the link at the end of the topic.
11. Optional: Select from the remaining tabs those fields that you want to change. Select the Appearance

tab, and specify an icon image used to represent events. For more information about data source
configuration options, see the links at the end of the topic.
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Note: If you do not configure security for you data source, the default is that only you have access
to view the data items. If you select a point geometry format for your data source and you do not
configure appearance, data items from your data source cannot be displayed in the user interface.

12. To add your data source to the solution, click OK.
13. Log on to IBM Intelligent Operations for Water as administrator.
14. Select Administration > Solution Administration.
15. Go to Application Configuration.
16. In Select a solution to configure, select Water.
17. Ensure that the Pages tab is selected.
18. In Select a page to configure, choose the Supervisor: Operations page.
19. Expand the Filter Panel in the tree.
20. Click the Events filter.
21. Click the Pipe Leak event and check the data source should be the one you created for the events

filter.
22. Click Save to save the configuration.

What to do next

Repeat the steps in the procedure to create and save a data source for other event types. You can use the
same database for each data source.
Related concepts:
“Customizing operational performance” on page 190
You can customize performance measurements in IBM Intelligent Operations for Water to suit the
requirements of your operational and executive staff. By specifying and implementing user specific Key
Performance Indicators (KPIs), you can establish service level agreements and key measurements to meet
the performance needs of your organization and key stakeholders.
Related information:
IBM Intelligent Operations Center configuring a data source

Configuring Enterprise Asset Management settings
You must update the enterprise asset management server settings in the water information hub database.

Before you begin

Add a security exception in the browser, by logging on to the browser: https://<maximo_hostname>:9443/
maximo/webclient/login/login.jsp?appservauth=true . Click Add Exceptions, and confirm.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Configuration.
4. In Select a solution to configure, select Water.
5. Ensure that the Synchronize Maximo tab is selected.
6. Select the model in the left pane and click the Connection tab.
7. Enter your Maximo server connection information (host name or IP, port details, User ID and

password).
8. Click Save to save the configuration.

Chapter 2. Installing the solution 11

http://pic.dhe.ibm.com/infocenter/cities/v1r6m0/topic/com.ibm.ioc.doc/use_datasourceportlet.html


Configuring the Combined Sewer Overflow application
Configure the mail server settings for the Combined Sewer Overflow (CSO) application.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration > System Properties.
3. Select Mail Sender and enter the mail sender details.
4. Select Mail Server Hostname and enter the hostname details of the mail server.
5. Select Mail Server Port and enter the port details of the mail server.

Configuring the Water Conservation Portal application
Meter, account, household and billing source data is required for the Water Conservation Portal
component. Sample data is provided to help you familiarize with the process of data ingestion.

About this task

IBM Intelligent Operations for Water uses multiple heterogeneous input data sources. In a typical
deployment, static and dynamic data is gathered from household or community-based water metering
infrastructure. Meter readings are captured at specified intervals and the data that is gathered is
transmitted to wireless gateways at specified intervals and uploaded to an FTP site.

The data that is gathered from the advanced metering infrastructure is the basis for fine-grained
consumption analyses to improve both consumption and demand management.

Data that is gathered is extracted, transformed, and loaded to a trusted data source on the Data server.
The secure data is used by to produce advanced water consumption analysis and leak alerts.

Important: Sample data is provided to help you familiarize with the process of importing and
configuring data ingestion.

Importing user information
Scripts are provided to simplify the import of data from CSV file sources into the database. Importing
LDAP authentication and authorization data is also facilitated by providing an XML file sourced in the
database.

Procedure
1. Log on to the data server with Tivoli Directory Integrator as root.
2. Locate the scripts to import user information into the database from the CSV file. The scripts are in

the /opt/IBM/water/wcp folder.
3. Use the sample user data available (account.csv, household.csv, meter.csv,, account_household.csv)

to test your data import flow. Run the command: /opt/IBM/water/wcp/user_import/import_users.sh.
For example:
./import_users.sh /opt/IBM/water/wcp/account.csv
/opt/IBM/water/wcp/household.csv
/opt/IBM/water/wcp/meter.csv
/opt/IBM/water/account_household.csv

The following data columns are created by the installer for the account.csv sample user data and
populated by running the script. Data from the account.csv file are populated into the WCP.ACCOUNT
table.
ACCOUNT_EXT_ID(NOT NULL), NAME, ADDRESS, CITY, STATE, ZIPCODE, TYPE,
EMAIL, ROLE(NOT NULL), CLASSIFICATION

Note: ACCOUNT_EXT_ID is unique. A role can be uadmin or PM.
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The following data columns are created by the installer for the household.csv sample user data and
populated by running the script. Data from the household.csv file are populated into the
WCP.HOUSEHOLD table.
HOUSEHOLD_EXT_ID(NOT NULL), NAME, LATITUDE, LONGITUDE, ADDRESS

Note: HOUSEHOLD_EXT_ID is unique.
The following data columns are created by the installer for the account_household.csv sample user
data and populated by running the script. Data from the account_household.csv file are populated
into the WCP.HOUSEHOLD_METERS table.
ACCOUNT_EXT_ID, HOUSEHOLD_EXT_ID

Note: The relationship between household and meters are described in this CSV. A meter only
belongs to one household.
The following data columns are created by the installer for the meter.csv sample user data and
populated by running the script. Data from the meter.csv file are populated into the WCP.METER table.
METER_EXT_ID(NOT NULL), HOUSEHOLD_EXT_ID, NAME, MODEL, TYPE,
MULTIPLIER(NOT NULL)

Note: METER_EXT_ID is unique. HOUSEHOLD_EXT_ID is the household this meter belongs to . A
meter only belongs to one household. MULTIPLIER is a number.

4. To import LDAP authentication and authorization data, log on to the IBM Intelligent Operations
Center portal as user wpsadmin.
http://<appserver>

5. Navigate to Administration > Portal settings > Import xml. The default password for all sample
users is passw0rd. You can change the password in the XML file before you import the XML file.

6. Import the file iow_wcp_portaluser.xml located at /opt/IBM/water/wcp/xmlTemplate on the application
server. The /opt/IBM/water/wcp//xmlTemplate/iow_wcp_portaluser.xml file, from the application
server, is provided as an example and can be used to import users defined in the sample account.csv
file in step 3 above.

Related concepts:
“Exception messages displayed when running scripts to ingest water conservation portal data” on page
274
When you run the scripts when ingesting data in the water conservation portal, an exception message
may be displayed.

Configuring data ingestion for meters
The Tivoli Directory Integrator software is used to facilitate the import and configuration of meter
reading and billing data.

Procedure
1. Log on to IBM Intelligent Operations for Water as water conservation portal user

(<solutionID>Citizen).
2. In the Solution Administration view, click Configuration Tools > Application Configuration and

select a solution to configure.
3. On the WCP Configuration tab, click the Property file tab.
4. Verify that the database details are correct:

JDBC URL: wcp.db.jdbc.url
Username: wcp.db.username
Password: wcp.db.password

5. Update the FTP details.
Hostname: wcp.ftp.hostname
Port: wcp.ftp.port
Username: wcp.ftp.username
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Password: wcp.ftp.password
Billing data file path: wcp.ftp.path.billing-data
Meter data file path: wcp.ftp.path.meter-reading-data

6. Modify the user data path information.
ACCOUNT.CSV: wcp.filesystem.path.account-data
HOUSEHOLD.CSV: wcp.filesystem.path.household-data
ACCOUNT_HOUSEHOLD.CSV wcp.filesystem.path.account-household-data
METER.CSV wcp.filesystem.path.meter-data

Solution to load user data for:
Solution: wcp.constant.solution

7. Modify the property file settings that are highlighted in bold in the example at the end of this topic.
8. Copy the CSV files onto the FTP server.
9. After ingestion of a large amount of historical meter reading data it is recommended to manually

execute RUNSTATS on the meter reading table to ensure good performance is maintained.
DB2 CONNECT TO WCPDB
DB2 RUNSTATS ON TABLE WCP.METERREADING ON ALL COLUMNS WITH DISTRIBUTION ON ALL COLUMNS

AND INDEXES ALL ALLOW WRITE ACCESS
DB2 CONNECT RESET

Results

The data is imported into the database (WCP.BILLING, WCP.METERREADING) when the Cron task is
triggered.
Related concepts:
“Exception messages displayed when running scripts to ingest water conservation portal data” on page
274
When you run the scripts when ingesting data in the water conservation portal, an exception message
may be displayed.
“Data ingest issues when data is archived or removed from the WIH reading table” on page 270
When you archive, remove or change data from the WIH.READING table, the missing or revised data
may prevent features of IBM Intelligent Operations for Water from operating as expected. Perform the
steps in this topic to diagnose and resolve data ingest record issues and restore operational capabilities.
“Configured volume and currency unit settings for water conservation portal are insufficient” on page
274
IBM Intelligent Operations for Water is pre-configured with volume and currency settings for use with
the water conservation portal. If you need to change the settings, you can use the workaround in this
topic to update the pre-configured settings.
Related tasks:
“Setting water conservation portal data import properties” on page 250
When you define a water conservation portal application, you define properties that determine data
import. IBM Intelligent Operations for Water uses the Tivoli Directory Integrator software to facilitate the
import and configuration of meter reading and billing data
“Setting water conservation portal units and rate” on page 251
When you define a water conservation portal application, you define properties that determine the
consumption units and conversion rates used for data imported to the portal.

Configuring Tivoli Directory Integrator to import meter data:
About this task

You can optionally run the Tivoli Directory Integrator configuration to import meter reading and billing
data separately. You must run the analysis program manually to complete the steps.
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Procedure

1. Log in as administrator: su - ibmadmin.
2. Set the path export TDIPATH=/opt/IBM/TDI/V7.1 command.
3. Set the solution directory path: export TDISOLDIR=/home/ibmadmin/TDI command.
4. Run the ${TDISOLDIR}/run_TDI_monthly.sh command. This command iterates all solutions, finds the

configure properties for each solution, and then imports BILLING data for them according to
different configurations in each property file.

5. Run the ${TDISOLDIR}/run_TDI_daily.sh command. This command iterates all solutions, finds the
configure properties for each solution, and then imports METER READING data for them according
to different configurations in each property file.

6. Run the ${TDISOLDIR}/run_assembly_line.sh "Import Meter Reading Data" "Sunshine" script. An
exception message is displayed but can be ignored. For more information on the exception, see the
related topic.

7. Run the ${TDISOLDIR}/run_assembly_line.sh "Import Billing Data" "Sunshine" script. An
exception message is displayed but can be ignored. For more information on the exception, see the
related topic.

8. Log on to the analytics server.
9. Locate the analysis program in the /opt/IBM/water/wcp/analysis folder.

10. Log in as administrator: su - ibmadmin.
11. Run the ./run_analysis.sh [StartDate(YYYY-MM-DD)] [EndDate(YYYY-MM-DD)] command after you

import the new meter reading. The time period must cover all new meter readings.

Note: This task is added into the Cron tasks on the analytics server with Tivoli Directory Integrator
configuration, so it can be run automatically after the new meter reading and billing data are
imported. Run it to initialize the database for a time after you import the sample data provided.
Example: ./run_analysis.sh 2010-06-01 2012-10-31.

12. If running the analysis program for a wide date range it is recommended to manually execute
RUNSTATS on the metric numeric table to ensure good performance is maintained.
DB2 CONNECT TO WCPDB
DB2 RUNSTATS ON TABLE WCP.METRICNUMERIC ON ALL COLUMNS WITH DISTRIBUTION ON ALL COLUMNS

AND INDEXES ALL ALLOW WRITE ACCESS
DB2 CONNECT RESET

Example
##{PropertiesConnector} savedBy=Administrator, saveDate=Fri Feb 21 12:55:41 CST 2014
wcp.constant.meter-reading.cubicFeet2Gal=7.48
wcp.constant.meter-reading.deltaThreshold=10000
wcp.db.jdbc.driver=com.ibm.db2.jcc.DB2Driver
wcp.db.jdbc.url=jdbc:db2://9.181.86.43:50002/WIHDB:currentSchema=WCP;
wcp.db.password=******
wcp.db.schema=WCP
wcp.db.tablename.billing-data=BILLING
wcp.db.tablename.meter-reading-data=METERREADING
wcp.db.username=db2inst2
wcp.detailed-log=false
wcp.ftp.hostname=9.110.179.205
wcp.ftp.password=******
wcp.ftp.path.billing-data=WCP/DI/billing.txt
wcp.ftp.path.meter-reading-data=WCP/DI/meterreading.txt
wcp.ftp.port=21
wcp.ftp.username=admin
wcp.constant.solution=Sunshinewcp.db.tablename.account-data=ACCOUNT
wcp.db.tablename.household-data=HOUSEHOLD
wcp.db.tablename.meter-data=METER
wcp.db.tablename.account-household-data=ACCOUNT_HOUSEHOLD
wcp.filesystem.path.account-data=/opt/IBM/water/wcp/user_import/ACCOUNT.CSV
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wcp.filesystem.path.household-data=/opt/IBM/water/wcp/user_import/HOUSEHOLD.CSV
wcp.filesystem.path.account-household-data=/opt/IBM/water/wcp/user_import/ACCOUNT_HOUSEHOLD.CSV
wcp.filesystem.path.meter-data=/opt/IBM/water/wcp/user_import/METER.CSV

Clearing the sample data
IBM Intelligent Operations for Water is shipped with sample data and sample users. For security reasons,
the sample data should be deleted after installation in a production environment.

Procedure
1. Go to the data server.
2. Run the following commands as user: db2inst2.

db2 -tvf clear_wcp_sample_data.sql
db2 -tvf clear_sample_data.sql

The files are located at:
water_content_cso_topo/CSO_DB/content
water_content_wcp_topo/WCP_DB/content

3. Log on to IBM Intelligent Operations for Water as administrator.
4. Select Administration > Portal Administration.
5. Select Portal setting > Import xml and enter clear_wcp_user.xml to browse the XML file.

The XML file is located at water_content_wcp_topo/WCP_PORTAL/content/xmlTemplate.

Securing the topology property files and passwords
IBM Intelligent Operations for Water uses passwords in topology files to complete the installation
process. Since the topology properties file on the installation server contain passwords in clear text, this
file should be stored in a secure location after installation is completed.

About this task

The topology properties file contains security-sensitive information, such as user names and passwords
for the system, in clear text. If an unauthorized person has access to this file, they will have full access to
the system. After modifying the topology properties file, save a copy to a secure location.
Related information:
Topology property files
Removing installation files from the production system

Migrating data from IBM Intelligent Operations for Water V1.5 to V1.6
IBM Intelligent Operations for Water provides scripts to migrate data. Use the DB Migration Tool and the
SyncModelToDB Tool to migrate data from IBM Intelligent Operations for Water version 1.5 to version
1.6. The application accesses data from the database tables of the Water Information Hub asset.

Before you begin

The DB Migration Tool is run on the data server with the IBM Intelligent Operations for Water 1.6
database installed. When run, the DB Migration Tool performs the following data migration tasks:
1. Create temporary tables for reading data and configure data.
2. Create a temporary function to retrieve the measurement_id in IBM Intelligent Operations for Water

version 1.6 by measval_id in version 1.5.
3. Catalog theIBM Intelligent Operations for Water 1.5 database in local.
4. Load data from version 1.5 into temporary tables created in step 1 above.
5. Uncatalog the version 1.5 database.
6. Migrate configuration data and reading data.
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7. Drop temporary tables, functions and procedures.

About this task

You take two steps to migrate the data:
1. Use the SyncModelToDB Tool to migrate data from the model server.
2. Use the DB Migration Tool to migrate data for use by the solution administrator. The tool migrates

the following data:
a. Reading data. The following tables are migrated from version 1.5 to version 1.6:

1) HISTORICAL_READING , REALTIME_READING => READING
b. Configuration data. The following tables are migrated from version 1.5 to version 1.6:

1) DERIVED_CALC => MEASUREMENT_DERIVED_CALC
2) NO_DEVICE_READING_CONFIG => MEASUREMENT_TIMEOUT
3) THRESHOLD_CONFIG => MEASUREMENT_THRESHOLD

The following table displays the different database tables used in versions 1.5 and 1.6.

Table 1. Contrast between database tables in versions 1.5 and 1.6

Version 1.5 Database
Tables Version 1.6 Database Tables

Difference in Version
1.6 Tool

ASSETS ASSET_INST, ASSET_TYPE
MODEL, ASSET_LOCATION

Separated into two
tables

SyncModelToDB

MEASUREMENT_VALUE MEASUREMENT,
MEASUREMENT_ALIAS

Separated into two
tables

SyncModelToDB

KEY_MEASUREMENT_
CONFIG

MEASUREMENT Refined SyncModelToDB

ZONES NAMED_AREA prefix=> model_id N/A

DERIVED_CALC MEASUREMENT_
DERIVED_CALC

measval_id =>
measurement_id

DB Migration Tool

NO_DEVICE _READING_
CONFIG

MEASUREMENT_ TIMEOUT measval_id=>
measurement_id

DB Migration Tool

THRESHOLD_CONFIG MEASUREMENT_ THRESHOLD measval_id=>
measurement_id

DB Migration Tool

HISTORICAL_ READING READING measval_id=>
measurement_id

DB Migration Tool

REALTIME_READING READING measval_id=>
meaurement_id

DB Migration Tool

CONFIG_ASSET_IMAGE N/A

WORKORDER N/A

ASSET_INST_EXT_
CITYNAME_RAIGUAGE

N/A

SITE N/A

DERIVED_CALC_
DEFAULT

No related table N/A N/A

NO_DEVICE_READING_
CONFIG_DEFAULT

No related table N/A N/A

KEY_MEASUREMENT
_CONFIG_DEFAULT

No related table N/A N/A
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Table 1. Contrast between database tables in versions 1.5 and 1.6 (continued)

Version 1.5 Database
Tables Version 1.6 Database Tables

Difference in Version
1.6 Tool

THRESHOLD_CONFIG
_DEFAULT

No related table N/A N/A

WIH_GLOBAL_CONFIG No related table N/A N/A

To migrate data from the model server using the SyncModelToDB tool, take the following steps:

Procedure
1. Start the model server: JenaServer.java under the test_water_modelserver project.

v For Linux:

a. Go to the folder: IBM/water/apps.
b. Run the command: ./syncModelToDB.sh <SolutionId> <Prefix>.

Note: Run ./syncModelToDB.sh only to see the parameter details.
v For Windows:

a. Go to the folder: IBM/water/apps.
b. Run the command: ./syncModelToDB.bat <SolutionId> <Prefix>

Note: Run ./db_migration.bat only to see the parameter details.
2. To migrate reading data and configuration data for solution administration using the DB Migration

Tool, take the following steps:
v For Linux:

a. Copy the DB Migrate folder to the data server. The DB Migrate folder is under the project:
water_data_model.

b. Log on to IBM Intelligent Operations for Water 1.6 database server with root, and go to the
following folder: “chmod 777 DB\ Migrate/”.

c. Go to folder: “cd DB\ Migrate/”.
d. Make the following sh files executable: “chmod +x *.sh”.
e. Change to the folder: db2 user: su db2inst2.
f. Run the migration tool: ./db_migration_tool.sh param1 param2 param3 param4 param5 param6.

Note: Run ./db_migration.sh only to see the parameter details.
v For Windows:

a. Copy the DB Migrate folder to the data server. The DB Migrate folder is under the project:
water_data_model.

b. Start a terminal session and from the command line, go to the DB Migrate folder.
c. Run the migration tool: db_migration_tool.bat param1 param2 param3 param4 param5 param6

Note: Run ./db_migration.bat only to see parameter details.
Related tasks:
“Synchronizing the model to the database” on page 186
The imported model must be synchronized to the database. Use the steps in this topic to synchronize the
model to the database.
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Chapter 3. Securing the solution

Securing IBM Intelligent Operations for Water is an important consideration. To ensure that the system is
secure, you must manage who can access the system and assign the correct level of access within the
solution.

Securing the base architecture

Because IBM Intelligent Operations for Water is a solution that runs on top of the IBM Intelligent
Operations Center, set the high-level security settings through the IBM Intelligent Operations Center. For
details on the various options available, see the security section of the IBM Intelligent Operations Center
Information Center.

Securing the data import

The importing of data into IBM Intelligent Operations for Water is performed on the management server.
Ensure that the method used to connect and transfer data on to this server is secure. For more
information, see the related links at the end of this topic.

Securing the portal

The following topics explain how to secure the solution and manage user access to the IBM Intelligent
Operations for Water portal.
Related concepts:
Chapter 5, “Integrating the solution,” on page 47
Products and services can be integrated with IBM Intelligent Operations for Water.
Related information:

Securing the IBM Intelligent Operations Center

Password information for a standard environment
Securing the model

User roles and responsibilities
IBM Intelligent Operations for Water implements security by limiting access to features, data and services
based on user roles.

The security model and user access roles of IBM Intelligent Operations for Water are consistent with the
IBM Intelligent Operations Center and other IBM Smarter Cities Software Solutions.

To use a specific feature of IBM Intelligent Operations for Water, a user must be a member of a user role
group that provides the required access level to use that feature. A user is made a member of a user role
group by the administrator.

Table 1 shows the authorized pages, portlets, and responsibilities of the user roles.
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Table 2. The roles of IBM Intelligent Operations for Water.

Job role User role group Authorized main responsibilities

Executive <solutionID>Executive The user role can access the Executive:
Status and Executive: Operations view.

v Reviews status for the executive's
area of responsibility by monitoring
key performance indicators (KPIs)

v Looks for trends or groupings of
where things are happening to make
strategic decisions on how to
improve situations

v Communicates with staff and
constituents about what insights
they have derived and how they can
address problems

Operator <solutionID>Operator The user can access the Operator:
Operations view.

v Monitors incoming data updates and
views details

v Responds to requests to address a
situation Keeps information about an
event or item that is in progress
current by updating information

v Looks for trends or areas of concern
where correctional short-term actions
are required

Supervisor <solutionID>Supervisor The user can access the Supervisor:
Operations and Supervisor: Status
view.

v Reviews status for the supervisor's
or manager's area of responsibility
and drills into details for areas of
concern

v Responds to notifications when
status changes negatively

v Supervises day-to-day operations
and directs work of staff

v Decides on short-term corrective
measures

Planner <solutionID>Planner The user can access the Planner:
Analysis view.

v Monitors incoming data updates and
views details

v Responds to requests to address a
situation Keeps information about an
event or item that is in progress
current by updating information

v Looks for trends or areas of concern
where correctional short-term actions
are required
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Table 2. The roles of IBM Intelligent Operations for Water. (continued)

Job role User role group Authorized main responsibilities

Citizen <solutionID>Citizen The user can access the Citizen: Water
Conservation view.

v Monitors incoming reports and
views details

v Looks for trends or areas of concern
where correctional short-term actions
are required

Solution administrator <solutionID>Admin The user can access the Portal:
Administration and Solution:
Administration view. Configures
components, including data sources,
filter options, maps, key performance
indicators, and standard operating
procedures

System administrator wpsadmin Administers all aspects of users
including defining groups, assigning
permissions to groups, and assigning
users to groups. Provides users with
the correct access level. Access level is
assigned based on group membership.
A system administrator can also
configure all the components, similar
to a solution administrator.

Related tasks:
“Adding users and groups”
To use a specific feature of IBM Intelligent Operations for Water, a user must be a member of a user role
group that provides the required access level to use that feature. Use the Administration portal to add
users and groups to IBM Intelligent Operations for Water.
“Viewing or modifying group membership” on page 23
Use the Administration portal to manage users of IBM Intelligent Operations for Water and their access
permissions. Membership of a role group gives users access to the parts of the solution appropriate to
that role. You can change the access level of a user by removing them from one role group and adding
them to another group. You can also remove a user from IBM Intelligent Operations for Water.

Adding users and groups
To use a specific feature of IBM Intelligent Operations for Water, a user must be a member of a user role
group that provides the required access level to use that feature. Use the Administration portal to add
users and groups to IBM Intelligent Operations for Water.

Before you begin

Choose from one of the following IBM Intelligent Operations for Water roles that provides the access
level that your users or groups require:
v <solutionID>Operator
v <solutionID>Executive
v <solutionID>Administrator
v <solutionID>Citizen
v <solutionID>Planner
v <solutionID>Supervisor
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See the related links at the end of this topic for more information about the roles of IBM Intelligent
Operations for Water and about IBM Intelligent Operations Center groups.

About this task

You can add new users and groups to IBM Intelligent Operations for Water. You can also add users and
groups from an existing Lightweight Directory Access Protocol (LDAP) directory source that is configured
to work with the underlying IBM Intelligent Operations Center. For more information about how to
import LDAP directory users into the solution, see the IBM Intelligent Operations Center Information
Center.

Procedure
1. Log on to the solution portal as a portal administrator, for example, wpsadmin or another user who is

a member of the wpsadmins portal group.
2. On the main navigation bar at the top of the page, click Administration > Portal Administration.
3. On the sidebar menu, expand the Access submenu, and click Users and Groups.
4. Click All Portal User Groups. The list of role groups for IBM Intelligent Operations for Water, the

IBM Intelligent Operations Center, and any other IBM Smarter Cities Software Solutions installed in
this environment are displayed.

5. Scroll through the list to find the user group role that you would like to assign to your users.
6. Select the required IBM Intelligent Operations for Water role group by clicking it. The IDs of the

existing group members are listed.
7. Add the user to the group using one of the following steps:

v To add a new user, click New User and complete the required Profile Management fields.
v To add an existing user or group of users, click Add Member and select one or more users or

groups from the list.
8. Click OK.

Results

The recently added users or groups appear in the membership list of the user role group. The users are
authorized to access the solution portal according to the permissions assigned to the role group selected.

What to do next

If the users also require access to the IBM Intelligent Operations Center and other IBM Smarter Cities
Software Solutions installed in this environment, add them to the relevant user roles for those solutions.
For more information, see the security topics in the information center for the IBM Intelligent Operations
Center or the other IBM Smarter Cities Software Solutions you have deployed.
Related concepts:
“User roles and responsibilities” on page 19
IBM Intelligent Operations for Water implements security by limiting access to features, data and services
based on user roles.
Related tasks:
“Viewing or modifying group membership” on page 23
Use the Administration portal to manage users of IBM Intelligent Operations for Water and their access
permissions. Membership of a role group gives users access to the parts of the solution appropriate to
that role. You can change the access level of a user by removing them from one role group and adding
them to another group. You can also remove a user from IBM Intelligent Operations for Water.
Related information:
Importing users and groups into the IBM Intelligent Operations Center
User role groups and authorization permissions
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Viewing or modifying group membership
Use the Administration portal to manage users of IBM Intelligent Operations for Water and their access
permissions. Membership of a role group gives users access to the parts of the solution appropriate to
that role. You can change the access level of a user by removing them from one role group and adding
them to another group. You can also remove a user from IBM Intelligent Operations for Water.

About this task

Use the following procedure to add or remove existing users from IBM Intelligent Operations for Water
user role groups. Users removed from an IBM Intelligent Operations for Water user role group can still
continue to access the IBM Intelligent Operations Center and any other IBM Smarter Cities Software
Solutions. For more information about how to completely delete a user and revoke their access to the
entire portal and all solutions running in this environment, see the related links.

Procedure
1. Log on to the solution portal as a portal administrator, for example, wpsadmin or another user who is

a member of the wpsadmins portal group.
2. On the main navigation bar at the top of the page, click Administration > Portal Administration.
3. On the sidebar menu, expand the Access submenu, and click Users and Groups.
4. Click All Portal User Groups. The list of role groups for IBM Intelligent Operations for Water, the

IBM Intelligent Operations Center, and any other IBM Smarter Cities Software Solutions installed in
this environment are displayed.

5. Click one of the following IBM Intelligent Operations for Water user role groups that you would like
to view or modify. You can scroll to the next page to find the required user role group that you are
interested in.
v <solutionID>Water Administrator
v <solutionID>Water Operator
v <solutionID>Executive
v <solutionID>Citizen

6. A table containing all the users and groups that have been assigned to the user role are displayed.
You can perform several actions by clicking the icons at the end of each row for the user you are
interested in.
v To remove a user or group, click the Delete icon on the row for that user.
v To view all other roles that the selected user or group has been assigned, click the View

membership icon on the row for that user.
v To add an existing portal user or group to this role, click Add Member and select the user or

groups to be added.
v To create a new portal user and add them to the role, click New User and complete the required

fields.
v To create a new portal group and add the group to this role, click New Group and complete the

required fields.
7. To finish and return to IBM Intelligent Operations for Water, on the main navigation bar at the top of

the portal, click More... and then select Intelligent Water.
Related concepts:
“User roles and responsibilities” on page 19
IBM Intelligent Operations for Water implements security by limiting access to features, data and services
based on user roles.
Related tasks:
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“Adding users and groups” on page 21
To use a specific feature of IBM Intelligent Operations for Water, a user must be a member of a user role
group that provides the required access level to use that feature. Use the Administration portal to add
users and groups to IBM Intelligent Operations for Water.
“Removing users or groups”
If a user or group no longer requires access to the solution, you can remove them from IBM Intelligent
Operations for Water. You can also remove a user or group from the entire solution including the IBM
Intelligent Operations Center and any other IBM Smarter Cities Software Solutions deployed in the
environment.

Removing users or groups
If a user or group no longer requires access to the solution, you can remove them from IBM Intelligent
Operations for Water. You can also remove a user or group from the entire solution including the IBM
Intelligent Operations Center and any other IBM Smarter Cities Software Solutions deployed in the
environment.

Procedure
1. To remove a user or group from only the IBM Intelligent Operations for Water solution, see Viewing

or modifying groups.

Note: Removing a user from the IBM Intelligent Operations for Water user role groups does not affect
any access the user may have to the IBM Intelligent Operations Center and any other IBM Smarter
Cities Software Solutions installed in this environment.

2. To completely remove a user or group from the entire system, see the security section of the IBM
Intelligent Operations Center Information Center.

Related tasks:
“Viewing or modifying group membership” on page 23
Use the Administration portal to manage users of IBM Intelligent Operations for Water and their access
permissions. Membership of a role group gives users access to the parts of the solution appropriate to
that role. You can change the access level of a user by removing them from one role group and adding
them to another group. You can also remove a user from IBM Intelligent Operations for Water.
Related information:
Deleting a user or group in the IBM Intelligent Operations Center
Viewing or modifying group membership

Viewing or modifying user profiles
View or edit the profile of a user to set or reset any of the user profile attributes including password,
name, email, and language. You cannot change the user ID.

About this task

The portal administrator can view or edit user profiles by using the Administration portal. Select the
user from the authenticated portal users list to open the user profile and change profile details.

Note: Each user can also change their own profile by clicking Edit My Profile on the top navigation bar
of the portal.

Procedure
1. Log on to the solution portal as a portal administrator, for example, wpsadmin or another user who is

a member of the wpsadmins portal group.
2. On the main navigation bar at the top of the page, click Administration > Portal Administration.
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3. On the sidebar menu, expand the Access submenu, and click Users and Groups.
4. Click All Authenticated Portal Users. A table containing all existing users is displayed.
5. Find the user that you are interested in. Click the edit icon on the row for that user, to display their

Profile Management page. The attribute fields for the user profile are displayed.
6. Optional: To change the password for the user, enter a new password in the New Password: and

Confirm Password: fields.
7. You can add, edit, or delete information in any of the remaining fields.
8. To submit the changes you have made, click OK.

Results

The user profile is updated with the changes you submitted.

Securing the model manager
Using model manager security options, you can set up access rights to graphs. You can also determine
which users can view resource data returned from SPARQL queries or the model manager. IBM
Intelligent Operations for Water

About this task

Model manager security is set by granting users or groups either read or write access to graphs. Using
the Administration options in IBM Intelligent Operations Center you can create users and groups. Model
manager security options are setup in both the IBM Integrated Information Core administrative console
and the WebSphere Application Server.

Procedure
1. Log on to the solution portal as a portal administrator, for example, wpsadmin or another user who is

a member of the wpsadmins portal group.
2. On the main navigation bar at the top of the page, click Administration.
3. On the sidebar menu, expand the Access submenu, and click Users and Groups to create users and

groups and map them accordingly as already described in this section. For example, log on to the
solution portal https://analyticserver/wps/myportal and create two groups and two users and
map them accordingly.
a. Click New User to add the following new users.

iicmmuser
iicmmuser1

b. Click New Group to add the following new groups.
iicmmgrp
iicmmgrp1

4. Log on to the IBM Integrated Information Core administrative console. Click the Properties tab to
view the MODELMNGT configuration properties.

5. In the MODELMGMT category, set the graphSecurityEnabled to true to enable graph security. Click
Update and publish the revisions.

6. Log on to the WebSphere Application Server console.
7. Update the Security role to user / group mapping for the following applications.

a. Select the iic_management_services application.
b. Update the setting for Special subjects for all roles from Everyone to None.
c. Add the new created mapped users or mapped groups to roles: modelserverRead and

modelserverWrite. For example to modelserverRead and modelserverWrite add the groups
created above.
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iicmmgrp
iicmmgrp1

d. Click OK and Save.
e. Repeat the steps above for the iic_model_services application (for example

iic_modelRepositoryServices_DB2Store_ear application).
8. You can now test the security configuration.
9. Log on to the IBM Integrated Information Core administrative console.

10. Load the ontology and RDF files. For example:
rsm.owl
WIH.owl
EPANET.owl
sunshine_pipeline_type.owl
sunshine_meter_type.owl
cityname_asset_type.owl
modelServer.owl

sunshine_pipeline_instances.rdf
sunshine_meter_instances.rdf
cityname_pipeline.rdf
cityname_sensorMeter.rdf

11. Load the security model.
The sample security model is available on the application server at /opt/IBM/water/sunshine/model.
Two examples are provided.
The Sunshine Water example secures the SunshineWaterGroup graph. In this example, a new group
iicmmgrp is mapped to the respective roles.
<?xml version="1.0" encoding="UTF-8"?>
<rdf:RDF xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:cdi="http://ibm.com/iss/iic/model#"
xml:base="http://ibm.com/iss/iic/model/security/namespace/Sunshine">
<cdi:GraphSecurity rdf:ID="SunshineWaterGroup">

<cdi:GraphSecurity.namespace>http://SunshineWaterGroup
</cdi:GraphSecurity.namespace>

<cdi:GraphSecurity.readRole>iicmmgrp</cdi:GraphSecurity.readRole>
<cdi:GraphSecurity.writeRole>iicmmgrp</cdi:GraphSecurity.writeRole>

</cdi:GraphSecurity>
</rdf:RDF>

The City Name example secures the CityName graph. In this example, a new group iicmmgrp1group
is mapped to the respective roles.
ModelManagerSecurityGraph_cityName.xml
<?xml version="1.0" encoding="UTF-8"?>
<rdf:RDF xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:cdi="http://ibm.com/iss/iic/model#"
xml:base="http://ibm.com/iss/iic/model/security/namespace/cityName">
<cdi:GraphSecurity rdf:ID="cityName">

<cdi:GraphSecurity.namespace>http://cityName
</cdi:GraphSecurity.namespace>

<cdi:GraphSecurity.readRole>iicmmgrp1</cdi:GraphSecurity.readRole>
<cdi:GraphSecurity.writeRole>iicmmgrp1</cdi:GraphSecurity.writeRole>

</cdi:GraphSecurity>
</rdf:RDF>

12. Run SPARQL queries to check the security implementation. Sample SPARQL security-enabled
queries are provided below to demonstrate.
Sample 1 SPARQL query works for user iicmmuser1 but fails for user iicmmuser.
PREFIX cim:<http://iec.ch/TC57/CIM-generic#>
PREFIX rdfs:<http://www.w3.org/2000/01/rdf-schema#>

DELETE DATA
{
GRAPH <http://SunshineWaterGroup> {
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<http://SunshineWaterGroup#T2> cim:RSM_WorkEquipment.EquipmentLevel ’2121’
}
}
INSERT DATA
{
GRAPH <http://SunshineWaterGroup> {
<http://SunshineWaterGroup#T2> cim:RSM_WorkEquipment.EquipmentLevel ’2’

}
}

SELECT QUERIES

SELECT * WHERE { GRAPH ?g {<http://SunshineWaterGroup#T2> ?predicate ?object } }

SELECT * WHERE { GRAPH ?g {<http://cityName#Junction123> ?predicate ?object } }

Sample 2 SPARQL query works for user iicmmuser but fails for user iicmmuser1.
PREFIX cim:<http://iec.ch/TC57/CIM-generic#>
PREFIX rdfs:<http://www.w3.org/2000/01/rdf-schema#>

DELETE DATA
{
GRAPH <http://SunshineWaterGroup> {
<http://SunshineWaterGroup#T2> cim:RSM_WorkEquipment.EquipmentLevel ’2121’

}
}
INSERT DATA
{
GRAPH <http://SunshineWaterGroup> {
<http://SunshineWaterGroup#T2> cim:RSM_WorkEquipment.EquipmentLevel ’2’

}
}

SELECT QUERIES

SELECT * WHERE { GRAPH ?g {<http://SunshineWaterGroup#T2> ?predicate ?object } }

SELECT * WHERE { GRAPH ?g {<http://cityName#Junction123> ?predicate ?object } }

Sample 3 SPARQL query works for user iicmmuser but fails for user iicmmuser1.
PREFIX cim:<http://iec.ch/TC57/CIM-generic#>
PREFIX rdfs:<http://www.w3.org/2000/01/rdf-schema#>

DELETE
{
GRAPH <http://SunshineWaterGroup> {

?object cim:RSM_WorkEquipment.EquipmentLevel ?desc_orig
}
}
INSERT
{
GRAPH <http://SunshineWaterGroup> {

?object cim:RSM_WorkEquipment.EquipmentLevel ’2’
}
}
WHERE
{
GRAPH <http://SunshineWaterGroup> {

?object cim:RSM_IdentifiedObject.name ’T2’ ;
cim:RSM_WorkEquipment.EquipmentLevel ?desc_orig

}
}

PREFIX cim:<http://iec.ch/TC57/CIM-generic#>
PREFIX rdfs:<http://www.w3.org/2000/01/rdf-schema#>

DELETE
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{
GRAPH <http://SunshineWaterGroup> {

?object cim:RSM_WorkEquipment.EquipmentLevel ?desc_orig
}
}
INSERT
{
GRAPH <http://SunshineWaterGroup> {

?object cim:RSM_WorkEquipment.EquipmentLevel ’2’
}
}
WHERE
{
GRAPH <http://SunshineWaterGroup> {

?object cim:RSM_IdentifiedObject.name ’T2’ ;
cim:RSM_WorkEquipment.EquipmentLevel ?desc_orig

}
}

This sample SPARQL query works for user iicmmuser1 but fails for user iicmmuser.
PREFIX cim:<http://iec.ch/TC57/CIM-generic#>
PREFIX rdfs:<http://www.w3.org/2000/01/rdf-schema#>
DELETE
{
GRAPH <http://cityName> {

?object cim:RSM_WorkEquipment.EquipmentLevel ?desc_orig
}
}
INSERT
{
GRAPH <http://cityName> {

?object cim:RSM_WorkEquipment.EquipmentLevel ’2’
}

}
WHERE
{
GRAPH <http://cityName> {

?object cim:RSM_IdentifiedObject.name ’Junction123’ ;
cim:RSM_WorkEquipment.EquipmentLevel ?desc_orig

}
}

Securing the application service
Security settings for application services in IBM Intelligent Operations for Water can be specified using
the solution administration capabilities. For application services, such as model services or water
conservation portal, you can specify security settings.

About this task

IBM Intelligent Operations for Water provides security control at two levels: services access control and
page access control. Service access is managed in the IBM Intelligent Operations for Water Solution
Administration interface. Page access control is configured in the Portal Administration interface. For
example, specific roles can access services and pages only if that access is defined. Table 1 summarizes
some sample service level security settings.

Table 3. Sample service access control security settings

Sample service Group GET PUT POST DEL Comment

/ibm/water/api wpsadmins Yes Yes Yes Yes wpsadmin
has full
service access
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Table 3. Sample service access control security settings (continued)

Sample service Group GET PUT POST DEL Comment

/ibm/water/api/
access

wpsadmins Yes Yes Yes Yes wpsadmin
has full
service access

/ibm/water/api/
pages

All
authenticated
users

Yes No No No All users can
use the
service to
lookup
solution id
and page id

/ibm/water/api/
rendering-service

All
authenticated
users

Yes No No No All users can
use this
service to
render data

/ibm/water/api/i18n All
authenticated
users

Yes No No No All users can
read i18n
information

/ibm/water/api/style All
authenticated
users

Yes No No No All users can
read style

/ibm/water/api/
application

<SolutionID>
Admin

Yes No No No <SolutionID>
Admin can
list all
applications

/ibm/water/api/
solution

<SolutionID>
Admin

Yes No No No <SolutionID>
Admin can
list all
solutions

/ibm/water/api/
solution/<solutionID>

<SolutionID>
Admin

Yes Yes Yes Yes <SolutionID>
Admin can
only access
the specific
solutions

/ibm/water/api/
solution/
<solutionID>/page/
PageID

<SolutionID>
Supervisor

Yes Yes Yes Yes <SolutionID>
Supervisor
can only
access the
specific page

/ibm/water/api/
asset/<solutionID>

<SolutionID>
Planner

Yes Yes Yes Yes <SolutionID>
Planner can
only access
the specific
asset

Attention: You can only use the following procedure to modify access control for the <SolutionID>
groups in the table above. It is not possible to use the Administration - Solution Administration options
to change wpsadmins and All authenticated user groups.

Procedure
1. Log in to IBM Intelligent Operations for Water as administrator.
2. Select Administration – Solution Administration.
3. Go to Application Configuration.
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4. Select the solution for which you want to specify access to service.
5. Select Services.
6. Configure access by selecting the service and specifying the users groups that have access to services.
7. Click Save.
Related tasks:
“Configuring service access for user groups” on page 39
Configure service access permissions for user groups in a solution application.
“Viewing user groups” on page 40
View the user groups available in a solution application.
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Chapter 4. Configuring the solution

The topics in this section describe how to create and manage solution applications in IBM Intelligent
Operations for Water.

Configuring solution applications
As administrator, you can create and manage a solution application, such as Water, in IBM Intelligent
Operations for Water. A solution application is an instantiated application that is comprised of one or
more supporting (or component) applications. You can also use the tools to configure the supporting
applications.
Related concepts:
“Customizing the water solution” on page 214
Creating a customized water solution involves working with the SDK. IBM Intelligent Operations for
Water provides many extension mechanisms to facilitate your development work.

Creating solution applications
Create a solution application with supporting applications to do various tasks in IBM Intelligent
Operations for Water.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Management.
4. Click Create.
5. In Create solution application, specify the following details for the solution:

a. In Solution Application Id, enter a unique identifier for the solution application.
b. In Name, enter the solution application name. Optionally, click the Translation icon to add a

translation of the name for supported locales.
c. Optionally, enter a description of the solution application in Description.

6. Click Save.
7. In Create Solution Application status, an update displays to inform you of the time that elapses

before the timeout limit while the solution application is created. When the solution application is
created, Create Solution Application status displays a status log that provides a completion message.

Note: The solution creation process occurs on the server. Because the processing takes place in the
background, it is independent of the web request that is made in Create solution application. The
server is queried to return the log file, which provides an update on the status of the process. Create
solution application status displays that log file data. Within the log file, a marker indicates when the
process is successful. When that occurs, the process is completed and a success message is shown.

8. Click Close.
9. In Application Management, the following message displays: “The solution application [ID] has been

created successfully”.

What to do next

The newly created solution application is named in the list pane of Application Management. You can
select the solution from the list and configure basic details, as well as install or uninstall supporting
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applications. You can configure the solution application and its supporting applications in Application
Configuration.

Customizing properties for a solution application
Update the ID, name, description of a solution application.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Management.
4. Select a solution application from the list pane.
5. In Basics, you can customize the following properties:

a. In Solution Application Id, update the unique identifier for the solution application.
b. In Name, update the solution application name. Optionally, click the Translation icon to update a

translation of the name for any of the supported locales.
c. Optionally, update the description of the solution application in Description.

6. Click Save. The solution application properties are updated.

Installing and uninstalling supporting applications
Add and remove supporting applications from a solution application.

About this task

A solution application consists of one or more supporting applications. For example, a solution
application might include supporting applications such as Combined Sewer Overflow and Water
Conservation Portal. You can add and remove supporting applications on any of your solution
applications.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Management.
4. Select a solution application to update from the application list.
5. In Basics, you can add and remove supporting applications as follows:

a. To add a supporting application to the solution, go to Available supporting applications, select an
application, and click Add. The application is added to Supporting applications already included.

b. To remove a supporting application from the solution, go to Supporting applications already
included, select an application, and click Remove. The application is removed from Supporting
applications already included and returned to Available supporting applications.

6. Click Save. The supporting application configuration is saved.

Deleting solution applications
Remove a solution application from IBM Intelligent Operations for Water.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Management.
4. Select a solution application from the list pane.
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5. Click Delete. A message displays to ensure that you want to delete the solution application.
6. Click Yes.
7. In Delete Solution Application status, you receive constant message updates on the time that elapses

before the timeout limit while the solution application is being created. When the solution application
is created, Delete Solution Application status displays a status log that provides a completion
message.

Note: The deletion process occurs on the server. Therefore, the processing takes place in the
background and is independent of the web request that is made in Delete Solution Application
Status. The server is queried to return the log file, which provides an update on the status of the
process. Delete Solution Application Status displays the log file data. Within the log file, a marker
indicates when the process is successful. When that occurs, the process is completed and a success
message is shown.

8. Click Close.
9. In Application Management, the following message displays: “The solution application [ID] has been

deleted successfully”. The solution application is deleted.

Extending solution applications
Create, customize, move, and delete functionality in IBM Intelligent Operations for Water.

Root level extensions
Root level extensions are a key concept to understand when you want to add new functionality to a
solution application.

When a solution application is created, default supporting applications are automatically installed. The
supporting applications contain scripts that load predefined application pages. Each page has root level
(or parent) extensions, which have a standard set of default (child) extensions. A root level extension
provides sets of functionality for every application page that is installed on the solution application.

As administrator, you can customize the pages that are displayed in the front end of a supporting
application. To do so, you extend the default root level extensions by creating child extensions. You can
also extend the child extensions.

You can create or customize child extensions of root level extensions for any page by using
Administration > Solution Administration. Any changes that you make behind the scenes are reflected
on the page in the front end of the supporting applications.

Two types of root level extension can be displayed on an application page – container widgets and
event-driven widgets. Container widgets are displayed as objects on an application page. For example,
the list container widget can display a vertical list of assets, or a horizontal row of tabs. The page enables
user interaction with container widgets. An event-driven widget is a static widget that displays
information for the user and is not interactive. An example of an event-driven widget is a preview card
of an asset that appears on a map. Event-driven widgets can be modified in code by changing the root
level extension that uses it.

There are some restrictions with root level extensions. You can create child extensions for most parent
extensions, but not all. Also, you cannot delete root level extensions from a page. Apart from these
restrictions, root level extensions make solution applications highly extensible.

Creating extensions
Add child extensions to provide functionality to a solution application.
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About this task

You can extend the functionality in the supporting applications in your solution application. Root level
extensions provide the sets of functionality for application pages. To extend the functionality, you create
child extensions of the root level extensions. You can also extend the child extensions.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Configuration.
4. In Select a solution application to configure, select a solution application.
5. Ensure that the Pages tab is selected.
6. In Select a page to configure, choose a page type to extend; for example, Supervisor: Operations.

When selected, the page displays a list of its root level extension functionality. You can drill-down on
the list items to view the child extension functionality.

7. Select a root level extension to extend. You can extend the following root level extensions:
a. A predefined root level extension; for example, you can select Content Panel to base a child

extension on the root level extension that provides its functionality. Note that you cannot extend
some root level extensions because they are static; for example, the list container widget that
holds options for the Filter Panel.

b. A child extension of a root level extension; for example, you can select Content Panel > Map to
base a child extension on the root level extension that provides the map function. This action
creates a subpage that displays as an extra map tab in the front end of the supporting
application.

8. Click Create.
9. In Create extension configuration, enter a title and select a child extension type from the drop-down

menu. Note that you cannot change the description because the root level extension cannot be
changed or deleted.

10. Complete the remaining metadata for the extension. Note that some root level extensions, such as
Content Panel, do not have any inputs. However, you can enter a title and add translated titles in
various supported languages. However, if you are creating a map item, you can add inputs such as
zoom level, latitude, and longitude .

11. Click Save to close Create extension configuration. The functionality added in the new child
extension is displayed in the corresponding page type in the front end of the supporting application.

Customizing extension properties
Configure the properties of child extension functionality for a solution application.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Configuration.
4. In Select a solution application to configure, select a solution application.
5. Ensure that the Pages tab is selected.
6. In Select a page to configure, choose a page type to extend; for example, Supervisor: Operations.

When selected, the page displays a list of its root level extension functionality. You can drill down on
the list items to view the child extension functionality.

7. Select a root or child extension to customize from the list.
8. Change the extension properties in fields that are active and therefore available for customization.

For example, you can customize Content Panel > Map > HouseHold Layer by changing its title.
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9. Optionally, you view properties in fields that are inactive, and therefore unavailable for
customization, such as default extension details.

10. Click Save. The extension functionality is updated on the application pages.

Ordering extensions
Adjust the order of list and tab items for a page in a supporting application. You can move functionality
for child extensions, but for root level extensions.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Configuration.
4. In Select a solution application to configure, select a solution application.
5. Select the Pages tab.
6. In Select a page to configure, choose the page type for which you want to move functionality; for

example, Supervisor: Operations. When selected, the page displays a list of its root level extension
functionality. You can drill down on the list items to view the child extension functionality.

7. Select a child extension to move; for example, to move Household Layer, select Content Panel > Map
> HouseHold Layer.

8. Click Move Up or Move Down to adjust the order that the child extension is displayed on an
application page. For example, you can move a child extension that provides a vertical list menu from
top to bottom, you can move a horizontal tab menu from left to right. The new position of the
functionality is reflected on the application page

Deleting extensions
Remove front end functionality from a solution application by deleting the relevant child extension. You
cannot delete root level extensions, which provide predefined functionality.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Configuration.
4. In Select a solution application to configure, select a solution application.
5. Ensure that the Pages tab is selected.
6. In Select a page to configure, select the page for which you want to delete functionality. For example,

Supervisor: Operations. When selected, the page displays a list of its root level extension functionality.
You can drill-down on the list items to view the child extension functionality

7. Select the child extension that provides the functionality that you want to delete; for example,
Content Panel > Map > HouseHold Layer.

8. Click Delete. A warning message displays to ensure that you want to delete the child extension.
9. Click Yes. The child extension that provides the functionality is deleted from the solution. The change

is reflected in the front end of the solution application.

Optimizing map rendering
Configure server-side rendering to improve browser performance with maps in IBM Intelligent
Operations for Water.

About this task

You can configure server-side rendering for asset layers that are likely to display more than 3,000-5,000
assets simultaneously on a map. An asset count of 3,000-5,000 is typically the range where client-side
rendering starts to cause significant performance issues in a browser.
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Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Configuration

4. In Select a solution application to configure, select a solution application.
5. Go to Pages.
6. In Select a page to configure, select Supervisor Operations.
7. Go to Content Panel > Map > Asset Layer.
8. Go to the table that displays asset types for the semantic model.
9. For each asset type where more than 3,000-5,000 assets are likely to be displayed simultaneously on

a map, select Excluded from Client Side Rendering. After you select this option for the appropriate
asset types, browser performance during map rendering is greatly improved.

Note: Server-side rendering causes two minor display issues. The status of an asset's primary
measurement is not displayed on the asset icon, and the icon that is used for server-side rendering is
not currently configurable.

10. To activate the change to server-side rendering with immediate effect, click Save.

Configuring semantic models in a solution application
Create, synchronize, extend, and delete semantic models in a solution application. The semantic model,
which is known as the Reference Semantic Model (RSM), provides a framework to create water-based
solution applications. It supports the integration of operational data and related enterprise applications.
You can extend the semantic model to define custom asset types, asset instances, and relationships
between assets.

To learn more about semantic models, go to the following topics in the IBM Intelligent Water Information
Centre, Customizing the solution > Populating the infrastructure > Semantic Model introduction.
Related concepts:
“Configuring the metadata and model” on page 213
As a core technology in the water information hub, you start by working with the model manager
component, and customizing the semantic model so that it represents your water network.

Creating semantic models
Create a semantic model to provide the data for your solution application to use.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Configuration.
4. In Select a solution application to configure, select a solution application.
5. Select the Model tab.
6. Click Create.
7. In Create model, enter a prefix for the new model. A prefix is a unique identifier for the model.
8. Click Save. The new model is added to the list of model options in the Model tab.
9. Select the new model in the list.

10. In the Basics tab, add a name for the model in Name.
11. Optionally, you can describe the model in Description.
12. Click Save. The model is created.
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What to do next

You can synchronize the model with the solution database to ensure that there is no loss of metadata.

Synchronizing semantic models
Synchronize the semantic model with the solution application data store.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Configuration.
4. In Select a solution application to configure, select a solution application.
5. Select the Model tab.
6. Select a model from the list of options.
7. In the Basics tab, click Synchronize Now. The page outputs the log results of the synchronized

process. On completion, the model and database are synchronized and the metadata is persevered.
8. Click Save.

Deleting semantic models
Remove a semantic model from your solution application.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Configuration.
4. In Select a solution application to configure, select a solution application.
5. Select the Model tab.
6. Select a model to delete from the list of options.
7. Click Delete. A warning message is displayed to ensure that you want to delete the model.
8. Click Yes. The model is deleted from the solution application.
Related tasks:
“Deleting unused semantic models from the database” on page 223
Deleting a semantic model from the WIH.MODEL table is a significant task as all asset types, asset
instances, asset measurements, asset readings, asset locations and associated measurements are deleted
from the database.

Viewing asset types and super types
View asset types and super type relationships in a solution application. A super type is a type that has a
parent to child relationship with one or more asset types to avoid duplication throughout the system.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Configuration.
4. In Select a solution application to configure, select a solution application.
5. Select the Model tab.
6. Select a model from the model list.
7. Select the Asset Types tab.
8. In the asset type table, view the following information for the asset types in the solution application:
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a. ID: The unique identifier for the asset type.
b. Name: The name of the asset type.
c. Super Type: The super types with which the asset type has a child to parent relationship.

Configuring asset instances
Configure asset instances in a solution application.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Configuration.
4. In Select a solution to configure, select a solution application.
5. Select the Model tab.
6. Select a model from the model list.
7. Select the Asset Instances tab.
8. In Select an asset type, choose an asset type from the menu. A table of asset instances for the

selected asset type is displayed. For each asset instance, the table provides the following data: ID,
Name, Start Date, End Date, and Key Measurement.

9. Select an asset instance to configure. If measurement data is available for the selected asset instance,
a table of measurements is displayed. For each measurement, the table provides the following data:
ID, Name, Type, and Unit.

10. Select a measurement to configure and click the Collapse Section down arrow to display the
measurement configuration tabs.

11. As applicable, configure the configuration tabs as follows:
v Thresholds: Use the tab to set the start and end range for threshold measurements. The default

threshold measurements are Acceptable, Caution, and Critical. You can add, remove, and reset
threshold measurements. You can also apply the threshold measurements to all asset instances
with the same asset type. After you configure the thresholds, click Save.

v Key Measurement: Use the tab to set the key measurement and apply it to all asset instances with
the same type.

v No Reading Timeout: Use the tab to specify the timeout setting in milliseconds when the user
changes the measurement status to NO_READING. You can also apply the No Reading Timeout
measurement to all asset instances with the same asset type. After you configure the No Reading
Timeout, click Save.

v Derived Value Configuration: Use the tab to set the derived value. You can enter the input
measurement and select a formula option. You can also choose whether the formula is time-based,
and set the duration and interval calculation. In addition, you can reset or delete the derived
value, and apply it to all asset instances with the same type. After you configure the derived
value, click Save.

Configuring named areas
Configure named geographical areas in a solution application.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Configuration.
4. In Select a solution application to configure, select a solution application.
5. Select the Model tab.
6. Select a model from the model list.
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7. Select the Named Areas tab.
8. In Select a Named Area, choose a named area from the menu.
9. You can configure named areas as follows:

v Add: To create a named area, click Add New Named Area and complete the resulting form.
v Update: To update the context of the selected named area, change the properties in Name and

Description. To adjust the size of the named area, change the latitude and longitude and click
Update coordinates.

v Delete: To remove the selected named area, click Delete.
v Reset: To reset the selected named area, click Reset

v Reload: To reload all the named areas, click Reload all areas.
10. After you configure a named area, click Save.
Related concepts:
“Defining named areas” on page 199
Named areas are displayed on the map and are configured to filter assets by geographical location.

Configuring services and user groups in solution applications
Configure services and user groups in a solution application.

Configuring service access for user groups
Configure service access permissions for user groups in a solution application.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Configuration.
4. In Select a solution application to configure, select a solution application.
5. Select Services. A table displays the service access for user groups. You can view the service location

URLs, the user groups with access to them, and type of access that they have.
6. To configure service access for a new user group, take the following steps:

a. Click Add.
b. In the resulting Create Access Control pane, enter the service access properties and select the type

of access you want for the group. The type of access available is GET (read access), PUT (write
access), POST (insertion permission) and DELETE.

c. Click OK.
7. To configure service access for a current user group, take the following steps:

a. Select the table row for the service or group that you want to configure. Click Edit in the row.
b. In the resulting Edit Access Control pane, you can update the service access URL, the user group

name, and access type for the group. The type of access available is GET (read access), PUT (write
access), POST (insertion permission) and DELETE.

c. Click OK.
8. To revoke service access for a user group, select the table row for the group in the table, and click

Remove in the row.
9. Click Save. The changes are reflected in the front-end of the solution application.
Related tasks:
“Securing the application service” on page 28
Security settings for application services in IBM Intelligent Operations for Water can be specified using
the solution administration capabilities. For application services, such as model services or water
conservation portal, you can specify security settings.
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Viewing user groups
View the user groups available in a solution application.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Configuration.
4. In Select a solution application to configure, select a solution application.
5. Select User Groups. The user groups are listed within the tab.
Related tasks:
“Securing the application service” on page 28
Security settings for application services in IBM Intelligent Operations for Water can be specified using
the solution administration capabilities. For application services, such as model services or water
conservation portal, you can specify security settings.

Configuring supporting applications
Configure and extend the supporting applications in a solution application. A solution application is
composed of supporting applications that are either predefined or added by the administrator. Within
every supporting application, default root level extensions provide sets of functionality for the front-end
application pages. You can extend the root level extensions to create new child extension functionality.
Related concepts:
“Configuring the metadata and model” on page 213
As a core technology in the water information hub, you start by working with the model manager
component, and customizing the semantic model so that it represents your water network.
“Customizing the water solution” on page 214
Creating a customized water solution involves working with the SDK. IBM Intelligent Operations for
Water provides many extension mechanisms to facilitate your development work.

Creating supporting applications
Create supporting applications for your solution application.

About this task

For every new supporting application that you create, you can use the root level extensions and child
extensions from any existing supporting application in a solution application. In this task, you create the
supporting application that you can then extend in your own way.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application.
4. Click Create.
5. In Create Supporting application, you can specify the basic properties for the supporting application

as follows:
a. In Id, enter a unique identifier for the supporting application.
b. In Name, enter the default supporting application name. Optionally, click the Translation icon to

add a translation of the name for supported locales.
c. Optionally, in Description, enter a description of the supporting application.

6. Click Save. The new supporting application is created.
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What to do next

You can configure user interface extensions, services, and configuration extensions for supporting
applications in Administration > Solution Administration > Application.

Customizing properties for supporting applications
Customize the basic properties of a supporting application in a solution application.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application.
4. Select an application from the list of application options.
5. In Basics, you can configure the main properties for the supporting application as follows:

a. In Id, update the unique identifier for the supporting application.
b. In Name, update the default application name. Optionally, click the Translation icon to update

translations of the name for supported locales.
c. Optionally, in Description, update the description of the supporting application.

6. Click Save. The supporting application properties are updated.

What to do next

You can update the entire configuration of the supporting application. To update user interface
extensions, services, and configuration extensions for the supporting application in Administration >
Solution Administration > Application.

Deleting supporting applications
Remove a supporting application from a solution application.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application.
4. Select a supporting application to delete from the list of application options within the tab.
5. Click Delete. A warning message is displayed to ensure that you want to delete the supporting

application.
6. Click Yes. The supporting application is deleted from the solution.

Configuring application extensions in supporting applications
Create, customize, and delete application (or front end) extensions in a supporting application.

Configuring application services in supporting applications
Create, customize, and delete services for supporting applications in a IBM Intelligent Operations for
Water .

Creating application services:

Create a service for supporting applications.

Chapter 4. Configuring the solution 41



Procedure

1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application.
4. Select the supporting application for which you want to create a service.
5. Select Services and click Create.
6. In Create application, enter the following service properties:

a. Name: Enter the unique default name for the service. Optionally, click the Translation icon to add
a translation of the name for supported locales.

b. Description: Optionally, enter the purpose of the service.
c. Service URL: Enter the location of the service.

7. Click Save.
8. In Application Service Creation status, an update displays to inform you of the time that elapses

before the timeout limit while the service is created.
9. When the service is created, Application Service Creation status displays a completion message and

a status log on the creation process.

Customizing application services:

Customize a service for a supporting application.

Procedure

1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application.
4. Select the supporting application for which you want to customize a service.
5. Select Services.
6. Select the service that you want to customize.
7. In the properties panel for the service, you can update the following service properties:

a. Name: Update the unique name for the service. Optionally, click the Translation icon to update a
translation of the name for supported locales.

b. Description: Optionally, update the purpose of the service.
c. Service URL: Update the location of the service.

8. Click Save.
9. In Application, the following message is displayed: “The service [Name] has been saved

successfully”. The service is updated.

Deleting services:

Remove a service from a supporting application.

Procedure

1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application.
4. Select the supporting application for which you want to delete a service.
5. Select Services.
6. Select the service that you want to delete and click Delete. A warning message displays to ensure that

you want to delete the service.
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7. Click Yes. In Application, the following message is displayed: “The service [Name] has been deleted
successfully”. The service is deleted from the supporting application.

Creating application extensions
Create child extensions to provide functionality to your supporting applications.

About this task

You can create references to front end extensions that are defined in the code of the application by using
the Application Extensions tab.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application.
4. Select the supporting application for which you want to create an extension.
5. Select Application Extensions.
6. Click Create.
7. In Create extension, enter the following extension properties:

a. Name

b. Dojo Module

c. Dojo Package

d. Dojo Package Path

e. Extensible – yes or no
f. Dynamic – yes or no
g. Parameters

8. Optionally, you can enter the following extension properties:
a. Extends

b. Description

c. URI pattern

9. Click Save.
10. In Extension Creation status, an update displays to inform you of the time that elapses before the

timeout limit while the extension is created.
11. When the extension is created, Extension Creation status displays a completion message and a status

log on the creation process.
12. Click Close.
13. In Application, the following message is displayed: “The extension [ID] has been created

successfully”. The supporting application is extended.

Customizing application extensions
Customize the root level and child extensions that provide functionality to your supporting applications.

About this task

You can customize references to front-end extensions that are defined in the code of the application by
using the Application Extensions tab.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
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3. Go to Application.
4. Select the supporting application for which you want to customize an extension.
5. Select Application Extensions.
6. Select an extension to customize from the list of extension options.
7. In the properties pane for the extension, you can update the following extension properties:

a. Name

b. Dojo Module

c. Dojo Package

d. Dojo Package Path

e. Extensible – yes or no
f. Dynamic – yes or no
g. Parameters

h. Extends

i. Description

j. URI pattern

8. Click Save. The extensions are updated.

Deleting application extensions
Remove extensions from your supporting applications.

About this task

You can delete references to front end extensions that are defined in the code of the application by using
the Application Extensions tab.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application.
4. Select the supporting application for which you want to delete an extension.
5. Select Application Extensions.
6. Select a user interface extension to delete.
7. Click Delete. A warning message is displayed to ensure that you want to delete the extension.
8. Click Yes. The extension is deleted from the supporting application.

Configuring administration extensions in supporting applications
Create, customize, and delete administration (or back-end) extensions for supporting applications in IBM
Intelligent Operations for Water.

Creating administration extensions
Create an administration extension in a supporting application for a task that is not apparent to the user.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application.
4. Select the supporting application for which you want to create a configuration extension.
5. Select Administration Extensions and click Create.

44 IBM Intelligent Water: IBM Intelligent Operations for Water Product Documentation



6. Enter the following extension properties:
a. Name: Enter the unique default name for the extension. Optionally, click the Translation icon and

add a translation of the name for supported locales.
b. Dojo Module

c. Dojo Package

d. Dojo Package Path

e. Optionally, in Description, you can enter the purpose of the extension.
7. Click Save.
8. In Application, the following message is displayed: “The extension [Name] has been created

successfully”. The service is created for the supporting application and an option for it displays
within Services.

Customizing administration extensions
Customize an administration extension in a supporting application for a task that is not apparent to the
user.

About this task

You can customize references to back-end extensions that are defined in the code of the application by
using the Administration Extensions tab.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application.
4. Select the supporting application for which you want to customize a configuration extension.
5. Select Administration Extensions.
6. Select the configuration extension that you want to customize.
7. In the properties pane for the extension, update any of the following extension properties:

a. Name: Update the unique default name for the extension. Optionally, click the Translation icon
and update a translation of the name for supported locales.

b. Dojo Module

c. Dojo Package

d. Dojo Package Path

e. Description

8. Click Save.
9. In Application, the following message is displayed: “The extension [Name] has been saved

successfully”. The service is created for the supporting application and an option for it displays
within Services.

Deleting administration extensions
Remove an administration extension in a supporting application for a task that is not apparent to the
user.

Procedure
1. Log on to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application.
4. Select the supporting application for which you want to delete a configuration extension.
5. Select Administration Extensions.
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6. Select the extension that you want to delete and click Delete. A warning message displays to ensure
that you want to delete the extension.

7. Click Yes. In Application, the following message is displayed: “The service [Name] has been deleted
successfully”. The extension is deleted from the supporting application.
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Chapter 5. Integrating the solution

Products and services can be integrated with IBM Intelligent Operations for Water.

IBM Intelligent Operations for Water provides a public web service interface when you are writing or
testing applications. You can use any HTTP client in any programming language to query metadata about
your water infrastructure. You can access the URLs and any HTTP client in any programming language
to interact with the API.

For information about other solution integration points, refer to the links at the end of the page.
Related concepts:
Chapter 3, “Securing the solution,” on page 19
Securing IBM Intelligent Operations for Water is an important consideration. To ensure that the system is
secure, you must manage who can access the system and assign the correct level of access within the
solution.
“Customizing the water solution” on page 214
Creating a customized water solution involves working with the SDK. IBM Intelligent Operations for
Water provides many extension mechanisms to facilitate your development work.

APIs and services
IBM Intelligent Operations for Water provides a set of APIs that are implemented using Representational
State Transfer (REST) Services.

The REST services provide a set of uniform resource identifiers (URIs) that access data in IBM Intelligent
Operations for Water components, such as system properties and key performance indicators (KPIs). You
can call the services with any HTTP client application, and define an expected response in the form of a
JavaScript Object Notation (JSON) object.

The JSON format can be easily parsed and processed by JavaScript, and other products, tools, and
languages, which gives you greater flexibility in using your own environment. Many of the services take
a simple HTTP GET URI as input. More complicated services take JSON input through HTTP GET for
retrieval, HTTP POST for create, or HTTP PUT for update.

Results are returned in JSON, and error messages and status indicators are returned in the HTTP
response as JSON output.

Application management services
Application management services provide functionality to manage supporting applications in a solution
application in IBM Intelligent Operations for Water. A supporting application is the concept that is used
to group related components such as UI extension, services, configuration extensions, algorithms, and so
on. The grouping of components takes place in a specific application domain; for example, the pipe
failure prediction application or the pressure optimization application in a Water solution application.

Application
Use the application services to manage supporting applications.

Listing applications:

List the supporting applications in a solution application.
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Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/application

Request Parameters

Not applicable.

Response
[{
"APP_ID": "CSO",
"NAME": "Combined Sewer Overflow Management",
"DESCRIPTION": "Combined Sewer Overflow Management",
"ROWID": 1,
"NAME_I18N": "Combined Sewer Overflow Management"

},{
"APP_ID": "EAM",
"NAME": "Maximo Integration",
"DESCRIPTION": "Maximo Integration",
"ROWID": 2,
"NAME_I18N": "Maximo Integration"

},{
"APP_ID": "IOW",
"NAME": {
"key": "application.name",
"group": "IOW"
},
"DESCRIPTION": "Intelligent Operations for Water",
"ROWID": 3,
"NAME_I18N": "Intelligent Operations for Water"

},{
"APP_ID": "PFP",
"NAME": "Pipe Failure Prediction",
"DESCRIPTION": "Pipe Failure Prediction",
"ROWID": 4,
"NAME_I18N": "Pipe Failure Prediction"

},{
"APP_ID": "PO",
"NAME": "Pressure Optimization",
"DESCRIPTION": "Pressure Optimization",
"ROWID": 5,
"NAME_I18N": "Pressure Optimization"

},{
"APP_ID": "WCP",
"NAME": "Water Conservation Portal",
"DESCRIPTION": "Water Conservation Portal",
"ROWID": 6,
"NAME_I18N": "Water Conservation Portal"

}
]

Getting a single application:

Retrieve a single supporting application in a solution application.

Method

GET.
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Resource URL
http://<web server hostname>/ibm/water/api/application/<APP_ID>

For example, https://<web server hostname>/ibm/water/api/application/IOW.

Request Parameters

Not applicable.

Response
{
"APP_ID": "IOW",
"NAME": {
"key": "application.name",
"group": "IOW"
},
"DESCRIPTION": "Intelligent Operations for Water",
"NAME_I18N": "Intelligent Operations for Water"
}

Registering an application:

Register a supporting application in a solution application.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/application

Request Parameters
{
"APP_ID": "MYAPP",
"NAME": "My Application ",
"DESCRIPTION": "My Application "
}

Response
{
"APP_ID": "MYAPP",
"NAME": "My Application ",
"DESCRIPTION": "My Application ",
"NAME_I18N": "My Application "
}

Updating an application:

Update a supporting application in a solution application.

Method

PUT.

Resource URL
https://<web server hostname>/ibm/water/api/application/<APP_ID>

For example, https://web server hostname>/ibm/water/api/application/MYAPP.
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Request Parameters
{
"NAME": "My Application ",
"DESCRIPTION": "My Application "

}

Response
{
"APP_ID": "MYAPP",
"NAME": "My Application ",
"DESCRIPTION": "My Application ",
"NAME_I18N": "My Application "

}

Deleting an application:

Delete a supporting application in a solution application.

Method

DELETE.

Resource URL
https://<web server hostname>/ibm/water/api/application/<APP_ID>

For example, https://<web server hostname>/ibm/water/api/application/MYAPP.

Request Parameters

Not applicable.

Response
{
"APP_ID": "MYAPP",
"NAME": "My Application ",
"DESCRIPTION": "My Application ",
"NAME_I18N": "My Application "

}

UI extension
Use the UI extension service to manage user interface extensions in a supporting application.

Listing registered UI extensions:

List the UI extensions registered in a supporting application.

Method

GET.

Resource URL
http://<web server hostname>/ibm/water/api/application/<APP_ID>/extension

For example, ://<web server hostname>/ibm/water/api/application/IOW/extension.

Request Parameters

Not applicable.
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Response
[{
"APP_ID": "IOW",
"EXTENSION_ID": "water.action.ItemAction",
"NAME": {
"key": "water.action.ItemAction",
"group": "IOW"
},
"DESCRIPTION": "Actions for Individual Items",
"IS_CONTAINER": true,
"DOJO_PACK_NAME": "water",
"DOJO_PACK_LOCATION": "\/ibm\/water\/widgets\/js\/water",
"DOJO_MODULE": "water\/action\/ItemAction",
"DOJO_MODULE_CONFIG": null,
"EXTENDS_APP_ID": null,
"EXTENDS": null,
"PARAMETERS": {

},
"IS_DYNAMIC": false,
"URI_PATTERN": null,
"ROWID": 1,
"NAME_I18N": "Actions for Individual Items"
},{
"APP_ID": "IOW",
"EXTENSION_ID": "water.action.SampleEventAction_1",
"NAME": {
"key": "water.action.SampleEventAction_1",
"group": "IOW"
},
"DESCRIPTION": "Sample Action event 1",
"IS_CONTAINER": false,
"DOJO_PACK_NAME": "water",
"DOJO_PACK_LOCATION": "\/ibm\/water\/widgets\/js\/water",
"DOJO_MODULE": "water\/action\/SampleEventAction_1",
"DOJO_MODULE_CONFIG": null,
"EXTENDS_APP_ID": "IOW",
"EXTENDS": "water.action.ItemAction",
"PARAMETERS": {

},
"IS_DYNAMIC": false,
"URI_PATTERN": "\/ibm\/ioc\/api\/spatial-service\/collections\/*\/records\/*",
"ROWID": 2,
"NAME_I18N": "Sample Action event 1"
}
...
...
...
]

Getting a single UI extension:

Retrieve a single UI extension from a supporting application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/application/<APP_ID>/extension/<EXTENSION_ID>

For example, https://web server hostname>/ibm/water/api/application/IOW/extension/
water.action.ItemAction.
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Request Parameters

Not applicable.

Response
{
"APP_ID": "IOW",
"EXTENSION_ID": "water.action.ItemAction",
"NAME": {
"key": "water.action.ItemAction",
"group": "IOW"
},
"DESCRIPTION": "Actions for Individual Items",
"IS_CONTAINER": true,
"DOJO_PACK_NAME": "water",
"DOJO_PACK_LOCATION": "\/ibm\/water\/widgets\/js\/water",
"DOJO_MODULE": "water\/action\/ItemAction",
"DOJO_MODULE_CONFIG": null,
"EXTENDS_APP_ID": null,
"EXTENDS": null,
"PARAMETERS": {

},
"IS_DYNAMIC": false,
"URI_PATTERN": null,
"NAME_I18N": "Actions for Individual Items"

}

Registering a UI extension:

Register a UI extension to a supporting application in a solution application.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/application/<APP_ID>/extension

For example, https://<web server hostname>/ibm/water/api/application/IOW/extension.

Request Parameters
{
"NAME": "My Sample Filter",
"DESCRIPTION": "My Sample Filter",
"IS_CONTAINER": false,
"IS_DYNAMIC": false,
"DOJO_PACK_NAME": "my",
"DOJO_PACK_LOCATION": "/myapp/js/my",
"DOJO_MODULE": "my/Filter",
"DOJO_MODULE_CONFIG": "my/FilterConfig",
"EXTENDS_APP_ID": "IOW",
"EXTENDS": "water.filter.FilterGroupPane",
"PARAMETERS": {

},
"URI_PATTERN": null

}

.
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Response
{
"APP_ID": "IOW",
"EXTENSION_ID": "d976cb0a-ff06-47a9-98e5-06ebca8f1647",
"NAME": "My Sample Filter",
"DESCRIPTION": "My Sample Filter",
"IS_CONTAINER": false,
"DOJO_PACK_NAME": "my",
"DOJO_PACK_LOCATION": "\/myapp\/js\/my",
"DOJO_MODULE": "my\/Filter",
"DOJO_MODULE_CONFIG": "my\/FilterConfig",
"EXTENDS_APP_ID": "IOW",
"EXTENDS": "water.filter.FilterGroupPane",
"PARAMETERS": {

},
"IS_DYNAMIC": false,
"URI_PATTERN": null,
"NAME_I18N": "My Sample Filter"
}

Updating a UI extension:

Update a UI extension in a supporting application.

Method

PUT.

Resource URL
https://<web server hostname>/ibm/water/api/application/<APP_ID>/extension/<EXTENSION_ID>

For example, https://<web server hostname>/ibm/water/api/application/IOW/extension/d976cb0a-
ff06-47a9-98e5-06ebca8f1647.

Request Parameters
{
"NAME": "My Sample Filter",
"DESCRIPTION": "This is a Sample Filter"
}

.

Response
{
"APP_ID": "IOW",
"EXTENSION_ID": " d976cb0a-ff06-47a9-98e5-06ebca8f1647",
"NAME": "My Sample Filter",
"DESCRIPTION": "This is a Sample Filter",
"IS_CONTAINER": false,
"DOJO_PACK_NAME": "my",
"DOJO_PACK_LOCATION": "\/myapp\/js\/my",
"DOJO_MODULE": "my\/Filter",
"DOJO_MODULE_CONFIG": "my\/FilterConfig",
"EXTENDS_APP_ID": "IOW",
"EXTENDS": "water.filter.FilterGroupPane",
"PARAMETERS": {

},
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"IS_DYNAMIC": false,
"URI_PATTERN": null,
"NAME_I18N": "My Sample Filter"

}

Unregistering a UI extension:

Unregister a UI extension for a supporting application.

Method

DELETE.

Resource URL
https://<web server hostname>/ibm/water/api/application/<APP_ID>/extension/<EXTENSION_ID>

For example, https://<web server hostname>/ibm/water/api/application/IOW/extension/d976cb0a-
ff06-47a9-98e5-06ebca8f1647

Request Parameters

Not applicable.

Response
{
"APP_ID": "IOW",
"EXTENSION_ID": " d976cb0a-ff06-47a9-98e5-06ebca8f1647",
"NAME": "My Sample Filter",
"DESCRIPTION": "This is a Sample Filter",
"IS_CONTAINER": false,
"DOJO_PACK_NAME": "my",
"DOJO_PACK_LOCATION": "\/myapp\/js\/my",
"DOJO_MODULE": "my\/Filter",
"DOJO_MODULE_CONFIG": "my\/FilterConfig",
"EXTENDS_APP_ID": "IOW",
"EXTENDS": "water.filter.FilterGroupPane",
"PARAMETERS": {

},
"IS_DYNAMIC": false,
"URI_PATTERN": null,
"NAME_I18N": "My Sample Filter"

}

Listing all available container extensions:

List all available container extensions for a supporting application. The list is not limited to the
application currently in use. The information is used when you register a child extension that extends its
parent to another application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/application/<APP_ID>/container

For example, https://<web server hostname>/ibm/water/api/application/IOW/container.
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Request Parameters

Not applicable.

Response
[{
"APP_ID": "IOW",
"EXTENSION_ID": "water.action.ItemAction",
"NAME": {
"group": "IOW",
"key": "water.action.ItemAction"
},
"DESCRIPTION": "Actions for Individual Items",
"IS_CONTAINER": true,
"DOJO_PACK_NAME": "water",
"DOJO_PACK_LOCATION": "\/ibm\/water\/widgets\/js\/water",
"DOJO_MODULE": "water\/action\/ItemAction",
"DOJO_MODULE_CONFIG": null,
"EXTENDS_APP_ID": null,
"EXTENDS": null,
"PARAMETERS": {

},
"IS_DYNAMIC": false,
"URI_PATTERN": null,
"ROWID": 1,
"NAME_I18N": "Actions for Individual Items"
},{
"APP_ID": "IOW",
"EXTENSION_ID": "water.filter.BoundaryFilter",
"NAME": {
"group": "IOW",
"key": "water.filter.BoundaryFilter"
},
"DESCRIPTION": "Boundary Filter",
"IS_CONTAINER": true,
"DOJO_PACK_NAME": "water",
"DOJO_PACK_LOCATION": "\/ibm\/water\/widgets\/js\/water",
"DOJO_MODULE": "water\/filter\/BoundaryFilter",
"DOJO_MODULE_CONFIG": null,
"EXTENDS_APP_ID": "IOW",
"EXTENDS": "water.filter.FilterGroupPane",
"PARAMETERS": null,
"IS_DYNAMIC": false,
"URI_PATTERN": null,
"ROWID": 2,
"NAME_I18N": "Boundary Filter"
},
...
...
]

Services
Manage services in supporting applications.

Listing the services registered:

List the services that are registered in a supporting application.

Method

GET.
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Resource URL
https://<web server hostname>/ibm/water/api/application/<APP_ID>/service

For example, https://<web server hostname>/ibm/water/api/application/IOW/service.

Request Parameters

Not applicable.

Response
[{
"APP_ID": "IOW",
"SERVICE_ID": "app",
"NAME": {
"key": "service.app_service",
"group": "IOW"
},
"DESCRIPTION": "Application Service",
"URL": "\/ibm\/water\/api\/application",
"ROWID": 2,
"NAME_I18N": "Application Service"

},{
"APP_ID": "IOW",
"SERVICE_ID": "das",
"NAME": {
"key": "service.data_access_service",
"group": "IOW"
},
"DESCRIPTION": "Data Access Service",
"URL": "\/ibm\/water\/api\/asset\/{solutionId}",
"ROWID": 3,
"NAME_I18N": "Data Access Service"

},{
"APP_ID": "IOW",
"SERVICE_ID": "rendering",
"NAME": {
"key": "service.rendering_service",
"group": "IOW"
},
"DESCRIPTION": "Rendering Service",
"URL": "\/ibm\/water\/api\/rendering-service",
"ROWID": 4,
"NAME_I18N": "Rendering Service"

},{
"APP_ID": "IOW",
"SERVICE_ID": "solution",
"NAME": {
"key": "service.solution_service",
"group": "IOW"
},
"DESCRIPTION": "Solution Service",
"URL": "\/ibm\/water\/api\/solution",
"ROWID": 5,
"NAME_I18N": "Solution Service"

}
]

Getting a single service:

Retrieve a single service from a supporting application.
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Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/application/<APP_ID>/service/<SERVICE_ID>

For example, https://<web server hostname>/ibm/water/api/application/IOW/service/das.

Request Parameters

Not applicable.

Response
{
"APP_ID": "IOW",
"SERVICE_ID": "das",
"NAME": {
"key": "service.data_access_service",
"group": "IOW"
},
"DESCRIPTION": "Data Access Service",
"URL": "\/ibm\/water\/api\/asset\/{solutionId}",
"NAME_I18N": "Data Access Service"
}

Registering a service:

Register a service to a supporting application.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/application/<APP_ID>/service

For example, https://<web server hostname>/ibm/water/api/application/IOW/service.

Request Parameters
{
"NAME": "My Service",
"DESCRIPTION": "My Service",
"URL": "\/ibm\/water\/api\/myservice\/{solutionId}"
}

Response
{
"APP_ID": "IOW",
"SERVICE_ID": "das",
"NAME": {
"key": "service.data_access_service",
"group": "IOW"
},
"DESCRIPTION": "Data Access Service",
"URL": "\/ibm\/water\/api\/asset\/{solutionId}",
"NAME_I18N": "Data Access Service"
}
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Updating a service:

Update a service in a supporting application.

Method

PUT.

Resource URL
https://<web server hostname>/ibm/water/api/application/<APP_ID>/service/<SERVICE_ID>

For example, https://<web server hostname>/ibm/water/api/application/IOW/service/75604c5c-a751-
44fb-a025-a5bd6613b0d9.

Request Parameters
{
"NAME": "My Service",
"DESCRIPTION": "My Service",
"URL": "\/ibm\/water\/api\/myservice\/{solutionId}"

}

Response
{
"APP_ID": "IOW",
"SERVICE_ID": "75604c5c-a751-44fb-a025-a5bd6613b0d9",
"NAME": "My Service",
"DESCRIPTION": "My Service",
"URL": "\/ibm\/water\/api\/myservice\/{solutionId}",
"NAME_I18N": "My Service"

}

Unregistering a service:

Unregister a service from a solution application.

Method

DELETE.

Resource URL
https://<web server hostname>/ibm/water/api/application/<APP_ID>/service/<SERVICE_ID>

For example, https://<web server hostname>/ibm/water/api/application/IOW/service/75604c5c-a751-
44fb-a025-a5bd6613b0d9.

Request Parameters

Not applicable.

Response
{
"APP_ID": "IOW",
"SERVICE_ID": "75604c5c-a751-44fb-a025-a5bd6613b0d9",
"NAME": "My Service",
"DESCRIPTION": "My Service",
"URL": "\/ibm\/water\/api\/myservice\/{solutionId}",
"NAME_I18N": "My Service"

}
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Configuration extension
Configure the widgets that extend the administration user interface in a supporting application.

Listing the registered configuration extensions:

List the registered configuration extensions in a supporting application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/application/<APP_ID>/extconfig

For example, https://<web server hostname>/ibm/water/api/application/IOW/extconfig.

Request Parameters

Not applicable.

Response
[{
"APP_ID": "IOW",
"EXTENSION_ID": "59dbb7db-f90e-4924-9274-f1c40a4a542a",
"NAME": "My Config",
"DESCRIPTION": "My Config",
"DOJO_PACK_NAME": "my",
"DOJO_PACK_LOCATION": "\/myapp\/js",
"DOJO_MODULE": "my\/MyConfig",
"ROWID": 1,
"NAME_I18N": "My Config"
}
]

Getting a single configuration extension:

Retrieve a single configuration extension in a supporting application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/application/<APP_ID>/extconfig/<EXTENSION_ID>

For example, https://<web server hostname>/ibm/water/api/application/IOW/extconfig/59dbb7db-
f90e-4924-9274-f1c40a4a542a.

Request Parameters

Not applicable.

Response
{
"APP_ID": "IOW",
"EXTENSION_ID": "59dbb7db-f90e-4924-9274-f1c40a4a542a",
"NAME": "My Config",
"DESCRIPTION": "My Config",
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"DOJO_PACK_NAME": "my",
"DOJO_PACK_LOCATION": "\/myapp\/js",
"DOJO_MODULE": "my\/MyConfig",
"NAME_I18N": "My Config"

}

Registering a configuration extension:

Register a configuration extension to a supporting application.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/application/<APP_ID>/extconfig

For example, https://<web server hostname>/ibm/water/api/application/IOW/extconfig.

Request Parameters
{
"NAME": "My Config",
"DESCRIPTION": "My Config",
"DOJO_PACK_NAME": "my",
"DOJO_PACK_LOCATION": "/myapp/js",
"DOJO_MODULE": "my/MyConfig"

}

Response
{
"APP_ID": "IOW",
"EXTENSION_ID": "59dbb7db-f90e-4924-9274-f1c40a4a542a",
"NAME": "My Config",
"DESCRIPTION": "My Config",
"DOJO_PACK_NAME": "my",
"DOJO_PACK_LOCATION": "\/myapp\/js",
"DOJO_MODULE": "my\/MyConfig",
"NAME_I18N": "My Config"

}

Updating a configuration extension:

Update a configuration extension in a supporting application.

Method

PUT.

Resource URL
https://<web server hostname>/ibm/water/api/application/<APP_ID>/extconfig/<EXTENSION_ID>

For example, https://<web server hostname>/ibm/water/api/application/IOW/extconfig/59dbb7db-
f90e-4924-9274-f1c40a4a542a.

Request Parameters
{
"NAME": "My Config",
"DESCRIPTION": "My Config",
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"DOJO_PACK_NAME": "my",
"DOJO_PACK_LOCATION": "/myapp/js",
"DOJO_MODULE": "my/MyConfig"
}

Response
{
"APP_ID": "IOW",
"EXTENSION_ID": "59dbb7db-f90e-4924-9274-f1c40a4a542a",
"NAME": "My Config",
"DESCRIPTION": "My Config",
"DOJO_PACK_NAME": "my",
"DOJO_PACK_LOCATION": "\/myapp\/js",
"DOJO_MODULE": "my\/MyConfig",
"NAME_I18N": "My Config"
}

Unregistering a configuration extension:

Unregister a configuration extension in a supporting application.

Method

DELETE.

Resource URL
https://<web server hostname>/ibm/water/api/application/<APP_ID>/extconfig/<EXTENSION_ID>

For example, https://<web server hostname>/ibm/water/api/application/IOW/extconfig/59dbb7db-
f90e-4924-9274-f1c40a4a542a.

Request Parameters

Not applicable.

Response
{
"APP_ID": "IOW",
"EXTENSION_ID": "59dbb7db-f90e-4924-9274-f1c40a4a542a",
"NAME": "My Config",
"DESCRIPTION": "My Config",
"DOJO_PACK_NAME": "my",
"DOJO_PACK_LOCATION": "\/myapp\/js",
"DOJO_MODULE": "my\/MyConfig",
"NAME_I18N": "My Config"
}

Solution management services
Manage the components of a solution application in IBM Intelligent Operations for Water.

Solution
Use the solution services to manage a solution application.

Listing solutions:

List the solutions applications.
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Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/solution

Request Parameters

Not applicable.

Response
[{
"SOLUTION_ID": "Sunshine",
"NAME": "Sunshine Sample Solution",
"DESCRIPTION": "Sunshine Sample Solution",
"ROWID": 1,
"NAME_I18N": "Sunshine Sample Solution"

}
]

Register a solution:

Register a solution application.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/solution

Request Parameters
[{
"SOLUTION_ID": "Sunshine",
"NAME": "Sunshine Sample Solution",
"DESCRIPTION": "Sunshine Sample Solution"}

]

Response
[{
"SOLUTION_ID": "Sunshine",
"NAME": "Sunshine Sample Solution",
"DESCRIPTION": "Sunshine Sample Solution",
"ROWID": 1,
"NAME_I18N": "Sunshine Sample Solution"

}
]

Updating a solution:

Update a solution application.

Method

PUT.
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Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>

For example, https://<web server hostname>/ibm/water/api/solution/MySolution.

Request Parameters
{
"NAME": "My Solution",
"DESCRIPTION": "My Solution"
}

Response
{
"SOLUTION_ID": "MySolution",
"NAME": "My Solution",
"DESCRIPTION": "My Solution",
"NAME_I18N": "My Solution"
}

Unregistering a solution:

Unregister a solution application.

Method

DELETE.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/solution/MySolution.

Request Parameters

Not applicable.

Response
{
"SOLUTION_ID": "MySolution",
"NAME": "My Solution",
"DESCRIPTION": "My Solution",
"NAME_I18N": "My Solution"
}

Creating a solution:

Creating a solution application is a three-step process. You must create a solution name, request to create
the solution, and poll the solution status to see that it is successful.

Step 1: Creating a solution name:

The first step to creating a solution application is to select a name.

Method

POST.
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Resource URL
https://<web server hostname>/ibm/water/api/i18n/resources

Request Parameters
{
"GROUP": "MySolution",
"LOCALE": "default",
"KEY": "4ec7c546-699d-409b-81df-d467d556b2c2",
"VALUE": "My Solution"

}

Response
{
"ID": 11815,
"GROUP": "MySolution",
"LOCALE": "default",
"KEY": "4ec7c546-699d-409b-81df-d467d556b2c2",
"VALUE": "My Solution",
"LASTUPDATEDATE": 1387354534000

}

Step 2: Requesting to create a solution:

The second step to creating a solution application is to request to create it.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/solution/SOLUTION_ID>/task

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/solution/MySolution/task

Request Parameters
{
"NAME": "CreateSolution",
"INPUT": {
"NAME": {
"GROUP": "MySolution",
"KEY": "4ec7c546-699d-409b-81df-d467d556b2c2"
},
"DESCRIPTION": "My Solution"
}

}

Response
{
"TASK_ID": "9c5cb6b6-06c0-4568-a25d-3c853d7e0fb4",
"NAME": "CreateSolution",
"STATUS": null,
"START_TIME": null,
"END_TIME": null,
"INPUT": {
"NAME": {
"GROUP": "MySolution",
"KEY": "4ec7c546-699d-409b-81df-d467d556b2c2"
},
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"DESCRIPTION": "My Solution"
},
"OUTPUT": null
}

Step 3: Polling to create a solution status:

The third and final step to creating a solution application is to poll to create a solution status. In the step,
you poll the status until the STATUS property name returns "Success".

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/task/<ID>

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/solution/MySolution/task/9c5cb6b6-06c0-
4568-a25d-3c853d7e0fb4.

Request Parameters

Not applicable.

Response
{
"TASK_ID": "9c5cb6b6-06c0-4568-a25d-3c853d7e0fb4",
"NAME": "CreateSolution",
"STATUS": "Success",
"START_TIME": 1387359000000,
"END_TIME": 1387359016000,
"INPUT": {
"NAME": {
"GROUP": "MySolution",
"KEY": "4ec7c546-699d-409b-81df-d467d556b2c2"
},
"DESCRIPTION": "My Solution"
},
"OUTPUT": {
"log": "......"
}
}

Deleting a solution:

Deleting a solution application is a two-step process. You request to delete the solution and then poll the
request status to ensure that it is successful.

Step 1: Request to delete the solution:

The third and final step to creating a solution application is to poll to create a solution status. In the step,
you poll the status to ensure that the STATUS property name returns "Success".

Method

POST.
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Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/task/

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/solution/MySolution/task.

Request Parameters
{
"NAME": "DeleteSolution",

}

Response
{
"TASK_ID": "c1c6e300-6769-4290-8de3-59ba1ca04ff7",
"NAME": "DeleteSolution",
"STATUS": null,
"START_TIME": null,
"END_TIME": null,
"INPUT": null,
"OUTPUT": null

}

Step 2: Polling to request the status:

The second and final step to deleting a solution application is to poll to request the status. When the
STATUS property returns "Success", the solution is deleted.

Method

GET

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/task/<ID>

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/solution/MySolution/task/c1c6e300-6769-
4290-8de3-59ba1ca04ff7.

.

Request Parameters

Not applicable.

Response
{
"TASK_ID": "c1c6e300-6769-4290-8de3-59ba1ca04ff7",
"NAME": "DeleteSolution",
"STATUS": "Success",
"START_TIME": 1387353687000,
"END_TIME": 1387353696000,
"INPUT": null,
"OUTPUT": {
"log": "DELETE:\/ibm\/water\/api\/solution\/MySolution\nLicensed Materials -

Property of IBM, 5724-E76, 5724-E77, 5724-I29 and 5655-Y16, (C) Copyright IBM Corp. 2001, 2012
- All Rights reserved.
US Government Users Restricted Rights - Use, duplication or disclosure restricted by GSA ADP Schedule
Contract with IBM Corp.
\nEJPXB0006I: Connecting to URL https:\/\/localhost:10029\/wps\/config\nEJPXB0004I:
Writing output file \/tmp\/iow-template-1387353692076\/MySolution.out.xml\nEJPXB0002I:
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Reading input file \/tmp\/iow-template-1387353692076\/MySolution.page.xml\nEJPXB0020I:
The request was processed successfully on the server.\n"
}
}

Include application
Use the include application service to manage supporting applications in a solution application.

Listing included applications:

List the supporting applications included in the solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/application

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/application.

Request Parameters

Not applicable.

Response
[{
"APP_ID": "CSO",
"NAME": "Combined Sewer Overflow Management",
"DESCRIPTION": "Combined Sewer Overflow Management",
"ROWID": 1,
"NAME_I18N": "Combined Sewer Overflow Management"
},{
"APP_ID": "EAM",
"NAME": "Maximo Integration",
"DESCRIPTION": "Maximo Integration",
"ROWID": 2,
"NAME_I18N": "Maximo Integration"
},{
"APP_ID": "IOW",
"NAME": {
"key": "application.name",
"group": "IOW"
},
"DESCRIPTION": "Intelligent Operations for Water",
"ROWID": 3,
"NAME_I18N": "Intelligent Operations for Water"
},{
"APP_ID": "PFP",
"NAME": "Pipe Failure Prediction",
"DESCRIPTION": "Pipe Failure Prediction",
"ROWID": 4,
"NAME_I18N": "Pipe Failure Prediction"
},{
"APP_ID": "PO",
"NAME": "Pressure Optimization",
"DESCRIPTION": "Pressure Optimization",
"ROWID": 5,
"NAME_I18N": "Pressure Optimization"
},{
"APP_ID": "WCP",
"NAME": "Water Conservation Portal",
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"DESCRIPTION": "Water Conservation Portal",
"ROWID": 6,
"NAME_I18N": "Water Conservation Portal"

}
]

Excluding an application:

Exclude a supporting application from the solution application.

Method

DELETE.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/application/<APP_ID>

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/application/CSO.

Request Parameters

Not applicable.

Response
{
"APP_ID": "CSO",
"NAME": "Combined Sewer Overflow Management",
"DESCRIPTION": "Combined Sewer Overflow Management",
"NAME_I18N": "Combined Sewer Overflow Management"

}

Including an application:

Add a supporting application to a solution application.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/application

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/application

/.

Request Parameters
{
"APP_ID": "CSO"

}

Response
{
"APP_ID": "CSO",
"NAME": "Combined Sewer Overflow Management",
"DESCRIPTION": "Combined Sewer Overflow Management",
"NAME_I18N": "Combined Sewer Overflow Management"

}
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Listing available extensions:

List available extensions for a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/extension

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/extension.

Request Parameters

Not applicable.

Response
[{
"APP_ID": "IOW",
"EXTENSION_ID": "water.action.ItemAction",
"NAME": {
"group": "IOW",
"key": "water.action.ItemAction"
},
"DESCRIPTION": "Actions for Individual Items",
"IS_CONTAINER": true,
"DOJO_PACK_NAME": "water",
"DOJO_PACK_LOCATION": "\/ibm\/water\/widgets\/js\/water",
"DOJO_MODULE": "water\/action\/ItemAction",
"DOJO_MODULE_CONFIG": null,
"EXTENDS_APP_ID": null,
"EXTENDS": null,
"PARAMETERS": {

},
"IS_DYNAMIC": false,
"URI_PATTERN": null,
"ROWID": 1,
"NAME_I18N": "Actions for Individual Items"
},{
"APP_ID": "IOW",
"EXTENSION_ID": "water.action.SampleEventAction_1",
"NAME": {
"group": "IOW",
"key": "water.action.SampleEventAction_1"
},
"DESCRIPTION": "Sample Action event 1",
"IS_CONTAINER": false,
"DOJO_PACK_NAME": "water",
"DOJO_PACK_LOCATION": "\/ibm\/water\/widgets\/js\/water",
"DOJO_MODULE": "water\/action\/SampleEventAction_1",
"DOJO_MODULE_CONFIG": null,
"EXTENDS_APP_ID": "IOW",
"EXTENDS": "water.action.ItemAction",
"PARAMETERS": {

},
"IS_DYNAMIC": false,
"URI_PATTERN": "\/ibm\/ioc\/api\/spatial-service\/collections\/*\/records\/*",
"ROWID": 2,
"NAME_I18N": "Sample Action event 1"
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},
...
...
]

Listing available services:

List available services for a solution application. When a supporting application is included in a solution
application, the services registered in the supporting application are available to the solution application
users.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/service

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/service.

Request Parameters

Not applicable.

Response
[{
"APP_ID": "IOW",
"SERVICE_ID": "75604c5c-a751-44fb-a025-a5bd6613b0d9",
"NAME": "My Service",
"DESCRIPTION": "My Service",
"URL": "\/ibm\/water\/api\/myservice\/{solutionId}",
"ROWID": 1,
"NAME_I18N": "My Service"

},{
"APP_ID": "IOW",
"SERVICE_ID": "Assets",
"NAME": "Data Access Service",
"DESCRIPTION": "Data Access Service",
"URL": "\/ibm\/water\/api\/asset\/{solutionId}",
"ROWID": 2,
"NAME_I18N": "Data Access Service"

},{
"APP_ID": "IOW",
"SERVICE_ID": "app",
"NAME": {
"group": "IOW",
"key": "service.app_service"
},
"DESCRIPTION": "Application Service",
"URL": "\/ibm\/water\/api\/application",
"ROWID": 3,
"NAME_I18N": "Application Service"

},{
"APP_ID": "IOW",
"SERVICE_ID": "das",
"NAME": {
"group": "IOW",
"key": "service.data_access_service"
},
"DESCRIPTION": "Data Access Service",
"URL": "\/ibm\/water\/api\/asset\/{solutionId}",
"ROWID": 4,
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"NAME_I18N": "Data Access Service"
},{
"APP_ID": "IOW",
"SERVICE_ID": "rendering",
"NAME": {
"group": "IOW",
"key": "service.rendering_service"
},
"DESCRIPTION": "Rendering Service",
"URL": "\/ibm\/water\/api\/rendering-service",
"ROWID": 5,
"NAME_I18N": "Rendering Service"
},{
"APP_ID": "IOW",
"SERVICE_ID": "solution",
"NAME": {
"group": "IOW",
"key": "service.solution_service"
},
"DESCRIPTION": "Solution Service",
"URL": "\/ibm\/water\/api\/solution",
"ROWID": 6,
"NAME_I18N": "Solution Service"
}
]

Listing available configuration extensions:

List the available configuration extensions for the solution application. When a supporting application is
included in a solution application, the configuration extension registered in the supporting application are
available to solution application users.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/extconfig

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/extconfig.

Request Parameters

Not applicable.

Response
[{
"APP_ID": "IOW",
"EXTENSION_ID": "1db5032e-73c5-4b5f-9295-063422c8fe62",
"NAME": "My Config 1",
"DESCRIPTION": "My Config",
"DOJO_PACK_NAME": "my",
"DOJO_PACK_LOCATION": "\/myapp\/js",
"DOJO_MODULE": "my\/MyConfig",
"ROWID": 1,
"NAME_I18N": "My Config 1"
},{
"APP_ID": "IOW",
"EXTENSION_ID": "8d366a8c-3f0d-4ebb-9b1f-983fe4c089c9",
"NAME": "My Config 2",
"DESCRIPTION": "My Config",
"DOJO_PACK_NAME": "my",
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"DOJO_PACK_LOCATION": "\/myapp\/js",
"DOJO_MODULE": "my\/MyConfig",
"ROWID": 2,
"NAME_I18N": "My Config 2"

}
]

Page
Use the page service to manage pages in a solution application.

Listing registered pages:

List pages registered to supporting applications in the solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/page

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/page.

Request Parameters

Not applicable.

Response
[{
"SOLUTION_ID": "Sunshine",
"PAGE_ID": "water.Sunshine.ExecutiveOperations",
"NAME": "Executive: Operations",
"DESCRIPTION": "Executive: Operations",
"TARGET_PAGE": "water.Sunshine.ExecutiveOperations",
"ROWID": 1,
"NAME_I18N": "Executive: Operations"

},{
"SOLUTION_ID": "Sunshine",
"PAGE_ID": "water.Sunshine.ExecutiveStatus",
"NAME": "Executive: Status",
"DESCRIPTION": "Executive: Status",
"TARGET_PAGE": "water.Sunshine.ExecutiveStatus",
"ROWID": 2,
"NAME_I18N": "Executive: Status"

},{
"SOLUTION_ID": "Sunshine",
"PAGE_ID": "water.Sunshine.OperatorOperations",
"NAME": "Operator: Operations",
"DESCRIPTION": "Operator: Operations",
"TARGET_PAGE": "water.Sunshine.OperatorOperations",
"ROWID": 3,
"NAME_I18N": "Operator: Operations"

},{
"SOLUTION_ID": "Sunshine",
"PAGE_ID": "water.Sunshine.PlannerOperations",
"NAME": "Planner: Operations",
"DESCRIPTION": "Planner: Operations",
"TARGET_PAGE": "water.Sunshine.PlannerOperations",
"ROWID": 4,
"NAME_I18N": "Planner: Operations"

},{
"SOLUTION_ID": "Sunshine",
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"PAGE_ID": "water.Sunshine.SupervisorOperations",
"NAME": "Supervisor: Operations",
"DESCRIPTION": "Supervisor: Operations",
"TARGET_PAGE": "water.Sunshine.SupervisorOperations",
"ROWID": 5,
"NAME_I18N": "Supervisor: Operations"
},{
"SOLUTION_ID": "Sunshine",
"PAGE_ID": "water.Sunshine.SupervisorStatus",
"NAME": "Supervisor: Status",
"DESCRIPTION": "Supervisor: Status",
"TARGET_PAGE": "water.Sunshine.SupervisorStatus",
"ROWID": 6,
"NAME_I18N": "Supervisor: Status"
}
]

Registering a new page:

Register a new page to the solution application.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/page

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/page.

Request Parameters
{
"NAME": "Custom Page",
"DESCRIPTION": "Custom Page",
"TARGET_PAGE": "water.Sunshine.CustomPage"
}

.

Response
{
"SOLUTION_ID": "Sunshine",
"PAGE_ID": "6f0e2a52-7854-45a1-bd79-441d4d40d2b5",
"NAME": "Custom Page",
"DESCRIPTION": "Custom Page",
"TARGET_PAGE": "water.Sunshine.CustomPage",
"NAME_I18N": "Custom Page"
}

Updating page registration:

Update the page registration in a solution application.

Method

PUT.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/page/<PAGE_ID>
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For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/page/6f0e2a52-7854-
45a1-bd79-441d4d40d2b5.

Request Parameters
{
"NAME": "Custom Page",
"DESCRIPTION": "Custom Page",
"TARGET_PAGE": "water.Sunshine.CustomPage"

}

.

Response Body
{
"SOLUTION_ID": "Sunshine",
"PAGE_ID": "6f0e2a52-7854-45a1-bd79-441d4d40d2b5",
"NAME": "Custom Page",
"DESCRIPTION": "Custom Page",
"TARGET_PAGE": "water.Sunshine.CustomPage",
"NAME_I18N": "Custom Page"

}

Looking up page by target page unique name:

Look up a page by target page unique name in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/pages/<PAGE_UNIQUE_NAME>

For example, https://<web server hostname>/ibm/water/api/pages/water.Sunshine.CustomPage.

Request Parameters

Not applicable.

Response Body
{
"SOLUTION_ID": "Sunshine",
"PAGE_ID": "6f0e2a52-7854-45a1-bd79-441d4d40d2b5",
"NAME": "Custom Page",
"DESCRIPTION": "Custom Page",
"TARGET_PAGE": "Water.Sunshine.CustomPage",
"NAME_I18N": "Custom Page"

}

Unregister a page:

Unregister a page in a solution application.

Method

DELETE.
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Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/page/<PAGE_ID>

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/page
/6f0e2a52-7854-45a1-bd79-441d4d40d2b5/<PAGE_ID>/<SOLUTION_ID>.

Request Parameters

Not applicable.

Response Body
{
"SOLUTION_ID": "Sunshine",
"PAGE_ID": "6f0e2a52-7854-45a1-bd79-441d4d40d2b5",
"NAME": "Custom Page",
"DESCRIPTION": "Custom Page",
"TARGET_PAGE": "water.Sunshine.CustomPage",
"NAME_I18N": "Custom Page"
}

Page configuration
Manage the page configuration in a solution application.

Listing page configuration:

List page configuration in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/page/<PAGE_ID>/pageConfig

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/page/
water.Sunshine.SupervisorOperations/pageConfig.

Request Parameters

Not applicable.

Response
[{
"CONFIG_ID": "item_actions_0",
"TITLE": {
"key": "item_actions_0",
"group": "Sunshine"
},
"INDEX": 900,
"PARENT": null,
"PARAMETERS": null,
"EXTENSION_APP_ID": "IOW",
"EXTENSION_ID": "water.action.ItemAction",
"IS_CONTAINER": true,
"IS_DYNAMIC": false,
"URI_PATTERN": null,
"DOJO_PACK_NAME": "water",
"DOJO_PACK_LOCATION": "\/ibm\/water\/widgets\/js\/water",
"DOJO_MODULE": "water\/action\/ItemAction",
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"DOJO_MODULE_CONFIG": null,
"EXTENDS_APP_ID": null,
"EXTENDS": null,
"ROWID": 1,
"TITLE_I18N": "Actions for Individual Items"

},{
"CONFIG_ID": "sample_action_event_1",
"TITLE": {
"key": "sample_action_event_1",
"group": "Sunshine"
},
"INDEX": 900,
"PARENT": "item_actions_0",
"PARAMETERS": {

},
"EXTENSION_APP_ID": "IOW",
"EXTENSION_ID": "water.action.SampleEventAction_1",
"IS_CONTAINER": false,
"IS_DYNAMIC": false,
"URI_PATTERN": "\/ibm\/ioc\/api\/spatial-service\/collections\/*\/records\/*",
"DOJO_PACK_NAME": "water",
"DOJO_PACK_LOCATION": "\/ibm\/water\/widgets\/js\/water",
"DOJO_MODULE": "water\/action\/SampleEventAction_1",
"DOJO_MODULE_CONFIG": null,
"EXTENDS_APP_ID": "IOW",
"EXTENDS": "water.action.ItemAction",
"ROWID": 2,
"TITLE_I18N": "Sample Action event 1"

},{
"CONFIG_ID": "sample_action_event_2",
"TITLE": {
"key": "sample_action_event_2",
"group": "Sunshine"
},
"INDEX": 1240,
"PARENT": "item_actions_0",
"PARAMETERS": {

},
"EXTENSION_APP_ID": "IOW",
"EXTENSION_ID": "water.action.SampleEventAction_2",
"IS_CONTAINER": false,
"IS_DYNAMIC": false,
"URI_PATTERN": "\/ibm\/ioc\/api\/spatial-service\/collections\/*\/records\/*",
"DOJO_PACK_NAME": "water",
"DOJO_PACK_LOCATION": "\/ibm\/water\/widgets\/js\/water",
"DOJO_MODULE": "water\/action\/SampleEventAction_2",
"DOJO_MODULE_CONFIG": null,
"EXTENDS_APP_ID": "IOW",
"EXTENDS": "water.action.ItemAction",
"ROWID": 3,
"TITLE_I18N": "Sample Action event 2"

},
...
...
]

Registering a new page configuration:

Register a new page configuration in a solution application.

Method

POST.
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Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/page/<PAGE_ID>/pageConfig

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/page/
water.Sunshine.SupervisorOperations/pageConfig.

Request Parameters
{
"TITLE": "My Filter Group",
"INDEX": 120,
"PARENT": "filter_panel_0",
"PARAMETERS": {
"color": "#90ee90"
},
"EXTENSION_APP_ID": "IOW",
"EXTENSION_ID": "water.filter.FilterGroupPane"
}

Response
{
"CONFIG_ID": "ada5678a-87a2-447b-ab0c-9f21042cafc3",
"TITLE": "My Filter Group",
"INDEX": 120,
"PARENT": "filter_panel_0",
"PARAMETERS": {
"color": "#90ee90"
},
"EXTENSION_APP_ID": "IOW",
"EXTENSION_ID": "water.filter.FilterGroupPane",
"IS_CONTAINER": true,
"IS_DYNAMIC": false,
"URI_PATTERN": null,
"DOJO_PACK_NAME": "water",
"DOJO_PACK_LOCATION": "\/ibm\/water\/widgets\/js\/water",
"DOJO_MODULE": "water\/filter\/FilterGroupPane",
"DOJO_MODULE_CONFIG": "water\/admin\/application\/extension\/config\/FilterGroupPaneConfig",
"EXTENDS_APP_ID": "IOW",
"EXTENDS": "water.panel.FilterPanel",
"TITLE_I18N": "My Filter Group"
}

Updating a page configuration:

Update a page configuration in a solution application.

Method

PUT.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/page/<PAGE_ID>/pageConfig/<CONFIG_ID>

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/page/
water.Sunshine.SupervisorOperations/pageConfig/ada5678a-87a2-447b-ab0c-9f21042cafc3.

Request Parameters
{
"TITLE": "My Filter Group",
"INDEX": 120,
"PARENT": "filter_panel_0",
"PARAMETERS": {
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"color": "#90ee90"
},
"EXTENSION_APP_ID": "IOW",
"EXTENSION_ID": "water.filter.FilterGroupPane"

}

Response
{
"CONFIG_ID": "ada5678a-87a2-447b-ab0c-9f21042cafc3",
"TITLE": "My Filter Group",
"INDEX": 120,
"PARENT": "filter_panel_0",
"PARAMETERS": {
"color": "#90ee90"
},
"EXTENSION_APP_ID": "IOW",
"EXTENSION_ID": "water.filter.FilterGroupPane",
"IS_CONTAINER": true,
"IS_DYNAMIC": false,
"URI_PATTERN": null,
"DOJO_PACK_NAME": "water",
"DOJO_PACK_LOCATION": "\/ibm\/water\/widgets\/js\/water",
"DOJO_MODULE": "water\/filter\/FilterGroupPane",
"DOJO_MODULE_CONFIG": "water\/admin\/application\/extension\/config\/FilterGroupPaneConfig",
"EXTENDS_APP_ID": "IOW",
"EXTENDS": "water.panel.FilterPanel",
"TITLE_I18N": "My Filter Group"

}

Unregistering a page configuration:

Unregister a page configuration in a solution application.

Method

DELETE.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/page/<PAGE_ID>/pageConfig
/<CONFIG_ID>

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/page/
water.Sunshine.SupervisorOperations/pageConfig/ada5678a-87a2-447b-ab0c-9f21042cafc3.

Request Parameters
{
"TITLE": "My Filter Group",
"INDEX": 120,
"PARENT": "filter_panel_0",
"PARAMETERS": {
"color": "#90ee90"
},
"EXTENSION_APP_ID": "IOW",
"EXTENSION_ID": "water.filter.FilterGroupPane"

}

.
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Response
{
"CONFIG_ID": "ada5678a-87a2-447b-ab0c-9f21042cafc3",
"TITLE": "My Filter Group",
"INDEX": 120,
"PARENT": "filter_panel_0",
"PARAMETERS": {
"color": "#90ee90"
},
"EXTENSION_APP_ID": "IOW",
"EXTENSION_ID": "water.filter.FilterGroupPane",
"IS_CONTAINER": true,
"IS_DYNAMIC": false,
"URI_PATTERN": null,
"DOJO_PACK_NAME": "water",
"DOJO_PACK_LOCATION": "\/ibm\/water\/widgets\/js\/water",
"DOJO_MODULE": "water\/filter\/FilterGroupPane",
"DOJO_MODULE_CONFIG": "water\/admin\/application\/extension\/config\/FilterGroupPaneConfig",
"EXTENDS_APP_ID": "IOW",
"EXTENDS": "water.panel.FilterPanel",
"TITLE_I18N": "My Filter Group"
}

Page saved filter
Manage the page saved filters in a solution application.

Listing saved filters visible to current user:

List saved filters that are visible to the current user in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/page/<PAGE_ID>/savedFilters

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/page/
water.Sunshine.SupervisorOperations/savedFilters.

Request Parameters

Not applicable.

Response
[{
"SOLUTION_ID": "Sunshine",
"PAGE_ID": "water.Sunshine.SupervisorOperations",
"FILTER_ID": 1,
"LABEL": "test1",
"SCOPE": "private",
"USER_ID": "wpsadmin",
"LASTUPDATEDATE": 1384756779000,
"ROWID": 1,
"LABEL_I18N": "test1"
},{
"SOLUTION_ID": "Sunshine",
"PAGE_ID": "water.Sunshine.SupervisorOperations",
"FILTER_ID": 2,
"LABEL": "test2",
"SCOPE": "public",
"USER_ID": "test",
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"LASTUPDATEDATE": 1384760839000,
"ROWID": 2,
"LABEL_I18N": "test2"

}
]

Retrieving saved filter by ID:

Retrieve saved filters by ID in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/page/<PAGE_ID>
/savedFilters/<FILTER_ID>

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/page/
water.Sunshine.SupervisorOperations/savedFilters/1.

Request Parameters

Not applicable.

Response
{
"SOLUTION_ID": "Sunshine",
"PAGE_ID": "water.Sunshine.SupervisorOperations",
"FILTER_ID": 1,
"LABEL": "test1",
"SCOPE": "private",
"USER_ID": "wpsadmin",
"DATA": [{
"data": {
"refreshInterval": 15,
"state": "Normal",
"selected": 0,
"refreshUnit": "seconds"
},
"id": "FilterPanel"
},
{
"data": {
"time": 23880000,
"isChecked": true,
"date": 1384704000000
},
"id": "DateTimeFilter"
},
{
"data": {
"zoom": 11,
"lon": -86.22000000000001,
"lat": 41.67000000000008
},
"id": "MapView"
},
{
"data": {
"isDefault": true
},
"id": "BaseMap_1"
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},
{
"state": "Collapsed",
"id": "SupportingContentPanel"
},
{
"state": "Normal",
"id": "DrillDownPanel"
}],
"LASTUPDATEDATE": 1384756779000,
"LABEL_I18N": "test1"
}

Creating saved filters for current user:

Create saved filters for the current user in a solution application.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/page/<PAGE_ID>/savedFilters

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/page/
water.Sunshine.SupervisorOperations/savedFilters.

Request Parameters
{
"LABEL": "test3",
"SCOPE": "private",
"DATA": [{

}]
}

Response Body
{
"SOLUTION_ID": "Sunshine",
"PAGE_ID": "water.Sunshine.SupervisorOperations",
"FILTER_ID": 8,
"LABEL": "test3",
"SCOPE": "private",
"USER_ID": "wpsadmin",
"DATA": [{

}],
"LASTUPDATEDATE": 1384762233000,
"LABEL_I18N": "test3"
}

Updating saved filters:

Update saved filters in the solution application.

Method

PUT.
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Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/page/<PAGE_ID>
/savedFilters/<FILTER_ID>

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/page/
water.Sunshine.SupervisorOperations/savedFilters/8.

Request Parameters
{
"LABEL": "test3",
"SCOPE": "private",
"DATA": [{

}]
}

Response Body
{
"SOLUTION_ID": "Sunshine",
"PAGE_ID": "water.Sunshine.SupervisorOperations",
"FILTER_ID": 8,
"LABEL": "test3",
"SCOPE": "private",
"USER_ID": "wpsadmin",
"DATA": [{

}],
"LASTUPDATEDATE": 1384762233000,
"LABEL_I18N": "test3"

}

Deleting saved filters:

Delete saved filters in a solution application.

Method

DELETE.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/page/<PAGE_ID>
/savedFilters/<FILTER_ID>

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/page/
water.Sunshine.SupervisorOperations/savedFilters/8.

Request Parameters

Not applicable.

Response Body
{
"SOLUTION_ID": "Sunshine",
"PAGE_ID": "water.Sunshine.SupervisorOperations",
"FILTER_ID": 8,
"LABEL": "test3",
"SCOPE": "private",
"USER_ID": "wpsadmin",
"DATA": [{
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}],
"LASTUPDATEDATE": 1384762233000,
"LABEL_I18N": "test3"
}

Page session data
Manage the page session data for users in a solution application.

Retrieving session data for the current user:

Retrieve current session data for a user in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/page/<PAGE_ID>/userPreference/<USER_ID>

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/page/
water.Sunshine.SupervisorOperations/userPreference/wpsadmin.

Request Parameters

Not applicable.

Response
{
"SOLUTION_ID": "Sunshine",
"PAGE_ID": "water.Sunshine.SupervisorOperations",
"USER_ID": "wpsadmin",
"DATA": [{
"data": {
"refreshInterval": 15,
"state": "Normal",
"selected": 0,
"refreshUnit": "seconds"
},
"id": "FilterPanel"
},
{
"data": {
"time": 30060000,
"isChecked": true,
"date": 1384704000000
},
"id": "DateTimeFilter"
},
{
"data": {
"zoom": 11,
"lon": -86.22000000000001,
"lat": 41.67000000000008
},
"id": "MapView"
},
{
"data": {
"isDefault": true
},
"id": "BaseMap_1"
},
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{
"state": "Collapsed",
"id": "SupportingContentPanel"
},
{
"state": "Normal",
"id": "DrillDownPanel"
}]

}

Creating session data for the current user:

Create session data for the current user in a solution application.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/page/<PAGE_ID>/userPreference

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/page/
water.Sunshine.SupervisorOperations/userPreference.

Request Parameters
{
"DATA": [{
"data": {
"refreshInterval": 15,
"state": "Normal",
"selected": 0,
"refreshUnit": "seconds"
},
"id": "FilterPanel"
},
{
"data": {
"time": 29160000,
"isChecked": true,
"date": 1384704000000
},
"id": "DateTimeFilter"
},
{
"data": {
"zoom": 11,
"lon": -86.22000000000001,
"lat": 41.67000000000008
},
"id": "MapView"
},
{
"data": {
"isDefault": true
},
"id": "BaseMap_1"
},
{
"state": "Collapsed",
"id": "SupportingContentPanel"
},
{
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"state": "Normal",
"id": "DrillDownPanel"
}],
}

Response
{
"SOLUTION_ID": "Sunshine",
"PAGE_ID": "water.Sunshine.SupervisorOperations",
"USER_ID": "wpsadmin",
"DATA": [{
"data": {
"refreshInterval": 15,
"state": "Normal",
"selected": 0,
"refreshUnit": "seconds"
},
"id": "FilterPanel"
},
{
"data": {
"time": 29160000,
"isChecked": true,
"date": 1384704000000
},
"id": "DateTimeFilter"
},
{
"data": {
"zoom": 11,
"lon": -86.22000000000001,
"lat": 41.67000000000008
},
"id": "MapView"
},
{
"data": {
"isDefault": true
},
"id": "BaseMap_1"
},
{
"state": "Collapsed",
"id": "SupportingContentPanel"
},
{
"state": "Normal",
"id": "DrillDownPanel"
}]
}

Updating session data for current user:

Update session data for the current user in a solution application.

Method

PUT.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/page/<PAGE_ID>/userPreference/<USER_ID>
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For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/page/
water.Sunshine.SupervisorOperations/userPreference/wpsadmin.

Request Parameters
{
"DATA": [{
"data": {
"refreshInterval": 15,
"state": "Normal",
"selected": 0,
"refreshUnit": "seconds"
},
"id": "FilterPanel"
},
{
"data": {
"time": 29160000,
"isChecked": true,
"date": 1384704000000
},
"id": "DateTimeFilter"
},
{
"data": {
"zoom": 11,
"lon": -86.22000000000001,
"lat": 41.67000000000008
},
"id": "MapView"
},
{
"data": {
"isDefault": true
},
"id": "BaseMap_1"
},
{
"state": "Collapsed",
"id": "SupportingContentPanel"
},
{
"state": "Normal",
"id": "DrillDownPanel"
}],

}

Response
{
"SOLUTION_ID": "Sunshine",
"PAGE_ID": "water.Sunshine.SupervisorOperations",
"USER_ID": "wpsadmin",
"DATA": [{
"data": {
"refreshInterval": 15,
"state": "Normal",
"selected": 0,
"refreshUnit": "seconds"
},
"id": "FilterPanel"
},
{
"data": {
"time": 29160000,
"isChecked": true,
"date": 1384704000000
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},
"id": "DateTimeFilter"
},
{
"data": {
"zoom": 11,
"lon": -86.22000000000001,
"lat": 41.67000000000008
},
"id": "MapView"
},
{
"data": {
"isDefault": true
},
"id": "BaseMap_1"
},
{
"state": "Collapsed",
"id": "SupportingContentPanel"
},
{
"state": "Normal",
"id": "DrillDownPanel"
}]
}

User group
Manage the user groups in a solution application.

Listing registered groups:

You can list user groups that are registered to a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/group

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/group

Request Parameters

Not applicable.

Response
[{
"SOLUTION_ID": "Sunshine",
"GROUP": "SunshineAdmin",
"ROWID": 1
},{
"SOLUTION_ID": "Sunshine",
"GROUP": "SunshineCitizen",
"ROWID": 2
},{
"SOLUTION_ID": "Sunshine",
"GROUP": "SunshineExecutive",
"ROWID": 3
},{
"SOLUTION_ID": "Sunshine",
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"GROUP": "SunshineOperator",
"ROWID": 4

},{
"SOLUTION_ID": "Sunshine",
"GROUP": "SunshinePlanner",
"ROWID": 5

},{
"SOLUTION_ID": "Sunshine",
"GROUP": "SunshineSupervisor",
"ROWID": 6

}
]

Registering a group:

Register a user group to a solution application.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/group

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/group/.

Request Parameters
{
"GROUP": "MyGroup"

}

Response
{
"SOLUTION_ID": "Sunshine",
"GROUP": "MyGroup"

}

Unregistering a group:

Unregister a user group in a solution application.

Method

DELETE.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/group/<GROUP_NAME>

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/group/MyGroup.

Request Parameters

Not applicable.

Response
{
"SOLUTION_ID": "Sunshine",
"GROUP": "MyGroup"

}
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Model
Manage semantic models in a solution application.

Listing registered models:

List models that are registered in the solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/model

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/model.

Request Parameters

Not applicable.

Response
[{
"SOLUTION_ID": "Sunshine",
"MODEL_ID": "SunshineWaterGroup",
"NAME": "SunshineWaterGroup",
"DESCRIPTION": "SunshineWaterGroup",
"PREFIX": "http:\/\/SunshineWaterGroup#",
"ROWID": 1
}
]

Registering a model:

Register a semantic model to a solution application.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/model

For example, http://<web server hostname>/ibm/water/api/solution/Sunshine/model.

Request Parameters
{
"MODEL_ID": "cityName"
}

Response
{
"SOLUTION_ID": "Sunshine",
"MODEL_ID": "cityName",
"NAME": "cityName",
"DESCRIPTION": "cityName",
"PREFIX": "http:\/\/cityName#"
}
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Unregistering a model:

Unregister a model in a solution application.

Method

DELETE.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/model/<MODEL_ID>

For example, https://<web server hostname>/ibm/water/api/solution/Sunshine/model/cityName.

Request Parameters

Not applicable.

Response
{
"SOLUTION_ID": "Sunshine",
"MODEL_ID": "cityName",
"NAME": "cityName",
"DESCRIPTION": "cityName",
"PREFIX": "http:\/\/cityName#"

}

Updating model name and description:

Update the name and description of a semantic model in a solution application.

Method

PUT.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/model/<MODEL_ID>

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/solution/Sunshine/model/cityName.

Request Parameters
{
"NAME": "My Model",
"DESCRIPTION": "My Model"

}

Response
{
"SOLUTION_ID": "Sunshine",
"MODEL_ID": "cityName",
"NAME": "My Model",
"DESCRIPTION": "My Model",
"PREFIX": "http:\/\/cityName#"

}

Syncing model to database:

Synchronize a semantic model to the database of a solution application.
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Access control service
Manage data access control in a solution application installed in IBM Intelligent Operations for Water.

Listing solution level access control:

List solution level access controls in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/access

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/solution/Sunshine/access.

Request Parameters

Not applicable.

Response
[{
"ID": 243,
"URL": "\/ibm\/water\/api\/application\/*",
"IDENTITY": "SunshineAdmin",
"IDENTITY_TYPE": "G",
"C_ACCESS": 0,
"R_ACCESS": 1,
"U_ACCESS": 0,
"D_ACCESS": 0,
"SOLUTION_ID": "Sunshine",
"ROWID": 1
},{
"ID": 244,
"URL": "\/ibm\/water\/api\/solution\/",
"IDENTITY": "SunshineAdmin",
"IDENTITY_TYPE": "G",
"C_ACCESS": 0,
"R_ACCESS": 1,
"U_ACCESS": 0,
"D_ACCESS": 0,
"SOLUTION_ID": "Sunshine",
"ROWID": 2
},{
"ID": 245,
"URL": "\/ibm\/water\/api\/solution\/Sunshine\/*",
"IDENTITY": "SunshineAdmin",
"IDENTITY_TYPE": "G",
"C_ACCESS": 1,
"R_ACCESS": 1,
"U_ACCESS": 1,
"D_ACCESS": 1,
"SOLUTION_ID": "Sunshine",
"ROWID": 3
},
...
...
]

Creating a solution level access control:

Create a solution level access control in a solution application.
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Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/access

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/solution/Sunshine/access.

Request Parameters
{
"URL": "\/ibm\/water\/po\/api\/Sunshine\/*",
"IDENTITY": "SunshineAdmin",
"IDENTITY_TYPE": "G",
"C_ACCESS": 1,
"R_ACCESS": 1,
"U_ACCESS": 1,
"D_ACCESS": 1

}

Response
{
"ID": 271,
"URL": "\/ibm\/water\/po\/api\/Sunshine\/*",
"IDENTITY": "SunshineAdmin",
"IDENTITY_TYPE": "G",
"C_ACCESS": 1,
"R_ACCESS": 1,
"U_ACCESS": 1,
"D_ACCESS": 1,
"SOLUTION_ID": "Sunshine"

}

Updating a solution level access control:

Update a solution level access control in a solution application.

Method

PUT.

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/access/<ID>

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/solution/Sunshine/access/271.

Request Parameters
{
"C_ACCESS": 1,
"R_ACCESS": 0,
"U_ACCESS": 0,
"D_ACCESS": 0

}

Response
{
"ID": 271,
"URL": "\/ibm\/water\/po\/api\/Sunshine\/*",
"IDENTITY": "SunshineAdmin",
"IDENTITY_TYPE": "G",
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"C_ACCESS": 1,
"R_ACCESS": 0,
"U_ACCESS": 0,
"D_ACCESS": 0,
"SOLUTION_ID": "Sunshine"
}

Deleting a solution level access control:

Delete a solution level access control in a solution application.

Method

DELETE

Resource URL
https://<web server hostname>/ibm/water/api/solution/<SOLUTION_ID>/access/<ID>

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/solution/Sunshine/access/271.

Request Parameters

Not applicable.

Response
{
"ID": 271,
"URL": "\/ibm\/water\/po\/api\/Sunshine\/*",
"IDENTITY": "SunshineAdmin",
"IDENTITY_TYPE": "G",
"C_ACCESS": 1,
"R_ACCESS": 0,
"U_ACCESS": 0,
"D_ACCESS": 0,
"SOLUTION_ID": "Sunshine"
}

Data access services
Use the data access services to manage data access in a solution application installed in IBM Intelligent
Operations for Water.

Model
Manage data access for the semantic model in a solution application.

Listing synchronized models:

List synchronized models in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/asset/<SOLUTION_ID>/model

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model.
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Request Parameters

Not applicable.

Response
[ {

"ID": "SunshineWaterGroup",
"NAME": {

"group": "Sunshine",
"key": "a8d161d5-897d-4afb-9821-295ba2999b23"

},
"DESCRIPTION": "SunshineWaterGroup",
"PREFIX": "http://SunshineWaterGroup#",
"ROWID": 1,
"NAME_I18N": "SunshineWaterGroup"

}, {
"ID": "cityName",
"NAME": {

"group": "Sunshine",
"key": "855cba14-b3a5-4373-ade6-ffc6108751bf"

},
"DESCRIPTION": "cityName",
"PREFIX": "http://cityName#",
"ROWID": 2,
"NAME_I18N": "cityName"

}
]

Note: Run syncModelToDB.sh to ensure the service returns models.

Asset type
Manage asset types in a solution application.

Listing asset types:

List asset types for a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/asset/<SOLUTION_ID>/model/<MODEL_ID>/assetType

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType.

Request Parameters

Not applicable.

Response
[{
"ID": "Junction",
"NAME": "Junction",
"DESCRIPTION": "Junction",
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"TYPE_ID": 8,
"SUPER_TYPE_ID": 6,
"ROWID": 1
},{
"ID": "Meter",
"NAME": "Meter",
"DESCRIPTION": "Meter",
"TYPE_ID": 1,
"SUPER_TYPE_ID": null,
"ROWID": 2
},{
"ID": "PRV",
"NAME": "Presure Reducing Valve",
"DESCRIPTION": "Contained by valves in pipe network, provide valve settings.",
"TYPE_ID": 3,
"SUPER_TYPE_ID": 1,
"ROWID": 3
},{
"ID": "Pipe",
"NAME": "Pipe",
"DESCRIPTION": "Pipe",
"TYPE_ID": 7,
"SUPER_TYPE_ID": 6,
"ROWID": 4
},{
"ID": "PipeNetwork",
"NAME": "PipeNetwork",
"DESCRIPTION": "Pipe",
"TYPE_ID": 6,
"SUPER_TYPE_ID": null,
"ROWID": 5
},{
"ID": "Reservoir",
"NAME": "Reservoir",
"DESCRIPTION": "Reservoir",
"TYPE_ID": 9,
"SUPER_TYPE_ID": 6,
"ROWID": 6
},{
"ID": "Tank",
"NAME": "Tank",
"DESCRIPTION": "Tank",
"TYPE_ID": 11,
"SUPER_TYPE_ID": 6,
"ROWID": 7
},{
"ID": "TankLevel",
"NAME": "Tank Level",
"DESCRIPTION": "Contained by tanks in pipe network, provide tank level.",
"TYPE_ID": 5,
"SUPER_TYPE_ID": 1,
"ROWID": 8
},{
"ID": "Valve",
"NAME": "Valve",
"DESCRIPTION": "Valve",
"TYPE_ID": 10,
"SUPER_TYPE_ID": 6,
"ROWID": 9
},{
"ID": "WPM",
"NAME": "Water Pressure Meter",
"DESCRIPTION": "Contained by junctions in pipe network, provide junction pressures.",
"TYPE_ID": 2,
"SUPER_TYPE_ID": 1,
"ROWID": 10
},{
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"ID": "WUM",
"NAME": "Water Usage Meter",
"DESCRIPTION": "Water Usage Meter",
"TYPE_ID": 4,
"SUPER_TYPE_ID": 1,
"ROWID": 11

}
]

Getting a single asset type:

Retrieve a single asset type for an application in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/asset/<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM.

Request Parameters

Not applicable.

Response
{
"ID": "WPM",
"NAME": "Water Pressure Meter",
"DESCRIPTION": "Contained by junctions in pipe network, provide junction pressures.",
"TYPE_ID": 2,
"SUPER_TYPE_ID": 1

}

Asset instance
Manage asset instances in a solution application.

Listing asset instances of a specific type:

List the asset instances of a specific type in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/asset/<SOLUTION_ID>
/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/assetInstance

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance.

Request Parameters

Not applicable.
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Response
[{
"STATUS": 2,
"ID": "PCP553",
"NAME": "PCP553",
"DESCRIPTION": "PCP553",
"TYPE_NAME": "Water Pressure Meter",
"TYPE_DESCRIPTION": "Contained by junctions in pipe network, provide junction pressures.",
"START_TIME": -62135798400000,
"END_TIME": 253402271999000,
"LOCATION": "POINT (-86.2115251 41.6906627)",
"EXTERNAL_ID": "http:\/\/SunshineWaterGroup#PCP553",
"PRIMARY_MEASUREMENT_ID": "PCP553_M",
"PRIMARY_MEASUREMENT_NAME": "Pressure of PCP553",
"PRIMARY_MEASUREMENT_TYPE": "WaterPressure",
"PRIMARY_MEASUREMENT_UNIT": "PSI",
"PRIMARY_MEASUREMENT_VALUE": 93.542283394879,
"PRIMARY_MEASUREMENT_STATUS": 2,
"PRIMARY_MEASUREMENT_TREND": -1,
"PRIMARY_MEASUREMENT_START_TIME": 1384840740000,
"PRIMARY_MEASUREMENT_END_TIME": 253402271999000,
"ROWID": 1
},{
"STATUS": 2,
"ID": "PCP604",
"NAME": "PCP604",
"DESCRIPTION": "PCP604",
"TYPE_NAME": "Water Pressure Meter",
"TYPE_DESCRIPTION": "Contained by junctions in pipe network, provide junction pressures.",
"START_TIME": -62135798400000,
"END_TIME": 253402271999000,
"LOCATION": "POINT (-86.2050638 41.6902690)",
"EXTERNAL_ID": "http:\/\/SunshineWaterGroup#PCP604",
"PRIMARY_MEASUREMENT_ID": "PCP604_M",
"PRIMARY_MEASUREMENT_NAME": "Pressure of PCP604",
"PRIMARY_MEASUREMENT_TYPE": "WaterPressure",
"PRIMARY_MEASUREMENT_UNIT": "PSI",
"PRIMARY_MEASUREMENT_VALUE": 60.176396984771266,
"PRIMARY_MEASUREMENT_STATUS": 2,
"PRIMARY_MEASUREMENT_TREND": 1,
"PRIMARY_MEASUREMENT_START_TIME": 1384840620000,
"PRIMARY_MEASUREMENT_END_TIME": 253402271999000,
"ROWID": 2
},{
"STATUS": 2,
"ID": "PCP599",
"NAME": "PCP599",
"DESCRIPTION": "PCP599",
"TYPE_NAME": "Water Pressure Meter",
"TYPE_DESCRIPTION": "Contained by junctions in pipe network, provide junction pressures.",
"START_TIME": -62135798400000,
"END_TIME": 253402271999000,
"LOCATION": "POINT (-86.2108040 41.6893747)",
"EXTERNAL_ID": "http:\/\/SunshineWaterGroup#PCP599",
"PRIMARY_MEASUREMENT_ID": "PCP599_M",
"PRIMARY_MEASUREMENT_NAME": "Pressure of PCP599",
"PRIMARY_MEASUREMENT_TYPE": "WaterPressure",
"PRIMARY_MEASUREMENT_UNIT": "PSI",
"PRIMARY_MEASUREMENT_VALUE": 77.47428815576647,
"PRIMARY_MEASUREMENT_STATUS": 2,
"PRIMARY_MEASUREMENT_TREND": -1,
"PRIMARY_MEASUREMENT_START_TIME": 1384841040000,
"PRIMARY_MEASUREMENT_END_TIME": 253402271999000,
"ROWID": 3
}
]
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Listing asset instance of specific type with minimal properties:

List the asset instance of a specific type with minimal properties in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/model/<MODEL_ID>/
assetType/<ASSET_TYPE_ID>/assetInstanceSimple

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstanceSimple.

Request Parameters

Not applicable.

Response
[{
"ID": "PCP553",
"NAME": "PCP553",
"STATUS": 2,
"LOCATION": "POINT (-86.2115251 41.6906627)",
"ROWID": 1

},{
"ID": "PCP604",
"NAME": "PCP604",
"STATUS": 2,
"LOCATION": "POINT (-86.2050638 41.6902690)",
"ROWID": 2

},{
"ID": "PCP599",
"NAME": "PCP599",
"STATUS": 2,
"LOCATION": "POINT (-86.2108040 41.6893747)",
"ROWID": 3

}
]

Listing asset status at a specific time:

List the asset status at a specific time for supporting applications in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/asset/<SOLUTION_ID>/
model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/assetInstance

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance.

Request Parameters

The following request parameters are passed in the URL, not in the HTTP body:
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Parameter Name: query
Parameter Value: DATE_TIME_AT=1384409122937

Response
[{
"STATUS": 0,
"ID": "PCP553",
"NAME": "PCP553",
"DESCRIPTION": "PCP553",
"TYPE_NAME": "Water Pressure Meter",
"TYPE_DESCRIPTION": "Contained by junctions in pipe network, provide junction pressures.",
"START_TIME": -62135798400000,
"END_TIME": 253402271999000,
"LOCATION": "POINT (-86.2115251 41.6906627)",
"EXTERNAL_ID": "http:\/\/SunshineWaterGroup#PCP553",
"PRIMARY_MEASUREMENT_ID": "PCP553_M",
"PRIMARY_MEASUREMENT_NAME": "Pressure of PCP553",
"PRIMARY_MEASUREMENT_TYPE": "WaterPressure",
"PRIMARY_MEASUREMENT_UNIT": "PSI",
"PRIMARY_MEASUREMENT_VALUE": 11.31015961180456,
"PRIMARY_MEASUREMENT_STATUS": 0,
"PRIMARY_MEASUREMENT_TREND": -1,
"PRIMARY_MEASUREMENT_START_TIME": 1384409100000,
"PRIMARY_MEASUREMENT_END_TIME": 1384409580000,
"ROWID": 1
},{
"STATUS": 2,
"ID": "PCP604",
"NAME": "PCP604",
"DESCRIPTION": "PCP604",
"TYPE_NAME": "Water Pressure Meter",
"TYPE_DESCRIPTION": "Contained by junctions in pipe network, provide junction pressures.",
"START_TIME": -62135798400000,
"END_TIME": 253402271999000,
"LOCATION": "POINT (-86.2050638 41.6902690)",
"EXTERNAL_ID": "http:\/\/SunshineWaterGroup#PCP604",
"PRIMARY_MEASUREMENT_ID": "PCP604_M",
"PRIMARY_MEASUREMENT_NAME": "Pressure of PCP604",
"PRIMARY_MEASUREMENT_TYPE": "WaterPressure",
"PRIMARY_MEASUREMENT_UNIT": "PSI",
"PRIMARY_MEASUREMENT_VALUE": 68.75820184942168,
"PRIMARY_MEASUREMENT_STATUS": 2,
"PRIMARY_MEASUREMENT_TREND": 1,
"PRIMARY_MEASUREMENT_START_TIME": 1384408980000,
"PRIMARY_MEASUREMENT_END_TIME": 1384409220000,
"ROWID": 2
},{
"STATUS": 0,
"ID": "PCP599",
"NAME": "PCP599",
"DESCRIPTION": "PCP599",
"TYPE_NAME": "Water Pressure Meter",
"TYPE_DESCRIPTION": "Contained by junctions in pipe network, provide junction pressures.",
"START_TIME": -62135798400000,
"END_TIME": 253402271999000,
"LOCATION": "POINT (-86.2108040 41.6893747)",
"EXTERNAL_ID": "http:\/\/SunshineWaterGroup#PCP599",
"PRIMARY_MEASUREMENT_ID": "PCP599_M",
"PRIMARY_MEASUREMENT_NAME": "Pressure of PCP599",
"PRIMARY_MEASUREMENT_TYPE": "WaterPressure",
"PRIMARY_MEASUREMENT_UNIT": "PSI",
"PRIMARY_MEASUREMENT_VALUE": 16.3060396130253,
"PRIMARY_MEASUREMENT_STATUS": 0,
"PRIMARY_MEASUREMENT_TREND": -1,
"PRIMARY_MEASUREMENT_START_TIME": 1384409100000,
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"PRIMARY_MEASUREMENT_END_TIME": 1384409460000,
"ROWID": 3

}
]

Listing asset status in an area at a specific time:

List the asset status in an area at a specific time in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/asset/<SOLUTION_ID>/
model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/assetInstance

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance.

Request Parameters

The following request parameters are passed in the URL, not in the HTTP body:
Parameter Name: query
Parameter Value: Intersects(LOCATION,POLYGON((-86.21305844306868 41.68870284595865,-86.20854160308777
41.68870284595865,-86.20854160308777 41.69003281852437,-86.21305844306868 41.69003281852437,
-86.21305844306868 41.68870284595865))) AND DATE_TIME_AT=1384409145415

Response
[{
"STATUS": 0,
"ID": "PCP599",
"NAME": "PCP599",
"DESCRIPTION": "PCP599",
"TYPE_NAME": "Water Pressure Meter",
"TYPE_DESCRIPTION": "Contained by junctions in pipe network, provide junction pressures.",
"START_TIME": -62135798400000,
"END_TIME": 253402271999000,
"LOCATION": "POINT (-86.2108040 41.6893747)",
"EXTERNAL_ID": "http:\/\/SunshineWaterGroup#PCP599",
"PRIMARY_MEASUREMENT_ID": "PCP599_M",
"PRIMARY_MEASUREMENT_NAME": "Pressure of PCP599",
"PRIMARY_MEASUREMENT_TYPE": "WaterPressure",
"PRIMARY_MEASUREMENT_UNIT": "PSI",
"PRIMARY_MEASUREMENT_VALUE": 16.3060396130253,
"PRIMARY_MEASUREMENT_STATUS": 0,
"PRIMARY_MEASUREMENT_TREND": -1,
"PRIMARY_MEASUREMENT_START_TIME": 1384409100000,
"PRIMARY_MEASUREMENT_END_TIME": 1384409460000,
"ROWID": 1

}
]

Getting a single asset instance:

Retrieve a single asset instance in a solution application.

Method

GET.
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Resource URL
http://<web server hostname>/ibm/water/api/asset/
<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>

For example, http://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553?.

Request Parameters

Not applicable.

Response
{
"STATUS": 2,
"ID": "PCP553",
"NAME": "PCP553",
"DESCRIPTION": "PCP553",
"TYPE_NAME": "Water Pressure Meter",
"TYPE_DESCRIPTION": "Contained by junctions in pipe network, provide junction pressures.",
"START_TIME": -62135798400000,
"END_TIME": 253402271999000,
"LOCATION": "POINT (-86.2115251 41.6906627)",
"EXTERNAL_ID": "http:\/\/SunshineWaterGroup#PCP553",
"PRIMARY_MEASUREMENT_ID": "PCP553_M",
"PRIMARY_MEASUREMENT_NAME": "Pressure of PCP553",
"PRIMARY_MEASUREMENT_TYPE": "WaterPressure",
"PRIMARY_MEASUREMENT_UNIT": "PSI",
"PRIMARY_MEASUREMENT_VALUE": 93.542283394879,
"PRIMARY_MEASUREMENT_STATUS": 2,
"PRIMARY_MEASUREMENT_TREND": -1,
"PRIMARY_MEASUREMENT_START_TIME": 1384840740000,
"PRIMARY_MEASUREMENT_END_TIME": 253402271999000
}

Getting a single asset instance at a specific time:

List a single asset status at specific time in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/asset/
<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/
assetInstance/<ASSET_ID>?DATE_TIME_AT=TIMESTAMP>

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553? DATE_TIME_AT=1384409122937.

Request Parameters

Not applicable.

Response
{
"STATUS": 2,
"ID": "PCP553",
"NAME": "PCP553",
"DESCRIPTION": "PCP553",
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"TYPE_NAME": "Water Pressure Meter",
"TYPE_DESCRIPTION": "Contained by junctions in pipe network, provide junction pressures.",
"START_TIME": -62135798400000,
"END_TIME": 253402271999000,
"LOCATION": "POINT (-86.2115251 41.6906627)",
"EXTERNAL_ID": "http:\/\/SunshineWaterGroup#PCP553",
"PRIMARY_MEASUREMENT_ID": "PCP553_M",
"PRIMARY_MEASUREMENT_NAME": "Pressure of PCP553",
"PRIMARY_MEASUREMENT_TYPE": "WaterPressure",
"PRIMARY_MEASUREMENT_UNIT": "PSI",
"PRIMARY_MEASUREMENT_VALUE": 93.542283394879,
"PRIMARY_MEASUREMENT_STATUS": 2,
"PRIMARY_MEASUREMENT_TREND": -1,
"PRIMARY_MEASUREMENT_START_TIME": 1384840740000,
"PRIMARY_MEASUREMENT_END_TIME": 253402271999000

}

Advanced filtering:

The asset instance service supports queries by CQL, sortBy columns, and pagination.

Asset key measurement configuration
Update asset key measurement configuration in a solution application.

Updating asset key measurement:

Update asset key measurements in a solution application.

Method

PUT.

Resource URL
https://<web server hostname>/ibm/water/api/asset/<SOLUTION_ID>/
model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/assetInstance/<ASSET_ID>

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM.

Request Parameters
{
"PRIMARY_MEASUREMENT_ID": "PCP553_M",

"IS_KEY_MEASUREMENT":"YES",
}

.

Response

Not applicable.

Batch updating asset key measurement by type:

Batch update asset key measurements by type in a solution application.

Method

PUT.
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Resource URL
https://<web server hostname>/ibm/water/api/asset/<SOLUTION_ID>/
model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/assetInstance/<ASSET_ID>

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM

Request Parameters
{
"PRIMARY_MEASUREMENT_ID": "PCP553_M"
}

.

Response

Not applicable.

Measurement
Manage measurements in a solution application.

Listing measurements:

List the measurement values of applications in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/asset/
<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/
assetInstance/<ASSET_ID>/measurement

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/measurement.

Request Parameters

Not applicable.

Response
[{
"ID": "PCP553_M",
"NAME": "Pressure of PCP553",
"DESCRIPTION": "Pressure of PCP553",
"TYPE": "WaterPressure",
"UNIT": "PSI",
"READING_VALUE": 93.542283394879,
"READING_STATUS": 2,
"READING_TREND": -1,
"READING_START_TIME": 1384840740000,
"READING_END_TIME": 253402271999000,
"ROWID": 1
}
]
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Listing measurement status at specific time:

List measurement status at a specified time for supporting applications in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/asset/<SOLUTION_ID>/model/
<MODEL_ID>/assetType/<ASSET_TYPE_ID>/assetInstance/<ASSET_ID>/measurement

For example, https://<web server hostname>//ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/measurement.

Request Parameters

The following request parameters are passed in the URL, not in the HTTP body:
Parameter Name: query
Parameter Value: DATE_TIME_AT=1384409122937

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/measurement? query=DATE_TIME_AT
%3D1384409122937.

Response
[{
"ID": "PCP553_M",
"NAME": "Pressure of PCP553",
"DESCRIPTION": "Pressure of PCP553",
"TYPE": "WaterPressure",
"UNIT": "PSI",
"READING_VALUE": 11.31015961180456,
"READING_STATUS": 0,
"READING_TREND": -1,
"READING_START_TIME": 1384409100000,
"READING_END_TIME": 1384409580000,
"ROWID": 1

}
]

Getting a single measurement:

Retrieve a single measurement for an asset type.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/asset/<SOLUTION_ID>/
model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/assetInstance/<ASSET_ID>/
measurement/<MEASUREMENT_ID>

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/ measurement/PCP553_M.
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Request Parameters

Not applicable.

Response
{
"ID": "PCP553_M",
"NAME": "Pressure of PCP553",
"DESCRIPTION": "Pressure of PCP553",
"TYPE": "WaterPressure",
"UNIT": "PSI",
"READING_VALUE": 93.542283394879,
"READING_STATUS": 2,
"READING_TREND": -1,
"READING_START_TIME": 1384840740000,
"READING_END_TIME": 253402271999000
}

Getting a single measurement at a specific time:

Retrieve a single measurement at a specified time in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/asset/SOLUTION_ID>/
model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/assetInstance/<ASSET_ID>/
measurement/<MEASUREMENT_ID>?DATE_TIME_AT=<TIMESTAMP>

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/ measurement/
PCP553_M?DATE_TIME_AT=1384409122937

Request Parameters

Not applicable.

Response
{
"ID": "PCP553_M",
"NAME": "Pressure of PCP553",
"DESCRIPTION": "Pressure of PCP553",
"TYPE": "WaterPressure",
"UNIT": "PSI",
"READING_VALUE": 11.31015961180456,
"READING_STATUS": 0,
"READING_TREND": -1,
"READING_START_TIME": 1384409100000,
"READING_END_TIME": 1384409580000
}

Measurement threshold configuration
Manage measurement threshold configurations in a solution application.

Listing measurement threshold configurations:

List measurement threshold configurations in a solution application.
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Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/asset/
<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/
assetInstance/<ASSET_ID>/measurement/<MEASUREMENT_ID>/threshold

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/ measurement/PCP553_M/threshold.

Request Parameters

Not applicable.

Response
[{
"RANGE_START": 0.0,
"RANGE_END": 20.0,
"STATUS": 0,
"ROWID": 1

},{
"RANGE_START": 20.0,
"RANGE_END": 50.0,
"STATUS": 1,
"ROWID": 2

},{
"RANGE_START": 50.0,
"RANGE_END": 100.0,
"STATUS": 2,
"ROWID": 3

}
]

Creating thresholds for a measurement configuration:

Create a measurement threshold configuration in a solution application.

Method

POST.

Resource URL
http://<web server hostname>/ibm/water/api/asset/<SOLUTION_ID>/
model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/assetInstance/
<ASSET_ID>/measurement/<MEASUREMENT_ID>/threshold

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/ measurement/PCP553_M/threshold.

Request Parameters
{
"RANGE_START": 100.0,
"RANGE_END": 200.0,
"STATUS": 2

}
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Response
204 no content

Deleting thresholds for a measurement configuration:

Delete thresholds for a measurement configuration in a solution application.

Method

DELETE.

Resource URL
https://<web server hostname>/ibm/water/water/api/asset/
<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/
assetInstance/<ASSET_ID>/measurement/<MEASUREMENT_ID>/threshold/<ID>

For example, https://<web server hostname>/ibm/water/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/measurement/PCP553_M/threshold/
PCP553_M.

Request Parameters

Not applicable.

Response
204 no content

Measurement reading timeout configuration
Manage measurement reading timeout configurations in a solution application.

Listing measurement reading timeout configuration:

List measurement reading timeout configurations in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/asset/
<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/
assetInstance/<ASSET_ID>/measurement/<MEASUREMENT_ID>/timeout

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/ measurement/PCP553_M/timeout.

Request Parameters

Not applicable.

Response
[{
"ID": "6",
"TIMEOUT_VALUE": 60000,
"ROWID": 1
}
]
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Listing measurement reading timeout configuration with ID:

List measurement reading timeout configurations with ID in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/asset/<SOLUTION_ID>/
model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/assetInstance/<ASSET_ID>/
measurement/<MEASUREMENT_ID>/timeout/<MEASUREMENT_ID>

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/ measurement/PCP553_M/timeout/
PCP553.

Request Parameters

Not applicable.

Response
{
"TIMEOUT_VALUE": 60000,
"MEASUREMENT_ID": "PCP553_M"

}

Updating the measurement reading timeout configuration:

Update the measurement reading timeout configuration in a solution application.

Method

PUT.

Resource URL
https://<web server hostname>/ibm/water/api/asset/<SOLUTION_ID>/
model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/assetInstance/<ASSET_ID>/
measurement/<MEASUREMENT_ID>/timeout/<MEASUREMENT_ID>

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/measurement/PCP553_M/timeout/
PCP553_M

Request Parameters
{

"TIMEOUT_VALUE": 600000,
}

Response
{

"ID": 6,
"TIMEOUT_VALUE": 600000

}
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Creating measurement reading timeout configuration:

Create a measurement reading timeout configuration in a solution application.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/asset/
<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/
assetInstance/<ASSET_ID>/measurement/<MEASUREMENT_ID>/timeout

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/ measurement/PCP553_M/timeout.

Request Parameters
[{
"TIMEOUT_VALUE": 600000
}]

Response
[{
"MEASUREMENT_ID": 6,
"TIMEOUT_VALUE": 600000,

"ROWID": 1,
}]

Creating measurement reading timeout configuration with ID:

Create a measurement reading timeout configuration with ID in a solution application.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/asset/
<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/
assetInstance/<ASSET_ID>/measurement/<MEASUREMENT_ID>

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/ measurement/PCP553_M

Request Parameters
[{
"TIMEOUT_VALUE": 600000
}]

Response
[{
"MEASUREMENT_ID": 6,
"TIMEOUT_VALUE": 600000,

"ROWID": 1,
}]
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Deleting measurement reading timeout configuration:

Delete the timeout configuration for measurement readings in a solution application.

Method

DELETE.

Resource URL
https://<web server hostname>/ibm/water/api/asset/<SOLUTION_ID>/
model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/assetInstance/<ASSET_ID>/
measurement/<MEASUREMENT_ID>/timeout/<MEASUREMENT_ID>

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/ measurement/PCP553_M.

Request Parameters

Not applicable.

Response
{
"ID": 6,
"TIMEOUT_VALUE": 600000

}

Measurement derived value configuration
Manage measurement derived value configurations in a solution application.

Listing measurement derived value configuration:

List the measurement derived value configurations in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/asset/
<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/
assetInstance/<ASSET_ID>/measurement/<MEASUREMENT_ID>/derivedValue

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/TankLevel/assetInstance/TANK4/measurement/HATL_T4_M/
derivedValue.

Request Parameters

Not applicable.

Response
[{
"INPUT_MEASUREMENT_ID": "TL_T4_M",
"INPUT_MEASUREMENT_TYPE": "TankLevel",
"OUTPUT_MEASUREMENT_ID": "HATL_T4_M",

"OUTPUT_MEASUREMENT_TYPE": "TankLevel",
"FORMULA": "MAX",
"DURATION": "3600",
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"TIMESTYLE": "NATURAL",
"ROWID": 1,

}
]

Updating a measurement derived value configuration:

Update the measurement derived value configurations in a solution application.

Method

PUT.

Resource URL
https://<web server hostname>/ibm/water/api/asset/
<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/
assetInstance/<ASSET_ID>/measurement/<MEASUREMENT_ID>

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/TankLevel/assetInstance/TANK4/measurement/HATL_T4_M/
derivedValue/HATL_T4_M.

Request Parameters
{
"INPUT_MEASUREMENT_ID": "TL_T4_M",
"INPUT_MEASUREMENT_TYPE": "TankLevel",
"OUTPUT_MEASUREMENT_ID": "HATL_T4_M",

"OUTPUT_MEASUREMENT_TYPE": "TankLevel",
"FORMULA": "MAX",
"DURATION": "3600",
"TIMESTYLE": "NATURAL"

}

Response
{
"INPUT_MEASUREMENT_ID": "TL_T4_M",
"INPUT_MEASUREMENT_TYPE": "TankLevel",
"OUTPUT_MEASUREMENT_ID": "HATL_T4_M",

"OUTPUT_MEASUREMENT_TYPE": "TankLevel",
"FORMULA": "MAX",
"DURATION": "3600",
"TIMESTYLE": "NATURAL"

}

Deleting a measurement derived value configuration:

Delete a measurement derived value configuration in a solution application.

Method

DELETE.

Resource URL
https://<web server hostname>/ibm/water/api/asset/
<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/
assetInstance/<ASSET_ID>/measurement/<MEASUREMENT_ID>
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For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/TankLevel/assetInstance/TANK4/measurement/HATL_T4_M/
derivedValue/HATL_T4_M.

Request Parameters

Not applicable.

Response
{
"INPUT_MEASUREMENT_ID": "TL_T4_M",
"INPUT_MEASUREMENT_TYPE": "TankLevel",
"OUTPUT_MEASUREMENT_ID": "HATL_T4_M",

"OUTPUT_MEASUREMENT_TYPE": "TankLevel",
"FORMULA": "MAX",
"DURATION": "3600",
"TIMESTYLE": "NATURAL"

}

Deleting a measurement derived value configuration for a type:

Delete a measurement derived value configuration for a type in a solution application.

Method

DELETE.

Resource URL
https://<web server hostname>/ibm/water/api/asset/
<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/
assetInstance/<ASSET_ID>/measurement/<MEASUREMENT_ID>

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/TankLevel/assetInstance/TANK4/measurement/HATL_T4_M/
derivedValue/HATL_T4_M.

Request Parameters

Not applicable.

Response

Not applicable.

Creating a measurement derived value configuration:

Create a measurement derived value configuration in a solution application.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/asset/
<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/
assetInstance/<ASSET_ID>/measurement/<MEASUREMENT_ID>
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For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/TankLevel/assetInstance/TANK4/measurement/HATL_T4_M/
derivedValue/HATL_T4_M.

Request Parameters
{
"INPUT_MEASUREMENT_ID": "TL_T4_M",
"INPUT_MEASUREMENT_TYPE": "TankLevel",
"OUTPUT_MEASUREMENT_ID": "HATL_T4_M",

"OUTPUT_MEASUREMENT_TYPE": "TankLevel",
"FORMULA": "MAX",
"DURATION": "3600",
"TIMESTYLE": "NATURAL"

}

Response
{
"INPUT_MEASUREMENT_ID": "TL_T4_M",
"INPUT_MEASUREMENT_TYPE": "TankLevel",
"OUTPUT_MEASUREMENT_ID": "HATL_T4_M",

"OUTPUT_MEASUREMENT_TYPE": "TankLevel",
"FORMULA": "MAX",
"DURATION": "3600",
"TIMESTYLE": "NATURAL"

}

Creating a measurement derived value configuration for a type:

Create a measurement derived value configuration for a type in a solution application.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/asset/
<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/
assetInstance/<ASSET_ID>/measurement/<MEASUREMENT_ID>/derivedValue

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/TankLevel/assetInstance/TANK4/measurement/HATL_T4_M/
derivedValue/HATL_T4_M/derivedValueBatch

Request Parameters
{
"INPUT_MEASUREMENT_ID": " DTT_T5_M",
"OUTPUT_MEASUREMENT_ID": " HVTL_T5_M",

"FORMULA": "YEAR",
"DURATION": null,
"TIMESTYLE": null

}

Response

Not applicable.

Reading
Manage reading in a solution application.
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Listing readings of specific measurement:

List readings for specified measurements in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/asset/
<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/
assetInstance/<ASSET_ID>/measurement/<MEASUREMENT_ID>/reading

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/ measurement/PCP553_M/reading.

Request Parameters

The following request parameters are passed in the URL, not in the HTTP body:
Optional Parameter:
orderBy=-START_TIME

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/ measurement/PCP553_M/
reading?sortBy=-START_TIME.

Response
[{
"VALUE": 93.542283394879,
"STATUS": 2,
"TREND": -1,
"START_TIME": 1384840740000,
"END_TIME": 253402271999000,
"ROWID": 1

},{
"VALUE": null,
"STATUS": null,
"TREND": null,
"START_TIME": -62135798400000,
"END_TIME": 1383840240000,
"ROWID": 2

},{
"VALUE": null,
"STATUS": null,
"TREND": null,
"START_TIME": 253402271999000,
"END_TIME": 253402271999000,
"ROWID": 3

},
...
...
]

Listing readings of specific measurement in a period:

List readings of specific measurement over a specified time period in a solution application.

Method

GET.
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Resource URL
https://<web server hostname>/ibm/water/ibm/water/api/asset/
<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/
assetInstance/<SET_ID>/measurement/<MEASUREMENT_ID>/reading

For example, https://<web server hostname>/ibm/water/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/ measurement/PCP553_M/reading.

Request Parameters
Parameter Name: query
Parameter Value:
START_TIME DURING 2013-11-10T00:00:00Z/2013-11-10T00:10:00Z

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/ measurement/PCP553_M/
reading?query=START_TIME DURING 2013-11-10T00:00:00Z/2013-11-10T00:10:00Z

Response
[{
"VALUE": 1.9226660969878233,
"STATUS": 0,
"TREND": -1,
"START_TIME": 1384041720000,
"END_TIME": 1384041780000,
"ROWID": 1
},{
"VALUE": 31.830805383465073,
"STATUS": 1,
"TREND": 1,
"START_TIME": 1384041780000,
"END_TIME": 1384042080000,
"ROWID": 2
},{
"VALUE": 54.07879879146702,
"STATUS": 2,
"TREND": 1,
"START_TIME": 1384042080000,
"END_TIME": 1384042260000,
"ROWID": 3
}
]

Listing first and last value:

List the first and last value of measurements in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/asset/
SOLUTION_ID>/model/ MODEL_ID>/assetType/ASSET_TYPE_ID>/
assetInstance/ASSET_ID>/measurement/MEASUREMENT_ID>/reading/byStep

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/measurement/PCP553_M/reading/latest/
byStep.
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Request Parameters

Not applicable.

Response
[{

"INDEX": null,
"FIRST": 41.02,

"LAST": 41.89,
"AVG": 41.405,
"MIN": 41.02,

"MAX": 41.89,
"START_TIME": 1384840740000,
"END_TIME": 253402271999000,
"ROWID": 1

}
]

Listing readings at current time:

List measurement readings at the current time in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/asset/
SOLUTION_ID>/model/MODEL_ID>/assetType/ASSET_TYPE_ID>/
assetInstance/ASSET_ID>/measurement/MEASUREMENT_ID>/reading/latest

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/measurement/PCP553_M/reading/latest.

Request Parameters

Not applicable.

Response
[{
"VALUE": 93.542283394879,
"STATUS": 2,
"TREND": -1,
"START_TIME": 1384840740000,
"END_TIME": 253402271999000,
"ROWID": 1

}
]

Listing maximum, minimum, and average values in a specified time:

List the maximum, minimum, and average measurement values within a specified time period.

Example 1: List values by year

Method

GET.
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Resource URL
https://<web server hostname>/ibm/water/api/asset/
<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/
assetInstance/<ASSET_ID>/measurement/<MEASUREMENT_ID>/reading/byYear

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/measurement/PCP553_M/reading/latest/
byYear.

Request Parameters

Not applicable.

Response
[{
"MAX": 41.89,
"MIN": 41.02,
"AVG": 41.405,
"TIME": 2013,
"ROWID": 1
}
]

Example 2: List values by month

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/asset/
<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/
assetInstance/<ASSET_ID>/measurement/<MEASUREMENT_ID>/reading/byMonth

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/measurement/PCP553_M/reading/latest/
byMonth

Request Parameters

Not applicable.

Response
[{
"MAX": 41.89,
"MIN": 41.02,
"AVG": 41.405,

"YEAR": 2013,
"TIME": 7,
"ROWID": 1
}
]

Example 3: List values by day

Method

GET.
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Resource URL
https://<web server hostname>/ibm/water/api/asset/
<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/
assetInstance/ASSET_ID>/<measurement/<MEASUREMENT_ID>/reading/byDay

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/measurement/PCP553_M/reading/latest/
byDay

Request Parameters

Not applicable.

Response
[{
"MAX": 41.89,
"MIN": 41.02,
"AVG": 41.405,

"YEAR": 2013,
"MONTH": 7,

"TIME": 2,
"ROWID": 1

}
]

Example 4: List values by hour

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/asset/
<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/
assetInstance/<ASSET_ID>/measurement/<MEASUREMENT_ID>/reading/byHour

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/measurement/PCP553_M/reading/latest/
byHour

Request Parameters

Not applicable.

Response
[{
"MAX": 41.89,
"MIN": 41.02,
"AVG": 41.405,

"YEAR": 2013,
"MONTH": 7,
"DAY": 2,

"TIME": 6,
"ROWID": 1

}
]

Example 5: List values by minute
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Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/asset/
<SOLUTION_ID>/model/<MODEL_ID>/assetType/<ASSET_TYPE_ID>/
assetInstance/<ASSET_ID>/measurement/<MEASUREMENT_ID>/reading/byMinute

For example, https://<web server hostname>/ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/assetType/WPM/assetInstance/PCP553/measurement/PCP553_M/reading/latest/
byMinute

Request Parameters

Not applicable.

Response
[{
"MAX": 41.89,
"MIN": 41.02,
"AVG": 41.405,

"YEAR": 2013,
"MONTH": 7,
"DAY": 2,
"HOUR": 6,

"TIME": 30,
"ROWID": 1
}
]

Rendering services
Manage rendering in a solution application in IBM Intelligent Operations for Water.

Web Map Service (WMS)
Use the web map services to manage web maps in a solution application.

GetMap service:

Use the GetMap service to retrieve a rendered map image in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/rendering-service/wms

Request Parameters
bbox: boundary of map query
layers: comma seperated data service URLs
filter: comma seperated data service filter expressions
styles: comma seperated style names
srs: client map projection code
width: image width
height: image height
For Example:
BBOX=-9627396.5852344,5087648.6019531,-9588260.8267578,5126784.3604297
FORMAT=image/png
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LAYERS=/ibm/water/api/asset/Sunshine/model/SunshineWaterGroup/assetType/WPM/assetInstanceSimple,
/ibm/water/api/asset/Sunshine/model/SunshineWaterGroup/assetType/TankLevel/assetInstanceSimple,
/ibm/water/api/asset/Sunshine/model/SunshineWaterGroup/assetType/Pipe/assetInstanceSimple

FILTERS=STATUS>0,STATUS=0
REQUEST=GetMap
SERVICE=WMS
SRS=EPSG:900913
STYLES=90ee90,90ee90,4b0082
TRANSPARENT=TRUE
VERSION=1.1.1
WIDTH=256
HEIGHT=256

Response

Rendered image.

GetFeatureInfo service:

Use the GetFeatureInfo service to retrieve map feature coordinates in a solution application.

Method

GET.

Resource URL
https://ioc16-dmz.cn.ibm.com/ibm/water/api/rendering-service/wms

Request Parameters
bbox: boundary of map query
layers: data service URL list
filter: comma seperated data service filter expressions
srs: client map projection code
width: image width
height: image height
featureCount
x: pixel offset
y: pixel offsetFor Example:
For example

BBOX=-9601802.678216,5113330.701203,-9591015.502601,5116349.96382
EXPECT_COUNT=10
FEATURE_COUNT=10
FORMAT=image/png
HEIGHT=316
INFO_FORMAT=text/html
LAYERS=/ibm/water/api/asset/Sunshine/model/SunshineWaterGroup/assetType/WPM/assetInstanceSimple,
/ibm/water/api/asset/Sunshine/model/SunshineWaterGroup/assetType/TankLevel/assetInstanceSimple,
/ibm/water/api/asset/Sunshine/model/SunshineWaterGroup/assetType/Pipe/assetInstanceSimple
REQUEST=GetFeatureInfo
SERVICE=WMS
SRS=EPSG:900913
STYLES=90ee90,90ee90,4b0082
VERSION=1.1.1
WIDTH 1129
X=457
Y=180

Response
{
"/ibm/water/api/asset/Sunshine/model/SunshineWaterGroup/assetType/WPM/assetInstanceSimple": [],
"/ibm/water/api/asset/Sunshine/model/SunshineWaterGroup/assetType/TankLevel/assetInstanceSimple": [],
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"/ibm/water/api/asset/Sunshine/model/SunshineWaterGroup/assetType/Pipe/assetInstanceSimple": [{
"type": "Feature",
"geometry": {
"type": "LineString",
"coordinates": [[-86.2163,
41.6896],
[-86.2143,
41.69]]
},
"properties": {
"STATUS": null,
"ROWID": "1",
"PRIMARY_MEASUREMENT_ID": null,
"NAME": "Pipe26",
"ID": "Pipe26"
},
"id": "Pipe26"
}]
}

Style service
Manage styles, layers, and colors in a solution application.

Listing styles:

Retrieve a list of default styles for colors in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/style

Request Parameters

Not applicable.

Response
[{
"NAME": "000000",
"DESCRIPTION": "Default Style for Color #000000",
"ROWID": 1
},{
"NAME": "000080",
"DESCRIPTION": "Default Style for Color #000080",
"ROWID": 2
},
...
...
]

Getting SLD definition of a style:

Retrieve a Style Layer Descriptor (SLD) definition of a style in a solution application.

Method

GET.
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Resource URL
https://<web server hostname>/ibm/water/api/style/ID>

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/style/000000.

Request Parameters

Not applicable

Response
{
"NAME": "000000",
"DESCRIPTION": "Default Style for Color #000000",
"STYLE": "<StyledLayerDescriptor>.../<StyledLayerDescriptor>" }

Model access services
Manage access to semantic models in a solution application in IBM Intelligent Operations for Water.

Model search service
Use the model search service to retrieve semantic models in a solution application.

Searching model by keyword:

Search a semantic model by keyword in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/model/<SOLUTION_ID>/search?keyword=<keyword>

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/model/Sunshine/search?keyword=PCP.

Request Parameters
Parameters
keyword: String, the search keyword

Response
[{
"ID": "http:\/\/SunshineWaterGroup#PCP553"

},{
"ID": "http:\/\/SunshineWaterGroup#PCP604"

},{
"ID": "http:\/\/SunshineWaterGroup#PCP599"

}
]

Searching model by keyword and asset type:

Search a semantic model by keyword asset type in a solution application.

Method

GET.
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Resource URL
https://<web server hostname>/ibm/water/api/model/<SOLUTION_ID>/search?
keyword=<keyword>&assetType=<assetType1>,<assetType2>,<assetType3>

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/model/Sunshine/search?keyword=PCP
&assetType=http%3A%2F%2FSunshineWaterGroup%23WPM.

Request Parameters
Parameters
keyword: String, the search keyword
assetType: String, comma separated asset type

Response
[{
"ID": "http:\/\/SunshineWaterGroup#PCP553"
},{
"ID": "http:\/\/SunshineWaterGroup#PCP604"
},{
"ID": "http:\/\/SunshineWaterGroup#PCP599"
}
]

Model property service
Manage semantic model properties in a solution application.

Retrieving properties of object:

Get the properties of an object in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/model/<SOLUTION_ID>/property?nodeId=<nodeId>

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/model/Sunshine/property?nodeId=
http%3A%2F%2FSunshineWaterGroup%23PCP553.

Request Parameters
Parameters
nodeId: String, the id of rdf object

Response
[{
"value": "http:\/\/iec.ch\/TC57\/CIM-generic#RSM_PhysicalEntity",
"name": "http:\/\/www.w3.org\/1999\/02\/22-rdf-syntax-ns#type"
},{
"value": "http:\/\/SunshineWaterGroup#J553",
"name": "http:\/\/iec.ch\/TC57\/CIM-generic#RSM_WorkEquipment.ContainedBy_Equipment"
},{
"value": "http:\/\/iec.ch\/TC57\/CIM-generic#RSM_FunctionalLocation",
"name": "http:\/\/www.w3.org\/1999\/02\/22-rdf-syntax-ns#type"
},{
"value": "http:\/\/iec.ch\/TC57\/CIM-generic#RSM_UnnamedObject",
"name": "http:\/\/www.w3.org\/1999\/02\/22-rdf-syntax-ns#type"
},{
"value": "http:\/\/SunshineWaterGroup#PCP553_M_ATM",
"name": "http:\/\/iec.ch\/TC57\/CIM-generic#RSM_PhysicalEntity.has_measurement"
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},{
"value": "PCP553",
"name": "http:\/\/iec.ch\/TC57\/CIM-generic#RSM_IdentifiedObject.name"

},{
"value": "http:\/\/iec.ch\/TC57\/CIM-generic#RSM_IdentifiedObject",
"name": "http:\/\/www.w3.org\/1999\/02\/22-rdf-syntax-ns#type"

},{
"value": "http:\/\/iec.ch\/TC57\/CIM-generic#RSM_MaintainableItem",
"name": "http:\/\/www.w3.org\/1999\/02\/22-rdf-syntax-ns#type"

},{
"value": "http:\/\/iec.ch\/TC57\/CIM-generic#ISA95_WorkLocation",
"name": "http:\/\/www.w3.org\/1999\/02\/22-rdf-syntax-ns#type"

},{
"value": "http:\/\/iec.ch\/TC57\/CIM-generic#ISO15926_FunctionalLocation",
"name": "http:\/\/www.w3.org\/1999\/02\/22-rdf-syntax-ns#type"

},{
"value": "http:\/\/iec.ch\/TC57\/CIM-generic#MIMOSA_Segment",
"name": "http:\/\/www.w3.org\/1999\/02\/22-rdf-syntax-ns#type"

},{
"value": "http:\/\/iec.ch\/TC57\/CIM-generic#RSM_ResourceMember",
"name": "http:\/\/www.w3.org\/1999\/02\/22-rdf-syntax-ns#type"

},{
"value": "http:\/\/iec.ch\/TC57\/CIM-generic#RSM_WorkEquipment",
"name": "http:\/\/www.w3.org\/1999\/02\/22-rdf-syntax-ns#type"

},{
"value": "http:\/\/SunshineWaterGroup#PCP553_M",
"name": "http:\/\/iec.ch\/TC57\/CIM-generic#RSM_PhysicalEntity.has_measurement"

},{
"value": "http:\/\/SunshineWaterGroup#Meter",
"name": "http:\/\/www.w3.org\/1999\/02\/22-rdf-syntax-ns#type"

},{
"value": "http:\/\/SunshineWaterGroup#WPM",
"name": "http:\/\/www.w3.org\/1999\/02\/22-rdf-syntax-ns#type"

},{
"value": "http:\/\/SunshineWaterGroup#PCP553LOC",
"name": "http:\/\/iec.ch\/TC57\/CIM-generic#RSM_PhysicalEntity.has_Location"

},{
"value": "PCP553",
"name": "http:\/\/iec.ch\/TC57\/CIM-generic#RSM_UnnamedObject.description"

},{
"value": "http:\/\/iec.ch\/TC57\/CIM-generic#MIMOSA_Agent",
"name": "http:\/\/www.w3.org\/1999\/02\/22-rdf-syntax-ns#type"

}
]

KNN service
Use the k-Nearest Neighbor (KNN) service to recognize similarities between patterns of data in a solution
application.

Nearest Neighbor Analysis is a method for classifying cases based on their similarity to other cases. In
machine learning, it was developed as a way to recognize patterns of data without requiring an exact
match to any stored patterns, or cases. Similar cases are near each other and dissimilar cases are distant
from each other. Thus, the distance between two cases is a measure of their dissimilarity. Cases that are
near each other are said to be “neighbors.”

When a new case (holdout) is presented, its distance from each of the cases in the model is computed.
The classifications of the most similar cases – the nearest neighbors – are tallied and the new case is
placed into the category that contains the greatest number of nearest neighbors. You can specify the
number of nearest neighbors to examine; this value is called k.
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The pictures show how a new case would be classified using two different values of k. When k = 5, the
new case is placed in category 1 because a majority of the nearest neighbors belong to category 1.
However, when k = 9, the new case is placed in category 0 because a majority of the nearest neighbors
belong to category 0.

Searching k-Nearest Neighbor:

Search for similar data patterns by using Near Neighbour analysis in a solution application.

Method

GET.

Resource URL
https://web server hostname>/ibm/water/api/model/<SOLUTION_ID>/knn?
startNode=<startNode>&depth=<depth>&relationship=<rel1>,<rel2>&direction=<direction>

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/model/Sunshine/knn?startNode=
http%3A%2F%2FSunshineWaterGroup%23PCP553&depth=2.

Request Parameters
Parameters
startNode: String, the rdf object id of start node
depth: int, the depth of search
relationship: (optional) String, comma separated relationship types,
e.g. http%3A%2F%2Fiec.ch%2FTC57%2FCIM-generic%23RSM_WorkEquipment.connected_WorkEquipment%2C
http%3A%2F%2Fiec.ch%2FTC57%2FCIM-generic%23RSM_PhysicalEntity.has_Location%2Chttp%3A%2F%2
Fiec.ch%2FTC57%2FCIM-generic%23RSM_WorkEquipment.connects_WorkEquipment%2Chttp%3A%2F%2Fiec.ch%2
FTC57%2FCIM-generic%23RSM_PhysicalEntity.has_measurement%2Chttp%3A%2F%2Fiec.ch%2FTC57%2FCIM-generic%
23RSM_WorkEquipment.ContainedBy_Equipment%2Chttp%3A%2F%2Fiec.ch%2FTC57%2FCIM-generic%23
RSM_WorkEquipment.Contains_Equipment%2Chttp%3A%2F%2Fwww.w3.org%2F1999%2F02%2F22-rdf-syntax-ns%23type
%2Chttp%3A%2F%2Fwww.w3.org%2F2000%2F01%2Frdf-schema%23subClassOf
direction: (optional)String, value can be “forward”, “backward” and “both”,
default is “both”. Used to rectrict the graph direction of knn search

Response
[{
"subject": "http:\/\/SunshineWaterGroup#J553",
"predict": "http:\/\/iec.ch\/TC57\/CIM-generic#RSM_WorkEquipment.connected_WorkEquipment",
"object": "http:\/\/SunshineWaterGroup#Pipe55"
},{
"subject": "http:\/\/SunshineWaterGroup#PRV24",
"predict": "http:\/\/www.w3.org\/1999\/02\/22-rdf-syntax-ns#type",
"object": "http:\/\/SunshineWaterGroup#Meter"
},{
...
...
]

Impact analysis service
Manage impact analysis in a solution application.

Running impact analysis:

Run impact analysis in a solution application.

Method

GET.
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Resource URL
https://web server hostname>/ibm/water/api/model/<SOLUTION_ID>/impactanalysis?startNode
=<startNode>&endNode=<endNode>&depth=<depth>&relationship=<rel1>,<rel2>

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/model/Sunshine/
impactanalysis?startNode=http%3A%2F%2FSunshineWaterGroup%23J553&endNode=http%3A%2F
%2FSunshineWaterGroup%23WPM&depth=6.

Request Parameters
Parameters
startNode: String, the rdf object id of start node
endNode: String, the rdf object id of end node
depth: int, the depth of search
relationship: (optional) String, comma separated relationship types,
e.g. http%3A%2F%2Fiec.ch%2FTC57%2FCIM-generic%23RSM_WorkEquipment.connected_WorkEquipment
%2Chttp%3A%2F%2Fiec.ch%2FTC57%2FCIM-generic%23RSM_PhysicalEntity.has_Location%2Chttp%3A%2
F%2Fiec.ch%2FTC57%2FCIM-generic%23RSM_WorkEquipment.connects_WorkEquipment%2Chttp%3A%2F%2
Fiec.ch%2FTC57%2FCIM-generic%23RSM_PhysicalEntity.has_measurement%2Chttp%3A%2F%2Fiec.ch%2
FTC57%2FCIM-generic%23RSM_WorkEquipment.ContainedBy_Equipment%2Chttp%3A%2F%2Fiec.ch%2
FTC57%2FCIM-generic%23RSM_WorkEquipment.Contains_Equipment%2Chttp%3A%2F%2Fwww.w3.org%2
F1999%2F02%2F22-rdf-syntax-ns%23type%2Chttp%3A%2F%2Fwww.w3.org%2F2000%2F01%2Frdf-schema%23subClassOf

Response
[{
"subject": "http:\/\/SunshineWaterGroup#PCP553",
"predict": "http:\/\/www.w3.org\/1999\/02\/22-rdf-syntax-ns#type",
"object": "http:\/\/SunshineWaterGroup#WPM"

},{
"subject": "http:\/\/SunshineWaterGroup#J553",
"predict": "http:\/\/iec.ch\/TC57\/CIM-generic#RSM_WorkEquipment.Contains_Equipment",
"object": "http:\/\/SunshineWaterGroup#PCP553"

}
]

Custom SPARQL query
Manage custom SPARQL queries in a solution application.

Defining a custom SPARQL query:

Define a custom SPARQL query in a solution application.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/model/<SOLUTION_ID>/query

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/model/Sunshine/query.

Request Parameters
{
"ID": "myquery",
"SPARQL": "select ?id where { ?id a <http:\/\/SunshineWaterGroup#WUM> . }"

}
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Response
{
"ID": "myquery",
"SPARQL": "select ?id where { ?id a <http:\/\/SunshineWaterGroup#WUM> .}"
}

Listing a custom SPARQL query:

List a custom SPARQL query in a solution application.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/model/<SOLUTION_ID>/query

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/model/Sunshine/query.

Request Parameters

Not applicable.

Response
[{
"ID": "myquery",
"SPARQL": "select ?id where { ?id a http> . }", "ROWID": 1 } ]

/http>

Running a custom SPARQL query:

Run a custom SPARQL query in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/model/<SOLUTION_ID>/result

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/model/Sunshine/result.

Request Parameters

Not applicable.

Response
[{
"id": "http:\/\/SunshineWaterGroup#WUM_9"
},{
"id": "http:\/\/SunshineWaterGroup#WUM_5"
},{
"id": "http:\/\/SunshineWaterGroup#WUM_7"
},{
"id": "http:\/\/SunshineWaterGroup#WUM_1"
},{
"id": "http:\/\/SunshineWaterGroup#WUM_3"
},{
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"id": "http:\/\/SunshineWaterGroup#WUM_8"
},{
"id": "http:\/\/SunshineWaterGroup#WUM_4"

},{
"id": "http:\/\/SunshineWaterGroup#WUM_6"

},{
"id": "http:\/\/SunshineWaterGroup#WUM_10"

},{
"id": "http:\/\/SunshineWaterGroup#WUM_2"

}
]

Updating a custom SPARQL query:

Update a custom SPARQL query in a solution application.

Method

PUT.

Resource URL
https://<web server hostname>/ibm/water/api/model/<SOLUTION_ID>/query/<ID>

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/model/Sunshine/query/myquery.

Request Parameters
{
"SPARQL": "PREFIX cim:<http://iec.ch/TC57/CIM-generic#>select ?id ?name where

{ ?id a <http://SunshineWaterGroup#WUM> . ?id cim:RSM_IdentifiedObject.name ?name . }"
}

Response
{
"ID": "myquery",
"SPARQL": "PREFIX cim:<http:\/\/iec.ch\/TC57\/CIM-generic#> select ?id ?name where

{ ?id a <http:\/\/SunshineWaterGroup#WUM> . ?id cim:RSM_IdentifiedObject.name ?name . }"
}

Deleting a custom SPARQL query:

Delete a custom SPARQL query in a solution application.

Method

DELETE.

Resource URL
https://<web server hostname>/ibm/water/api/model/<SOLUTION_ID>/query/<ID>

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/model/Sunshine/query/myquery.

Request Parameters

Not applicable.
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Response
{
"ID": "myquery",
"SPARQL": "PREFIX cim:<http:\/\/iec.ch\/TC57\/CIM-generic#> select ?id ?name where{ ?id
a <http:\/\/SunshineWaterGroup#WUM> . ?id cim:RSM_IdentifiedObject.name ?name . }"
}

I18N services
Use the I18N services to manage rendering in a solution application in IBM Intelligent Operations for
Water. I18N is an abbreviation of the term, Internationalization service API that provides default values
for both unavailable and invalid Internationalization context elements.

Querying I18N resources
Query I18N resources in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/i18n/resources

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/i18n/resources?group=Sunshine
&key=filter_group_pane_0&locale=zh.

Request Parameters
Parameters:
group: String, optional, group name
key: String, optional, key name
locale: String, optional, locale name

Response
[{
"ID": 1179,
"GROUP": "Sunshine",
"LOCALE": "zh",
"KEY": "filter_group_pane_0",
"VALUE": "[\u9ed2\u6192\u9055Boundary~~~zh]",
"LASTUPDATEDATE": 1387774429000
}
]

Creating I18N resources
Query I18N resources in a solution application.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/i18n/resources

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/i18n/resources.
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Request Parameters
{
"GROUP": "Sunshine",
"LOCALE": "zh-CN",
"KEY": "filter_group_pane_0",
"VALUE": "[\u9ed2\u6192\u9055Boundary~~~zh]"

}

Response
{
"ID": 1695,
"GROUP": "Sunshine",
"LOCALE": "zh-cn",
"KEY": "filter_group_pane_0",
"VALUE": "[\u9ed2\u6192\u9055Boundary~~~zh]",
"LASTUPDATEDATE": 1388388249000

}

Updating I18N Resources
Update I18N resources in a solution application.

Method

PUT.

Resource URL
https://<web server hostname>/ibm/water/api/i18n/resources/<ID>

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/i18n/resources/1695.

Request Parameters
{
"GROUP": "Sunshine",
"LOCALE": "zh-CN",
"KEY": "filter_group_pane_0",
"VALUE": "[\u9ed2\u6192\u9055Boundary~~~zh]"

}

Response
{
"ID": 1695,
"GROUP": "Sunshine",
"LOCALE": "zh-cn",
"KEY": "filter_group_pane_0",
"VALUE": "[\u9ed2\u6192\u9055Boundary~~~zh]",
"LASTUPDATEDATE": 1388388324000

}

Deleting I18N Resources
Delete I18N resources in a solution application.

Method

DELETE.

Resource URL
https://<web server hostname>/ibm/water/api/i18n/resources/<ID>

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/i18n/resources/1695.
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Request Parameters

Not applicable.

Response
{
"ID": 1695,
"GROUP": "Sunshine",
"LOCALE": "zh-cn",
"KEY": "filter_group_pane_0",
"VALUE": "[\u9ed2\u6192\u9055Boundary~~~zh]",
"LASTUPDATEDATE": 1388388324000
}

Listing I18N groups
List I18N groups in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/i18n/group

Request Parameters

Not applicable.

Response
[{
"GROUP": "IOW",
"ROWID": 1
},{
"GROUP": "Sunshine",
"ROWID": 2
}
]

Listing I18N keys in a group
List I18N keys in a group in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/i18n/group/Sunshine/key

Request Parameters

Not applicable.

Response
[{
"KEY": "asset_detail_view_0",
"ROWID": 1
},{
"KEY": "asset_list_0",
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"ROWID": 2
},{
"KEY": "asset_preview_card_0",
"ROWID": 3

},{
...
...
]

Access control service
Manage access control in a solution application in IBM Intelligent Operations for Water.

Global access services
Manage global access in a solution application.

Listing access control:

List access controls in a solution application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/access

Request Parameters

Not applicable.

Response
[{
"ID": 1,
"URL": "\/ibm\/water\/api\/*",
"IDENTITY": "wpsadmins",
"IDENTITY_TYPE": "G",
"C_ACCESS": 1,
"R_ACCESS": 1,
"U_ACCESS": 1,
"D_ACCESS": 1,
"SOLUTION_ID": null,
"ROWID": 1

},{
"ID": 3,
"URL": "\/ibm\/water\/api\/access\/*",
"IDENTITY": "wpsadmins",
"IDENTITY_TYPE": "G",
"C_ACCESS": 1,
"R_ACCESS": 1,
"U_ACCESS": 1,
"D_ACCESS": 1,
"SOLUTION_ID": null,
"ROWID": 2

},{
...
]

Listing access control with ID:

List access controls with a specified ID in a solution application.
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Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/access/<ID>

Request Parameters

Not applicable.

Response
{
"ID": 1,
"URL": "\/ibm\/water\/api\/*",
"IDENTITY": "wpsadmins",
"IDENTITY_TYPE": "G",
"C_ACCESS": 1,
"R_ACCESS": 1,
"U_ACCESS": 1,
"D_ACCESS": 1,
"SOLUTION_ID": null

}

Creating access control:

Create access controls in a solution application.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/access/

Request Parameters
{
"URL": "\/ibm\/water\/api\/*",
"IDENTITY": "wpsadmin",
"IDENTITY_TYPE": "U",
"C_ACCESS": 1,
"R_ACCESS": 1,
"U_ACCESS": 1,
"D_ACCESS": 1
}

Response
{
"ID": 78,
"URL": "\/ibm\/water\/api\/*",
"IDENTITY": "wpsadmin",
"IDENTITY_TYPE": "U",
"C_ACCESS": 1,
"R_ACCESS": 1,
"U_ACCESS": 1,
"D_ACCESS": 1,
"SOLUTION_ID": null
}
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Updating access control:

Update access controls in a solution application.

Method

PUT.

Resource URL
https://<web server hostname>/ibm/water/api/access/<ID>

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/access/78.

Request Parameters
{
"URL": "\/ibm\/water\/api\/*",
"IDENTITY": "wpsadmin",
"IDENTITY_TYPE": "U",
"C_ACCESS": 0,
"R_ACCESS": 1,
"U_ACCESS": 1,
"D_ACCESS": 1

}

Response
{
"ID": 78,
"URL": "\/ibm\/water\/api\/*",
"IDENTITY": "wpsadmin",
"IDENTITY_TYPE": "U",
"C_ACCESS": 0,
"R_ACCESS": 1,
"U_ACCESS": 1,
"D_ACCESS": 1,
"SOLUTION_ID": null

}

Deleting access control:

Delete access controls in a solution application.

Method

DELETE.

Resource URL
https://<web server hostname>/ibm/water/api/access/<ID>

For example, https://ioc16-dmz.cn.ibm.com/ibm/water/api/access/78.

Request Parameters

Not applicable.

Response
{
"ID": 78,
"URL": "\/ibm\/water\/api\/*",
"IDENTITY": "wpsadmin",
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"IDENTITY_TYPE": "U",
"C_ACCESS": 0,
"R_ACCESS": 1,
"U_ACCESS": 1,
"D_ACCESS": 1,
"SOLUTION_ID": null
}

Solution level access control
Manage solution level access control for user groups in a solution application.

Service security

Use the following table to reference solution application services.

URL User Group GET POST PUT DELETE Comments

/ibm/water/api/* wpsadmins Yes Yes Yes Yes wpsadmins have full
service access

/ibm/water/api/
access/*

wpsadmins Yes Yes Yes Yes

/ibm/water/api/
pages/*

All
Authenticated
Users

Yes No No No All users can use this
service to look up
solution ID and page
ID

/ibm/water/api/
rendering-service/*

All
Authenticated
Users

Yes No No No All users can use this
service to render data

/ibm/water/api/
i18n/*

All
Authenticated
Users

Yes No No No All users can read
I18n data

/ibm/water/api/
style/*

All
Authenticated
Users

Yes No No No All users can read
styles

/ibm/water/api/
application /*

Admin Yes No No No

/ibm/water/api/
solution

Admin Yes No No No Solution
Administrator can list
all solutions

/ibm/water/api/
solution/
<SolutionID>/*

Admin Yes Yes Yes Yes Solution
Administrator can
only access the
solution application

/ibm/water/api/
solution/
<SolutionID>/*

Executive Yes No No No

/ibm/water/api/
solution/<SolutionID>
/*

Supervisor Yes No No No

/ibm/water/api/
solution/
<SolutionID>/*

Operator Yes No No No
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URL User Group GET POST PUT DELETE Comments

/ibm/water/api/
solution/
<SolutionID>/*

Planner Yes No No No

/ibm/water/api/
solution/
<SolutionID>/*

Citizen Yes No No No

/ibm/water/api/
solution/
<SolutionID>/page/
{PageID}/
savedFilters/*

/ibm/water/api/
solution/
<SolutionID>/page/
Executive
Operations/
savedFilters/*

Executive Yes Yes Yes Yes

/ibm/water/api/
solution/
<SolutionID>/page/
Executive
Operations/
userPreference/*

Executive Yes Yes Yes Yes

/ibm/water/api/
solution/
<SolutionID>/page/
Executive
Status/savedFilters/*

Executive Yes Yes Yes Yes

/ibm/water/api/
solution/
<SolutionID>/page/
{PageID}/
userPreference/*

Executive Yes Yes Yes Yes

/ibm/water/api/
solution/
<SolutionID>/page/
{PageID}/
savedFilters/*

Supervisor Yes Yes Yes Yes

/ibm/water/api/
solution/
<SolutionID>/page/
{PageID}/
userPreference/*

Supervisor Yes Yes Yes Yes

/ibm/water/api/
solution/
<SolutionID>/page/
{PageID}/
savedFilters/*

Supervisor Yes Yes Yes Yes
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URL User Group GET POST PUT DELETE Comments

/ibm/water/api/
solution/
<SolutionID>/page/
{PageID}/
userPreference/*

Supervisor Yes Yes Yes Yes

/ibm/water/api/
solution/
<SolutionID>/ page
/{PageID}/
savedFilters /*

Operator Yes Yes Yes Yes

/ibm/water/api/
solution/
<SolutionID>/page
/{PageID}
/userPreference /*

Operator Yes Yes Yes Yes

/ibm/water/api/
solution/
<SolutionID>/
page/{PageID}/
savedFilters /*

Operator Yes Yes Yes Yes

/ibm/water/api/
solution/
<SolutionID>/page/
{PageID}/
userPreference/*

Operator Yes Yes Yes Yes

/ibm/water/api/
solution/
<SolutionID>/page/
{PageID}/
savedFilters/*

Planner Yes Yes Yes Yes

/ibm/water/api/
solution/
<SolutionID>/page/
{PageID}/
userPreference/*

Planner Yes Yes Yes Yes

/ibm/water/api/
solution/
<SolutionID>/page/
{PageID}/
savedFilters/*

Citizen Yes Yes Yes Yes

/ibm/water/api/
solution/
<SolutionID>/page/
{PageID}/
userPreference/*

Citizen Yes Yes Yes Yes
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URL User Group GET POST PUT DELETE Comments

/ibm/water/api/
solution/
<SolutionID>/*

Admin Yes Yes Yes Yes

/ibm/water/api/
solution/
<SolutionID>/*

Executive Yes No No No

/ibm/water/api/
solution/
<SolutionID>/*

Supervisor Yes No No No

/ibm/water/api/
solution/
<SolutionID>/*

Operator Yes No No No

/ibm/water/api/
solution/
<SolutionID>/*

Planner Yes No No No

/ibm/water/api/
solution/
<SolutionID>/*

Citizen Yes No No No

Example 1

The configuration in the table below indicates that the administrator of the group, <SolutionID>, can
access list solution applications. In addition, the administrator has read/write access to supporting
applications.

URL User Group GET POST PUT DELETE

/ibm/water/api/
solution

Admin Yes No No No

/ibm/water/api/
solution/
<SolutionID>*

Admin Yes No No No

Example 2

Suppose that you created two solutions: Sunshine and MySolution. The table below indicates that the
SunshineAdmin and MySolutionAdmin configurations can list solutions. In addition, SunshineAdmin can
access Sunshine solution, and vice versa.

URL User Group GET POST PUT DELETE

/ibm/water/api/
solution

Sunshine Admin Yes No No No

/ibm/water/api/
solution

MySolution
Admin

Yes No No No

/ibm/water/api/
solution/
Sunshine/*

Sunshine Admin Yes Yes Yes Yes

/ibm/water/api/
solution/
Sunshine /*

MySolution
Admin

Yes Yes Yes Yes
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Using 1.5 SDK
To provide backward compatibility, IOW 1.5 SDK is provided as an optional library.

Installing Water 1.5 SDK
The Water 1.5 Sofware Development Kit (SDK) is not installed by default. To use the Water 1.5 SDK,
follow the guide to install it manually.

Creating database tables:

The first step to installing the Water 1.5 Software Development Kit (SDK) is to create database tables.

Procedure

1. Go to the application node at /opt/IBM/water/sdk15.
2. Copy the following files to database node:

v db/create_RenderService_Tables.ddl
v db/create_TopicMap_tables.ddl
v db/create_RenderService_Procedures.db2

3. Log in to the database node as db2inst2.
4. Run the following command:

db2 connect to WIHDB
db2 -tvf $IOC_BASE_DIR/content/sdk_db/create_RenderService_Tables.ddldb2 -tvf
$IOC_BASE_DIR/content/sdk_db/create_TopicMap_tables.ddl
db2 -td@ -vf $IOC_BASE_DIR/content/sdk_db/create_RenderService_Procedures.db2

What to do next

The second and final step is to deploy the Water 1.5 Software Development Kit (SDK) applications.

Deploying 1.5 SDK applications:

The second step to installing the Water 1.5 Software Development Kit (SDK) is to deploy Water 1.5 SDK
applications.

Before you begin

Ensure that you complete the first step to installing the Water 1.5 Software Development Kit (SDK),
which is to create database tables.

Procedure

1. Go to application node /opt/IBM/water/sdk15 and take the following steps:
a. Copy apps/* to /opt/IBM/water/apps
b. Copy lib/* to /opt/IBM/water/lib.

2. Deploy water_sdk15_ear.ear to portal by taking the following steps:
a. Log on to WebSphere Application Server Console at http://app-node>:9061/ibm/console.
b. Go to Applications > Application Types > WebSphere Enterprise Applications.
c. Click Install and select water_sdk15_ear.ear.
d. Click Next, accept the default configurations, until the step, Map modules to servers.
e. Map water_sdk15_web to PortalClusterand ihsserver1.
f. Click Next, accept default configurations to deploy the ear file.
g. Restart Portal.
h.
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What to do next

The second and final step is to deploy the Water 1.5 Software Development Kit (SDK) applications.

Using 1.5 SDK Services
The SDK service is available at context root, /ibm/water15/api.

Extending the Client Programming Model
The client programming model for IBM Intelligent Operations for Water provides an extension
mechanism to customize the client user interface.

The client programming model is based on the Dojo Toolkit 1.8 and the IBM Dojo extension (dojox).

The Dojo Toolkit is a powerful JavaScript™ library that enables web developers to create Rich Internet
Applications using object-oriented widgets. It comes with four packages, known as Dojo (the core), Dijit
(the UI framework), dojox (the dojo extension) and util. You can use the functionality provided by the
toolkit as is, or you can extend them and create your own widgets.

The client programming model composed of
1. Out-of-box extensions
2. Extension API
3. Library API
4. Extension service
5. Page config service

Extension characteristics
An extension is a plain dijit (dojo widget) that implements a specific extension API.

The following questions help to define the characteristics of the extension:
v What is the extension type?
v What data can be consumed by the extension?

Extension Types

The following are extension types:
v Container Extension

– The Container Extension can contain child extensions. For example, the Filter Panel is a container
extension. It can contain multiple Filter Map Views with multiple map layers.

v Static Extension
– Static extensions are created when the page is loaded. It will not be destroyed before the pages

unload. Most container extensions are static extensions. For example, the Filter Panel will be created
during page load.

v Dynamic Extension
– Dynamic extensions are created and destroyed many times dynamically at runtime. For example, the

asset map layer is the dynamic extension. The extension is created when the user selects a specific
filter checkbox, and destroyed when user deselects a specific filter. Another example is the Preview
card. It is created when user selects one asset in the map, and destroyed when the user deselects the
asset.
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Lifecycles of static and dynamic extensions
Static and dynamic extensions have different lifecycles.

Static Extensions

Static extensions are created when an application page is loaded. Its tree structure is created by the
addChild and setParent API methods.

Dynamic Extensions

Dynamic extensions are created at runtime, when the user selects/deselects an application feature. The
addChild and setParent API methods are called to dynamically construct the tree structure. The setModel
method is called to set data for the extension.

Binding extensions to data URI patterns
You can bind an extension to a URI pattern. The pattern indicates the data that can be consumed by an
extension.

When to use URI patterns with extensions

You can use URI to identify data, whether it is a collection of data items, or a single data item. For
example, the URI, /ibm/water/api/asset/Sunshine/model/SunshineWaterGroup/Pipe/assetInstance,
represents a collection of pipes. As another example, the URI, /ibm/water/api/asset/Sunshine/model/
SunshineWaterGroup/Pipe/assetInstance/Pipe14, represents a single pipe named Pipe14.

URI Patters and wild cards

An URI Pattern is a URI with wild cards in its path. A wild card is a character that you can use as a
substitute for any character in a pattern. For example, one URI pattern is /ibm/water/api/asset/*/model/
*/assetType/*/assetInstance. The pattern can match all URIs that represent a collection of asset
instances, such as the pipes in previous example. Another URI pattern is /ibm/water/api/asset/*/model/
*/assetType/*/assetInstance/*. The pattern can match all URIs that represent a single item of asset
instance; for example, Pipe14 in the previous example.

Matching to a URI Pattern

Two URI patterns can match the same URI. For example, the URIs, /ibm/water/api/asset/*/model/*/
assetType/*/assetInstance/* and /ibm/water/api/asset/*/model/*/assetType/Pipe/assetInstance/*,
can match the URI, /ibm/water/api/asset/Sunshine/model/SunshineWaterGroup/Pipe/assetInstance. The
degree to which both URIs match to the single URI is different. In this case, the second URI can better
match to the single URI's client programming model. You can leverage the single URI to extend the UI
dynamically. In another example, an out-of-box default method, AssetPreviewCard, can bind to the URI,
/ibm/water/api/asset/*/model/*/assetType/*/assetInstance/*. The match can be used to preview all
types of asset. You can also create a PipePreviewCard method, and bind it to the URI,
/ibm/water/api/asset/*/model/*/assetType/Pipe/assetInstance/*. The match overwrites the default
asset preview card. In this way, when the user select a pipe, the PipePreviewCard will be used.

Out-of-Box extensions
You can use the set of default extensions provided with the solution. Many of the out-of-box extensions
are containers. A custom extension can extend these containers to add child extensions.

Operations UI extensions
You can use default user interface (UI) extensions for the Operations pages.
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Status UI extensions
You can use default user interface (UI) extensions for the Status pages.

Citizen UI extensions
You can use default user interface (UI) extensions for the Citizen page.

Extension API
You can use the methods in the Extension API as the contract between extension and framework. The
framework uses the Extension API to manage the lifecycle of a custom extension. Therefore, all custom
extensions must implement the Extension API.

Define a custom extension
The define method is used for basic class creation. In this case, you want to create a custom extension,
my.custom.Extension.

Syntax
define(["dojo/_base/declare",

"dijit/_WidgetBase",
"dijit/_TemplatedMixin",
"dijit/_WidgetsInTemplateMixin",
"water/Library"

], function(
declare,
_Widget,
_TemplatedMixin,
_WidgetsInTemplateMixin,
Library,
) {

return declare("my.custom.Extension", [_Widget, _TemplatedMixin, _WidgetsInTemplateMixin], {
......
......
});

});

The above code sample can be explained as follows:
v The class name is my.custom.Extension.
v The class can be referenced by the globally available my.custom.Extension and from the return value.
v The class inherits from dijit/_WidgetBase, dijit/_TemplatedMixin, and dijit/

_WidgetsInTemplateMixin

v The declare method is used to provide inheritance.

constructor
The constructor method is called to receive initial parameters from the page configuration.

Syntax
constructor : function(args) {
lang.mixin(this, args);

},

postCreate
The postCreate method is called after the visualization of the extension is created. The method is a place
to put the extension initialization logic.
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Syntax
postCreate : function() {
//put your postCreate logic here
},

addChild
The addChild method is called to add child extension to a container.

Syntax
addChild: function(/*Extension*/ child, /*Integer*/order){
}

setParent
The setParent method is called when an extension is added as a child of container.

Syntax
setParent : function(/*Extension*/parent) {
},

removeChild
The removeChild method is called before the child extension is destroyed.

Syntax
/*
* Remove child extension from container extension
*/
removeChild: function(/*Extension*/child){

startup
The startup method is called to customize the layout. The method is called after the dijit is created and
placed at the page (after addChild and setParent).

Syntax
startup : function(){
},

_getSessionAttr
The _getSessionAttr method returns the current state of the extension in a serializable object. The
method is called during page loading and page unloading to persist the data across a page refresh. The
extension state can be restored by the _setSessionAttr method. You should ensure that the unique
session ID does not change after the page refresh.

Syntax
_getSessionAttr: function(){
var session = {
id: "<unique_id_of_dijit>",
data:{

//put the state that requires need persistence here
}
};
return session;
},
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_setSessionAttr
The _setSessionAttr method restores the extension state. The method is called during page load and
page unloads to persist states across a page refresh. Initially, the _getSessionAttr method returns the
current state of the extension in a serializable object.

Syntax
_setSessionAttr: function(session){
session.id;
session.data;

},

setModel
The setModel method is called when the data of the extension is changed. For example, when a filter is
selected, the setModel of the map/list extension is called.

Syntax
setModel:function(message){
//
//message: the parameter comes from Library.publishSelection()
//
//message.enabled: true/false, indicates filter check or unchecked
//message.url: the url of data,
//e.g. /ibm/water/api/asset/Sunshine/assetType/WPM/assetInstance
//message.isCollection: indicate the url represent
//a collection of data or data item
//message.query: the query string for data collection,
//e.g. the CQL query string
//message.parameters: additional parameters
//

},

onRefresh
The onRefresh method is called when the data of the extension needs to be refreshed. For example,
during a configured timeout interval, the method is called to change the map boundary and the date time
filter.

Syntax
onRefresh:function(message){
//
//message: comes from Library.publishRefreshRequest
//message.refreshInterval: auto refresh interval in milliseconds
//message.boundary: current map boundary in WKT POLYGON format
//message.namedAreas: array of selected named areas
//message.namedAreas[0].modelId: ID of the model that named area belongs to
//message.namedAreas[0].areaId: ID of the named area
//message.namedAreas[0].area: the area in WKT POLYGON format
//message.datetime: "latest" if current date time is checked in date time filter
//otherwise the date time value of date time filter in milliseconds
//

},

destroy
The destroy method is called when an extension is to be removed. For example, when a filter is
unchecked, the method is called to destroy the map layer extension.

Syntax
destroy:function(){
},
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Library API
You can use the methods in the Library API to allow extensions to access the framework.

Require water library
The require function references dependences from other scripts. You can use it to import the Water
library.

Syntax
require([ "water/Library"], function(Library){
Library.xxxxx;
}

getSolutionId
The getSolutionId method returns the ID of current solution. The solution ID is required in many service
calls.

Syntax
/**
* Query the solution id of curren page
* @return String, the solution id
*/
getSolutionId: function(){

getPageId
The getPageId method return the ID of current page.

Syntax
/**
* Get page id of current portal page
* @return String the unique id (portal page unique name) of the portal page
*/
getPageId: function(){

getUserProfile
The getUserProfile method returns a user’s preference configuration. The configuration includes user ID,
configuration, and default language. You can change the user preference in Edit Profile.

Syntax
/**
* Get user profile of current login user
*/
getUserProfile: function(){

getTimeZoneOffsetNumber
The getTimeZoneOffsetNumber method returns the timezone offset number.

Syntax
/**
* return timezone offset number, e.g. -480

*/
getTimeZoneOffsetNumber: function(){

getTimeZoneOffset
The getTimeZoneOffset method returns the timezone offset relative to GMT.
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Syntax
/**
* return timezone offset relative to GMT. , e.g. -08:00
*/

getTimeZoneOffset: function(){

publishMessage
The publishMessage method publishes error, warning, and information messages to the application
theme.

Syntax
/**
*

* summary:
* Publishes the message (ID and I18N text) to the messages
* topic for processing
* @param messageId: String
* the message ID
* @param i18nMessageText: String
* the I18N message text
*/

publishMessage: function(messageId, i18nMessageText) {

Example

The following example creates three different lists of error messages in the application:
Library.publishMessage("ID001E", "Error Messages");
Library.publishMessage("ID001W", "Warning Messages");
Library.publishMessage("ID001I", "Information Messages");

publishSelection
The publishSelection method triggers the UI framework to handle the user’s selection. Typically, the
method is called when the user checks or unchecks a filter and selects one item in the map/list. The UI
framework will find the best matched UI extension based on the URL in the message and page
configuration. It will then get or create an instance of the UI extension and call the setModel of the UI
extension. For example, in the custom filter, the user can call Library.publishSelection to indicate that
the filter is selected or unselected. The corresponding map layer will be created or destroyed.

Syntax
/**
* summary:
* Publish user selection
* @param message: Object
* {
* "url": "<url of the selected data>",
* "isCollection": true/false,
* "query": "<the query string>",
* "enabled": true/false,
* "parameters": custom parameters, e.g. {
* color: red
* title: title
* }
* }
*/
publishSelection: function(message){

publishRefreshRequest
The publishRefreshRequest method triggers the UI framework to refresh the data. The UI framework
calls the applyFilter method on each filter. It gives the user the opportunity to add filter criteria to each
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filter, such as the boundary, refreshInterval, datetime, namedAreas, and so on. Then the UI framework
calls the onRefresh method on each UI extension. The UI extension can respond to this event to process
the refresh.

Syntax
/**
* summary:
* Publish refresh request
* @param message: Object
* {
* "parameters": custom parameters
* }
*/
publishRefreshRequest: function(message){

publishBoundary
The publishBoundary method is used when the user wants to create a custom map view. The method
triggers the UI framework to refresh the data when the map boundary changes. The UI framework calls
the onRefresh method on each UI extension. The UI extension can respond to this event to process the
boundary change.

Syntax
/**
* summary:
* Publish the map boundary change
* @param boundary: the map boundary in WKT polygon format
*/
publishBoundary: function(boundary){

getPreviewCard
The getPreviewCard method is used to get the preview card for a selected item. The UI framework uses
the date item URL and page configuration to assemble a preview card, which has configured More
Actions, Preview Content, and Properties Dialog sections.

Syntax
/**
* Get a preview card for the select data item
* @param message
* url: the url of selected data item
* @returns {PreviewCard}
*/
getPreviewCard: function(message){

getPreviewCardForSelection
The getPreviewCardForSelection method is used to show the preview card for the custom rendering
service WMS layer.

Syntax
/**
* Get a preview card with a list of items for the user to select
*
* @param layers: the layers result from rendering service getFeatureInfo response
* @returns {PreviewCard}
*/
getPreviewCardForSelection: function(layers){
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publishHighlightOnMap
The publishHighlightOnMap method is called to highlight an asset in a map.

Syntax
/**
* summary:
* Publish highlight selection

* @param message: Object
* {
* "parameters": {

* modelId: "SunshineWaterGroup",
* assetTypeId: "Pipe",
* assetId: "Pipe001"
* }

* }
*/
publishHighlightOnMap: function(message){,

publishMoreActions
The publishMoreActions method is called to register more custom actions in the More Actions menu.

Syntax
/**
* Create a new menu item in More Actions menu
* @param action
* label: the label of the action
* callback: the call back function when the action selected
* children: array of child items
*/

publishMoreActions:function(action){

removeMoreActions
The removeMoreActions method is called to remove an action item in the More Actions menu.

Syntax
/**
* Remove a More Actions menu item
* @param label: label of the menu item to be remove

*/
removeMoreActions:function(label){

registerPortlet
The registerPortlet method is called to register contextual help to the application theme.

Syntax
/**
* summary:
* Registers the portlet help to the theme
* @param kwArgs: parameters
* label: the label of the help
* type: the type of the help
* help: the help file
* customHelp: true/false
*/

registerPortlet: function(kwArgs) {

Example

The following is an example of contextual help registered with the registerPortlet method.
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Library.registerPortlet({
label: "My Help",
type: "water",
help: "myhelp.html"
});

registerFilterHandler
The registerFilterHandler method is called to register a filter handler to the UI framework. The method
creates a custom common filter, such as a date time filter or a boundary filter. It responds with an auto
refresh in this custom filter.

registerFilterHandler Syntax
/**
* Register a filter handler, so that the filter can be triggered in Library.publishRefreshRequest
* @param propertyName: the property
* @param handlerId: ID of the filter widget
* e.g. for BoundaryFilter, Library.registerFilterHandler("boundary", this.id)
*/
registerFilterHandler: function(propertyName, handlerId){

Custom Filter Syntax

The custom filter needs to implement theapplyFitler method.
applyFilter: function(message){
message["boundary"] = this.boundary;
}

getNamedArea
The getNamedArea method returns the Get specified named area by model ID and zone ID.

Syntax
/**
* Get specified named area by model ID and zone ID
* Usage: Library.getNamedArea("SunshineWaterGroup",
"9e3f86c1-9d75-48b0-8601-e0b102730d83").then(function(data){...},
function(error){ ... });
* @param modelId String the data model ID
* @param areaId String the unique IDs of the named area
* @return Deferred object to hold the result
*/
getNamedArea: function(modelId, areaId){

unionBoundaries
The unionBoundaries method unites the map boundary and named areas into the well-known binary
(WKP) MultiPolygon format.

Syntax
/**
* unites the map boundary and named areas into WKP MULTIPOLYGON
* @param boundary in WKT POLYGON format
* @param areas, arrray areas in WKT POLYGON format
* @returns Deferred object to hold the result
*/
unionBoundaries: function(/*String*/boundary, /*Array*/areas){

loadModule
The loadModule method dynamically loads the extension module.
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Syntax
/**
* To load specific dojo modules into memory for future usage:
* @param packageName: The package name, e.g. water
* @param packageLocation: The package location path, e.g. /ibm/water/widgets/js/water
* @param moduleName: the module class name, e.g. water/panel/FilterPanel
* @return Object deferred: The dojo deferred for async call
*/
loadModule: function(packageName, packageLocation, moduleName){

Application extensions
Application is a concept that describes group-related UI extensions -- such as services and algorithms --
in a specific application domain. For example, in the Water solution application, the domain can be
supporting applications such as Pipe Failure Prediction and Pressure Optimization. Application can be
referenced and instantiated in a solution application.

Extension properties

The Application service is composed of a set of extensions to which you can add child extensions. You
can configure extensions by setting its properties (or metadata).

Extension properties are registered in the database table, CFG.APPLICATION_EXTENSION. View the
table below for a description of the properties.

Property Name Description

APP_ID The ID of the application to which the extension is
registered.

EXTENSION_ID The ID of the extension. Use Dojo module name as the
extension ID. For example, “water.map.MapView”.

NAME The name of the extension.

DESCRIPTION The description of the extension.

DOJO_PACKAGE_NAME Top-level Dojo package name. For example, “water”.

DOJO_PACKAGE_PATH Absolute URL of the Dojo package. For example,
“/ibm/water/widgets/js/water”.

DOJO_MODULE Dojo module. For example, “water/map/MapView”. The
three properties point to a deployed Dojo module.

DOJO_MODULE_CONFIG Dojo module that is embedded in the Administration
User Interface of the page configuration. It is used to
configure the PARAMETERS property for this extension.

EXTENDS_APP_ID The APP_ID property of the container extension.

EXTENDS The EXTENSION_ID property of the container extension.
For example, “water.panel.ContentPanel”. It is used to
restrict the scope of this extension.

IS_CONTAINER Indicates if the extension is a true container. If the
property is true, the extension is a container node (or
folder). If the property is false, the extension is a leaf
node.

IS_DYNAMIC Indicates how the extension is initialized at runtime. If
the property is true, the extension is created at runtime
and triggered by user selection, and there can be more
than one instance. If the property is false, the extension is
created at page load time, there can be one instance only.
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Property Name Description

PARAMETERS Parameters and default value in JSON (Javascript Object
Notation) format. For example, {“color”: “#ff00ff”}.

URI_PATTERN The URI pattern that is used to match the extension at
runtime. Typically the property uses the URI pattern of
the backend data access service. For example,
“/ibm/water/api/asset/*/model/*/assetType/*/
assetInstance”.

Extension properties
Extension properties are registered in the database table, CFG.APPLICATION_EXTENSION.

Properties table

View the table below for a description of the extension properties.

Property Name Description

APP_ID The ID of the application to which the extension is
registered.

EXTENSION_ID The ID of the extension. Use Dojo module name as the
extension ID. For example, “water.map.MapView”.

NAME The name of the extension.

DESCRIPTION The description of the extension.

DOJO_PACKAGE_NAME Top-level Dojo package name. For example, “water”.

DOJO_PACKAGE_PATH Absolute URL of the Dojo package. For example,
“/ibm/water/widgets/js/water”.

DOJO_MODULE Dojo module. For example, “water/map/MapView”. The
three properties point to a deployed Dojo module.

DOJO_MODULE_CONFIG Dojo module that is embedded in the Administration
User Interface of the page configuration. It is used to
configure the PARAMETERS property for this extension.

EXTENDS_APP_ID The APP_ID property of the container extension.

EXTENDS The EXTENSION_ID property of the container extension.
For example, “water.panel.ContentPanel”. It is used to
restrict the scope of this extension.

IS_CONTAINER Indicates if the extension is a true container. If the
property is true, the extension is a container node (or
folder). If the property is false, the extension is a leaf
node.

IS_DYNAMIC Indicates how the extension is initialized at runtime. If
the property is true, the extension is created at runtime
and triggered by user selection, and there can be more
than one instance. If the property is false, the extension is
created at page load time, there can be one instance only.

PARAMETERS Parameters and default value in JSON (Javascript Object
Notation) format. For example, {“color”: “#ff00ff”}.

URI_PATTERN The URI pattern that is used to match the extension at
runtime. Typically the property uses the URI pattern of
the backend data access service. For example,
“/ibm/water/api/asset/*/model/*/assetType/*/
assetInstance”.
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Listing all applications
Use the GET method to list all the applications in a solution application.

Method

GET.

Resource URL
https://<bookweb server hostname>/ibm/water/api/application

Request Parameters

Not applicable.

Response
[
{"APP_ID":"CSO","NAME":"Combined Sewer Overflow Management","DESCRIPTION":
"Combined Sewer Overflow Management","ROWID":1,"NAME_I18N":
"Combined Sewer Overflow Management"},
{"APP_ID":"EAM","NAME":"Maximo Integration","DESCRIPTION":"Maximo Integration","ROWID":2,
"NAME_I18N":"Maximo Integration"},
{"APP_ID":"IOW","NAME":"Intelligent Operations for Water","DESCRIPTION":"Intelligent
Operations for Water","ROWID":3,"NAME_I18N":"Intelligent Operations for Water"},
{"APP_ID":"PFP","NAME":"Pipe Failure Prediction","DESCRIPTION":"Pipe Failure Prediction",
"ROWID":4,"NAME_I18N":"Pipe Failure Prediction"},
{"APP_ID":"PO","NAME":"Pressure Optimization","DESCRIPTION":"Pressure Optimization",
"ROWID":5,"NAME_I18N":"Pressure Optimization"},
{"APP_ID":"WCP","NAME":"Water Conservation Portal","DESCRIPTION":"Water Conservation Portal",
"ROWID":6,"NAME_I18N":"Water Conservation Portal"}
]

Creating a new application
Use the POST method to create a supporting application.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/application

Request Parameters
{
"APP_ID": "MyApp",
"NAME": "My Application",
"DESCRIPTION": "My Application"
}

Response
{"APP_ID":"MyApp",
"NAME":"My Application",
"DESCRIPTION":"My Application",
"NAME_I18N":"My Application"}
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Retrieving an application
Use the GET method to retrieve a supporting application.

Method

GET.

Resource URL
https://<web server hostname>/ibm/water/api/application/MyApp

Request Parameters

Not applicable.

Response
{"APP_ID":"MyApp","NAME":"My Application","DESCRIPTION":"My Application","NAME_I18N":"My Application"}

Registering an extension
Use the POST method to register a supporting application.

Method

POST.

Resource URL
https://<web server hostname>/ibm/water/api/application/MyApp/extension

Request Parameters
{
"EXTENSION_ID":"my.Filter",
"NAME":"My Sample Filter",
"DESCRIPTION":"My Sample Filter",
"IS_CONTAINER":false,
"IS_DYNAMIC":false,
"DOJO_PACK_NAME":"my",
"DOJO_PACK_LOCATION":"/myapp/js/my",
"DOJO_MODULE":"my/Filter",
"DOJO_MODULE_CONFIG":"my/FilterConfig",
"EXTENDS_APP_ID":"IOW",
"EXTENDS": "water.filter.FilterGroupPane",
"PARAMETERS":{},
"URI_PATTERN":null
}

Response
{"APP_ID":"MyApp",
"EXTENSION_ID":"my.Filter",
"NAME":"My Sample Filter",
"DESCRIPTION":"My Sample Filter",
"IS_CONTAINER":false,
"DOJO_PACK_NAME":"my",
"DOJO_PACK_LOCATION":"\/myapp\/js\/my",
"DOJO_MODULE":"my\/Filter",
"DOJO_MODULE_CONFIG":"my\/FilterConfig",
"EXTENDS_APP_ID":"IOW",
"EXTENDS":"water.filter.FilterGroupPane",
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"PARAMETERS":{},
"IS_DYNAMIC":false,
"URI_PATTERN":null,
"NAME_I18N":"My Sample Filter"}

Updating an extension
Use the PUT method to update a supporting application.

Method

PUT.

Resource URL
https://<web server hostname>/ibm/water/api/application/MyApp/extension

Request Parameters
{
"NAME":"My Sample Filter",
"DESCRIPTION":"This is a Sample Filter"
}

Response
{"APP_ID":"MyApp",
"EXTENSION_ID":"my.Filter",
"NAME":"My Sample Filter",
"DESCRIPTION":"My Sample Filter",
"IS_CONTAINER":false,
"DOJO_PACK_NAME":"my",
"DOJO_PACK_LOCATION":"\/myapp\/js\/my",
"DOJO_MODULE":"my\/Filter",
"DOJO_MODULE_CONFIG":"my\/FilterConfig",
"EXTENDS_APP_ID":"IOW",
"EXTENDS":"water.filter.FilterGroupPane",
"PARAMETERS":{},
"IS_DYNAMIC":false,
"URI_PATTERN":null,
"NAME_I18N":"My Sample Filter"}

Deleting an extension
Use the DELETE method to remove an extension in a supporting application.

Method

DELETE.

Resource URL
https://<web server hostname>/ibm/water/api/application/MyApp/extension/my.Filter

Request Parameters

Not applicable.

Response
{"APP_ID":"MyApp",
"EXTENSION_ID":"my.Filter",
"NAME":"My Sample Filter",
"DESCRIPTION":"My Sample Filter",
"IS_CONTAINER":false,
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"DOJO_PACK_NAME":"my",
"DOJO_PACK_LOCATION":"\/myapp\/js\/my",
"DOJO_MODULE":"my\/Filter",
"DOJO_MODULE_CONFIG":"my\/FilterConfig",
"EXTENDS_APP_ID":"IOW",
"EXTENDS":"water.filter.FilterGroupPane",
"PARAMETERS":{},
"IS_DYNAMIC":false,
"URI_PATTERN":null,
"NAME_I18N":"My Sample Filter"}
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Chapter 6. Customizing the solution

You can customize some aspects of the user interface and system settings of IBM Intelligent Operations
for Water to suit your operational requirements and users. By working with the sample content, you can
become familiar with system capabilities when customizing the solution.

Configuring the model server
To work with the model manager, you start by configuring the model server. By default, the IBM
Intelligent Operations for Water model manager is configured to use DB2RDF as model server.
Alternatively, you can configure Apache Jena as both model manager and server.
Related concepts:
“Preparing the development environment” on page 212
To prepare the development environment, you must build and populate the infrastructure. As a core
technology in the water information hub, you start by working with the model manager component, and
customizing the semantic model so that it represents your water network.

Configuring Apache Jena as the model manager
With IBM Intelligent Operations for Water, you can use the Apache Jena open source semantic web
framework for Java.

About this task

A number of scripts are made available with IBM Intelligent Operations for Water to perform tasks on the
Apache Jena model server. The scripts are available on the application server in the folder
/opt/IBM/water/jena. The Apache Jena Fuseki console is also available at http://<app-node>:3030/. To
interact with the RDF store using the Jena console, on the home page select Control panel, then select
/data as dataset. This will take you to a page where you can query/update the model and also perform
model loads.

Procedure
1. Use the following scripts to perform tasks on the Apache Jena model server.

a. Start the Jena Fuseki server: StartJena.sh
b. Stop the Jena Fuseki server: stopJena.sh
c. Import ontologies and RDF instances: importModel.sh
d. Remove all triples under the specified namespace: cleanModels.sh
e. Inference the model and generate the class hierarchy and inverse properties: inference.sh

2. You can switch between IIC model server and Jena using the following property file. Note that
changes will take effect after the next Portal restart.
[root@ioc16-app lib]# pwd
/opt/IBM/water/lib
[root@ioc16-app lib]# cat water.properties
################################
# Model Server Configuration
################################
#Jena Model Server
QueryEngineImpl=com.ibm.water.modelserver.JenaQueryEngine
EndpointUrl=http://localhost:3030/data
#IIC Model Server
#QueryEngineImpl=com.ibm.water.modelserver.IICQueryEngine
#EndpointUrl=http://localhost:9083/iic_modelserver_ejb_HTTPRouter/ModelAccessWebService
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Ensure the QueryEngineImpl and EndpointUrl settings are configured correctly for your environment.

Populating the infrastructure
The IBM Intelligent Operations for Water solution provides extension options that you can use to
customize the data that is made visible to users. Working with the model manager, you can define what
infrastructure, assets, measurements, and values are presented in the interface, and determine how to
integrate that data with components in the solution. Use the information in this topic to prepare the
infrastructure and familiarize with model customization and extensions.

Semantic model introduction
IBM Intelligent Operations for Water uses the IBM Integrated Information Core as a core component. IBM
Integrated Information Core provides a framework to create water-based applications that are centered on
a semantic model of the real world, and that support integration of real-time operational data and related
enterprise applications.

The key component of the IBM Integrated Information Core architecture is the semantic model called the
Reference Semantic Model (RSM). Based on industry standards (centered largely on ISA-95 and ISA-88)
the architecture supports the definition of an enterprise model down to assets and associated
measurements. The RSM is a semantic model because it provides a real world abstraction of the
enterprise and assets in a graphical model. Through it, applications can access information from disparate
systems with various access methods. IBM Intelligent Operations for Water extends the RSM with
water-specific content.

The information model in IBM Integrated Information Core contains named entities based on industry
standards (today, primarily including ISA-95, ISA-88, and ISO15926) and relationships either defined by
those standards or implied by combining the standards into one, homogenous model.

The Reference Semantic Model is queried through services or, depending on the deployment, through a
SPARQL interface.

A key component of the IBM Integrated Information Core architecture is the model aware adapters layer
that supports integration of various types of endpoints (OPC, databases, and web services accessible
applications), and maps of the information flowing between those endpoints and elements of the model.

There are really two views of the IBM Integrated Information Core semantic model:

Reference model (ontology)
This view defines the classes that exist in the model and the relations between them, but does not
correspond to any particular enterprise or asset.

Instantiated model
This view includes instances of the classes that have a direct mapping to real-world entities. They
are populated with a set of properties (for example, location, temperature) and with relationships
to other instantiated entities in the model.

Related concepts:
“Preparing the development environment” on page 212
To prepare the development environment, you must build and populate the infrastructure. As a core
technology in the water information hub, you start by working with the model manager component, and
customizing the semantic model so that it represents your water network.

Model applications
IBM Intelligent Operations for Water contains applications that are centered on a semantic model of the
real world, and that support the integration of real-time operational data and related enterprise
applications.
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Table describes the model applications that are deployed as part of the semantic model manager
component in IBM Intelligent Operations for Water .

Table 4. Application services deployed with the model manager component in IBM Intelligent Operations for Water

Application Enterprise application resource

Client services iic_client_services

Data access services iic_data_access_services

Management services iic_management_services

Model repository services iic_modelRepositoryServices_DB2Store

Model services iic_model_services

Model properties
IBM Intelligent Operations for Water provides the following properties used when configuring model
management. The model management properties can be configured in the Property Configurator.

Table 1 describes the model management properties that can be configured.

Table 5. Model management properties

Name Value Description

repository.0.chunksize 108200 Chunk size defines the size in which
the model needs to be broken down.
The value is the recommended size.

repository.0.db iicrdfdb db name repository where the model
will reside

repository.0.dbpass db password to access the iicrdfdb
(encrypted)

repository.0.dbuser db2inst2 db user name

repository.0.host db2inst2 db user name

repository.0.jndi ejb/iic_model
RepositoryServices_DB2Store_ear/iic_
modelrepository_db2store_ejb.jar/
ModelRepositoryDB2Store#
com.ibm.iss.iic.model.server.
repository.ModelRepositoryRemote

jndi of the model repository ejb

repository.0.maxtriples 30000 maxtriples is the value that is set to
ensure that a larger model is not
loaded through the admin console

repository.0.name db2store db repository name

repository.0.port 50002 db port number

repository.0.schema IIC db schema

repository.0.storename iicrdfStore Store name created within the
iicrdfdb

Model ontologies
IBM Intelligent Operations for Water uses a model framework or ontology to organize information that is
used in the water domain. Sample ontologies are provided that you can use to familiarize with
knowledge about your water infrastructure, including asset types, properties and their interrelationships.
When you create a semantic model, you define the elements of the ontology and load the ontology into
the model manager.
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Model queries
Sample SPARQL queries are provided in this section and query the SunshineWaterGroup and CityName
models.

Select query with graph
SELECT * WHERE { graph ?g {<http://SunshineWaterGroup#R1> ?predicate ?object }} LIMIT 10

Insert and delete data
PREFIX cim:<http://iec.ch/TC57/CIM-generic#>
PREFIX rdfs:<http://www.w3.org/2000/01/rdf-schema#>
PREFIX sb:<http://SunshineWaterGroup#>

DELETE DATA
{
GRAPH <http://SunshineWaterGroup> {

<http://SunshineWaterGroup#T2>
<http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment.EquipmentLevel> "1" .

}
}
INSERT DATA
{
GRAPH <http://SunshineWaterGroup> {

<http://SunshineWaterGroup#T2>
<http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment.EquipmentLevel> "2" .

}
}

Insert and delete
PREFIX cim:<http://iec.ch/TC57/CIM-generic#>
PREFIX rdfs:<http://www.w3.org/2000/01/rdf-schema#>
WITH <http://SunshineWaterGroup>
DELETE
{

?object cim:RSM_UnnamedObject.description ?desc_orig
}
INSERT
{

?object cim:RSM_UnnamedObject.description ’J1000lOC2’
}
WHERE
{

?object cim:RSM_IdentifiedObject.name ’J1000lOC’ ;
cim:RSM_UnnamedObject.description ?desc_orig

}

Delete all triples belonging to an instance
PREFIX swg:<http://SunshineWaterGroup#>

DELETE where
{
GRAPH <http://SunshineWaterGroup>
{
swg:Pipe1 ?predicate ?object
}
}

Clear cache
Query

clearcache
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Response
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<sparql xmlns="http://www.w3.org/2007/SPARQL/results#">

<boolean>true</boolean>
</sparql>

When a model is loaded using the iicmodelloader script, it is necessary to execute this query to refresh
the model server query cache. The query cache can also be refreshed using the script
/opt/IBM/water/modelServer/scripts/clearcache.sh located on the application server.

Grammar that is not supported in DB2RDF
The following grammar functions are not supported by DB2RDF.

These standard query language functions, listed by category below, are not available in DB2RDF.
Workarounds for these functions are listed where they exist.

See SPARQL 1.1 Query Language for more details of the query language.
1. Category: Miscellaneous functions

a. Negation: NOT EXISTS

b. EXISTS

c. Negation: MINUS
d. Comparison of NOT EXISTS against MINUS

e. BIND

f. Federated Query
g. IF

h. CONCAT

i. BASE

j. DESCRIBE

2. Category: RDF Term functions
a. UUID

b. STRUUID

c. STRLANG

d. IRI

e. BNODE

f. STRDT

3. Category: String functions
a. STRLEN

b. UCASE

c. LCASE

d. STRBEFORE

e. STRAFTER

f. ENCODE_FOR_URI

g. REPLACE

h. ISNUMERIC

4. Category: Numeric functions
a. ABS

b. ROUND

c. CEIL

d. FLOOR
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e. RAND

5. Category: Date and time functions
a. NOW

b. YEAR

c. MONTH

d. DAY

e. HOURS

f. MINUTES

g. SECONDS

h. TIMEZONE

i. TZ

6. Category: Hash functions
a. MD5

b. SHA1

c. SHA256

d. SHA384

e. SHA512

7. Category: Property paths
a. ^elt (Inverse Path)
b. elt1 | elt2 (alternative property path)
c. elt1/elt2 (sequence)
d. elt1/^elt2 (Inverse Path Sequence)

Miscellaneous functions:
Negation: NOT EXISTS

Display all assets of type <http://SunshineWaterGroup#PRV> which do not have a
'cim:RSM_IdentifiedObject.name' property equal to PRV18.

Sample query:
PREFIX rdfs:<http://www.w3.org/2000/01/rdf-schema#>
PREFIX cim:<http://iec.ch/TC57/CIM-generic#>
PREFIX swg:<http://SunshineWaterGroup#>

SELECT ?asset
WHERE

{
?asset a swg:PRV .
FILTER NOT EXISTS { ?asset cim:RSM_IdentifiedObject.name "PRV18" }

}

Workaround:
PREFIX rdfs:<http://www.w3.org/2000/01/rdf-schema#>
PREFIX cim:<http://iec.ch/TC57/CIM-generic#>
PREFIX swg:<http://SunshineWaterGroup#>

SELECT ?asset
WHERE

{
?asset a swg:PRV .
OPTIONAL

{
?asset cim:RSM_IdentifiedObject.name ?name .
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FILTER (?name = "PRV18")
}
FILTER (!BOUND(?name))

}

EXISTS

Display all assets of type <SunshineWaterGroup#PRV> that have cim:RSM_IdentifiedObject property equal to
PRV18.

Sample query:
PREFIX rdfs:<http://www.w3.org/2000/01/rdf-schema#>
PREFIX cim:<http://iec.ch/TC57/CIM-generic#>
PREFIX swg:<http://SunshineWaterGroup#>

SELECT ?asset
WHERE

{
?asset a swg:PRV .
FILTER EXISTS { ?asset cim:RSM_IdentifiedObject.name "PRV18" }

}

Workaround:
PREFIX rdfs:<http://www.w3.org/2000/01/rdf-schema#>
PREFIX cim:<http://iec.ch/TC57/CIM-generic#>
PREFIX swg:<http://SunshineWaterGroup#>

SELECT ?asset
WHERE

{
?asset a swg:PRV .
OPTIONAL

{
?asset cim:RSM_IdentifiedObject.name ?name .
FILTER (?name = "PRV18")

}
FILTER (BOUND(?name))

}

Negation: MINUS

Display all assets of type <http://SunshineWaterGroup#PRV> which do not have a
cim:RSM_IdentifiedObject.name property equal to PRV18.

Sample query:
PREFIX rdfs:<http://www.w3.org/2000/01/rdf-schema#>
PREFIX cim:<http://iec.ch/TC57/CIM-generic#>
PREFIX swg:<http://SunshineWaterGroup#>

SELECT ?asset
WHERE

{
?asset a swg:PRV .
MINUS { ?asset cim:RSM_IdentifiedObject.name "PRV18" }

}

Workaround:
PREFIX rdfs:<http://www.w3.org/2000/01/rdf-schema#>
PREFIX cim:<http://iec.ch/TC57/CIM-generic#>
PREFIX swg:<http://SunshineWaterGroup#>

SELECT ?asset
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WHERE
{

?asset a swg:PRV .
OPTIONAL

{
?asset cim:RSM_IdentifiedObject.name ?name .
FILTER (?name = "PRV18")

}
FILTER (!BOUND(?name))

}

Comparison of NOT EXISTS against MINUS

Sample data and query:
@prefix : <http://example/> .
:a :b :c .

SELECT *
{

?subject ?predicate ?object
FILTER NOT EXISTS { ?x ?y ?z }

}

evaluates to a result set with no solutions, because { ?x ?y ?z } matches any
?subject ?predicate ?object, so NOT EXISTS { ?x ?y ?z } eliminates all solutions.

subject predicate object

With MINUS there is no shared variable between the first part, (?subject ?predicate ?object), and the
second part, (?x ?y ?z), so no bindings are eliminated.
@prefix : <http://example/> .
:a :b :c .

SELECT *
{

?subject ?predicate ?object
MINUS { ?x ?y ?z }

}

evaluates to:

subject predicate object

<http://example/a> <http://example/b> <http://example/c>

BIND

Sample data:
@prefix dc: <http://purl.org/dc/elements/1.1/> .
@prefix : <http://example.org/book/> .
@prefix ns: <http://example.org/ns#> .

:book1 dc:title "SPARQL Tutorial" .
:book1 ns:price 42 .
:book1 ns:discount 0.2 .

:book2 dc:title "The Semantic Web" .
:book2 ns:price 23 .
:book2 ns:discount 0.25 .
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Sample query 1:
PREFIX dc: <http://purl.org/dc/elements/1.1/>
PREFIX ns: <http://example.org/ns#>

SELECT ?title ?price
{ ?x ns:price ?p .

?x ns:discount ?discount
BIND (?p*(1-?discount) AS ?price)
FILTER(?price < 20)
?x dc:title ?title .

}

Query result:

title price

"The Semantic Web" 17.25

Workaround: none

Sample query 2:
PREFIX rdfs:<http://www.w3.org/2000/01/rdf-schema#>
PREFIX cim:<http://iec.ch/TC57/CIM-generic#>
PREFIX swg:<http://SunshineWaterGroup#>

SELECT ?asset ?name ?newname
WHERE

{
?asset a swg:PRV .
?asset cim:RSM_IdentifiedObject.name ?name .
BIND (CONCAT("New ",?name) as ?newname)

}

Query 2 workaround:
PREFIX rdfs:<http://www.w3.org/2000/01/rdf-schema#>
PREFIX cim:<http://iec.ch/TC57/CIM-generic#>
PREFIX swg:<http://SunshineWaterGroup#>

SELECT ?asset ?name (CONCAT("New ",?name) as ?newname)
WHERE

{
?asset a swg:PRV .
?asset cim:RSM_IdentifiedObject.name ?name .

}

Sample query 3:
SELECT ?subject ?predict ?object

WHERE
{

VALUES ?startNode {<http://SunshineWaterGroup#J599>
<http://SunshineWaterGroup#PCP599LOC>
<http://SunshineWaterGroup#PCP599_M>
<http://SunshineWaterGroup#WPM>
<http://SunshineWaterGroup#Meter>}

VALUES ?predict {<http://iec.ch/TC57/CIM-generic
#RSM_WorkEquipment.connected_WorkEquipment>

<http://iec.ch/TC57/CIM-generic
#RSM_PhysicalEntity.has_Location>

<http://iec.ch/TC57/CIM-generic
#RSM_WorkEquipment.connects_WorkEquipment>

<http://iec.ch/TC57/CIM-generic
#RSM_PhysicalEntity.has_measurement>

<http://iec.ch/TC57/CIM-generic
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#RSM_WorkEquipment.ContainedBy_Equipment>
<http://iec.ch/TC57/CIM-generic

#RSM_WorkEquipment.Contains_Equipment>
<http://www.w3.org/1999/02/22-rdf-syntax-ns#type>
<http://www.w3.org/2000/01/rdf-schema#subClassOf>}

{
?startNode ?predict ?object .
BIND (?startNode AS ?subject)

}
UNION

{
?subject ?predict ?startNode .
BIND (?startNode AS ?object)

}
FILTER ((regex(STR(?subject),

"^http://SunshineWaterGroup#")) || (regex(STR(?subject),
"^http://cityName#"))).

FILTER ((regex(STR(?object),
"^http://SunshineWaterGroup#")) || (regex(STR(?object),
"^http://cityName#"))).

}

Query 3 workaround:
SELECT ?subject ?predict ?object

WHERE
{ { {

SELECT (?startNode AS ?subject) ?predict ?object
WHERE

{ {
?startNode ?predict ?object .

}
FILTER (?startNode = <http://SunshineWaterGroup#J599>

|| ?startNode = <http://SunshineWaterGroup#PCP599LOC>
|| ?startNode = <http://SunshineWaterGroup#PCP599_M>
|| ?startNode = <http://SunshineWaterGroup#WPM>
|| ?startNode = <http://SunshineWaterGroup#Meter> ).

FILTER (?predict = <http://iec.ch/TC57/CIM-generic
#RSM_WorkEquipment.connected_WorkEquipment>

|| ?predict = <http://iec.ch/TC57/CIM-generic
#RSM_PhysicalEntity.has_Location>

|| ?predict =<http://iec.ch/TC57/CIM-generic
#RSM_WorkEquipment.connects_WorkEquipment>

|| ?predict = <http://iec.ch/TC57/CIM-generic
#RSM_PhysicalEntity.has_measurement>

|| ?predict = <http://iec.ch/TC57/CIM-generic
#RSM_WorkEquipment.ContainedBy_Equipment>

|| ?predict = <http://iec.ch/TC57/CIM-generic
#RSM_WorkEquipment.Contains_Equipment>

|| ?predict = <http://www.w3.org/1999/02/22-rdf-syntax-ns
#type>

|| ?predict = <http://www.w3.org/2000/01/rdf-schema
#subClassOf>

).
FILTER ((regex(STR(?object),

"^http://SunshineWaterGroup#"))
|| (regex(STR(?object), "^http://cityName#"))).

}
}

}
UNION

{ {
SELECT ?subject ?predict (?startNode AS ?object )

WHERE
{ {

?subject ?predict ?startNode .
}
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FILTER (?startNode = <http://SunshineWaterGroup#J599>
|| ?startNode = <http://SunshineWaterGroup#PCP599LOC>
|| ?startNode = <http://SunshineWaterGroup#PCP599_M>
|| ?startNode = <http://SunshineWaterGroup#WPM>
|| ?startNode = <http://SunshineWaterGroup#Meter> ).

FILTER (?predict = <http://iec.ch/TC57/CIM-generic
#RSM_WorkEquipment.connected_WorkEquipment>

|| ?predict = <http://iec.ch/TC57/CIM-generic
#RSM_PhysicalEntity.has_Location>

|| ?predict = <http://iec.ch/TC57/CIM-generic
#RSM_WorkEquipment.connects_WorkEquipment>

|| ?predict = <http://iec.ch/TC57/CIM-generic
#RSM_PhysicalEntity.has_measurement>

|| ?predict = <http://iec.ch/TC57/CIM-generic
#RSM_WorkEquipment.ContainedBy_Equipment>

|| ?predict = <http://iec.ch/TC57/CIM-generic
#RSM_WorkEquipment.Contains_Equipment>

|| ?predict = <http://www.w3.org/1999/02/22-rdf-syntax-ns
#type>

|| ?predict = <http://www.w3.org/2000/01/rdf-schema
#subClassOf>

).
FILTER ((regex(STR(?subject), "^http://SunshineWaterGroup#"))

|| (regex(STR(?subject), "^http://cityName#"))).
}

}
}

}

Federated Query

See SPARQL 1.1 Federated Query for more information.

This example shows how to query a remote SPARQL endpoint and join the returned data with the data
from the local RDF data set. The query searches for the names of people in the database. The names are
available at the endpoint http://people.example.org/sparql.

Sample data:
@prefix foaf: <http://xmlns.com/foaf/0.1/> .
@prefix : <http://example.org/> .

:people15 foaf:name "Alice" .
:people16 foaf:name "Bob" .
:people17 foaf:name "Charles" .
:people18 foaf:name "Daisy" .

We want to combine this data with a local file http://example.org/myfoaf.rdf that contains the single
triple: <http://example.org/myfoaf/I> <http://xmlns.com/foaf/0.1/
knows> <http://example.org/people15>.

Sample query:
PREFIX foaf: <http://xmlns.com/foaf/0.1/>

SELECT ?name
FROM <http://example.org/myfoaf.rdf>
WHERE

{
<http://example.org/myfoaf/I> foaf:knows ?person .
SERVICE <http://people.example.org/sparql>

{
?person foaf:name ?name .

}
}
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This query, on the data above, has one solution:

Query result:

name

"Alice"

IF

Sample query:
PREFIX rdfs:<http://www.w3.org/2000/01/rdf-schema#>
PREFIX cim:<http://iec.ch/TC57/CIM-generic#>

SELECT ?prv19
WHERE

{
?prv cim:RSM_IdentifiedObject.name "PRV19" .
BIND (IF (BOUND (?prv),"PRV19 exists",

"PRV19 does not exist") AS ?prv19)
}

Workaround: none.

CONCAT

Syntax:
string literal CONCAT( string literal ltrl1 ... string literal ltrln)

The CONCAT function corresponds to the XPath fn:concat function. The function accepts string literals as
arguments. CONCAT is supported by DB2RDF where n=2 only. So, the following query where n=3 will drop
the third argument (?des) from the response:

Sample query (where n>2):
PREFIX cim:<http://iec.ch/TC57/CIM-generic#>

SELECT ?name ?des (CONCAT (?name," :: ",?des) AS ?that)
WHERE

{
?a cim:RSM_IdentifiedObject.name ?name ;
cim:RSM_UnnamedObject.description ?des

}

Workaround for the above (and any other query where n>2):
PREFIX cim:<http://iec.ch/TC57/CIM-generic#>

SELECT ?name ?des (CONCAT( ?name, CONCAT(" :: ",?des)) AS ?that)
WHERE

{
?a cim:RSM_IdentifiedObject.name ?name ;
cim:RSM_UnnamedObject.description ?des

}

BASE

The BASE keyword defines the base IRI used to resolve relative IRIs.

Sample query:
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BASE <http://iec.ch/TC57/CIM-generic#>

SELECT ?name
WHERE

{
?uri <RSM_IdentifiedObject.name> ?name

}

Workaround:
PREFIX cim:<http://iec.ch/TC57/CIM-generic#>

SELECT ?name
WHERE

{
GRAPH ?g {?uri cim:RSM_IdentifiedObject.name ?name}

}

DESCRIBE

Sample query:
DESCRIBE <http://cityName#Junction378-Location>

Workaround: See Registering custom DESCRIBE handlers.

Note:

When you implement your own DESCRIBE handlers, you should minimize the number of calls made to
the DB2 database server, to avoid performance issues.

RDF term functions:
UUID

Syntax:
iri UUID()

Return a fresh IRI from the UUID URN scheme. Each call of UUID() returns a different IRI. It must not be
the "nil" IRI (all zeroes). The variant and version of the IRI is implementation dependent.

Example:
UUID() <urn:uuid:b9302fb5-642e-4d3b-af19-29a8f6d894c9>

Workaround: none.

STRUUID

Return a string that is the scheme specific part of UUID. This is the result of generating a UUID, converting
to a simple literal, and removing the initial urn:uuid:.

Example:
STRUUID() "73cd4307-8a99-4691-a608-b5bda64fb6c1"

Workaround: none.

STRLANG

Syntax:
literal STRLANG(simple literal lexicalForm, simple literal langTag)
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The STRLANG function constructs a literal with lexical form and language tag as specified by the argument.

Example:
STRLANG("chat", "en") "chat"@en

Workaround: none.

IRI

Syntax:
iri IRI(simple literal)
iri IRI(xsd:string)
iri IRI(iri)
iri URI(simple literal)
iri URI(xsd:string)
iri URI(iri)

The IRI function constructs an IRI by resolving the string argument (see RFC 3986 and RFC 3987 or any
later RFC that supersedes RFC 3986 or RFC 3987). The IRI is resolved against the base IRI of the query
and must result in an absolute IRI.

The URI function is a synonym for IRI.

If the function is passed an IRI, it returns the IRI unchanged.

Passing any RDF term other than a simple literal, xsd:string or an IRI is an error.

An implementation may normalize the IRI.

Examples:
IRI("http://example/") <http://example/>

or
IRI(<http://example/>) <http://example/>

Workaround: none.

BNODE

Syntax:
blank node BNODE()
blank node BNODE(simple literal)
blank node BNODE(xsd:string)

The BNODE function constructs a blank node that is distinct from all blank nodes in the data set being
queried, and distinct from all blank nodes created by calls to this constructor for other query solutions. If
the no argument form is used, every call results in a distinct blank node. If the form with a simple literal
is used, every call results in distinct blank nodes for different simple literals, and the same blank node for
calls with the same simple literal within expressions for one solution mapping.

This functionality is compatible with the treatment of blank nodes in SPARQL CONSTRUCT templates.

STRDT

Syntax:
literal STRDT(simple literal lexicalForm, IRI datatypeIRI)
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The STRDT function constructs a literal with lexical form and type as specified by the arguments.

Examples:
STRDT("123", xsd:integer) "123"^^<http://www.w3.org/2001/XMLSchema#integer>

or
STRDT("iiii", <http://example/romanNumeral>) "iiii"^^<http://example/romanNumeral>

Workaround: none.

String functions:
STRLEN

Syntax:
xsd:integer STRLEN(string literal str)

The STRLEN function corresponds to the XPath fn:string-length function and returns an xsd:integer with
a value equal to the length in characters of the lexical form of the literal.

Examples:
strlen("chat") 4

or
strlen("chat"@en) 4

or
strlen("chat"^^xsd:string) 4

Workaround: none.

UCASE

Syntax:
string literal UCASE(string literal str)

The UCASE function corresponds to the XPath fn:upper-case function. It returns a string literal with a
lexical form that is the upper case of the lexical form of the argument.

Examples:
ucase("foo") "FOO"
ucase("foo"@en) "FOO"@en
ucase("foo"^^xsd:string) "FOO"^^xsd:string

Workaround: none.

LCASE

Syntax:
string literal LCASE(string literal str)

The LCASE function corresponds to the XPath fn:lower-case function. It returns a string literal with a
lexical form that is the lower case of the lexical form of the argument.

Examples:
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lcase("BAR") "bar"
lcase("BAR"@en) "bar"@en
lcase("BAR"^^xsd:string) "bar"^^xsd:string

Workaround: none.

STRBEFORE

Syntax:
literal STRBEFORE(string literal arg1, string literal arg2)

The STRBEFORE function corresponds to the XPath fn:substring-before function. If the arguments are not
compatible, an error is raised.

For compatible arguments, if the lexical part of the second argument occurs as a sub-string of the lexical
part of the first argument, the function returns a literal of the same kind as the first argument arg1
(simple literal, plain literal same language tag, or xsd:string). The lexical form of the result is the
sub-string of the lexical form of arg1 that precedes the first occurrence of the lexical form of arg2. If the
lexical form of arg2 is the empty string, this is considered to be a match and the lexical form of the result
is the empty string.

If there is no such occurrence, an empty simple literal is returned.

Examples:
strbefore("abc","b") "a"
strbefore("abc"@en,"bc") "a"@en
strbefore("abc"@en,"b"@cy) error
strbefore("abc"^^xsd:string,"") ""^^xsd:string
strbefore("abc","xyz") ""
strbefore("abc"@en, "z"@en) ""
strbefore("abc"@en, "z") ""
strbefore("abc"@en, ""@en) ""@en
strbefore("abc"@en, "") ""@en

Workaround: none.

STRAFTER

Syntax:
literal STRAFTER(string literal arg1, string literal arg2)

The STRAFTER function corresponds to the XPath fn:substring-after function. If the arguments are not
compatible, an error is raised.

For compatible arguments, if the lexical part of the second argument occurs as a sub-string of the lexical
part of the first argument, the function returns a literal of the same kind as the first argument arg1
(simple literal, plain literal same language tag, or xsd:string). The lexical form of the result is the
sub-string of the lexical form of arg1 that follows the first occurrence of the lexical form of arg2. If the
lexical form of arg2 is the empty string, this is considered to be a match and the lexical form of the result
is the lexical form of arg1.

If there is no such occurrence, an empty simple literal is returned.

Examples:
strafter("abc","b") "c"
strafter("abc"@en,"ab") "c"@en
strafter("abc"@en,"b"@cy) error
strafter("abc"^^xsd:string,"") "abc"^^xsd:string
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strafter("abc","xyz") ""
strafter("abc"@en, "z"@en) ""
strafter("abc"@en, "z") ""
strafter("abc"@en, ""@en) "abc"@en
strafter("abc"@en, "") "abc"@en

Workaround: none.

ENCODE_FOR_URI

Syntax:
simple literal ENCODE_FOR_URI(string literal ltrl)

The ENCODE_FOR_URI function corresponds to the XPath fn:encode-for-uri function. It returns a simple
literal with the lexical form obtained from the lexical form of its input after translating reserved
characters according to the fn:encode-for-uri function.

Examples:
encode_for_uri("Los Angeles") "Los%20Angeles"
encode_for_uri("Los Angeles"@en) "Los%20Angeles"
encode_for_uri("Los Angeles"^^xsd:string) "Los%20Angeles"

Workaround: none.

REPLACE

Syntax:
string literal REPLACE (string literal arg, simple literal pattern,

simple literal replacement )
string literal REPLACE (string literal arg, simple literal pattern,

simple literal replacement,
simple literal flags)

The REPLACE function corresponds to the XPath fn:replace function. It replaces each non-overlapping
occurrence of the regular expression pattern with the replacement string. Regular expression matching
may involve modifier flags. See REGEX.

Examples:
replace("abcd", "b", "Z") "aZcd"
replace("abab", "B", "Z","i") "aZaZ"
replace("abab", "B.", "Z","i") "aZb"

Workaround: none.

ISNUMERIC

Syntax:
xsd:boolean isNumeric (RDF term term)

Returns true if term is a numeric value. Returns false otherwise. term is numeric if it has an appropriate
data type, and has a valid lexical form, making it a valid argument to functions and operators that take
numeric arguments.

Examples:
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isNumeric(12) true
isNumeric("12") false
isNumeric("12"^^xsd:nonNegativeInteger) true
isNumeric("1200"^^xsd:byte) false
isNumeric(<http://example/>) false

Workaround: none.

Numeric functions:
ABS

Syntax:
numeric ABS (numeric term)

Returns the absolute value of arg. An error is raised if arg is not a numeric value.

This function is the same as fn:numeric-abs for terms with a data type from XDM.

Examples:
abs(1) 1
abs(-1.5) 1.5

Workaround: none.

ROUND

Syntax:
numeric ROUND (numeric term)

Returns the number with no fractional part that is closest to the argument. If there are two such numbers,
then the one that is closest to positive infinity is returned. An error is raised if arg is not a numeric value.

This function is the same as fn:numeric-round for terms with a data type from XDM.

Examples:
round(2.4999) 2.0
round(2.5) 3.0
round(-2.5) -2.0

Workaround: none.

CEIL

Syntax:
numeric CEIL (numeric term)

Returns the smallest (closest to negative infinity) number with no fractional part that is not less than the
value of arg. An error is raised if arg is not a numeric value.

This function is the same as fn:numeric-ceil for terms with a data type from XDM.

Examples:
ceil(10.5) 11.0
ceil(-10.5) -10.0

Workaround: none.
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FLOOR

Syntax:
numeric FLOOR (numeric term)

Returns the largest (closest to positive infinity) number with no fractional part that is not greater than the
value of arg. An error is raised if arg is not a numeric value.

This function is the same as fn:numeric-floor for terms with a data type from XDM.

Examples:
floor(10.5) 10.0
floor(-10.5) -11.0

Workaround: none.

RAND

Syntax:
xsd:double RAND ()

Returns a pseudo-random number between 0 (inclusive) and 1.0e0 (exclusive). Different numbers can be
produced every time this function is invoked. Numbers should be produced with approximately equal
probability.

Example:
rand() "0.31221030831984886"^^xsd:double

Workaround: none.

Date and time functions:
NOW

Syntax:
xsd:dateTime NOW ()

Returns an XSD dateTime value for the current query execution. All calls to this function in any one query
execution must return the same value. The exact moment returned is not specified.

Example:
now() "2011-01-10T14:45:13.815-05:00"^^xsd:dateTime

Workaround: none.

YEAR

Syntax:
xsd:integer YEAR (xsd:dateTime arg)

Returns the year part of arg as an integer.

This function corresponds to fn:year-from-dateTime.

Example:
year("2011-01-10T14:45:13.815-05:00"^^xsd:dateTime) 2011
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Workaround: none.

MONTH

Syntax:
xsd:integer MONTH (xsd:dateTime arg)

Returns the month part of arg as an integer.

This function corresponds to fn:month-from-dateTime.

Example:
month("2011-01-10T14:45:13.815-05:00"^^xsd:dateTime) 1

Workaround: none.

DAY

Syntax:
xsd:integer DAY (xsd:dateTime arg)

Returns the day part of arg as an integer.

This function corresponds to fn:day-from-dateTime.

Example:
day("2011-01-10T14:45:13.815-05:00"^^xsd:dateTime) 10

Workaround: none.

HOURS

Syntax:
xsd:integer HOURS (xsd:dateTime arg)

Returns the hours part of arg as an integer. The value is as given in the lexical form of the XSD dateTime.

This function corresponds to fn:hours-from-dateTime.

Example:
hours("2011-01-10T14:45:13.815-05:00"^^xsd:dateTime) 14

Workaround: none.

MINUTES

Syntax:
xsd:integer MINUTES (xsd:dateTime arg)

Returns the minutes part of the lexical form of arg. The value is as given in the lexical form of the XSD
dateTime.

This function corresponds to fn:minutes-from-dateTime.

Example:
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minutes("2011-01-10T14:45:13.815-05:00"^^xsd:dateTime) 45

Workaround: none.

SECONDS

Syntax:
xsd:decimal SECONDS (xsd:dateTime arg)

Returns the seconds part of the lexical form of arg.

This function corresponds to fn:seconds-from-dateTime.

Example:
seconds("2011-01-10T14:45:13.815-05:00"^^xsd:dateTime) 13.815

Workaround: none.

TIMEZONE

Syntax:
xsd:dayTimeDuration TIMEZONE (xsd:dateTime arg)

Returns the timezone part of arg as an xsd:dayTimeDuration. Raises an error if there is no timezone.

This function corresponds to fn:timezone-from-dateTime, except for the treatment of literals with no
timezone.

Example:
timezone("2011-01-10T14:45:13.815-05:00"^^xsd:dateTime)

"-PT5H"^^xsd:dayTimeDuration
timezone("2011-01-10T14:45:13.815Z"^^xsd:dateTime)

"PT0S"^^xsd:dayTimeDuration
timezone("2011-01-10T14:45:13.815"^^xsd:dateTime)

error

Workaround: none.

TZ

Syntax:
simple literal TZ (xsd:dateTime arg)

Returns the timezone part of arg as a simple literal. Returns the empty string if there is no timezone.

Examples:
tz("2011-01-10T14:45:13.815-05:00"^^xsd:dateTime) "-05:00"
tz("2011-01-10T14:45:13.815Z"^^xsd:dateTime) "Z"
tz("2011-01-10T14:45:13.815"^^xsd:dateTime) ""

Workaround: none.

Hash functions:
MD5

Syntax:
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simple literal MD5 (simple literal arg)
simple literal MD5 (xsd:string arg)

Returns the MD5 check-sum, as a hex digit string, calculated on the UTF-8 representation of the simple
literal or lexical form of the xsd:string. Hex digits should be in lower case.

Examples:
MD5("abc") "900150983cd24fb0d6963f7d28e17f72"
MD5("abc"^^xsd:string) "900150983cd24fb0d6963f7d28e17f72"

Workaround: none.

SHA1

Syntax:
simple literal SHA1 (simple literal arg)
simple literal SHA1 (xsd:string arg)

Returns the SHA1 check-sum, as a hex digit string, calculated on the UTF-8 representation of the simple
literal or lexical form of the xsd:string. Hex digits should be in lower case.

Examples:
SHA1("abc") "a9993e364706816aba3e25717850c26c9cd0d89d"
SHA1("abc"^^xsd:string) "a9993e364706816aba3e25717850c26c9cd0d89d"

Workaround: none.

SHA256

Syntax:
simple literal SHA256 (simple literal arg)
simple literal SHA256 (xsd:string arg)

Returns the SHA256 check-sum, as a hex digit string, calculated on the UTF-8 representation of the simple
literal or lexical form of the xsd:string. Hex digits should be in lower case.

Examples:
SHA256("abc") "ba7816bf8f01cfea414140de5dae2223

b00361a396177a9cb410ff61f20015ad"
SHA256("abc"^^xsd:string) "ba7816bf8f01cfea414140de5dae2223

b00361a396177a9cb410ff61f20015ad"

Workaround: none.

SHA384

Syntax:
simple literal SHA384 (simple literal arg)
simple literal SHA384 (xsd:string arg)

Returns the SHA384 check-sum, as a hex digit string, calculated on the UTF-8 representation of the simple
literal or lexical form of the xsd:string. Hex digits should be in lower case.

Examples:
SHA384("abc") "cb00753f45a35e8bb5a03d699ac65007

272c32ab0eded1631a8b605a43ff5bed
8086072ba1e7cc2358baeca134c825a7"
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SHA384("abc"^^xsd:string) "cb00753f45a35e8bb5a03d699ac65007
272c32ab0eded1631a8b605a43ff5bed
8086072ba1e7cc2358baeca134c825a7"

Workaround: none.

SHA512

Syntax:
simple literal SHA512 (simple literal arg)
simple literal SHA512 (xsd:string arg)

Returns the SHA512 check-sum, as a hex digit string, calculated on the UTF-8 representation of the simple
literal or lexical form of the xsd:string. Hex digits should be in lower case.

Examples:
SHA512("abc") "ddaf35a193617abacc417349ae204131

12e6fa4e89a97ea20a9eeee64b55d39a
2192992a274fc1a836ba3c23a3feebbd
454d4423643ce80e2a9ac94fa54ca49f"

SHA512("abc"^^xsd:string) "ddaf35a193617abacc417349ae204131
12e6fa4e89a97ea20a9eeee64b55d39a
2192992a274fc1a836ba3c23a3feebbd
454d4423643ce80e2a9ac94fa54ca49f"

Workaround: none.

Property paths:
^elt (Inverse Path)

Sample query:
{ <mailto:alice@example> ^foaf:mbox ?x }

Workaround:
{ ?x foaf:mbox <mailto:alice@example> }

elt1 | elt2 (alternative property path)

Sample query:
{ :book1 dc:title|rdfs:label ?displayString }

Equivalent to:
{ :book1 <http://purl.org/dc/elements/1.1/title>

| <http://www.w3.org/2000/01/rdf-schema#label> ?displayString }

Workaround: None

elt1/elt2 (sequence)

Find the names of people 2 "foaf:knows" links away.

Sample query:
{

?x foaf:mbox <mailto:alice@example> .
?x foaf:knows/foaf:knows/foaf:name ?name .

}
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This is the same as the SPARQL query:
SELECT ?x ?name

{
?x foaf:mbox <mailto:alice@example> .
?x foaf:knows [ foaf:knows [ foaf:name ?name ]].

}

Workaround:
SELECT ?x ?name

{
?x foaf:mbox <mailto:alice@example> .
?x foaf:knows ?a1 .
?a1 foaf:knows ?a2 .
?a2 foaf:name ?name .

}

elt1/^elt2 (Inverse Path Sequence)

Find all the people who know someone ?x knows.

Sample query:
{

?x foaf:knows/^foaf:knows ?y .
FILTER(?x != ?y)

}

Workaround:
{

?x foaf:knows ?gen1 .
?y foaf:knows ?gen1 .
FILTER(?x != ?y)

}

Creating the semantic model
The semantic model provides a framework to create water-based applications. The semantic model
supports the integration of operational data and related enterprise applications. Water users can extend
the semantic model to define custom asset types, asset instances, and relationships between assets.
Related concepts:
“Preparing the development environment” on page 212
To prepare the development environment, you must build and populate the infrastructure. As a core
technology in the water information hub, you start by working with the model manager component, and
customizing the semantic model so that it represents your water network.

Defining the asset type
The custom asset type is defined as an OWL ontology. You can extend RSM_WorkEquipment to define a
custom asset type. You can also define the asset type in the inherent hierarchy.

Example
<rdf:RDF

xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:owl="http://www.w3.org/2002/07/owl#"
xmlns:rdfs="http://www.w3.org/2000/01/rdf-schema#"
xmlns:swg="http://SunshineWaterGroup#"
xml:base="http://SunshineWaterGroup">

<rdf:Description rdf:about="http://SunshineWaterGroup#Meter">
<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class"/>
<rdfs:label xml:lang="en">Meter</rdfs:label>
<rdfs:subClassOf rdf:resource="http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment"/>

<rdfs:comment>Meter</rdfs:comment>
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</rdf:Description>
<rdf:Description rdf:about="http://SunshineWaterGroup#WPM">

<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class"/>
<rdfs:label xml:lang="en">Water Pressure Meter</rdfs:label>
<rdfs:subClassOf rdf:resource="http://SunshineWaterGroup#Meter"/>

<rdfs:comment>Contained by junctions in pipe network, provide junction
pressures.</rdfs:comment>

</rdf:Description>
<rdf:Description rdf:about="http://SunshineWaterGroup#TankLevel">

<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class"/>
<rdfs:label xml:lang="en">Tank Level</rdfs:label>
<rdfs:subClassOf rdf:resource="http://SunshineWaterGroup#Meter"/>

<rdfs:comment>Contained by tanks in pipe network, provide tank level.
</rdfs:comment>

</rdf:Description>
<rdf:Description rdf:about="http://SunshineWaterGroup#PRV">

<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class"/>
<rdfs:label xml:lang="en">Presure Reducing Valve</rdfs:label>
<rdfs:subClassOf rdf:resource="http://SunshineWaterGroup#Meter"/>

<rdfs:comment>Contained by valves in pipe network, provide valve
settings.</rdfs:comment>

</rdf:Description>
<rdf:Description rdf:about="http://SunshineWaterGroup#WUM">

<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class"/>
<rdfs:label xml:lang="en">Water Usage Meter</rdfs:label>
<rdfs:subClassOf rdf:resource="http://SunshineWaterGroup#Meter"/>

<rdfs:comment>Water Usage Meter</rdfs:comment>
</rdf:Description>

</rdf:RDF>

Defining the asset instance
When you define a new asset instance, the model instance metadata is captured in the RDF file.

Example

In this example, the asset instance is defined as RDF. It instantiates the custom asset type and also other
classes in the RSM model to describe the asset instance.
<?xml version="1.0" encoding="UTF-8"?>
<rdf:RDF

xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:owl="http://www.w3.org/2002/07/owl#"
xmlns:rdfs="http://www.w3.org/2000/01/rdf-schema#"
xmlns:cim="http://iec.ch/TC57/CIM-generic#"
xmlns:swg="http://SunshineWaterGroup#"
xml:base="http://SunshineWaterGroup">

<!--Pressure Reducing Valve Start-->
<swg:PRV rdf:ID="PRV19">

<cim:RSM_IdentifiedObject.name>PRV19</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>PRV19</cim:RSM_UnnamedObject.description>
<cim:RSM_WorkEquipment.ContainedBy_Equipment rdf:resource="#V19"/>

</swg:PRV>
<cim:RSM_GeoSpacial rdf:ID="PRV19_Loc">

<cim:RSM_IdentifiedObject.name>PRV19-Location</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>PRV19-Location</cim:RSM_UnnamedObject.description>
<cim:RSM_Location.TypeOfLocation>ISO6709</cim:RSM_Location.TypeOfLocation>
<cim:RSM_GeoSpacial.InternalLocation>POINT(-86.21263432150522 41.69176027662383)

</cim:RSM_GeoSpacial.InternalLocation>
<cim:RSM_Location.providesLocationOf_PhysicalEntity rdf:resource="#PRV19"/>

</cim:RSM_GeoSpacial>
<cim:RSM_Measurement rdf:ID="PRV19_STM">

<cim:RSM_IdentifiedObject.name>PRV19 Setting</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>PRV19 Setting</cim:RSM_UnnamedObject.description>
<cim:RSM_Measurement.UOM>PSI</cim:RSM_Measurement.UOM>
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<cim:RSM_Measurement.associatedTo_physicalEntity rdf:resource="#PRV19"/>
<cim:RSM_Measurement.Is_Primary_Measurement_Of rdf:resource="#PRV19"/>
<cim:RSM_Measurement.Type>ValveSetting</cim:RSM_Measurement.Type>

</cim:RSM_Measurement>
<cim:RSM_MeasurementValue rdf:ID="PRV19_Setting_Value_MV">

<cim:RSM_IdentifiedObject.name>PRV19_Setting_Value</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.alias>PRV19_Setting_Value</cim:RSM_UnnamedObject.alias>
<cim:RSM_MeasurementValue.IsA_Measurement rdf:resource="#PRV19_STM"/>

</cim:RSM_MeasurementValue>

The asset instance in the example above includes the following sections.

Name space of model
<rdf:RDF

xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:owl="http://www.w3.org/2002/07/owl#"
xmlns:rdfs="http://www.w3.org/2000/01/rdf-schema#"
xmlns:cim="http://iec.ch/TC57/CIM-generic#"
xmlns:swg="http://SunshineWaterGroup#"
xml:base="http://SunshineWaterGroup">

Asset instance

Note: The asset instance uses the type defined in asset type OWL.
<swg:PRV rdf:ID="PRV19">

<cim:RSM_IdentifiedObject.name>PRV19</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>PRV19</cim:RSM_UnnamedObject.description>
<cim:RSM_WorkEquipment.ContainedBy_Equipment rdf:resource="#V19"/>

</swg:PRV>

Asset location
<cim:RSM_GeoSpacial rdf:ID="PRV19_Loc">

<cim:RSM_GeoSpacial.InternalLocation>POINT(-86.21263432150522 41.69176027662383)
</cim:RSM_GeoSpacial.InternalLocation>

<cim:RSM_Location.providesLocationOf_PhysicalEntity rdf:resource="#PRV19"/>
</cim:RSM_GeoSpacial>

List of measurements
<cim:RSM_Measurement rdf:ID="PRV19_STM">

<cim:RSM_IdentifiedObject.name>PRV19 Setting</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>PRV19 Setting</cim:RSM_UnnamedObject.description>
<cim:RSM_Measurement.UOM>PSI</cim:RSM_Measurement.UOM>
<cim:RSM_Measurement.Type>ValveSetting</cim:RSM_Measurement.Type>
<cim:RSM_Measurement.associatedTo_physicalEntity rdf:resource="#PRV19"/>
<cim:RSM_Measurement.Is_Primary_Measurement_Of rdf:resource="#PRV19"/>

</cim:RSM_Measurement>

Each measurement has a measurement value.
<cim:RSM_MeasurementValue rdf:ID="PRV19_Setting_Value_MV">

<cim:RSM_IdentifiedObject.name>PRV19_Setting_Value</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.alias>PRV19_Setting_Value</cim:RSM_UnnamedObject.alias>
<cim:RSM_MeasurementValue.IsA_Measurement rdf:resource="#PRV19_STM"/>

</cim:RSM_MeasurementValue>

Note: The alias is used as the key in reading input message.

Defining the connect relationships
Use the connect relationship to define relationships between assets.
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Example

In this example, RSM_WorkEquipment.connects_WorkEquipment is used define the connects relationship
between two assets: a valve (V19) connected to a pair of junctions (J542 and J546).
<swg:Valve rdf:ID="V19">
<cim:RSM_IdentifiedObject.name>V19</cim:RSM_IdentifiedObject.name>
<cim:RSM_WorkEquipment.connects_WorkEquipment rdf:resource="#J542"/>
<cim:RSM_WorkEquipment.connects_WorkEquipment rdf:resource="#J546"/>
</swg:Valve>

Defining the contains relationships
Use the contain relationship to define relationships between assets.

Example

In this example, RSM_WorkEquipment.ContainedBy_Equipment is used to define contains relationship
between the two assets. A pressure reducing valve (PRV19) is contained by a valve (V19).
<swg:PRV rdf:ID="PRV19">

<cim:RSM_IdentifiedObject.name>PRV19</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>PRV19</cim:RSM_UnnamedObject.description>
<cim:RSM_WorkEquipment.ContainedBy_Equipment rdf:resource="#V19"/>

</swg:PRV>

Defining the primary measurements
An asset can provide multiple measurements and you can specify a single measurement as the primary
measurement as provided in the example.

Example
<cim:RSM_Measurement rdf:ID="PRV19_STM">

<cim:RSM_IdentifiedObject.name>PRV19 Setting</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>PRV19 Setting</cim:RSM_UnnamedObject.description>
<cim:RSM_Measurement.UOM>PSI</cim:RSM_Measurement.UOM>
<cim:RSM_Measurement.Type>ValveSetting</cim:RSM_Measurement.Type>
<cim:RSM_Measurement.associatedTo_physicalEntity rdf:resource="#PRV19"/>
<cim:RSM_Measurement.Is_Primary_Measurement_Of rdf:resource="#PRV19"/>

</cim:RSM_Measurement>

Defining the measurement threshold
Multiple thresholds can be defined for the measurement as displayed in the example in this topic.

Example

You can define multiple thresholds for a measurement. The measurement format is <rangeStart>/
<rangeEnd>:<statusCode>. For example 0/10:0 indicates the measurement status is 0 (acceptable) when
the value is in the range from 0 (include) to 10 (exclude).
<cim:RSM_Measurement rdf:ID="PRV19_STM">

<cim:RSM_IdentifiedObject.name>Setting</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>PRV19 Setting</cim:RSM_UnnamedObject.description>
<cim:RSM_Measurement.UOM>PSI</cim:RSM_Measurement.UOM>
<cim:RSM_Measurement.associatedTo_physicalEntity rdf:resource="#PRV19"/>

<cim:RSM_Measurement.Is_Primary_Measurement_Of rdf:resource="#PRV19"/>
<cim:RSM_Measurement.Type>ValveSetting</cim:RSM_Measurement.Type>
<cim:RSM_Measurement.Threshold>0/10:0</cim:RSM_Measurement.Threshold>
<cim:RSM_Measurement.Threshold>10/20:1</cim:RSM_Measurement.Threshold>
<cim:RSM_Measurement.Threshold>20/100:2</cim:RSM_Measurement.Threshold>

</cim:RSM_Measurement>

Defining the measurement timeout
Measurement timeout is used to define a time out value when there is no measurement reading. The
value is set in milliseconds.
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Example

This example indicates that PRV19_STM will change to a NO_READING(3) status after 10 minutes
(600000 milliseconds).
<cim:RSM_Measurement rdf:ID="PRV19_STM">

<cim:RSM_IdentifiedObject.name>Setting</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>PRV19 Setting</cim:RSM_UnnamedObject.description>
<cim:RSM_Measurement.UOM>PSI</cim:RSM_Measurement.UOM>
<cim:RSM_Measurement.associatedTo_physicalEntity rdf:resource="#PRV19"/>

<cim:RSM_Measurement.Is_Primary_Measurement_Of rdf:resource="#PRV19"/>
<cim:RSM_Measurement.Type>ValveSetting</cim:RSM_Measurement.Type>

<cim:RSM_Measurement.Timeout>600000</cim:RSM_Measurement.Timeout>
</cim:RSM_Measurement>

Defining the derived value relationship
With derived values, the value of a measurement is calculated from another measurement.

Example

To define a derived value relationship in the RSM_Measurement element, use
RSM_Measurement.DeriveFrom, RSM_Measurement.DeriveCalc, RSM_Measurement.DeriveTimeStyle and
RSM_Measurement.DeriveDuration. In this example, the water pressure in unit of atmosphere is
calculated from water pressure measured in PSI using the formula: H * 0.68.
<cim:RSM_Measurement rdf:ID="PCP553_M">

<cim:RSM_IdentifiedObject.name>Pressure</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>Pressure of PCP553</cim:RSM_UnnamedObject.description>
<cim:RSM_Measurement.UOM>PSI</cim:RSM_Measurement.UOM>
<cim:RSM_Measurement.associatedTo_physicalEntity rdf:resource="#PCP553"/> </cim:RSM_Measurement>

<cim:RSM_Measurement rdf:ID="PCP553_M_ATM">
<cim:RSM_IdentifiedObject.name>Pressure in ATM</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>Pressure of PCP553 in ATM</cim:RSM_UnnamedObject.description>
<cim:RSM_Measurement.UOM>ATM</cim:RSM_Measurement.UOM>
<cim:RSM_Measurement.associatedTo_physicalEntity rdf:resource="#PCP553"/>

<cim:RSM_Measurement.Type>WaterPressureAtm</cim:RSM_Measurement.Type>
<cim:RSM_Measurement.DeriveFrom rdf:resource="#PCP553_M"/>

<cim:RSM_Measurement.DeriveCalc>H * 0.68</cim:RSM_Measurement.DeriveCalc>
</cim:RSM_Measurement>

Importing the model
When you update the model instance with new asset data, you must import the updated model instance
into the model manager.

Importing the model using the console (IIC)
The IIC administrative console is most effective for smaller semantic models.

About this task

Import the model using the IBM Integrated Information Core administrative console. Use the console to
load smaller models that have less than 30,000 triples.

Procedure
1. Log on to the IBM Integrated Information Core administrative console at http://iocapp:9086/iic/

console.
2. Select Model manager > Ontologies.
3. Click Browse and select an OWL file.
4. Click Load.
5. Repeat for any additional OWL files.
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6. Select Model manager > Load

7. Click Browse and select an RDF file.
8. Click Load.
9. Repeat for any additional RDF files.

10. Click Model manager > Graphs to view models that have been loaded.

Importing the model from the command line (IIC)
You can import the IIC semantic model from the command line. Use the command line option to import
the model if you have a large model to import.

About this task

You can choose to import the model using the script iicmodelloader.sh available on the data server at:
/datahome/db2inst2/sqllib/rdf/bin or on the application server at /opt/IBM/DB2/rdf/bin. Use the script
to load larger models. It is recommended to run the script on the data server.

Procedure
1. Log on to the data server.
2. Run the command: ./iicmodelloader.sh ${modelfile} ${dbusername} ${dbpassword}. For example:

./iicmodelloader.sh ~/models/sunshine_pipe.xml dbadmin dbadminpass

Importing the model (Jena)
If you have configured your system to use Apache Jena as the model manager, use the following steps to
load ontologies and RDF instances.

About this task

Choose to import the Jena model as described in this procedure.

Procedure
1. Log on to the application server and go to the folder /opt/IBM/water/jena.
2. Import OWL files: ./importModel.sh <owl>

3. Import RDF instances: ./importModel.sh <rdf>

4. Run inference to enrich the model: ./inference.sh

Example
root@ioc16-app jena]# pwd
/opt/IBM/water/jena
[root@ioc16-app jena]# ./importModel.sh ../ sunshine/model/sunshine_pipeline_type.owl
Triples = 20
[root@ioc16-app jena]# ./importModel.sh ../ sunshine/model/sunshine_meter_type.owl
Triples = 24
[root@ioc16-app jena]# ./importModel.sh ../ sunshine/model/sunshine_pipeline_instances.rdf
Triples = 946
[root@ioc16-app jena]# ./importModel.sh ../sunshine/model/sunshine_meter_instances.rdf
Triples = 574
[root@ioc16-app jena]# ./inference.sh

Success
Update succeeded
[root@ioc16-app jena]#

Creating a customized solution
You may decide to perform the optional step to create a customized solution by making use of the
sample Sunshine Water solution provided.
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Procedure
1. Log on to the application server and go to the folder /opt/IBM/water/apps

2. Run the command ./createSolution.sh <url> <username> <password> <solutionId> <solutionName>
<solutionDescription>

Example
[root@ioc16-app apps]# ./createSolution.sh https://localhost:10029 wpsadmin
<password> Sunshine "Sunshine Water Group" "Sunshine Water Group"

Synchronizing the model to the database
The imported model must be synchronized to the database. Use the steps in this topic to synchronize the
model to the database.

Procedure
1. Log on to the application server and go to the folder /opt/IBM/water/apps.
2. Run the command ./syncModelToDB.sh <SolutionId> <Prefix>

Example
[root@ioc16-app apps]# ./syncModelToDB.sh
Usage: syncModelToDB.sh <SolutionID> <PREFIX>
Example: syncModelToDB.sh Sunshine http://cityName#
[root@ioc16-app apps]# pwd
/opt/IBM/water/apps
[root@ioc16-app apps]# ./syncModelToDB.sh Sunshine http://SunshineWaterGroup#

Related tasks:
“Migrating data from IBM Intelligent Operations for Water V1.5 to V1.6” on page 16
IBM Intelligent Operations for Water provides scripts to migrate data. Use the DB Migration Tool and the
SyncModelToDB Tool to migrate data from IBM Intelligent Operations for Water version 1.5 to version
1.6. The application accesses data from the database tables of the Water Information Hub asset.

Recreating the RDF store
If, for any reason, the DB2 RDF store becomes unusable, you can use the scripts located on the data
server to recreate the RDF store.

Before you begin

Use the scripts located on the data server in /datahome/db2inst2/ to recreate the DB2 RDF store in the
event that the store becomes corrupt.

Procedure
1. Stop the IICSvcs cluster in the WebSphere Application Server administrative console on the

application server.
2. On the data server, log in as user db2inst2:

su - db2inst2

3. Run iic_db_cleanup.sh.
4. Run db2store_clean.sh. If this step fails to drop the IICRDFDB database, run the following command

as user db2inst2 to list applications currently connected to the database
db2 list applications | grep -i IICRDFDB

If there are any active application handles, close them as follows (for example, if the command lists
handles 12345 and 23456):
db2 "force application (12345, 23456)"
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Now it should be possible to drop the database:
db2 drop database iicrdfdb

Then proceed to step 5.
5. Run create_db2_store.sh.
6. Start the IICSvcs cluster in the WebSphere Application Server administrative console on the

application server.
7. Open the IBM Integrated Information Core administrative console (refresh if it is already open in the

browser) http://<apphost>:9086/iic/console.
8. Load ontologies as previously described.
9. Load models as previously described.

Customizing measurements
You can customize the measurements by modifying the tables in the database or by using the
administration interface capabilities.

Procedure
1. Log on to the data server .
2. Open the WIHDB database.
3. Edit the CFG.MEASUREMENT_THRESHOLD table to set your measurement thresholds.
4. Edit the CFG.MEASUREMENT_TIMEOUT table to set your measurement timeouts.

Example

Configuring derived measurements
You can customize the derived measurements by modifying the tables in the database or by using the
administration interface capabilities.

Procedure
1. Log on to the data server .
2. Open the WIHDB database.
3. Edit the CFG.MEASUREMENT_DERIVED_CALC table to set your derived measurement calculations.

Example

Normal and time based derived value properties are described in the following tables.

Table 6. Normal derived value properties

Property Description

YEAR Sums the measurement reading values from the start of
the year giving a cumulative value. Readings are reset to
0 at the start of each new year.

MONTH Sums the measurement reading values from the start of
the month giving a cumulative value. Readings are reset
to 0 at the start of each new month.

DAY_OF_YEAR Sums the measurement reading values from the start of a
day giving a cumulative value. Readings are reset to 0 at
the start of each new day.

WEEK_OF_YEAR Sums the measurement reading values from the start of a
week giving a cumulative value. Readings are reset to 0
at the start of each new week.
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Table 6. Normal derived value properties (continued)

Property Description

Javascript formula with optional placeholders H : This placeholder substitutes in the formula for the
reading value of the original measurement.

T : This placeholder substitutes in the formula for the
time in seconds since the last reading of the original
measurement.

For example: if (T < 0) {H/288} else {H/(86400/T)}

Table 7. Time based derived value properties

Property Description

AVG Averages the measurement reading values from a time
period

SUM Sums all the measurement reading values from a time
period

MIN Gets the minimum in all the measurement reading
values from a time period

MAX Gets the maximum in all the measurement reading
values from a time period. A valid combined formula
using the options above For example: (MAX - MIN) * 100
/MAX

DURATION Number of seconds. AVT/SUM/MIN/MAX are
calculated from the start time – duration to start time.
The value of start times depends on the TIMESTYLE
setting.

TIMESTYLE CURRENT Start time used in DURATION is the current
reading time. NATURAL Start time used in DURATION
is the time of end of the day (24:00:00).

Defining key measurements
You can define the key measurement by modifying the asset instance table in the database or by using
the administration interface capabilities.

Procedure
1. Log on to the data server .
2. Open the WIHDB database.
3. Edit the CFG.ASSET_INST table to set your key measurement.

Customizing data import and operational storage
With IBM Intelligent Operations for Water, you can build a customized data consolidation plan to gather
and reconcile data from many sources. Use the information in this section to customize data population.

IBM Intelligent Operations for Water uses the middleware components provided by IBM Intelligent
Operations Center to manage and process data streams sourced from external systems. IBM Intelligent
Operations for Water works with data that is extracted from sources such as sensor systems, meter
systems, or enterprise asset management systems. The extracted data is transformed using WebSphere
Message Broker and then loaded into operational data stores for use by IBM Intelligent Operations for
Water.
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The middleware components accept common separated value (CSV) data feeds. Using the CSV data feed,
IBM Intelligent Operations for Water generates an RDF model that is imported into the model manager.
The model instance is extendable, and describes the water network, assets, connection points and
geographic locations. Working with WebSphere Message Broker, you can create a schedule to connect to
SCADA systems historians.

Configuring the simulator
To ingest data, you must configure the simulator properties.

Procedure
1. Log on to the application server and go to the folder /opt/IBM/water/apps/simulator/

simulator.properties

2. Check the following entries are configured correctly for your environment.
solution.id=Sunshine
model.id=SunshineWaterGroup

Creating a sample reading message
The format of a sample incoming reading message is described in this topic.

Procedure

Create a CSV incoming message in the following format.
<Alias>,<Value>,<Timestamp>
<Alias>,<Value>,<Timestamp>
<Alias>,<Value>,<Timestamp>
<Alias>,<Value>,<Timestamp>

Example
PRV19_Setting_Value,40.0,2013-10-02T14:30:01.0+08:00
PRV24_Setting_Value,100.0,2013-10-02T14:30:01.0+08:00
PRV18_Setting_Value,40.0,2013-10-02T14:30:01.0+08:00
PRV23_Setting_Value,50.0,2013-10-02T14:30:01.0+08:00
PRV9_Setting_Value,50.0,2013-10-02T14:30:01.0+08:00
Pressure_Value_PCP604_MV,21.75,2013-10-02T14:30:01.0+08:00
Pressure_Value_PCP604_MV,22.33,2013-10-02T15:30:01.0+08:00
Pressure_Value_PCP604_MV,22.89,2013-10-02T16:30:01.0+08:00
Pressure_Value_PCP604_MV,23.29,2013-10-02T17:30:01.0+08:00
Pressure_Value_PCP604_MV,24.88,2013-10-02T18:30:01.0+08:00
Pressure_Value_PCP604_MV,25.15,2013-10-02T19:30:01.0+08:00
Pressure_Value_PCP599_MV,29.68,2013-10-02T14:30:01.0+08:00
Pressure_Value_PCP599_MV,30.39,2013-10-02T15:30:01.0+08:00
Pressure_Value_PCP599_MV,30.68,2013-10-02T16:30:01.0+08:00
Pressure_Value_PCP599_MV,31.08,2013-10-02T17:30:01.0+08:00
Pressure_Value_PCP599_MV,31.43,2013-10-02T18:30:01.0+08:00
Pressure_Value_PCP599_MV,31.79,2013-10-02T19:30:01.0+08:00
Pressure_Value_PCP553_MV,41.02,2013-10-02T14:30:01.0+08:00
Pressure_Value_PCP553_MV,41.11,2013-10-02T15:30:01.0+08:00
Pressure_Value_PCP553_MV,41.35,2013-10-02T16:30:01.0+08:00
Pressure_Value_PCP553_MV,41.45,2013-10-02T17:30:01.0+08:00
Pressure_Value_PCP553_MV,41.61,2013-10-02T18:30:01.0+08:00
Pressure_Value_PCP553_MV,41.89,2013-10-02T19:30:01.0+08:00
Tank_Level_Value_TANK2_MV,200,2013-10-02T12:11:01.234+08:00
Tank_Level_Value_TANK4_MV,1000,2013-10-02T12:11:01.234+08:00
Tank_Level_Value_TANK5_MV,500,2013-10-02T12:11:01.234+08:00

Sending the reading message
To send a reading message, you place the message in a folder that is used by the Simulator for incoming
messages.
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Procedure
1. Copy the CSV file to the /opt/IBM/water/apps/simulator/incoming folder.

[root@ioc16-app simulator]# pwd
/opt/IBM/water/apps/simulator
[root@ioc16-app simulator]# ./run_simulator.sh
Start to monitor the directory /opt/IBM/water/apps/simulator/incoming

[root@ioc16-app simulator]#

2. Run the command ./run_simulator.sh to send the message.
[root@ioc16-app simulator]# nohup ./run_simulator.sh &
[1] 17409
[root@ioc16-app simulator]# nohup: ignoring input and appending output to `nohup.out’

[root@ioc16-app simulator]#

Customizing operational performance
You can customize performance measurements in IBM Intelligent Operations for Water to suit the
requirements of your operational and executive staff. By specifying and implementing user specific Key
Performance Indicators (KPIs), you can establish service level agreements and key measurements to meet
the performance needs of your organization and key stakeholders.

Customizing operational performance involves working with IBM Intelligent Operations Center to build
and deploy customized KPIs that are used in IBM Intelligent Operations for Water. You should be
familiar with the following tasks.

Defining the KPI CAP Event
Before defining or modifying a KPI you must understand the Common Alerting Protocol (CAP)
alert on which the KPI is based. For example, if you are defining a KPI that tracks the status of
water pressure sensors, you must know the CAP elements to track (water sensor name, reading
time, reading status, reading value).

Creating a KPI Model
With your understanding of the Common Alerting Protocol (CAP) alert and purpose of the KPI,
you can begin to model the KPI using available tooling.

Creating a KPI Policy
The KPI policy sets the framework for when KPI processing is triggered, when data consolidation
happens, when KPI CAP events are built and sent to the IBM Intelligent Operations Center.

This section provides guidelines on how to create and deploy a customized KPI using the samples
provided in the IBM Intelligent Operations for Water.
Related tasks:
“Configuring source data for event filtering” on page 9
Source data is required for events. After installing, sample data is made available but you must make that
data available from the data server and use the Water solution administration capabilities to configure
data sources so that the event data is displayed in the interface.
Related information:
Configuring KPIs in the IBM Intelligent Operations Center
Creating and integrating KPIs in the IBM Intelligent Operations Center
Configuring standard operating procedures in the IBM Intelligent Operations Center
IBM Intelligent Operations Center configuring a data source

Subscribing to a reading message
After the reading message is processed, the message is sent to a topic named water/reading/topic in the
queue manager.
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Procedure
1. Start the IBM WebSphere MQ Explorer and locate the queue manager WIH.MB.QM

2. Log on to the analytics server .
3. Run the command:

[root@ioc16-ana bin]# cd /opt/mqm/bin
[root@ioc16-ana bin]# ./MQExplorer

4. Create a topic with topic string: water/reading/topic.
5. Create a destination queue.
6. Subscribe the topic to the destination queue.

Example
Time: 23:46:15
Topic String: water/reading/topic
Message: <ns2:WIHRealTimeReading xmlns:ns2="http://www.ibm.com/iss/iow/wih">
<record>
<SolutionID>Sunshine</SolutionID>
<ModelID>SunshineWaterGroup</ModelID>
<ReadingAlias>PRV19_Setting_Value</ReadingAlias>
<ReadingValue>41.0</ReadingValue><ReadingTime>2013-10-03T14:30:01.000+08:00</ReadingTime>
<MeasurementID>15</MeasurementID>
<Asset>PRV19</Asset>
<AssetType>PRV</AssetType>
<Measurement>PRV19_STM</Measurement>
<MeasurementType>ValveSetting</MeasurementType>
</record>
<record>
<SolutionID>Sunshine</SolutionID>
<ModelID>SunshineWaterGroup</ModelID>
<ReadingAlias>PRV24_Setting_Value</ReadingAlias>
<ReadingValue>2604.5404291418613</ReadingValue>
<ReadingTime>2013-10-03T14:30:01.000+08:00</ReadingTime>
<MeasurementID>14</MeasurementID>
<Asset>PRV24</Asset>
<AssetType>PRV</AssetType>
<Measurement>PRV24_STM</Measurement>
<MeasurementType>ValveSetting</MeasurementType>
</record>
<record>
<SolutionID>Sunshine</SolutionID>
<ModelID>SunshineWaterGroup</ModelID>
<ReadingAlias>PRV18_Setting_Value</ReadingAlias>
<ReadingValue>2604.5404291418613</ReadingValue>
<ReadingTime>2013-10-03T14:30:01.000+08:00</ReadingTime>
<MeasurementID>19</MeasurementID>
<Asset>PRV18</Asset>
<AssetType>PRV</AssetType>
<Measurement>PRV18_STM</Measurement>
<MeasurementType>ValveSetting</MeasurementType>
</record>
</ns2:WIHRealTimeReading>

Creating a message flow to process a subscription
Use the information in this topic to create a message flow to process a subscription.

Procedure
1. Create an WebSphere Message Broker application.
2. Create a message flow in the WebSphere Message Broker application.
3. Open the flow and place a WebSphere MQ input node in the flow. The WebSphere MQ node is used

to receive messages from clients that connect to the WebSphere Message Broker application.
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4. Specify the queue name for the node.
5. Place an Extended Structured Query Language (ESQL) compute node or Java compute node into the

flow.
6. Write business codes into the nodes to process the messages. Use one of the following options.

v Save the processed message into the database directly without any output.
v Send the processed message into another queue, or publish the message in a topic.

Create a datasource to trigger processing
Using IBM Intelligent Operations Center solution administration capabilities, you can create a datasource
and trigger processing and setup for events, key performance indicators, and standard operating
procedures.

Procedure

To access the configuration tools for data sources, events, key performance indicators, and standard
operating procedures, click Administration > Solution Administration > Configuration Tools.

Customizing the user interface
You can customize some aspects of the user interface to suit your operation. IBM Intelligent Operations
for Water provides comprehensive interface extension mechanisms. Using IBM Intelligent Operations
Center capabilities, you can configure the filter panel, content panel, and supporting content panel.
Related concepts:
“Tutorial 5 - Configuring the panels in the user interface” on page 205
Use this section to configure the panels in the user interface.
Related tasks:
“Configuring the filter panel” on page 205
Complete the steps in this example to add a pane to the filter panel.
“Configuring the content panel” on page 206
Complete the steps in this example to configure the content panel.
“Configuring the drilldown panel” on page 207
Complete the steps in this example to configure the drill down panel.
“Configuring the supporting panel” on page 208
Complete the steps in this example to configure the supporting content panel.

192 IBM Intelligent Water: IBM Intelligent Operations for Water Product Documentation



Chapter 7. Tutorials

In this section a number of tutorials are presented that use sample applications provided with IBM
Intelligent Operations for Water. The aim of the tutorials is to help you familiarize withIBM Intelligent
Operations for Water and the process of building integrated applications.

Sample applications provide a simulated environment that you can use to perform application
development in IBM Intelligent Operations for Water. When you install IBM Intelligent Operations for
Water, sample applications are loaded in the following directory: /opt/IBM/water/sunshine/samples on
the application server.

Using the sample applications

The sample projects, source code, and services are provided to facilitate the deployment of customized
web applications in IBM Intelligent Operations for Water. The following samples are provided to facilitate
deployment:
v Sample custom semantic model to import into the model server. This includes sample OWL and RDF

files for pipeline and meter types and instances.
v Sample Cognos project used to deploy reports.
v Sample WebSphere Message Broker project.
v Sample application source code.

The sample applications are used extensively to share knowledge on the IBM Intelligent Operations for
Water application development process.

Tutorial 1 - Populating the infrastructure
The IBM Intelligent Operations for Water solution provides extension options that you can use to
customize the data that is made visible to users. Working with the model manager, you can define what
infrastructure, assets, measurements, and values are presented in the interface, and determine how to
integrate that data with components in the solution. In this tutorial, the focus is on understanding and
familiarizing with model customization and extensions.

By extending the IBM Intelligent Operations for Water semantic model, you can build a customized
model to meet your requirements. Use this tutorial to understand how to populate the infrastructure in
order to customize the semantic model.

Creating the semantic model
The first step in populating the infrastructure involves building the semantic model.

Defining the meter asset type
The meter asset type is defined in the OWL ontology. In this step, you can customize the sample
provided for your deployment.

The code example provides sample asset type definitions, highlighted in bold, for the Sunshine Water
Group that you can customize for your deployment. You can extend the RSM_WorkEquipment resource,
for example, to define a customized asset type.

Important: A unique namespace is used to distinguish between customers. Please ensure the namespace
is unique and that the same namespace is used for all models for the customer.
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<rdf:RDF
xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:owl="http://www.w3.org/2002/07/owl#"
xmlns:rdfs="http://www.w3.org/2000/01/rdf-schema#"
xmlns:swg="http://SunshineWaterGroup#"
xml:base="http://SunshineWaterGroup">

<rdf:Description rdf:about="http://SunshineWaterGroup#Meter">
<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class"/>

<rdfs:label xml:lang="en">Meter</rdfs:label>
<rdfs:subClassOf rdf:resource="http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment"/>

<rdfs:comment>Meter</rdfs:comment>
</rdf:Description>
<rdf:Description rdf:about="http://SunshineWaterGroup#WPM">

<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class"/>
<rdfs:label xml:lang="en">Water Pressure Meter</rdfs:label>
<rdfs:subClassOf rdf:resource="http://SunshineWaterGroup#Meter"/>

<rdfs:comment>Contained by junctions in pipe network, provide junction pressures.</rdfs:comment>
</rdf:Description>
<rdf:Description rdf:about="http://SunshineWaterGroup#TankLevel">

<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class"/>
<rdfs:label xml:lang="en">Tank Level</rdfs:label>
<rdfs:subClassOf rdf:resource="http://SunshineWaterGroup#Meter"/>

<rdfs:comment>Contained by tanks in pipe network, provide tank level.</rdfs:comment>
</rdf:Description>
<rdf:Description rdf:about="http://SunshineWaterGroup#PRV">

<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class"/>
<rdfs:label xml:lang="en">Presure Reducing Valve</rdfs:label>
<rdfs:subClassOf rdf:resource="http://SunshineWaterGroup#Meter"/>

<rdfs:comment>Contained by valves in pipe network, provide valve settings.</rdfs:comment>
</rdf:Description>
<rdf:Description rdf:about="http://SunshineWaterGroup#WUM">

<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class"/>
<rdfs:label xml:lang="en">Water Usage Meter</rdfs:label>
<rdfs:subClassOf rdf:resource="http://SunshineWaterGroup#Meter"/>

<rdfs:comment>Water Usage Meter</rdfs:comment>
</rdf:Description>

</rdf:RDF>

Defining the meter asset instance
Each meter asset instances definition contain four parts: Basic, GeoSpacial, Measurements and
Measurement Values.

More meter asset instances definition sample, please check sunshine_meter_instances.rdf

Basic information contains asset type, asset id and asset name.
<!--Pressure Reducing Valve Start-->

<swg:PRV rdf:ID="PRV19">
<cim:RSM_IdentifiedObject.name>PRV19</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>PRV19</cim:RSM_UnnamedObject.description>
<cim:RSM_WorkEquipment.ContainedBy_Equipment rdf:resource="#V19"/>

</swg:PRV>

GeoSpacial information contains the location of the asset;
<cim:RSM_GeoSpacial rdf:ID="PRV19_Loc">

<cim:RSM_IdentifiedObject.name>PRV19-Location</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>PRV19-Location</cim:RSM_UnnamedObject.description>
<cim:RSM_GeoSpacial.InternalLocation>POINT(-86.21263432150522 41.69176027662383)

</cim:RSM_GeoSpacial.InternalLocation>
<cim:RSM_Location.providesLocationOf_PhysicalEntity rdf:resource="#PRV19"/>

</cim:RSM_GeoSpacial>

194 IBM Intelligent Water: IBM Intelligent Operations for Water Product Documentation



Measurement information contains whether it is the key measurement, measurement type, threshold of
the measurement, reading timeout of the measurement and Derive value information
<cim:RSM_Measurement rdf:ID="PRV19_STM">

<cim:RSM_IdentifiedObject.name>Setting</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>PRV19 Setting

</cim:RSM_UnnamedObject.description>
<cim:RSM_Measurement.UOM>PSI</cim:RSM_Measurement.UOM>
<cim:RSM_Measurement.associatedTo_physicalEntity rdf:resource="#PRV19"/>

<cim:RSM_Measurement.Is_Primary_Measurement_Of rdf:resource="#PRV19"/>
<cim:RSM_Measurement.Type>ValveSetting</cim:RSM_Measurement.Type>
<cim:RSM_Measurement.Threshold>0/10:0</cim:RSM_Measurement.Threshold>
<cim:RSM_Measurement.Threshold>10/20:1</cim:RSM_Measurement.Threshold>
<cim:RSM_Measurement.Threshold>20/100:2</cim:RSM_Measurement.Threshold>
<cim:RSM_Measurement.Timeout>600000</cim:RSM_Measurement.Timeout>
</cim:RSM_Measurement>

Hourly MIN Tank Level measurement sample:
<cim:RSM_Measurement rdf:ID="HITL_T2_M">

<cim:RSM_IdentifiedObject.name>Hourly MIN Tank Level</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>Hourly MIN Tank Level of

TANK2</cim:RSM_UnnamedObject.description>
<cim:RSM_Measurement.UOM>FEET</cim:RSM_Measurement.UOM>
<cim:RSM_Measurement.associatedTo_physicalEntity rdf:resource="#TANK2"/>

<cim:RSM_Measurement.Is_Primary_Measurement_Of rdf:resource="#TANK2"/>
<cim:RSM_Measurement.Type>TankLevel</cim:RSM_Measurement.Type>
<cim:RSM_Measurement.Threshold>0/10:0</cim:RSM_Measurement.Threshold>
<cim:RSM_Measurement.Threshold>10/20:1</cim:RSM_Measurement.Threshold>
<cim:RSM_Measurement.Threshold>20/100:2</cim:RSM_Measurement.Threshold>
<cim:RSM_Measurement.DeriveFrom rdf:resource="#TL_T2_M"/>

<cim:RSM_Measurement.DeriveCalc>MIN</cim:RSM_Measurement.DeriveCalc>
<cim:RSM_Measurement.DeriveTimeStyle>NATURAL</cim:RSM_Measurement.DeriveTimeStyle>
<cim:RSM_Measurement.DeriveDuration>3600</cim:RSM_Measurement.DeriveDuration>

</cim:RSM_Measurement>

Measurement value information contains measurement value alias and the value belong to which
measurement. Measurement value alias must be unique in current model
<cim:RSM_MeasurementValue rdf:ID="PRV19_Setting_Value_MV">

<cim:RSM_IdentifiedObject.name>PRV19_Setting_Value</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.alias>PRV19_Setting_Value</cim:RSM_UnnamedObject.alias>
<cim:RSM_MeasurementValue.IsA_Measurement rdf:resource="#PRV19_STM"/>

</cim:RSM_MeasurementValue>

Defining the pipeline asset type
User can define the pipeline asset types as the same way to define meter asset types.
<rdf:RDF xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:owl="http://www.w3.org/2002/07/owl#" xmlns:rdfs="http://www.w3.org/2000/01/rdf-schema#"
xml:base="http://SunshineWaterGroup" >
<rdf:Description rdf:about="http://SunshineWaterGroup#PipeNetwork">

<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class"/>
<rdfs:label xml:lang="en">PipeNetwork</rdfs:label>
<rdfs:subClassOf rdf:resource="http://iec.ch/TC57/CIM-generic#RSM_WorkEquipment"/>

<rdfs:comment>Pipe</rdfs:comment> </rdf:Description>
<rdf:Description rdf:about="http://SunshineWaterGroup#Pipe">

<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class"/>
<rdfs:label xml:lang="en">Pipe</rdfs:label>
<rdfs:subClassOf rdf:resource="http://SunshineWaterGroup#PipeNetwork"/>

<rdfs:comment>Pipe</rdfs:comment> </rdf:Description>
<rdf:Description rdf:about="http://SunshineWaterGroup#Junction">

<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class"/>
<rdfs:label xml:lang="en">Junction</rdfs:label>
<rdfs:subClassOf rdf:resource="http://SunshineWaterGroup#PipeNetwork"/>

<rdfs:comment>Junction</rdfs:comment> </rdf:Description>
<rdf:Description rdf:about="http://SunshineWaterGroup#Reservoir">

<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class"/>
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<rdfs:label xml:lang="en">Reservoir</rdfs:label>
<rdfs:subClassOf rdf:resource="http://SunshineWaterGroup#PipeNetwork"/>

<rdfs:comment>Reservoir</rdfs:comment> </rdf:Description>
<rdf:Description rdf:about="http://SunshineWaterGroup#Valve">

<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class"/>
<rdfs:label xml:lang="en">Valve</rdfs:label>
<rdfs:subClassOf rdf:resource="http://SunshineWaterGroup#PipeNetwork"/>

<rdfs:comment>Valve</rdfs:comment> </rdf:Description>
<rdf:Description rdf:about="http://SunshineWaterGroup#Tank">

<rdf:type rdf:resource="http://www.w3.org/2002/07/owl#Class"/>
<rdfs:label xml:lang="en">Tank</rdfs:label>
<rdfs:subClassOf rdf:resource="http://SunshineWaterGroup#PipeNetwork"/>

<rdfs:comment>Tank</rdfs:comment>
</rdf:Description>

</rdf:RDF>

Defining the pipeline asset instance
In the pipeline asset instances definition, you define the geospatial information and connection
information for each pipeline asset.

Important: Meter and pipeline assets are similar. Both have a name, ID, and geospatial information. One
significant difference is that meter assets have measurements, measurement values, and associated
measurement configuration.

Sample Junction definition
<!-- a Junction segment - START -->
<swg:Junction rdf:ID="J547">
<cim:RSM_IdentifiedObject.name>J547</cim:RSM_IdentifiedObject.name>
<cim:RSM_PhysicalEntity.TypeOfPhysicalEntity>WorkEquipment</cim:RSM_PhysicalEntity.TypeOfPhysicalEntity>
<cim:RSM_WorkEquipment.TypeOfEquipment>Junction</cim:RSM_WorkEquipment.TypeOfEquipment>
<cim:RSM_WorkEquipment.EquipmentLevel>1</cim:RSM_WorkEquipment.EquipmentLevel>
</swg:Junction>
<cim:RSM_GeoSpacial rdf:ID="J547lOC">
<cim:RSM_IdentifiedObject.name>J547lOC</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>J547lOC</cim:RSM_UnnamedObject.description>
<cim:RSM_GeoSpacial.InternalLocation>POINT(-86.21177328555342 41.69814473321164)
</cim:RSM_GeoSpacial.InternalLocation>
<cim:RSM_Location.providesLocationOf_PhysicalEntity rdf:resource="#J547"/>
</cim:RSM_GeoSpacial>
<!-- a Junction segment - END -->

Sample pipe definition:
<!-- a Pipe segment - START -->
<swg:Pipe rdf:ID="Pipe1">
<cim:RSM_IdentifiedObject.name>Pipe1</cim:RSM_IdentifiedObject.name>
<cim:RSM_PhysicalEntity.TypeOfPhysicalEntity>WorkEquipment</cim:RSM_PhysicalEntity.TypeOfPhysicalEntity>
<cim:RSM_WorkEquipment.TypeOfEquipment>Pipe</cim:RSM_WorkEquipment.TypeOfEquipment>
<cim:RSM_WorkEquipment.EquipmentLevel>1</cim:RSM_WorkEquipment.EquipmentLevel>
<cim:RSM_WorkEquipment.connects_WorkEquipment rdf:resource="#J541"/>
<cim:RSM_WorkEquipment.connects_WorkEquipment rdf:resource="#J540"/>
</swg:Pipe>
<cim:RSM_GeoSpacial rdf:ID="Pipe1lOC">
<cim:RSM_IdentifiedObject.name>Pipe1lOC</cim:RSM_IdentifiedObject.name>
<cim:RSM_UnnamedObject.description>Pipe1lOC</cim:RSM_UnnamedObject.description>
<cim:RSM_GeoSpacial.InternalLocation>LINESTRING(-86.20972325405445 41.69817547842112,-86.20680681538411
41.69830054220117)</cim:RSM_GeoSpacial.InternalLocation>
<cim:RSM_Location.providesLocationOf_PhysicalEntity rdf:resource="#Pipe1" />
</cim:RSM_GeoSpacial>
<!-- a Pipe segment - END -->

Importing the semantic model
After you update your ontology or model, you must import it using one of the options described in this
section.
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You can configure your system to use Apache Jena as the model manager, or configure your system to
use the IIC model manager.

Importing the semantic model (IIC)
You can import the IIC semantic model from the command line or using the administrative console. Use
the command line option to import the model if you have a large model. The IIC administrative console
is most effective for smaller semantic models.

About this task

Complete the following steps to import the semantic model (IIC) using the administrative console. The
command line options are also described in this topic.

Procedure
1. Log on to the administrative console: http://iocapp:9086/iic/console.
2. Select Model manager > Ontologies.
3. Click Browse and select an OWL file.
4. Click Load.
5. Repeat for any additional OWL files.
6. Click Model manager > Ontologies to view OWL files that have been loaded.

sunshine_pipeline_type.owl
sunshine_meter_type.owl

7. Select Model manager > Load.
8. Click Browse and select an RDF file.
9. Click Load.

10. Repeat for any additional RDF files.
11. Click Model manager > Graphs to view models that have been loaded.

http://cityName
http://SunshineWaterGroup

Importing the semantic model from the command line:
About this task

Use the script iicmodelloader.sh, available on the data server at: /datahome/db2inst2/sqllib/rdf/bin or
on the application server at /opt/IBM/DB2/rdf/bin. Use the script to load larger models. It is
recommended to run the script on the data server.

Procedure

1. Log on to the data server.
2. Run the command: ./iicmodelloader.sh ${modelfile} ${dbusername} ${dbpassword}.

./iicmodelloader.sh ~/models/sunshine_pipe.xml dbadmin dbadminpass

3. Refresh the model server query cache. On the application server run the script /opt/IBM/water/
modelServer/scripts/clearcache.sh

Example

OWL Import
/opt/IBM/water/modelServer/scripts/modelserver.sh owlload
/opt/IBM/water/sunshine/model/sunshine_pipeline_type.owl
/opt/IBM/water/modelServer/scripts/modelserver.sh owlload
/opt/IBM/water/sunshine/model/sunshine_meter_type.owl

RDF Import
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cd /opt/IBM/DB2/rdf/bin
./iicmodelloader.sh /opt/IBM/water/sunshine/model
/sunshine_pipeline_instances.rdf $DB_INSTANCE_USER $DB2_PASSWORD

./iicmodelloader.sh /opt/IBM/water/sunshine/model
/sunshine_meter_instances.rdf $DB_INSTANCE_USER $DB2_PASSWORD

Importing the semantic model (Jena)
If you have configured your system to use Apache Jena as the model manager, use the following steps to
load ontologies and RDF instances.

Procedure
1. Log on to the application server and go to the folder /opt/IBM/water/jena.
2. Import OWL files: ./importModel.sh <owl>

3. Import RDF instances: ./importModel.sh <rdf file>

4. Run inference to enrich the model: ./inference.sh

Example
/opt/IBM/water/jena/importModel.sh /opt/IBM/water/sunshine
/model/sunshine_pipeline_type.owl

/opt/IBM/water/jena/importModel.sh /opt/IBM/water/sunshine
/model/sunshine_meter_type.owl

/opt/IBM/water/jena/importModel.sh /opt/IBM/water/sunshine
/model/sunshine_pipeline_instances.rdf

/opt/IBM/water/jena/importModel.sh /opt/IBM/water/sunshine
/model/sunshine_meter_instances.rdf

Creating a custom solution application
You can use the solution administration options to create a new solution application. Your new created
solution application contains the IBM Intelligent Operations for Water application as the default
application, and you can customize the sample to modify pages, user groups, and then configure the IBM
Intelligent Operations for Water application to display on those pages.
1. Log in to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Management.
4. Click Create.
5. In Create solution application, specify the details for the solution:

v In Id, enter the identifier for the solution application Sunshine.
v In Name, enter the solution application name: Water.
v In Description, enter the description of the solution application: Sunshine Solution.

Synchronizing the model to the database
When you have created the solution application, you can synchronize the model into the WIHDB
database.
1. Log in to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Configuration.
4. In Select a solution to configure, select Water.
5. Select the Model tab.
6. In Create model, enter a prefix http://SunshineWaterGroup# for the new model.
7. Click Save.
8. Select a model from the list of options.
9. In the Basics tab, click Synchronize Now.
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You can also synchronize the model to the database from the command line.
1. Log on to the application server.
2. Go to the folder /opt/IBM/water/apps.
3. Run the command ./syncModelToDB.sh Sunshine http://SunshineWaterGroup#

Configuring readings and measurements
After the model is synchronized into the WIHDB database, you can configure reading thresholds, reading
time out, key measurements, and derived values for measurements. You must synchronize these
measurements into the database.

To configure readings and measurements you need to select the asset type, configure the asset instances,
select measurements, and then synchronize the readings and measurements into the database. Using the
SunshineWaterGroup sample model, perform the following tasks.
1. Log in to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration

3. Go to Application Configuration.
4. In Select a solution to configure, select Water.
5. Select the Model tab.
6. Select the Asset Instances tab.
7. In Select an asset type, choose SunshineWaterGroup from the drop-down menu
8. Select an asset instance to configure.
9. Select a measurement to configure. Click the tab to enter measurement thresholds, key measurements,

no reading timeout, and derived value configuration.

You can also configure readings and measurements in the database.
1. Log on to the data server.
2. Open the WIHDB database.
3. Edit the WIH.MEASUREMENT_THRESHOLD table to set your measurement thresholds.
4. Edit the WIH.MEASUREMENT_TIMEOUT table to set your no reading time outs
5. Edit the WIH.MEASUREMENT_DERIVED_CALC table to set your derived value calculations.
6. Edit the WIH.ASSET_INST table to set your key measurement.

Defining named areas
Named areas are displayed on the map and are configured to filter assets by geographical location.
1. Log in to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration

3. Go to Application Configuration.
4. In Select a solution to configure, select Water.
5. Select the Model tab.
6. Select a model from the model list.
7. Select the Named Areas tab to add, update, delete or load a named area. For more information, refer

to the related topic.
Related tasks:
“Configuring named areas” on page 38
Configure named geographical areas in a solution application.
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Tutorial 2 - Ingesting data
With IBM Intelligent Operations for Water, you can build a customized data consolidation plan to gather
and reconcile data from many sources. Use this tutorial to familiarize with importing data.

IBM Intelligent Operations for Water uses the middleware components to manage and process data
streams sourced from external systems. IBM Intelligent Operations for Water works with data that is
extracted from sources such as sensor systems, meter systems, or enterprise asset management systems.
The extracted data is transformed using WebSphere Message Broker and then loaded into operational
data stores for use by IBM Intelligent Operations for Water.

WebSphere Message Broker connects applications together, regardless of the message formats or protocols
that they support. For IBM Intelligent Operations for Water, data that is exported from external systems is
available as CSV files. Data that is imported to IBM Intelligent Operations for Water through WebSphere
Message Broker is validated, enriched, transformed, and then routed to the appropriate data stores.

IBM Intelligent Operations for Water uses a common data ingest mechanism. Sensor or meter data that is
exported from data management systems as CSV files is ingested into IBM Intelligent Operations for
Water internal data stores. When the CSV file is exported from the data management system, the data is
placed on a WebSphere Message queue: Water.Reading.IN. WebSphere Message Broker applications
monitor the queue. When a message that contains water usage reading data is placed on the queue, the
data in the queue is updated in the IBM Intelligent Operations for Water analytic data stores. When the
WebSphere Message Broker data consolidation is completed, data is published to a topic that has topic
string water/reading/topic for operational processing by IBM Intelligent Operations for Water.

Configuring the simulator
IBM Intelligent Operations for Water provides a simulation tool that monitors incoming folders, parses
CSV files, and sends data readings. You can use the Simulator to check operational data flows sourced
from external systems.

The Simulator is installed on the application server in the directory: /opt/IBM/water/apps/simulator. The
Simulator can be configured to support multiple applications, so it can send reading messages for
different models and applications. To do this, you can make copies of the Simulator and each Simulator
copy can be configured individually for a specific solution application and model.

Before you start the Simulator, please check you have configuration settings as described in the
simulator.properties file.
# cat simulator.properties

#This file is used to define properties for CSV simulator

#The directory where the incoming message file is put.
#Once new files are copied into this folder, the file will processed.
incoming.message.dir=/opt/IBM/water/apps/simulator/incoming

#After new files are processed, the processed files will be copied into this directory.
processed.message.dir=/opt/IBM/water/apps/simulator/processed

# In millisecond. This configuration is used to define the scan interval.
By default, incoming.message.dir will be scanned every 5 seconds.
scan.interval=5000

# In millisecond. This configuration is used to define the message sending interval.
The message found will be sent every configured milliseconds.
send.interval=10000

# true or false. This configuration enable or disable batch message support
batch=true
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# max count of messages in batch.
batch.max=500

# Whether connect to MQ server directly
connectmq=true

# MQ Server host name
mqhostname=ioc16-ana.cn.ibm.com

# MQ Server port
mqport=1415

# MQ Queue Manager
mqqm=WIH.MB.QM

# MQ Queue
mqqueue=WIH.Reading.IN

solution.id=Sunshine

model.id=SunshineWaterGroup

In this example, properties are configured to send messages for the Sunshine solution application, and to
use the SunshineWaterGroup RDF models.

The remaining parameters relate to WebSphere MQ connection information and send modes.

Note: In this release, the Simulator can use the Java Client to connect WebSphere MQ server directly.

Creating a reading message
Build a sample reading message that contains asset readings that can then be processed by the Simulator.
1. Create a CSV incoming message in the following format. The <Alias> in this example is a

measurement value alias.
<Alias>,<Value>,<Timestamp>

2. The Simulator processes the readings, appends the solution application and model ID for each reading
message, and sends the readings to the WIH.Reading.IN queue.

PRV19_Setting_Value,40.0,2013-10-02T14:30:01.0+08:00
PRV24_Setting_Value,100.0,2013-10-02T14:30:01.0+08:00
PRV18_Setting_Value,40.0,2013-10-02T14:30:01.0+08:00
PRV23_Setting_Value,50.0,2013-10-02T14:30:01.0+08:00
PRV9_Setting_Value,50.0,2013-10-02T14:30:01.0+08:00
Pressure_Value_PCP604_MV,21.75,2013-10-02T14:30:01.0+08:00
Pressure_Value_PCP604_MV,22.33,2013-10-02T15:30:01.0+08:00
Pressure_Value_PCP604_MV,22.89,2013-10-02T16:30:01.0+08:00
Pressure_Value_PCP604_MV,23.29,2013-10-02T17:30:01.0+08:00
Pressure_Value_PCP604_MV,24.88,2013-10-02T18:30:01.0+08:00
Pressure_Value_PCP604_MV,25.15,2013-10-02T19:30:01.0+08:00
Pressure_Value_PCP599_MV,29.68,2013-10-02T14:30:01.0+08:00
Pressure_Value_PCP599_MV,30.39,2013-10-02T15:30:01.0+08:00
Pressure_Value_PCP599_MV,30.68,2013-10-02T16:30:01.0+08:00
Pressure_Value_PCP599_MV,31.08,2013-10-02T17:30:01.0+08:00
Pressure_Value_PCP599_MV,31.43,2013-10-02T18:30:01.0+08:00
Pressure_Value_PCP599_MV,31.79,2013-10-02T19:30:01.0+08:00
Pressure_Value_PCP553_MV,41.02,2013-10-02T14:30:01.0+08:00
Pressure_Value_PCP553_MV,41.11,2013-10-02T15:30:01.0+08:00
Pressure_Value_PCP553_MV,41.35,2013-10-02T16:30:01.0+08:00
Pressure_Value_PCP553_MV,41.45,2013-10-02T17:30:01.0+08:00
Pressure_Value_PCP553_MV,41.61,2013-10-02T18:30:01.0+08:00
Pressure_Value_PCP553_MV,41.89,2013-10-02T19:30:01.0+08:00
Tank_Level_Value_TANK2_MV,200,2013-10-02T12:11:01.234+08:00
Tank_Level_Value_TANK4_MV,1000,2013-10-02T12:11:01.234+08:00
Tank_Level_Value_TANK5_MV,500,2013-10-02T12:11:01.234+08:00
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Sending a reading message
Complete the steps in this section to send the reading message.
1. Copy the CSV file to the /opt/IBM/water/apps/simulator/incoming folder specified in the

simulator.properties file.
2. Start the Simulator by running the following command: nohup ./run_simulator.sh > simulator.log

&

Note: Check the Simulator is not already running. To check the startup status, view the Simulator log
by entering the command: tail –f simulator.log. If the Simulator is running, you will need to stop
and restart if you have made any changes to the configuration.

3. Run the command ./run_simulator.sh to send the message. The Simulator monitors the incoming
folder, and then processes the CSV files one by one. All processed CSV files are placed into the
processed folder which is also configured in simulator.properties.

4. Verify the value, status trending, and send time in the IBM Intelligent Operations for Water interface
has changed.

The Simulator use the Java Client to connect to WebSphere MQ and send the processed messages to the
queue directly. You can write your own application to send the messages to the WIH.Reading.IN queue
directly, however the messages in the queue must include both the solution application and model ID
information. The format for such messages is:
Sunshine, SunshineWaterGroup, PRV19_Setting_Value,40.0,2013-10-02T14:30:01.0+08:00
Sunshine, SunshineWaterGroup, PRV24_Setting_Value,100.0,2013-10-02T14:30:01.0+08:00

Tutorial 3 - Data processing
IBM Intelligent Operations for Water provides a sample application that simplifies how user applications
can subscribe to messages that are processed by WebSphere Message Broker. Processing of the messages
in the message flow can be customized for your own business requirements.

The following samples are provided:

Table 8. Sample projects

Samples Description

water_sunshine_mb_msgflowJava Message Broker projects

water_sunshine_model Data model for Sunshine water

water_sunshine_mb_lib Message Broker projects

water_sunshine_mb_msgflow Message Broker projects

To define the message flow, you must be familiar with WebSphere Message Broker and know how to
create the queue and import the required data to create the message flow.

Subscribing to a reading message
Complete the steps in this tutorial to subscribe to a message in IBM Intelligent Operations for Water.
1. Create a queue to receive the forwarded message.
2. Create a subscription in WebSphere MQ to forward the message to the queue. The processed message

can be retrieved by subscribing a topic string: water/reading/topic, then forward the message to the
queue: WATER.READING.SUNSHINE.QUEUE

3. Write a Message Broker flow to process the received messages. The processed message by IBM
Intelligent Operations for Water message broker is in XML format. It contains more information about
the readings in the message body, such as Asset ID, Asset type, and Measurement type.
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(0x01000000:Folder):XMLNSC = ( [’xmlnsc’ : 0x2118c00]
(0x01000000:Folder)http://www.ibm.com/iss/iow/wih:WIHRealTimeReading = (

(0x03000102:NamespaceDecl)http://www.w3.org/2000/xmlns/:ns2
= ’http://www.ibm.com/iss/iow/wih’ (http://www.ibm.com/iss/iow/wih%27) (CHARACTER)

(0x01000000:Folder ):record = (
(0x03000000:PCDataField):SolutionID = ’Sunshine’ (CHARACTER)
(0x03000000:PCDataField):ModelID = ’SunshineWaterGroup’ (CHARACTER)
(0x03000000:PCDataField):ReadingAlias = ’PRV19_Setting_Value’ (CHARACTER)
(0x03000000:PCDataField):ReadingValue = ’40.0’ (CHARACTER)
(0x03000000:PCDataField):ReadingTime = ’2013-10-03T14:30:01.000+08:00’ (CHARACTER)
(0x03000000:PCDataField):MeasurementID = ’16’ (CHARACTER)
(0x03000000:PCDataField):Asset = ’PRV19’ (CHARACTER)
(0x03000000:PCDataField):AssetType = ’PRV’ (CHARACTER)
(0x03000000:PCDataField):Measurement = ’PRV19_STM’ (CHARACTER)
(0x03000000:PCDataField):MeasurementType = ’ValveSetting’ (CHARACTER)

)
)

)

4. Sample XSD files are provided for parsing the messages in their broker codes.
Related concepts:
“Checking messages when performing data ingest to the WIH reading table” on page 271
If you have problems during the data ingestion process where messages are not reaching the
WIH.READING table and exceptions are generated, complete the steps in this topic.

Creating a Message Broker flow to process the subscription
In this tutorial, using the Sunshine sample application you can create a message flow to process
subscribed messages. To define the message flow, you must be familiar with WebSphere Message Broker
and know how to create the queue and import the required data to create the message flow.

Using the broker for Sunshine solution application as a sample, you can do the following:
v Create a message flow to process the subscribed messages
v Use messages that are relevant to water usage meters only
v Summarize the daily water usage readings
v Save the result to the Sunshine database: SUNSHINE.WATER_USAGE table.

To create the flow, complete the following steps:
1. Install the WebSphere Message Broker Toolkit 8.0.
2. Import the required code to WebSphere Message Broker Toolkit 8.0 to create the message flow. The

flow creates a WebSphere MQ input node to receive the messages from a specific queue and a Java
compute node to process the logic.
MQ Input ---> Java Compute

3. Specify the properties for the WebSphere MQ input node in WebSphere Message Broker Toolkit.
v Select MQInput node.
v Click the Basic tab and in Queue name, enter: WATER_READING_SUNSHINE_QUEUE
v Click the Input Message Parsing tab and in Message domain, enter: XMLNSC: For XML message

(namespace aware, validation, low memory use)
4. Specify the properties for the Java Compute node in WebSphere Message Broker Toolkit.

v Select JavaCompute node and configure the Java Compute node class.
v For Source folder, enter water_sunshine_mb_msgflowJava

v For Package, enter com.ibm.water.sunshine.mb

v For Name, enter Water_sunshine_mb_JAvaCompute

v For Superclass, enter com.ibm.broker.javacompute.MbJavaComputeNode
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5. Select to create a New Java Compute Node Class. Select Process via Java Architecture for XML
Binding (JAXB) class from the available templates

6. Click Browse, and select resource WIHRealTimeReading.xsd

7. Generate the JAXB Java Object Classes from the Message Schema for use by the Java Compute Node
Class.
v For Message Schema, enter /water_sunshine_mb_lib/WIHReadTimeReading.xsd

v For Target Java Source Folder, enter water_sunshine_mb_msgflowJava

v For Target Java Package, enter com.ibm.water.sunshine.mb.model

8. Write the code to process messages. Sample code is in the
water_sunshine_message_broker_projects.zip including the data model for Sunshine, and the
WebSphere Message Broker projects.

Tutorial 4 - Deploying Cognos reports
IBM Intelligent Operations for Water supports the generation of many types of business relevant custom
reports.

Before creating reports in IBM Intelligent Operations for Water, you must import metadata. Using the
IBM® Cognos® Framework Manager metadata modeling tool, you can import metadata from a variety of
data sources. Framework Manager is part of IBM Cognos Business Intelligence, the reporting subsystem
used by IBM Intelligent Operations for Water. You should also be able to complete the following steps.
v Import the water usage metadata.
v Define the data model.
v Define the report.
v Import the report package on the IBM Intelligent Operations for Water Cognos server
v Integrate the report page with the IBM Intelligent Operations for Water.

For the purposes of this tutorial, use the sample Cognos model project, and report package in the
water_sunshine_cognos_report_projects.zip file which has the following contents:

Table 9. Sample report data

Folder Description

Report model Sample report model

Sunshine reports Sample data and structure files

Creating the Cognos model
Using the IBM® Cognos® Framework Manager metadata modeling tool, and the sample report data
provided, you can start to create a Cognos model.

You can work with the sample provided to create a Cognos model.
1. Start IBM® Cognos® Framework Manager to create a new project.
2. Select Projects > Create a new project.
3. For Project name, enter water_sunshine_reports.
4. For Location, enter the path to where you saved the sample project, for example

D:\workspace\water_sunshine_reports.
5. Use the Metadata Wizard provided by IBM Cognos® Framework Manager to import metadata from

data sources.
6. For Select Data Source, select WIHDB and click New.
7. Specify a name for the new data source: enter DEMO_DS.
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8. Specify parameters for the connection of the datasource. For Type, select IBM DB2. Click to
Configure JDBC connection.

9. Enter the parameters to build a DB2 connection. Enter WIHDB for the DB2 database name.
10. Enter DB2 authentication details for the data source in Signons and test the connection using the

user ID and password entered.
11. The data source and connection in the IBM Cognos software server is operational.
12. Select the new data source from the list defined in IBM Cognos: DEMO_DS.
13. Select the objects that you want to import. Select the Sunshine tables and click the ID, SOLUTION,

ASSET, WATER_USAGE, READING_TIME options.
14. Click Next to complete the Metadata Wizard and finish the object creation and import process.

The water_sunshine_reports are now available in the Project Viewer in IBM® Cognos® Framework
Manager. Using the project data, you can create a line chart Cognos report.

Creating a line chart Cognos report
Using Report Studio in IBM Cognos Connection, you can create new reports and modify existing reports.

Using the objects that are available in the Presentation View of the metadata model, you can create
customized reports.
1. Open IBM Cognos Connection.
2. From the Launch menu, select Report Studio.
3. Select the Water Information Hub package to access the presentation view of the metamodel.
4. Click Create New.
5. Select the type of report type to build, for example a Line chart.
6. From the Sunshine_Reports presentation view, build the report page by dragging Time in the Time

Dimension to the X-axis, and Water Usage in the Measure Dimension to the Y-axis.
7. Run the report, making your selection from the required parameters to generate the report.

Tutorial 5 - Configuring the panels in the user interface
Use this section to configure the panels in the user interface.

IBM Intelligent Operations for Water views are comprised of the following sections:
v Filter panel
v Content panel
v Supporting content panel
v Drill down panel

Each panel can be configured to display different data depending on your requirements.
Related concepts:
“Customizing the user interface” on page 192
You can customize some aspects of the user interface to suit your operation. IBM Intelligent Operations
for Water provides comprehensive interface extension mechanisms. Using IBM Intelligent Operations
Center capabilities, you can configure the filter panel, content panel, and supporting content panel.
“Customizing the water solution” on page 214
Creating a customized water solution involves working with the SDK. IBM Intelligent Operations for
Water provides many extension mechanisms to facilitate your development work.

Configuring the filter panel
Complete the steps in this example to add a pane to the filter panel.
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About this task

The filter panel is a logical group of data sources, including assets, events, pipe networks, work orders
and other filters. You can add new panes to display in the filter panel . In this example, a Junction pane
is added to the filter panel.

Procedure
1. Log in to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Configuration.
4. In Select a solution to configure, select Water.
5. Select the Pages tab and select a page to configure. For this tutorial, select the Supervisor: Operations

page.
6. A list of page extensions is displayed that are used to customize the page.
7. Select the Filter Panel extension.
8. Click Create.
9. In Title, enter Junction.

10. In Extension type, enter Filter Group Pane.
11. Select a color (for example Blue) from the list.
12. Click Save. The Junction filter panel is added.
13. Select Junction and click Create. The Create extension configuration screen is displayed.
14. In Extension type, enter Asset Filter.
15. In Model, select SunshineWaterGroup.
16. In Asset types, select WaterPressureMeter.
17. In Icon name, select pipejunction.png.
18. Click Save. Junction is added to the Junction Filter panel.
19. Select Water > Supervisor: Operations. The Junction filter panel is added to the interface.
20. Return to the Administration > Solution Administration menu and delete your changes if required

using the Application Configuration options.
Related concepts:
“Customizing the user interface” on page 192
You can customize some aspects of the user interface to suit your operation. IBM Intelligent Operations
for Water provides comprehensive interface extension mechanisms. Using IBM Intelligent Operations
Center capabilities, you can configure the filter panel, content panel, and supporting content panel.

Configuring the content panel
Complete the steps in this example to configure the content panel.

About this task

The content panel is used to display the map, list, and logical map. In this tutorial, a map view is added
to the content panel.

Procedure
1. Log in to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Configuration.
4. In Select a solution to configure, select Water.
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5. Select the Pages tab and select a page to configure. For this tutorial, select the Supervisor: Operations
page.

6. A list of page extensions is displayed that are used to customize the page.
7. Select the Map View extension.
8. Click Create.
9. In Title, enter Asset Map.

10. In Extension type, enter Map View.
11. Enter your configuration for the map. For example, set the center, longitude, latitude and extension

and zoom settings.
12. Click Save. The new map named newMap is added. You can now add layers to the Map view. To

begin add the XYZ layer as the base map.
13. Select newMap and click Create. The Create extension configuration screen is displayed.
14. In Extension type, select XYZ Layer.
15. In URL, enter a valid map URL.
16. Click Yes to make the map the default base map.
17. Click Save.
18. Choose between client side or server side rendering. Complete steps a-e for a client side rendering

layer or steps f to k for a server side rendering layer.
a. Add a client side rendering layer.
b. Select newMap and click Create.
c. In Title, enter client render layer.
d. In Extension type, select Asset Layer.
e. Use the grid to set the asset type rendering method. For example, specify to exclude specific

assets from client side rendering. You may want render Pipe asset types for server side rendering.
f. Add a server side rendering layer.
g. Select newMap and click Create.
h. In Title, enter server render layer.
i. In Extension type, select WMS Asset Layer.
j. Enter the service URL. For example /ibm/water/api/render-service/wms.
k. Use the grid to set the asset type rendering method. For example, specify to exclude specific

assets from server side rendering. You may want render Pipe asset types for server side
rendering.

l. Click Save.
19. Select Water > Supervisor: Operations. The newMap tab is added to the content panel. Select the

asset type from the filter panel to display the asset on the map.
20. Return to the Administration > Solution Administration menu and delete your changes as required

using the Application Configuration options.
Related concepts:
“Customizing the user interface” on page 192
You can customize some aspects of the user interface to suit your operation. IBM Intelligent Operations
for Water provides comprehensive interface extension mechanisms. Using IBM Intelligent Operations
Center capabilities, you can configure the filter panel, content panel, and supporting content panel.

Configuring the drilldown panel
Complete the steps in this example to configure the drill down panel.
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About this task

Use the drill down panel to display detailed information about data displayed in the content panel. In
this tutorial, asset measurement details are added to the drill down panel.

Procedure
1. Log in to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Configuration.
4. In Select a solution to configure, select Water.
5. Select the Pages tab and select a page to configure. For this tutorial, select the Supervisor: Operations

page.
6. A list of page extensions is displayed that are used to customize the page.
7. Select the Drill Down Content Panel extension.
8. Click Create.
9. In Title, enter Asset Detail.

10. In Extension type, enter Asset Detail View. The Asset Detail panel is added to the drill down panel.
11. Enter your configuration for the asset detail.
12. In Title, enter Asset Measurement.
13. In Extension type, select Measurements.
14. Click Save. The new tab is added to the drill down content panel.
15. Select Water > Supervisor: Operations. The new tab is added to the drill down content panel. Select

the asset on the map to display associated measurement data in the drill down panel.
16. Return to the Administration > Solution Administration menu and delete your changes as required

using the Application Configuration options.
Related concepts:
“Customizing the user interface” on page 192
You can customize some aspects of the user interface to suit your operation. IBM Intelligent Operations
for Water provides comprehensive interface extension mechanisms. Using IBM Intelligent Operations
Center capabilities, you can configure the filter panel, content panel, and supporting content panel.

Configuring the supporting panel
Complete the steps in this example to configure the supporting content panel.

About this task

Use the supporting content panel to display reports. In this tutorial, a Cognos report is added to the
supporting content panel in the Operations view.

Procedure
1. Log in to IBM Intelligent Operations for Water as administrator.
2. Select Administration > Solution Administration.
3. Go to Application Configuration.
4. In Select a solution to configure, select Water.
5. Select the Pages tab and select a page to configure. For this tutorial, select the Supervisor: Operations

page.
6. A list of page extensions is displayed that are used to customize the page.
7. Select the Supporting Content Panel extension.
8. Click Create.
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9. In Title, enter Cognos Report.
10. In Extension type, enter Report View. The Cognos Report extension is added to the panel.
11. Enter your extension configuration for the report.
12. In Title, enter WUM Report.
13. In Extension type, select Cognos report.
14. In Cognos Path, enter the path to the servlet, for example /ServletGateway/servlet/Gateway.
15. In Package name, enter the package, for example Sunshine_Reports.
16. In Report name, enter the name of the report, for example Sunshine_Report.
17. In Report Parameters, enter the report parameters, for example p_assetId=&p_solutionId. For

example, if the report requires parameters A, B and C, then you must in this step provide the string
for the report parameters: p_A=****&p_B=****&p_C=**** where **** represents the value of the
parameter.

18. Click Save. The report is added to the supporting content panel.
19. Select Water > Supervisor: Operations. The report is added to the supporting content panel.
20. Return to the Administration > Solution Administration menu and delete your changes as required

using the Application Configuration options.
Related concepts:
“Customizing the user interface” on page 192
You can customize some aspects of the user interface to suit your operation. IBM Intelligent Operations
for Water provides comprehensive interface extension mechanisms. Using IBM Intelligent Operations
Center capabilities, you can configure the filter panel, content panel, and supporting content panel.

Chapter 7. Tutorials 209



210 IBM Intelligent Water: IBM Intelligent Operations for Water Product Documentation



Chapter 8. Developing for the solution

You can use the topics in this section to develop and enhance your solution.

Understanding the developer roles
The IBM Intelligent Operations for Water SDK provides an application framework that enables
developers to create custom applications by using a set of reusable components. Developers require
different skills and competencies to work with the SDK. A summary of the development roles and tasks
is provided in this topic.

Table 10. IBM Intelligent Operations for Water developer roles

If your role is: IBM Intelligent Operations for Water is used to:

Application developer v Develop an application that exposes a service to address a problem

v Define any database extensions

v Develop analytics algorithms

v Develop services to expose the database extension and algorithms For example, develop a
water-related application that exposes a service for managing pressure (requires the
server programming model).

v Develop user interface extensions that consume services. For example, develop customer
filter and map layer that consumes manage pressure services (requires the client
programming model).

v Develop configuration user interface extensions for application specific configuration For
example, develop configuration UI to configure parameters for algorithms

v Develop a sample solution for the application (for example, a demonstration)

v Identify and load sample data, for example pipe data, pressure sensor data.

v Define sample KPI/SOP/Event

v Create sample user interface by assembling the user interface extensions

Application deployer v Deploy the application into IBM Intelligent Operations for Water

v Update database schema

v Deploy application packages, for example application ear or jar files.

v Register user interface extensions

v Register services

v Register configuration user interface extension

v Deploy the sample solution into IBM Intelligent Operations for Water

v Identify and load sample data, for example pipe data, pressure sensor data

v Define sample KPI/SOP/Event

v Create sample user interface by assembling the user interface extensions

Content pack
developer

v Integrate the applications into a solution

v Each solution combines one or more applications

v Load customer data

v Load production data for the solution

v Develop KPI/SOP/Event

v Create and deploy KPI/SOP/Event and develop event mediations
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Table 10. IBM Intelligent Operations for Water developer roles (continued)

If your role is: IBM Intelligent Operations for Water is used to:

Business customizer v Customize user experiences

v User interface branding and customization to cater for the specific market

v Configure the solution

v Perform solution specific configuration, for example, the parameters for analytics
algorithms

v Secure the solution by managing the users and groups that have access to the solution

Understanding the developer framework
The water information hub is central to IBM Intelligent Operations for Water. The core technology behind
the water information hub is the semantic model of the water network.

The IBM Intelligent Operations for Water SDK consists of three core interfaces.
v An interface into the water information hub (WIH), which gives an application access any and all

water, related assets, such as the water pipe network, pumps, sensor, meters
v An interface into the advanced analytics engines of the platform, which gives an application developer

access to descriptive analytics (historical insights), prescriptive/optimization analytics (optimization),
and predictive analytics (predication)

v An interface into a rendering service, which allows the application developer to create a resulting
information layer that can then be placed on a map.

Using the interfaces, a core pattern for application development can be adopted. For example:
v An application can read the types of water asset from the water information hub (WIH), for example,

pump, pipe, valves, sensors, meters, and so on.
v An application can focus on a particular asset, such a pipe, and then read the pipe network from the

WIH, for a particular pressure zone. The application could also iterate through the pipe network and
read off the meter reading in that pipe network.

v An application can perform some advanced analytics on the pipe network, such as checking the meters
that have high readings.

v An application can create a layer of the pipe network and set display parameters (for example, a
specific color for high meter readings) and then display that pipe network on a map.

Starting steps
Before exploring the development environment, you should familiarize with the applications that have
been developed for the solution. IBM Intelligent Operations for Water contains a number of applications
developed using the SDK including the water conservation and combined sewer overflow applications.

Preparing the development environment
To prepare the development environment, you must build and populate the infrastructure. As a core
technology in the water information hub, you start by working with the model manager component, and
customizing the semantic model so that it represents your water network.

Preparing the development environment requires a number of activities:
v Starting the Jena model manager
v Configuring the model manager endpoint
v Creating the semantic model

212 IBM Intelligent Water: IBM Intelligent Operations for Water Product Documentation



When the above tasks are completed, you can begin the process of configuring the metadata and model.
Related concepts:
“Semantic model introduction” on page 158
IBM Intelligent Operations for Water uses the IBM Integrated Information Core as a core component. IBM
Integrated Information Core provides a framework to create water-based applications that are centered on
a semantic model of the real world, and that support integration of real-time operational data and related
enterprise applications.
Related tasks:
“Configuring the model server” on page 157
To work with the model manager, you start by configuring the model server. By default, the IBM
Intelligent Operations for Water model manager is configured to use DB2RDF as model server.
Alternatively, you can configure Apache Jena as both model manager and server.
“Creating the semantic model” on page 180
The semantic model provides a framework to create water-based applications. The semantic model
supports the integration of operational data and related enterprise applications. Water users can extend
the semantic model to define custom asset types, asset instances, and relationships between assets.

Configuring the metadata and model
As a core technology in the water information hub, you start by working with the model manager
component, and customizing the semantic model so that it represents your water network.

Configuring the metadata and model involves a number of activities:
v Extending the semantic model to represent your water network
v Defining relationships between model elements
v Importing the model into the model manager
v Creating a customized solution that consumes the model
v Synchronizing the model to the database
v Performing any final customization of synchronized data

When the above tasks are completed, you can begin the process of ingesting data. Data may represent
sensor readings.
Related concepts:
“Configuring semantic models in a solution application” on page 36
Create, synchronize, extend, and delete semantic models in a solution application. The semantic model,
which is known as the Reference Semantic Model (RSM), provides a framework to create water-based
solution applications. It supports the integration of operational data and related enterprise applications.
You can extend the semantic model to define custom asset types, asset instances, and relationships
between assets.
“Configuring supporting applications” on page 40
Configure and extend the supporting applications in a solution application. A solution application is
composed of supporting applications that are either predefined or added by the administrator. Within
every supporting application, default root level extensions provide sets of functionality for the front-end
application pages. You can extend the root level extensions to create new child extension functionality.

Configuring event processing
Configuring event processing requires you to create processes for managing key performance indicators
(KPIs), events, and standard operating procedures.
Related information:
Configuring KPIs in the IBM Intelligent Operations Center
Creating and integrating KPIs in the IBM Intelligent Operations Center
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Configuring standard operating procedures in the IBM Intelligent Operations Center
IBM Intelligent Operations Center configuring a data source

Customizing the water solution
Creating a customized water solution involves working with the SDK. IBM Intelligent Operations for
Water provides many extension mechanisms to facilitate your development work.

The extension mechanisms allow you to customize the water solution.

Out-of-box extensions
A set of extensions provided with the solution. Some of these out-of-box extensions are
containers. A custom extension can extend these containers to add child extensions. For example,
custom extensions can extend the Filter Panel to add a custom filter, extend the Map view to add
custom map layers, or extend the Preview Card to add a custom preview card. Some out-of-box
extensions are part of the default solution, for example, asset filter, asset layer, asset list, asset
preview card, and so on.

Extension API
An interface that is the contract between extension and framework. The framework uses these
APIs to manage the lifecycle custom extension. Any custom extensions must implement these
extension APIs.

Library API
A set of utilities to allow the extension to access framework.

Application Management Service
A registry of extensions, out-of-box or custom extensions are register in this service. The
extension metadata is registered in the extension service.

Application Management UI
An interface for managing applications that includes registering UI extensions.

Solution Management Service
The Page config service groups a set of extension instances into a page. Extension instances in a
single page are organized in a tree structure and each extension instance is configured with
parameters. Using this tree structure, and parameters, the UI framework can dynamically
construct the UI at runtime.

Solution Management UI
An interface to manage solutions, including configure pages

Related concepts:
Chapter 5, “Integrating the solution,” on page 47
Products and services can be integrated with IBM Intelligent Operations for Water.
“Configuring supporting applications” on page 40
Configure and extend the supporting applications in a solution application. A solution application is
composed of supporting applications that are either predefined or added by the administrator. Within
every supporting application, default root level extensions provide sets of functionality for the front-end
application pages. You can extend the root level extensions to create new child extension functionality.
“Configuring solution applications” on page 31
As administrator, you can create and manage a solution application, such as Water, in IBM Intelligent
Operations for Water. A solution application is an instantiated application that is comprised of one or
more supporting (or component) applications. You can also use the tools to configure the supporting
applications.
“Tutorial 5 - Configuring the panels in the user interface” on page 205
Use this section to configure the panels in the user interface.
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Chapter 9. Maintaining the solution

Perform the tasks described in this section to keep your solution running smoothly.

Tuning performance
After you complete installation of the product you can enhance the performance of the product and
configure for scalability.

IBM Intelligent Operations for Water runs on top of the IBM Intelligent Operations Center. For details on
tuning performance in IBM Intelligent Operations Center, see the section of the IBM Intelligent
Operations Center Information Center.
Related concepts:
“Performance issues and slow system response to actions” on page 269
If you are experiencing performance problems, you must check several settings.
Related information:
Tuning performance in the IBM Intelligent Operations Center

Tuning the application server
Use this section to configure WebSphere Application Server for improved performance and scalability.

About this task

Because of its close relationship with the base WebSphere Application Server product, tuning the IBM
Intelligent Operations for Water solution stack entails tuning WebSphere Application Server. This section
does not cover every possible tuning parameter available for WebSphere Application Server. Instead, we
present recommendations stemming from performance impacts experienced by the performance team. For
more details on tuning WebSphere Application Server, see the “Tuning performance” section in the
WebSphere Application Server information center. The following settings are recommended changes to
the as-installed IBM Intelligent Operations for Water product that would be required to scale the solution.

Configuring the Web Container Thread Pool
Web Container threads are used by Application Server to support HTTP requests from clients. A pool of
threads is maintained by WebSphere; the maximum size of the pool needs to be greater than the
maximum number of concurrent clients.

Procedure
1. Go to the WebSphere Application Server administrative console.
2. Select the Servers > Server types > WebSphere application servers.
3. Click the WebSphere Portal server link.
4. Scroll to the Additional Properties section at the end of the displayed page, and click Thread pools.
5. Click the WebContainer link and modify the web container minimum and maximum size as required.
6. Save the changes and restart the server.

Setting the log level to avoid excessive logging
At the default setting log level, there might be excessive logging in one component that can cause
significant log file creation as well as CPU consumption. By changing the default log setting from info to
severe, you can minimize the impact.
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Procedure
1. Log on to the WebSphere Application Server administrative console.
2. Click Troubleshooting > Logs and Trace.
3. Select WebSphere Portal from the list of servers.
4. Click Change the Log Detail Levels setting.
5. Click Runtime. Check Save runtime changes to configuration as well for all components. Replace the

string *=info with *=severe.

Configuring the direct memory setting
It is necessary to add this parameter in order to allocate sufficient native memory to support the large
number of socket resources used under high load.

Procedure
1. Log on to the WebSphere Application Server administrative console.
2. Select the Servers > Server types > WebSphere application servers.
3. Click the WebSphere Portal server link.
4. In the configuration tab, under Server Infrastructure, click Java and Process Management > Process

Definition.
5. Click Java Virtual Machine.
6. In Generic JVM arguments , add -XX:MaxDirectMemorySize=2147483648

7. Save the changes and restart the server.

Configuring outbound HTTP connections
This property specifies the maximum number of connections that are created in the HTTP outbound
connector connection pool. The value should be proportional to the maximum size of the Web Container
thread pool.

Procedure
1. Log on to the WebSphere Application Server administrative console.
2. Select Servers > Server types > WebSphere application servers.
3. Click the WebSphere Portal server link.
4. In the Container settings > Web Container Settings, select Web Container and Custom Properties.
5. Add a new property named com.ibm.websphere.webservices.http.maxConnection and set the value to

the desired number.
6. Save the changes and then restart the server.

Configuring the LTPA timeout
LTPA is used by IBM Intelligent Operations Center to implement single sign-on (SSO). The LTPA timeout
property specifies how long an LTPA token is valid. When the token expires the user is required to log in
again in order to re-authenticate the session. To prevent this from happening during extended HTTP
sessions, increase the setting for the property.

Procedure
1. Log on to the WebSphere Application Server administrative console.
2. Select the Security > LTPA > LTPA Timeout.
3. Set the desired value.

Setting heap size for the application server
When you set the heap size for an application server, refer to the guidelines in this topic.
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About this task

When you set the heap size for an application server, refer to the following guidelines:
v Make sure that the system has enough physical memory for all of the processes to fit into physical

memory, plus enough for the operating system. When more memory is allocated than the physical
memory in the system, paging occurs, which can result in poor performance.

v After you tune heap sizes, monitor the system to make sure that paging is not occurring. Paging can
cause poor performance.

v 32-bit operating systems have an address space limit of 4 GB, regardless of the amount of physical
memory in the system. This limits the maximum size of each individual process in the system. In
addition, some operating systems restrict the size of processes to be even less than the limit. The
following systems restrict the process size:

v Many versions of Windows limit processes to 2 GB in size.
v Many 32-bit Linux® kernels default to a 2 GB limit for processes.
v The address space limit further restricts the size of the JVM process. If the process grows larger than

the limit imposed by the operating system, it might terminate unexpectedly.

Procedure
1. Log on to the WebSphere Application Server administrative console.
2. Select Servers > Server types > WebSphere application servers.
3. Click the WebSphere Portal server link.
4. In the configuration tab, under Server Infrastructure, click Java and Process Management > Process

Definition.
5. Click Java Virtual Machine.
6. In the Maximum Heap Size field, enter your recommended value; for example: 4086.
7. In the Initial Heap Size field, enter your recommended value; for example: 2048.
8. Save the changes and restart the server.

Maintaining the database server
Use this section for guidance on maintaining the health and performance of the database server.

Before you begin

Maintaining a healthy database system and ensuring consistent performance requires that regular
maintenance is performed. It is important to monitor the database server as a whole to ensure the system
as configured can handle steady-state and peak workloads. Particular consideration should be given to
monitoring patterns of memory and CPU consumption, disk IO activity, and disk storage capacity.
Consult IBM DB2’s extensive ‘best practice’ documentation for further information.

As data is added to, or updated in, database tables, the data partition(s) can become fragmented and
degrade performance of database operations. If this happens the tables and/or indexes should be
defragmented (using the REORG command).

DB2 relies on statistical information about tables and indexes in order to determine the optimal access
plans for statement execution. As the content of tables and indexes changes, the optimal access plan may
also change. In order for DB2 to make the best decisions in a dynamic environment, statistics should be
gathered on a regular basis (using the RUNSTATS command).

Some database functionality is stored in packages. By default, DB2 will determine the access plan for
statements in a package at the time the package is compiled and bound to the database. So if there is
small amount of content in the database at bind time, DB2 may choose access plans that will become
increasingly suboptimal as the content of the database grows. To prevent this from happening, packages
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should be rebound after statistics have been updated.

About this task

Comprehensive maintenance planning involves configuring automatic maintenance supplemented with
manual tasks. Key points are highlighted below.

Procedure
1. Maintenance tasks can be carried out during online and offline maintenance periods.
2. By default, DB2 configures a 23-hour online period each day, during which it will execute RUNSTATS

on tables with out-of-date statistics. DB2 will periodically check tables and indexes to determine
whether RUNSTATS should be executed.

Note: You can influence the RUNSTATS options used by DB2 by executing a manual RUNSTATS with
the ‘SET PROFILE’ clause appended.

3. It is recommended that tables (and indexes) are reorganized during an offline maintenance period,
typically during a quiet time in the early hours of the morning. You can define an offline maintenance
period using Data Studio and specify that tables (and indexes) are reorganized. DB2 will use the
REORGCHK command to check which tables have become sufficiently fragmented to require
reorganization. Indexes are automatically reorganized when a table is reorganized offline.

4. The same offline period can be used to implement a backup policy.

Note: A table will not be accessible while it is being reorganized in offline mode, so consideration
should be given to the possibility of data loss during this period, for example incoming events or
sensor readings, and whether such loss is acceptable.

5. Packages should be rebound, either manually or via scheduled tasks, after REORG, and subsequent
RUNSTATS operations, have completed.

6. As per database best practice, the above maintenance activities (REORG, RUNSTATS, REBIND)
should be manually executed immediately after large data loads. We also recommend this
immediately after installing IBM Intelligent Operations for Water. We would recommend that a script
be executed that includes all tables in all schemas, as follows:
db2 connect to <database>
db2 REORG TABLE <SCHEMA>.<TABLE>
db2 RUNSTATS ON TABLE <SCHEMA>.<TABLE> ON ALL COLUMNS WITH DISTRIBUTION ON ALL COLUMNS AND

DETAILED INDEXES ALL ALLOW WRITE ACCESS SET PROFILE
db2rbind <database> -l bind.log all -u db2inst2 -p <password>
db2 connect reset

where <database> is, in particular, WIHDB, IOCDB and IICRDFDB.
7. Consult DB2 documentation for best practice in respect of data storage configuration. At a minimum

we recommend that transaction logs for IOCDB and WIHDB are redirected to dedicated disks to
avoid IO contention with data partitions. The DB configuration parameter NEWLOGPATH can be
used to implement this redirection; the change will take effect after the next DB restart. If using a
SAN storage system ensure that sufficient throughput capacity is available to the application at all
times to avoid IO bottlenecks.

Related concepts:
“Data ingest issues when data is archived or removed from the WIH reading table” on page 270
When you archive, remove or change data from the WIH.READING table, the missing or revised data
may prevent features of IBM Intelligent Operations for Water from operating as expected. Perform the
steps in this topic to diagnose and resolve data ingest record issues and restore operational capabilities.
Related tasks:
“Optimizing access to spatial data” on page 221
Part of the base functionality in IBM Intelligent Operations for Water uses specialized data types that
capture location-based information. For example, spatial data is used to define locations for water assets,
pipe infrastructure and events. You can optimize access to database tables with spatial data types by
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using a spatial grid index.

Managing database growth
Consult DB2 best practice documentation for details on managing database growth. Key points and
guidelines to managing IBM Intelligent Operations for Water database growth are provided here.

About this task
v Tables in the main IBM Intelligent Operations for Water database, WIHDB, may experience rapid

growth depending on patterns of usage. The most likely tables to experience growth are
WIH.READING and WIH.ASSET_STATUS.

v Performance of certain queries may degrade as these tables grow in size.
v Maintenance activities, such as REORG and RUNSTATS, will also take longer to complete.
v Because these tables are implemented as application-period temporal tables, and each

‘measurement_id’ requires two ‘boundary records’ to ensure proper functioning of the application, it
was not possible to adopt a partitioning strategy to manage their growth, as per database best practice.

v Depending on the data retention policy of your organization, growth could be curtailed by scheduled
purging of data that falls outside data retention periods.

v Remember that large delete operations can saturate the DB transaction logs; in such cases, either
increase the size of the transaction logs, or purge the data in smaller batches.

v Care should be taken when purging data to avoid removal of ‘boundary records’.

Note: The need to purge data from these two tables will depend on the IO throughput capacity of the
storage system being used. The more IO capacity available the better DB2 will be able to maintain
consistent performance with data growth.

Network tuning
Use this section for guidance on tuning network settings for performance and scalability.

About this task

In any production environment, the network must be closely monitored to ensure its performance is
acceptable and consistent. Based on a private switched 100MB Ethernet on a 1GB backbone, the following
network parameters were modified on the application server. The settings tune the Linux operating
system to optimize the performance of WebSphere Application Server.

Configuring network parameters
Configure network parameter settings as recommended in this procedure.

About this task

Change the settings as recommended in this procedure.

Note: The settings will not persist after a reboot.

Procedure
1. Connection Backlog

Change the following parameters when a high rate of incoming connection requests result in
connection failures.
echo 3000 > /proc/sys/net/core/netdev_max_backlog
echo 3000 > /proc/sys/net/core/somaxconn

2. TCP_KEEPALIVE_INTERVAL
Determines the wait time between isAlive interval probes.
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echo 15 > /proc/sys/net/ipv4/tcp_keepalive_intvl

Default value: 75 seconds
Recommended value: 15 seconds

3. TCP_KEEPALIVE_PROBES
Determines the number of probes before timing out.
echo 5 > /proc/sys/net/ipv4/tcp_keepalive_probes

Default value: 9 seconds
Recommended value: 5 seconds

Tuning the IBM HTTP Server
Use the following information to tune IBM HTTP Server for performance and scalability.

Configuring compression
The following enables compression for certain types of data. It should result in a significant impact on
performance on the client side.

Procedure
1. Edit the file /opt/IBM/HTTPServer/conf/httpd.conf.
2. Uncomment the following line in section one:

LoadModule deflate_module modules/mod_deflate.so

3. Add the following block on the next line:
<IfModule mod_deflate.c>
SetOutputFilter DEFLATE
SetEnvIfNoCase Request_URI \
\.(?:gif|jpe?g|png)$ no-gzip dont-vary
DeflateCompressionLevel 9
</IfModule>

4. Restart the IBM HTTP Server.

Configuring the number of max clients
This setting increases the number of IHS network clients to accommodate the amount of concurrent load
to be expected on the system.

Procedure
1. Edit file /opt/IBM/HTTPServer/conf/httpd.conf.. In the section <IfModule worker.c>

MaxClients: 600 -> 3000

2. Restart the IBM HTTP Server.

Configuring the KeepAlive Timeout
To allow more efficient reuse of HTTP connections the KeepAlive Timeout value is reduced so that
connections are freed more quickly.

Procedure
1. Edit file /opt/IBM/HTTPServer/conf/httpd.conf. In section one, change the following setting:

KeepAliveTimeout: 10 -> 3

2. Restart the IBM HTTP Server.

Configuring monitoring of HTTP Server
You can enable monitoring of the running IHS server by allowing administrators to check on the status of
the running server at: https://<webserver>/server-status.
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Procedure
1. Edit file /opt/IBM/HTTPServer/conf/httpd.conf.. In section <IfModule mod_status.c> under

<Location> add “Allow from” directive to allow users from specific IP numbers or all machines to
check server-status.
Allow from all

2. Restart the IBM HTTP Server.

Optimizing access to spatial data
Part of the base functionality in IBM Intelligent Operations for Water uses specialized data types that
capture location-based information. For example, spatial data is used to define locations for water assets,
pipe infrastructure and events. You can optimize access to database tables with spatial data types by
using a spatial grid index.

About this task

With the current versions of DB2, there are no built-in data types that can be used to represent spatial
information in such a way that DB2 can understand their underlying properties. Spatial data types are
available through the use of the DB2 Spatial Extender. It is difficult for DB2 to optimize performance
when columns of this type are referenced in SQL queries; in particular, WHERE clauses that use spatial
functions such as db2gse.ST_Intersects.

A spatial grid index is a specialized index that is defined on a table column that contains spatial data. A
suitable grid size is defined by the user and DB2 will index all geometries within the selected column
using that grid size. You can define the index with three grid sizes to suit three common query window
sizes. Grid size is the key to optimizing index performance and will depend on the query window size
and the distribution and type of spatial data.

To simplify the task of selecting optimum grid sizes, the Spatial Extender comes with a built-in Index
Advisor. See the related documentation to learn how to interpret the output produced by the Advisor.
Location information in IBM Intelligent Operations for Water is stored in the LOCATION column of the
WIH.ASSET_LOCATION table.

To determine appropriate grid sizes for the index, invoke the Advisor as follows:
gseidx "CONNECT TO WIHDB GET GEOMETRY STATISTICS FOR

COLUMN WIH.ASSET_LOCATION(LOCATION) ADVISE"

The optimum choice for grid size(s) will depend on the size of a typical query window (where 0.5
degrees approximates 55 km).

To analyze statistics for an existing grid index, invoke the Advisor as follows:
gseidx "CONNECT TO WIHDB GET GEOMETRY STATISTICS FOR INDEX

WIH.ASSET_INST_LOCATION_IDX DETAIL SHOW HISTOGRAM ADVISE"

An example of the command used to create a spatial grid index is given below:
CREATE INDEX WIH.ASSET_INST_LOCATION_IDX ON WIH.ASSET_LOCATION(LOCATION)

EXTEND USING db2gse.spatial_index(0.0021, 0.011, 0.044)

If an index already exists on this column, drop it first:
DROP INDEX WIH.ASSET_INST_LOCATION_IDX

Create the index after all spatial data has been loaded into Intelligent Operations for Water. As per
database best practice, update statistics in the IBM Intelligent Operations for Water database and rebind
packages after creating the new index.
Related tasks:

Chapter 9. Maintaining the solution 221



“Maintaining the database server” on page 217
Use this section for guidance on maintaining the health and performance of the database server.
Related information:

IBM DB2 Spatial Extender User's Guide

Backing up data
Guidance is provided in this topic on backing up product databases.

IBM Data Studio client, installed on the database server, can be used to manage backup policies quickly
and easily. With archive logging enabled, it is possible to perform a (full, incremental or delta) backup
online while maintaining full read and write access to the database. Backups can also be scheduled
during offline maintenance periods. Consideration should be given to the possibility of data loss during
an offline maintenance period, for example incoming events or sensor readings, and whether such loss is
acceptable.

As part of a comprehensive backup policy, the following databases under the primary DB2 instance
db2inst2, should be included:

Database name Purpose Usage pattern

WIHDB Main application database for IBM
Intelligent Operations for Water
(including core WIH application
data)

Updated continuously

IICRDFDB RDF Store for IBM Intelligent
Operations for Water model manager

Updated infrequently. Changes when
new RDF models are loaded and
existing RDF models are updated

IIC Configuration database for IBM
Intelligent Operations for Water
model manager

Updated when changes are made in
the model manager console (for
example, configuration changes,
model loads, owl loads, model clears)

IOCDB Main application database for IBM
Intelligent Operations Center

Likely to change frequently

IOCME SiBus message store for WebSphere
Application Server message engine

Similar change pattern to IOCDB

CATSCHDB Used by IOP scheduler in WebSphere
Application Server

Updated infrequently

IBM Intelligent Operations for Water inherits two other DB2 instances from IBM Intelligent Operations
Center.

dsrdbm01
Contains the LDAP database (LDAPDB).

db2inst1
Contains six Portal databases (COMMDB, CUSTDB, FDBKDB, JCRDB, LKMDDB, RELDB), two
databases used by WebSphere Business Monitor (WBMDB and MONITOR), two databases used
by Cognos (CXLOGDB and CXCONTDB), three databases used by Worklight (APPCNTR,
WRKLGHT, WLREPORT), one database used by Tivoli Identity Manager (ITIMDB) and an
unused database (USAGEAN).

Depending on usage patterns, some or all of these databases may also require inclusion as part of a
backup policy. If archive logging is turned on for all databases, care should be taken to monitor disk
space utilization, in particular the databases used by WebSphere Business Monitor which generate a lot of
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transaction logging. Consult IBM Intelligent Operations Center documentation for more information on
these databases and whether, and how often, they should be backed up.

Deleting unused semantic models from the database
Deleting a semantic model from the WIH.MODEL table is a significant task as all asset types, asset
instances, asset measurements, asset readings, asset locations and associated measurements are deleted
from the database.

About this task

You can remove a semantic model from the solution application in IBM Intelligent Operations for Water
as described in the related topic. When you use the solution administration options to remove the
semantic model, the model is deleted from the solution application interface, however the WIH.MODEL
table remains in the WIHDB database. If you delete the WIH.MODEL table, the semantic model data is
lost and can not be restored. For large reading data volumes, limitations imposed by the transaction log
may also prevent data deletion. Some guidelines are provided in this topic for deleting unused semantic
models.

Procedure
1. To remove the WIH.MODEL table, find the MODEL_ID that you want to remove from the specific

solution application. For example, to remove the cityName model under the Sunshine solution
application (with model_id 2) perform the following actions to remove the model. Steps 2, 3, 4, 5 and
6 below must be completed first.

2. To remove WIH.ASSET_TYPE, find all asset types (for model_id 2), and archive or remove them.
Perform this action after step 3 below is completed.

3. To remove WIH.ASSET_INST, find all asset types (for model_id 2), and archive or remove them.
Perform this action after step 8 is completed.

4. To remove WIH.NAMED_AREA, find all named area (for model_id 2), and archive or remove them.
5. To remove WIH.MEASUREMENT, find all measurements (for model_id 2), and archive or remove

them. Perform this action after step 6 and 7 is completed.
6. To remove WIH.MEASUREMENT_ALIAS, find all measurement alias (for model_id 2), and archive or

remove them. Perform this action after step 7 is completed.
7. To remove WIH.MEASUREMENT_DERIVED_CALC,

WIH.MEASUREMENT_THRESHOLD,WIH.MEASUREMENT_TIMEOUT and WIH.READING, find all
measurement IDs that are related the measurement (for model id 2), and archive or remove them.

8. To remove WIH.ASSET_STATUS and WIH.ASSET_LOCATION, find all asset IDs that are related the
assets (for model id 2), and archive or remove them.

Related tasks:
“Deleting semantic models” on page 37
Remove a semantic model from your solution application.

Maintenance tips
More tips for maintaining the solution are documented in the form of individual technotes in the IBM
Support Portal.

The following link starts a customized query of the live Support knowledge base for IBM Intelligent
Operations for Water:

IBM Intelligent Operations for Water technotes and APARs (problem reports)
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Chapter 10. Using the solution interface

The IBM Intelligent Water Family of web-based solutions use portal technology to enable water
companies to manage and monitor water assets and infrastructure.

With the solution, you can monitor operating alerts and key performance indicators to get a summary
and detailed view of water assets. The IBM Intelligent Water Family of solutions aggregate data from
water monitoring systems and other asset management systems into a centralized, configurable
dashboard that provides valuable information to support water management.

You can access the solutions by using the solution portal. You can access the solution with any of the
supported web browsers. For details of which browsers are supported, see the detailed system
requirements.
Related information:

Supported browsers for the IBM Intelligent Operations Center

Logging on
Log on to access the IBM Intelligent Operations for Water user interface.

Before you begin

Contact your local administrator to obtain your user ID and password. Your administrator is responsible
for ensuring that you have the security access level that is appropriate to your role in your organization.
Your administrator will also supply you with the web address URL for accessing the solution portal.

About this task

Use the following procedure to start a new browser session and access IBM Intelligent Operations for
Water. You can also access the solution from other IBM Smarter Cities Software Solutions that are
installed in your environment. From the main navigation bar at the top of the portal, select IBM
Intelligent Operations for Water.

Procedure
1. Enter the URL into the address field of the browser.

Note: The fully qualified domain name is required in the URL, for example, https://web_hostname/
wps/portal where web_hostname is the host name of the web server. If you use the IP address instead
of the registered fully qualified domain name, some windows do not open correctly.

2. On the login page, enter your user ID and password.
3. Click Log In.

Results

Only the pages, features, and data that you have permission to access are displayed. Contact your
administrator if you require more access.

Logging off
Log off to exit the IBM Intelligent Operations for Water user interface and end the server session.
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Procedure

To log off, from the list that is next to your user name at the top of the view, select Sign Out.

Results

The login window opens.

Viewing or editing your user profile
You can view and edit the information in your IBM Intelligent Operations for Water user profile. An
administrator creates a user profile for each new user.

About this task

The following table lists the attributes that your user profile contains. An administrator can edit all the
attributes. The attributes that users can edit are indicated in the table.

Table 11. IBM Intelligent Operations for Water user profile attributes

Attribute Description
User can
edit?

User ID* An administrator assigns a user ID to each new user for identification purposes. No

Password* An administrator assigns a password for security. The password must be unique and 5
- 60 characters in length. Valid passwords contain only the characters a-z, A-Z, period
".", dash "-", and underscore "_ ".

Yes

Given name A given name, or first name. Yes

Surname* A surname, last name, or family name. Yes

Email An email address. Yes

Profile image A profile image; for example, a photograph. Yes

Telephone
number

A telephone number. Yes

Job title A job title. Yes

Preferred
language

A preferred language, can be selected from a list. Yes

Time zone A preferred time zone, can be selected from a list. Yes

Notification
display limit

Notification display time limit in days. If a notification is older than the number of
days specified in this limit, it is not displayed in the Notifications window. The default
value is 3.

Yes

Note: Attributes that are marked with an asterisk are required for the successful creation of a new user.
Attributes that are not marked with an asterisk are optional.

Procedure
1. To view or edit your user profile, from the list that is next to your user name at the top of the view,

select Edit Profile.
2. Optional: To change your password, do the following substeps:

a. Enter your Current password. The password that you enter is not displayed.
b. Enter your New password, and then enter it again in Confirm password.

3. Optional: Edit the information in the remaining fields.
4. To submit your changes, click OK.
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Results

Your user profile is updated with any changes.

Managing notifications
Click Notifications to view a dynamic list of your notifications and their details.

To see whether there are notifications for you, look for an icon on the Notifications button. If there are no
notifications for you, there is no icon. If there are notifications for you, the number of notifications is
displayed on the icon.

Notifications is an interactive window that contains a list of all the current notifications that are relevant
to you. You see only notifications that are sent to you or to the user groups you are a member of.

Notifications are received when a predefined key performance indicator (KPI) value change occurs, where
the new value is in a different range to the existing value. For example, the water level measurement of a
reservoir is unacceptably low and the users with access to the KPI are notified.

Notifications list

The Notifications window provides a dynamic, interactive list of notifications. The list contains key
information for each notification: a headline description, and the sent date and time. The list is sorted in
an order that is based on the sent date and time, starting with the most recent notification. You can
change the sort order in the list.

Initially, the Notifications window displays a list of all of your current notifications. To see more
information about a specific notification, click the row for that notification. The preview card for a
notification displays its key properties, including the full description, the sent date and time, and the
sender.

To remove the notification from the list, click More Actions on the preview card, and then click Cancel.
To close the preview card and return to the list, click the close icon at the top of the card.

Note: Remove a notification only after you are certain it is obsolete because the notification is removed
for all recipients when you close it.

A summary bar at the end of the list indicates the total number of notifications that are displayed and the
number of notifications that are selected. Scroll down through the list with the side-bar.

To close the Notifications window, click Notifications on the menu bar.

By default, each notification is displayed for a maximum time period of three days. You can set the
length of time that a notification is displayed for you before the notification is removed from the list. On
the top menu bar, click your user name and then click Edit Profile. Enter a number in the Notification
display limit field to specify a value for the length of time in days that each notification is displayed. The
default time limit is three days.
Related concepts:
“Viewing KPIs in status views” on page 235
Use the Supervisor: Status and Executive: Status views to obtain a consolidated view of key performance
indicators (KPIs) that highlight key data. Users can monitor, manage, and respond to status changes in
relation to the key areas of organizational performance.
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Managing activities
Click My Activities to view a dynamic list of activities that are owned or monitored by the currently
logged on user. However, an administrator can see the activities for all owners and monitors in the My
Activities window.

Each time a standard operating procedure is launched, the associated activities are assigned to owners.

An icon is displayed on the My Activities button that indicates the number of standard operating
procedures that are active. To view the activities for which you are an owner or a monitor, click My
Activities. In the My Activities window, the activities are grouped by their parent standard operating
procedure instance.

For each instance of a standard operating procedure that has been launched, the My Activities window
displays all the activities, including those activities that have been completed.

The following activity due icons are displayed near the top of the My Activities window:

Past Due
Activities whose completion is past due.

Due Today
Activities that are due to be completed today.

Future Activities whose completion is due in the future.

When an activity is started, the due date is calculated by adding the start time to the duration of the
activity. The activity due dates are used to calculate the number that is displayed in each of the activity
due icons.

In the My Activities window, standard operating procedures are displayed in alphabetical order. Next to
each standard operating procedure in the list that has past due activities, a red icon indicates the number
of activities that are past due.
Related information:

Configuring standard operating procedures

Managing contacts
Click Contacts to send instant messages to other users within the solution.

Note: You must log on to the solution portal by using the fully qualified domain name of the IBM
Intelligent Operations Center application server. If you log on to the portal by using an IP address or a
host name alias instead of the registered fully qualified domain name, this instant messaging window
does not display correctly.

Your default status indicates that you are available. You can change your status indicator to indicate that
you are away from your computer, in a meeting, or that you do not want to be disturbed. You can also
change your default status message. To change your status, at the top of the window, click the
drop-down button beside your status indicator.

You can set up a list of your contacts that is organized by category. You can organize contacts in
categories that are based on the people you want to communicate with. For example, you can have a
category for general work contacts and another category for project work contacts.
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To communicate with contacts, select from the contacts you set up, or find a contact by typing a name in
the field provided. The status of each user is displayed with their name. You can also modify your own
online status, contacts, or groups. Click the menus at the top of the window:
v File to add contacts, modify groups, or log off
v Tools to set up a chat, or announcement; or to change your privacy settings
v Help to get more detailed information about how to use the portlet

Note: A list is displayed with the status of all users who are logged on. Occasionally, when a user who is
logged on closes the browser window or logs off, the status of that user might be still displayed as
logged on until the session expires. However, any messages that are sent to that user after the user closed
the browser window, or logged off, are not delivered. An error message is then displayed to a user who
is trying to send a message to that user. To ensure that your status is always updated immediately to
"unavailable", log off by clicking File > Log Out.

Viewing reports
Water reports are available in both the drill down panel and supporting content panel in IBM Intelligent
Operations for Water. Use the supporting content panel to view a Cognos reports on assets. Use the drill
down panel to view reports that are displayed are dependent on the specific data sources that you select
from the filter panel and that are visible in the current view of the map.

Viewing water specific reports in the solution

View water specific reports by clicking on the data items visible in the current view of the map. The drill
down panel has predefined panes that are used to display reports in the Chart tab or List tab. Reports
are generated for assets only and show the historical data for one asset at a time.

Viewing a Cognos report in the solution

View the Cognos water report by clicking the splitter bar on the trailing side of the map portal that
expands the supporting content panel. Select in the supporting content panel the asset and solution to be
used as report input. Click OK to generate the report. The report output is vertically displayed within the
supporting content panel. By default, the top of the report output displays a graph of asset resource
usage by time. The bottom of the report output displays asset resource usage in a table. Click Back in the
browser navigation bar to re-display the form, select another asset or solution, and generate a new
Cognos report.

Filtering data on the maps and list
In the appropriate operations view, use the filter panel to define what data is displayed in the content
panel. The content panel contains the Map tab, the List tab, and the Logical Map tab.

The filter panel has the following predefined panes:
v Favorites
v Date & Time
v Boundary

The filter panel also has dynamic panes that contain the data source categories that are defined for the
filter panel.

The data source categories defined include:
v Assets
v Pipe Network
v Events
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v Water Conservation
v Work Orders
v CSO

Depending on the operations view selected, some of the categories may not be displayed.

In the predefined and dynamic panes, you can apply filter criteria to define what data is displayed in the
content panel. After you apply a set of filter criteria, you can name and save the set of filter criteria. You
can view and access saved sets of filter criteria in the Saved Filters pane. To clear the current filter
settings, near the bottom of the filter panel, click Clear.
Related information:
Filtering data on the maps and list

Using the maps and list
In the content panel of the operations view, you can view data on a geospatial map, on a logical map, or
in list format.
Related information:
Configuring geospatial maps

Controlling the map
You can move the cursor around the map by using your mouse or keyboard.

Controls at the top of the map

The following controls are available at the top of the map:
v Pan arrows (up, down, left, right)
v Zoom in
v World view (zooms out to the maximum extent)
v Zoom out

Controls for moving around the map

To move around the map, you can use the following controls:
v Click and drag the map by using the mouse
v Press the up pan arrow, or the up arrow key on the keyboard, to pan north
v Press the down pan arrow, or the down arrow key on the keyboard, to pan south
v Press the right pan arrow, or the right arrow key on the keyboard, to pan east
v Press the left pan arrow, or the left arrow key on the keyboard, to pan west

Zoom controls for magnifying or reducing the scale of the map

To zoom in and out of the map, you can use the following controls:
v Click the + map icon to zoom in, or the - map icon to zoom out of the center of the map
v Double-click the selected location to center the map and zoom in to that location
v Click the World view icon to maximize the zoom out to show the world view
v Press the + key on the keyboard to zoom in
v Press the - key on the keyboard to zoom out
v Press Shift while you use the mouse to draw a rectangle around the area to zoom in on
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Map tab
Use the Map tab to see current information that is represented on a geospatial map. You can obtain
information from data items marked on the map. Select your data sources on the filter panel and your
base map from the list of maps available in the solution.

The Map tab provides you with a visual representation of data items associated with their relevant
positions on the map. Using information that is displayed on the Map together with the List tab, you can
identify issues, resources, location patterns, conflicts, and synergies. You can easily keep up with rapidly
changing situations, accessing relevant data sources and data feeds.

The Map and List tabs are linked together to share input and changes to the data items displayed. You
can set filters on the filter panel for the data items you want to see. This setting controls which data items
are displayed on the Mapand List tabs. On the List tab, you can see the name of the selected data source
and all its current data items listed with their properties.

Map tab elements

The Map tab has two interactive interface elements as shown in the following table.

Table 12. Map interface elements

Interface element Description

Geospatial map The selected base map is displayed with markers that indicate where data items and
detailed location maps exist.

More Actions menu A menu of actions that is associated with the map:

Reset map
Return to the default base map for the solution. Reset the map to override
your center point and zoom level with the default settings.

Base maps
Display an alternative base map, select the required map from the list of
available maps.

Work Orders
Provides an option to create a work order. Select from the required work
order type and drop the work order item on the map.

Note: When you log on to the system for the first time, the map center point and zoom level is set to the
default. Subsequently, when you log on to the system, the center point and zoom level is retrieved from
your previous session. If the default map settings are changed by an administrator, reset the map to see
the new default settings.

The map is updated with data items in relation to positions on the map, subject to settings on the filter
panel. Settings on the filter panel control which data sources are used and which data items are
displayed.

Map markers

The position on the map of data items is indicated with markers as shown in the following table.

Table 13. Map markers

Marker Type Description

Single-point icon An icon marker indicates a point location on the map that is associated with a data
item, with a unique icon picture to represent each data source.

Polygon A shape outlines on the map the area that is associated with a data item.
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Table 13. Map markers (continued)

Marker Type Description

Line A line segment or a set of lines outlines on the map the lines that are associated with a
data item.

Multi-point A single data item can be associated with more than one point on the map. A
multi-point data item is represented by the same marker at more than one location.
When you select one of these markers, the other icons that are associated with the data
item are also highlighted at the same time.

To display details for a single data item, click the marker on the map. The preview card initially displays
minimal and key properties. Depending on the data source, you can click for more information and
actions that are associated with an item. You can update a data item if the data source is designed to
allow an update.

If you have administration access, you can go to the Solution Administration view to
configure what is shown on this tab.

List
Use the List tab to view, monitor, and manage data items in IBM Intelligent Operations for Water.

The List tab contains an interactive list of data items and their details. All the data items that match the
filter panel settings are available to view on the List tab.

The Map, and List tabs are linked together to share input and changes to the data items displayed. You
can set filters on the filter panel for the data items you want to see. This setting controls which data items
are displayed on the Map, and List tabs. On the List tab, you can see the name of the selected data
source and all its current data items listed with their properties.

You can view data items from one data source at a time and select the data source that you want to view
from the drop-down list of data sources at the top of the List tab.

The list outlines the minimal and key properties that describe an item. You can adjust the width and sort
order of each column.

To display details for a single data item, click the row. The preview card initially displays minimal and
key properties. Depending on the data source, you can click for more information and actions that are
associated with an item. If the item occurs on the geospatial map, you can highlight the item on the map
by clicking More Actions > Highlight On Map. You can update a data item if the data source is
configured to allow an update.

To highlight from the list one or more items on the geospatial map, select the items on the list and on the
top menu bar click More Actions > Highlight On Map.

The list is refreshed regularly with updates, subject to any filters you set.

Using the Logical Map
Use the Logical Map tab in IBM Intelligent Operations for Water to show relationships between the assets
and to perform impact analysis.

Before you begin

The Logical Map provides a standards-based meta model view of current information about a specific
location. A logical map is a map, diagram, or graph with predefined areas for interaction. Using a logical
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map, you can filter, rank, and select asset content based on context. You can also index, aggregate, and
integrate information across different domains and sources. Logical maps can be processed as
mathematical graphs. Therefore, you can use graph theory algorithms to perform impact analysis on a
logical map.
Related information:
IBM Intelligent Operations Center model services installation

Displaying data on the Logical Map
About this task

The task explains how to navigate to, populate, and display data sources on the logical map.

Procedure
1. Log on to IBM Intelligent Operations for Water.
2. Use the Filter Panel to select data sources for display on the logical map. For example, expand the

Assets data source to select the Water Pressure Meter and Tank Level pipes, and expand the Pipe
Network data source to select Pipe.

3. In the Logical Map tab, use the Input Keyword text field and the View Asset drop-down menu to
select a specific asset to display on the logical map.

Tip: It is advisable to avoid the use of the underscore character '_' in the search term for the Input
Keyword field as the response time to the search will be higher.

4. Click on an asset in the map to display its preview card. On the asset preview card, there are options
for More details and More Actions.

5. Optionally, to better view an asset on the map, you can separate it from other assets on the map. To
do so, click and drag the asset on the map.

Filtering data on the Logical Map
About this task

The task explains how to configure the logical map to display asset relationships and to perform impact
analysis.

Procedure

With data displayed on the logical map, select the More Actions tab and select Configure. In the
Configure panel, you can refine the display as follows:
v Select from the following available options to customize the display of relationships in the model.

-Has Location shows the relationships between assets and locations.
-Connects shows the connection relationship between assets.
-Has DirectType

-Contains shows the contain relationship between two assets.
-Connected

-Has measurement shows the relationship between assets and measurements.
-Contains By

-Type

-subClassOf

v Use the Color drop-down menu for each relationship option to customize the color of its
corresponding map icon.

v Enter a number in Limit item count to: to set the maximum number of items to display in the map.
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v Enter a number in Limit impact analysis depth to: to set how deep within the layers in the map you
want to allow impact analysis to be performed.

Performing impact analysis:
About this task

Use the Logical Map to perform impact analysis on model artifacts; for example, on a measurement in
the model.

Procedure

1. Use the Logical Map to perform impact analysis, for example, on a measurement in the model.
2. Log on to IBM Intelligent Operations for Water as operator.
3. Select the Operator: Operations view.
4. Select the Logical Map option to view the logical map.
5. Navigate the Logical Map to find the asset that you want to analyze. Right-click and select the

Perform Impact Analysis option.

Changing the layout of the Logical Map:
About this task

The task explains how to use the various layout options for the logical map that are provided by the
More Actions menu.

Procedure

1. Open the logical map tab and select the More Actions and select Configure.
2. In the Configure panel, select from the Force Directed Layout, Circular Layout, Tree Layout, or

Hierarchical Layout, Long Link Layout,Short Link Layout options.

Resetting the Logical Map:
About this task

The task explains how to reset the logical map to the default display.

Procedure

1. Open the logical map tab and select the More Actions and select Configure.
2. In the Configure panel, select Reset Map.

Viewing asset and household details
In the appropriate operations view, use the drill down panel to view water asset and household details
and reports.

The drill down panel has the following predefined panes:
v Asset Details panel is used to display measurement values for water assets and equipment selected in

the content panel.
v Household Detail View panel is used to display water conservation portal information for any

households selected in the content panel

Reports panels are used to display both historical and aggregated data on measurements in a chart or
grid.

In the predefined panes, you can apply filter criteria to define what data is displayed.
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Sample user views
The interface is a role-based dashboard for consolidating data that contains sample views. Each view
consists of interface items that you can interact with to access the information you need. Each view
provides a consolidated view of water operations that enable specific roles to monitor, manage, and
respond to key areas that impact water organizational performance.

Operations views
Use the Operations views to monitor and manage water operations. This may involve monitoring the
pressure status of your entire water network, managing pipe pressure optimization or other tasks.

The Operations view is an interactive web page. Each view contains independent sections that cooperate
with one another to provide comprehensive information and interaction at the operations level.

Table 14. Operations view

Type Description

Supervisor Use the Supervisor: Operations view to obtain an
overview of current data. The Supervisor: Operations
view is intended for supervisors and managers who
are monitoring current data and anticipating future
issues.

Operator Use the Operator: Operations view to maintain
awareness of current data items and their location.
The Operator: Operations view is intended for
operators, managers, or others who are monitoring
and responding to data.

Executive Use the Executive: Operations to obtain a
consolidated view of current data. The Executive:
Operations enables users with cross-organization
responsibility to manage and respond to changes in
relation to data and location.

The operations views contain the following panels:

Filter panel
In the appropriate operations view, use the filter panel to define what data is displayed in the
content panel. Use the sample filters provided or create your own filter as required.

Content panel
In the content panel of the operations view, you can view data on a geospatial map, on a logical
map, or in list format. The geospatial map of the region contains event and resource markers,
water assets, equipment and status, logical zones, and layers. The logical map shows the logical
structure and contains a graphical view of the semantic model topics, topic associations, and
linkages.

Supporting content panel
In the supporting content panel, you can view asset or work order details, and specific reports of
events as graphs, tables, or pie charts.

Viewing KPIs in status views
Use the Supervisor: Status and Executive: Status views to obtain a consolidated view of key performance
indicators (KPIs) that highlight key data. Users can monitor, manage, and respond to status changes in
relation to the key areas of organizational performance.
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The KPIs that are available in the view depend on the access permission that is assigned to the user. A
group of users in an organization is assigned a set of permissions. Members of the group can see only
those KPIs that are appropriate to their job.

Select the required view from the Water menu on the top menu bar. The view that is available to a user
depends on the access permission that is assigned to the user. Each group of users can see only those
pages that are appropriate to the job role that is associated with that group. The status views that are
provided are outlined in the following table.

Table 15. Status views

Views Description

Supervisor: Status Use the Supervisor: Status view to see the status of
selected KPIs for the organization that you are
supervising. The Supervisor: Status view is intended for
supervisors who are monitoring KPIs that are associated
with day-to-day operations.

Executive: Status Use the Executive: Status view to see all KPIs for a single
organization or across multiple organizations that you
are managing. See recent changes in the KPI status so
that you can plan and direct operations as necessary. The
Executive: Status view is intended to provide an
executive-level summary of the status of KPIs across the
organizations that you are managing.

The status views contain the following elements:

Navigation tree
In the status views, use the navigation panel to define the data that is displayed in the content
panel.

Content panel
In the content panel of the status view, you can view the highest level KPIs, or drill down to
view underlying KPIs as required.

The status view provides a summary of the status of the KPIs that you have permission to view. View the
current KPI status so that you can plan and act if necessary.

There is a view filter on the legend bar. From a check box menu, you can select the range of KPIs that
you want to view. By default all ranges are selected.

Status view navigation

In the Top Line view, each column contains KPIs of a kind that are grouped under the KPI model name
at the top of the column. The KPIs that are associated with each KPI group are represented by colored
cells according to predefined status. The color code is explained in the legend at the top of the view.
v To see KPI details, click the cell. A preview card is displayed with the value, KPI type, and range type

of the KPI. If the KPI is composed of underlying child KPIs, the preview card contains a More Actions
menu.

v To focus on a specific KPI, on the menu, select Drill In to display underlying KPIs. You can repeat this
action at each KPI level until you reach a level where there are no underlying KPIs. For each KPI, you
can also see all of the underlying KPIs.

v To navigate back to focus on a higher level, click the required node on the navigation tree.
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KPI color code

Each KPI is represented by a colored cell. The cell color for a KPI reflects its status.

The color code that is supplied with the sample KPIs for the solution is as follows:
v Green indicates that the status is acceptable, based on the parameters for that KPI, no action is

required.
v Yellow indicates that caution or monitoring is required, action may be required.
v Red indicates that the status is critical and action is recommended.
v Gray indicates that there is insufficient data available to calculate the KPI status.

The color code is defined in the legend at the top of the view.

KPI updates

When an underlying child KPI is updated, the change is reflected in the status view. For example, one of
the sample KPIs that determine the status of the Water Quality KPI changes status from acceptable to
caution. The change is reflected by a change in the background color of the Water Quality cell from green
to yellow. In addition, on the icon on the Notifications button, the number changes to notify a KPI
change.

When the solution receives data that is related to the calculation of a KPI, there is a corresponding color
change in the cell on the status view. This feature is an advantage when the KPI is one that is likely to
receive changes in real time, for example, airport delays. It is not relevant to historical KPIs, for example,
a KPI measuring water level for flood control. For that KPI, regular daily measurements are taken and
there is unlikely in the interim to be a sudden change that affects status.

Configuring KPIs

If you have administration access, you can go to the Solution Administration view to configure what is
shown on the status view.

Sample KPIs

A set of sample KPIs is provided with the solution. These KPIs are designed to provide guidance for
planning and implementing different types of KPIs to suit your organization. Examples are provided in
the areas of water.

Table 16. Sample KPIs

Sample KPI Description

Storm Water Overflow Management v Dry weather sewer overflows

v Dry weather sewer overflows prevented

v Wet weather collection system maximization

Waste Water Treatment and Recycling v Total volume of waste water treated

v Volume of waste water treatment plant effluent
recycled

v Wet weather waste water plant maximization
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Table 16. Sample KPIs (continued)

Sample KPI Description

Fixed Asset Repair and Management v Cumulative number of pump starts and stops

v Cumulative pump runtime

v Number of feet of sewer inspected

Analysis view
Use the Analysis view to plan and manage water operations. You can obtain a consolidated view of
assets and key details. The Analysis view enables a planner with cross-organization responsibility to
monitor, manage, and respond to asset status changes.

The Analysis view is an interactive web page and contains independent sections that cooperate with one
another to provide comprehensive information and interaction at the analysis level.

The Analysis view contains the following panels:

Filter panel
In the appropriate operations view, use the filter panel to define what data is displayed in the
content panel. Use the sample filters provided or create your own filter as required. The filter
form is used to select:
v Date and time
v Boundary
v Assets
v Pipe Network
v Events

Content panel
In the content panel of the operations view, you can view data on a geospatial map, on a logical
map, or in list format. The geospatial map of the region contains water assets. Key asset details
can be displayed. The logical map shows the logical structure and contains a graphical view of
the semantic model topics, topic associations, and linkages.

Supporting content panel
In the supporting content panel, you can view asset or work order details, and specific reports of
events as graphs, tables, or pie charts.

Water conservation view
Use the Water Conservation view to obtain a consolidated view of resource consumption and use. The
Water Conservation view enables users to analyze individual consumption and monitor water leakages.
The view provides a water report. By using the report, you can plan for changes to behavior, usage
patterns, or changes to individual water equipment to actively engage in water conservation.

The Water Conservation view is an interactive web page and contains independent sections that
cooperate with one another to provide comprehensive information and interaction at the water
conservation citizen level.

The Water Conservation view contains the following sections:
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Table 17. Water Conservation view display

Interface element Description

Profile area Shows the profile name for the report. The profile name might be a park, a marina, or
a household. You can select from the list. Below the profile name is the one or multiple
meters in the account. If you have multiple meters, you can select from the list to see
the consumption of each meter.

Progress area Shows your progress, such as your Usage Trend, Monthly Year to Date Variance in
dollars and in gallons. Shows your water conservation progress in relation to other
participants. The Rank shows your position in relation to other participants in your
community. The Green Points shows the number of points earned. Green points are
awarded for reductions in water consumption and determined by weekly readings
from your water meter.

Water usage area Shows your daily water usage for the past several months in 2 usage units: gallons
and dollars. Using the slider bar, you can move along a 12 month calendar to see the
total water consumption each day. When you move the slider bar, the data and usage
unit also change in the two views in the Details area: Hourly Usage and Weekly
Usage. Hover over each bar to see the actual amount for weekly usage

Details area Compares hourly and weekly usage in a chart. The following views are available for
display:

v Hourly Usage - toggle to display in a graph or table the hourly water usage in a
specific day.

v Weekly Usage - toggle to display in a graph or table the water usage for a four week
period.

v Compare Usage - toggle to display in a graph or table a comparison of water usage
for each day over weekly intervals.

v Game Usage - toggle to display in a graph or table a comparison of your water
usage with usage by others in your community.

Team Chat / Pilot Chat Communications facility to chat with other users and pilot participants in your
community.

Initially, when you open the view, household data is displayed. If your household comprises a number of
accounts, you can select to display the data for each account.

The lists are refreshed regularly with updates, subject to any filters you set to limit the categories that are
shown.

Solution administration view
In the Solution Administration view, you can manage and configure solution applications. A solution
application, such as Water, is comprised of one or more supporting applications. You can also use the
tools to configure the supporting applications.

To access the Solution Administration view, from the Administration menu at the top of the view, click
Solution Administration. You can use the following configuration tools:
v Application Management: Create a solution application such as Water, and install its supporting

applications.
v Application Configuration: Configure the user interface for the solution application, and customize its

model, services and user groups.
v Application: Configure and extend the supporting applications.

For more information, see the Administrator tasks section of the IBM Intelligent Water product
documentation.
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Operator tasks
Use the information in this topic to perform operator tasks using the solution.

The Operator: Operations view provides a visual representation of water data enabling you to perform
the following actions:
v View current water levels, devices, and events, on a geographical information system (GIS) map and

accompanying table.
v Navigate around the GIS map, zooming in and out of water infrastructure networks to view pipe

infrastructure, asset types and locations within the network.
v View graphical reports summarizing recent water events.
v Monitor specific pipe networks and areas of interest.
v Customize the water data you would like to monitor on the GIS maps.

Use the Operator: Operations view to monitor and analyze current water data available in the solution.

If you have administrator access, you also can perform some configuration and customization actions
from this view.

Displaying the Map tab
Use the information in this topic to monitor the status and performance of water infrastructure and
assets. The map contains geo-spatial and system data collected from subsystems and external data
sources. The map provides a single view of infrastructure, assets, devices, and events sourced from
SCADA, meter, or sensor systems that are configured in the water network.

Before you begin

Before you can perform this task, you must be authenticated with the appropriate role and privileges.
The subsystems, for example GIS and SCADA subsystems, and all external data feeds must be
operational.

Procedure
1. Log on as operator.
2. Select the Operator: Operations view.
3. View the Map tab.
4. Select your data sources on the filter panel to refine your view.
5. Use the pan or zoom options to navigate and refine your view of the map.

Showing the pipe network on the map
Use the information in this topic to display the pipe network on the Map tab.

Before you begin

Before you can perform this task, you must be authenticated with the appropriate role and privileges,
and validated as a water operator.

Procedure
1. Log on as operator.
2. Select the Operator: Operations view.
3. View the Map tab.
4. Expand the Pipe Network data source on the filter panel and select the data items to display (for

example, pipe, valve, junction).
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5. Use the pan or zoom options to refine your view of the data items in the pipe network.

What to do next

To display details for a single data item, click the marker on the map. The preview card initially displays
minimal and key properties. Depending on the data source, you can click for more information and
actions that are associated with an item. You can update a data item if the data source is designed to
allow an update.

Viewing water assets and equipment
Use the information in this topic to display water assets and equipment on the Operator: Operations
view.

Before you begin

Before you can perform this task, you must be authenticated with the appropriate role and privileges,
and validated as a water operator.

Procedure
1. Log on as operator.
2. Select the Operator: Operations view.
3. View the Map tab.
4. Use the pan or zoom options to refine your view of the map.
5. Expand the Assets data source on the filter panel and select the data items to display (for example,

water pressure meter).
6. Use the pan or zoom options to refine your view of the data items.
7. Click the asset marker on the map to display details for a single asset. The preview card initially

displays minimal and key properties. Depending on the data source, you can click for more
information and actions that are associated with an item. You can update an asset if the data source is
designed to allow an update.

8. Use the drill down panel to view more water asset details and reports.
9. Click the List tab to view more details about the asset.

Displaying measurement values for assets
Use the information in this topic to display measurement values for water assets and equipment on the
Operator: Operations view.

Before you begin

Before you can perform this task, you must be authenticated with the appropriate role and privileges,
and validated as a water operator.

Procedure
1. Log on as operator.
2. Select the Operator: Operations view.
3. View the Map tab.
4. Use the pan or zoom options to refine your view of the map.
5. Expand the Assets data source on the filter panel and select the data items to display (for example,

water pressure meter).
6. Use the pan or zoom options to refine your view of the data items.
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7. Click the asset marker on the map to display details for a single asset. The preview card initially
displays minimal and key properties. Depending on the data source, you can click for more
information and actions that are associated with an item. You can update an asset if the data source is
designed to allow an update.

8. Use the drill down panel to view measurement details.
9. Click the List tab to view measurement details about the asset.

View historical data records for an asset measurement
Use the information in this topic to display past measurement values for water assets and equipment on
the Operator: Operations view. By reading historical measurement values and readings from water
network sensors or meters, you can monitor the performance water infrastructure more effectively.

Before you begin

Before you can perform this task, you must be authenticated with the appropriate role and privileges,
and validated as a water operator.

Procedure
1. Log on as operator.
2. Select the Operator: Operations view.
3. View the Map portlet.
4. Use the pan or zoom options to refine your view of the map.
5. Use the filtering options on the map to view the asset types.
6. Select the asset or equipment item in the map.
7. View the status of the asset on the Details portlet.
8. Right-click the asset to display the Measurement Details dialog.

Note: If the default measurement displayed for the asset in the Details portlet is not what you
require, right-click on the asset on the Details portlet to select an associated measurement from the
list.

9. Use the scroll bar to navigate to the Historical Values section.
10. Click the Date Time (All) field on the x-axis to toggle views of historical values.

Displaying assets in a domain or zone
Use the information in this topic to display assets in a domain or area on the Map tab. By selecting a
boundary, you can get a clearer view of the assets and equipment that are displayed on a map.

Procedure
1. Log on as operator.
2. Select the Operator: Operations view.
3. View the Map tab.
4. Use the pan or zoom options to refine your view of the map.
5. Expand the Boundary data source on the filter panel and select the area to display.
6. Expand the Assets data source on the filter panel and select the data items to display (for example,

water pressure meter).
7. Use the pan or zoom options to refine your view of the data items.
8. Click the asset marker on the map to display details for a single asset in the area. The preview card

initially displays minimal and key properties. Depending on the data source, you can click for more
information and actions that are associated with an item. You can update an asset if the data source
is designed to allow an update.

242 IBM Intelligent Water: IBM Intelligent Operations for Water Product Documentation



9. Use the drill down panel to view more water asset details and reports.
10. Click the List tab to view more details about the asset.

Adding water events
Use the information in this topic to add water events on the Operator: Operations view.

Before you begin

Use the zoom and pan map controls to find the exact location on the map where the new water event has
occurred. Otherwise, you need to know the latitude and longitude coordinates of the event location
before you begin.

Procedure
1. Add a new item by using the following options:

v View the Map tab.
v Use the pan or zoom options to refine your view of the map and location for the event
v Expand the Events data source on the filter panel and select the event type to add (for example,

pipe burst).
v Click the More Actions and select New Item from the menu to display events of the type selected
v Select the new item you want to add and drag it on to the map
v Complete the Add New Item form by adding all information about the event.

2. Click Save.

Water event properties
Water events include properties for identifying the individual event, its type, and its location.

The following table outlines the properties of a water event.

Table 18. Water event properties

Label Description

Name Meaningful name to identify the event.

Start and End Start and end date and time.
Note: In IBM Intelligent Water the start and end settings in the event time filter specify the
time range within which the start date/time and end date/time value of the event must fall.
The end date/time of the filter must exceed the end date/time of the events you want
displayed on the map.

Location Geographical coordinates of the event location. (Latitude / Longitude)

Address Address

CALL_DISPOSITION Nature of call

ID Unique identifier that is used to identify the event in the water system and subsystems. The
syntax and format of the ID are specific to the organization requirements.

PRIORITY_NUMBER Detailed classification of the event, specific to the general classification.

PROBLEM Additional details and information to describe the event.

Viewing key alerts and notification messages
Use the information in this topic to understand how to view key alerts on the Operator: Operations view.
Managing alerts requires that you regularly evaluate and monitor received alerts to identify recurring
performance problems.
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About this task

Notifications provides a dynamic, interactive list of alerts that result from changing KPIs and correlated
events. For example if multiple events are happening in the same vicinity and at a similar time, there
might be a conflict that requires coordination. In a similar way, a predefined key performance indicator
(KPI) value that changes might trigger an alert where such a change is defined for notification by your
administrator.

Procedure
1. Log on as operator.
2. Select the Operator: Operations view.
3. Click Notifications to view your current alerts.
4. View the properties associated with the alert. Click the alert to view more details on the alert.

Notifying stakeholders of water network events
Use the information in this topic to understand how to notify stakeholders of water network events.

About this task

Use Contacts to collaborate with key stakeholders to manage water network events.

Procedure
1. Log on as operator.
2. Select the Operator: Operations view.
3. Click Contacts portlet to view your current contacts.
4. Use the capabilities to notify the relevant parties of water network events by sending a broadcast or

instant message.

Building a list of key contacts
Use the information in this topic to build a list of contact to collaborate with when managing water
network events.

About this task

Use Contacts to build a list of key contacts to collaborate with when managing water network events.

Procedure
1. Log on as operator.
2. Select the Operator: Operations view.
3. Click Contacts to view your current contacts.
4. Add contacts to your list.

Displaying the logical map
Use the information in this topic to monitor the semantic model in a map. The model is a real world
abstraction of the water infrastructure, assets, and measurements represented in a graph. Working with
the graph, you can explore the model and analyze integration points and impacts.

Before you begin

Before you can perform this task, you must be authenticated with the appropriate role and privileges.
You must load the model with the required OWL and RDF files.
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Procedure
1. Log on as operator.
2. Select the Operator: Operations view.
3. Select the Logical Map tab. Enter a keyword or select an alternate asset.
4. Use the filter options on the Logical Map tab to refine your view of the map. Select More Actions

and Configure to configure the data displayed in the graph
v Select from the available options to limit the scope of relationships displayed in the map.

Type instance shows relationships of type instance, for example, where Pipe 1 is an instance of
Pipe.
Contains and Contained By show the contain relationship between two assets.
Connected and Connects show the connection relationship between assets.
Has measurement shows the relationship between assets and measurements.
SubClassOf shows the class inherent relationship between two asset types.
type shows the inherent relationship between two asset types.
Has Location shows the inherent relationship between two asset locations.
Has DirectType shows the inherent relationship between two direct asset types.

v Enter a number in Limit item count to: to set the maximum number of items to display in the map.
v Enter a number in Limit impact analysis depth to: to set how deep within the layers in the map

you want to allow impact analysis to be performed.
v Select to focus your analysis on a specific asset.
v Select More Actions and Change Layout to change the layout of the graph. Select from the Force

Directed Layout, Circular Layout, Tree Layout, or Hierarchical Layout, Long Link Layout,Short
Link Layout options.

Displaying work orders
In the Supervisor: Operations view, you can display work order items.

Procedure
1. Log on to IBM Intelligent Operations for Water as Operator
2. Select the Supervisor: Operations view.
3. In the filter panel, expand the Work Orders data source category.
4. Check the items you want to display in the content panel. The options include: Corrective

Maintenance, Emergency Maintenance, Preventive Maintenance and Event Report.
5. Click one of the data items in the content panel (for example an asset). Select the More Actions

option to either create a work order or to view more details about the asset in Maximo® Asset
Management.

Executive tasks
Use the information in this topic to perform executive tasks with the solution.

Use the Executive: Status view to obtain a consolidated view of key performance indicators (KPIs) and
key events. The Executive: Status view provides a visual representation of water infrastructure and
organizational efficiency.

If you have administrator access, you can perform configuration and customization actions.
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Displaying Key Performance Indicators
Use the information in this topic to monitor the overall health of the water network. Using the heat map
on the Executive: Status view, you can monitor system health for performance categories that are
configured in your system.

Procedure
1. Log on as executive.
2. Select the Executive: Status view.
3. View the key performance indicator categories. The background color options and legends indicate

the performance status.
4. Click the key performance indicator to display information in the preview card. To display associated

child key performance indicators, select More Actions > Drill in.

Viewing Key Performance Indicator details
Use the information in this topic to get a detailed view of the health of the water network. By drilling
down on performance indicators in the heat map on the Executive: Status view, you can get a detailed
view of system health. You can expand nested Key Performance Indicators that monitor system health for
additional diagnosis.

Procedure
1. Log on as Executive.
2. Select the Executive: Status view.
3. View the Key Performance Indicator categories. The background color options and legends indicate

the performance status.
4. Click the performance indicator to view details. Select More Actions > Drill in to display associated

child performance indicators.

What to do next

Switch to the Operator: Operations view to locate the key performance indicator abnormality
geo-spatially and display it on the map. Alerts are also posted in the Notifications panel.

Note: All key performance indicators that are beyond the normal range are displayed and reported to the
Executive: Status dashboard.

Monitoring changes to Key Performance Indicators
The Notifications portlet provides a dynamic interactive list of alerts that result from changing KPIs and
correlated events.

Procedure
1. Log on as executive.
2. Select the Executive: Status view.
3. Click Notifications to view your current alerts.
4. View the properties associated with the alert by right clicking the alert.

Working with Standard Operating Procedures
The My Activities panel provides a dynamic table of open activities that are owned by the person who
logged on to the solution. Standard Operating Procedures are provided to respond to changing KPIs and
correlated events.
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Procedure
1. Log on to IBM Intelligent Operations for Water as Executive.
2. Click My Activities to view the procedural response to your current alerts. Counters are displayed for

past, present, and future activities.
3. Expand the procedure to view the steps. Click Start to begin the procedure. Click the information icon

for more information about the procedure.

Administrator tasks
If you have administrator access, you can perform administration tasks and related configuration and
customization actions.

Log on to IBM Intelligent Operations for Water as administrator, and select Administration > Solution
Administration. Within this view, refer to the topics below to use the administration consoles and
customization capabilities.
Related information:
Configuring the application
Administering the servers
System verification check tool
Configuring the solution in Intelligent Operations Center

Configuring solution applications
As administrator, you can create and manage solution applications such as Water. A solution application
is comprised of supporting applications, which provide highly extensible functionality in the user
interface. Within Solution Administration view, you can configure solution applications and supporting
applications.

Setting up solution applications
Create and manage a solution application, and install supporting applications.

Customizing a solution application

In the Application Management window, you can create and delete solution applications, such as Water.

Create select to create a solution application

Delete select an existing solution application and click Delete

In the Basics tab, you can customize the solution application by updating basic properties.

Solution Application Id unique identifier for the solution application

Name title of the solution application

Description description of the solution application

Your solution application might include one or more preinstalled supporting applications. You can add or
remove other available supporting applications. The selected supporting applications load application
pages with functionality that will display in the front-end of your solution application.

In the Basics tab, install or uninstall supporting applications.

Available supporting applications list of the supporting applications available
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Supporting applications already included list of the supporting applications included in the
solution

For detailed information about configuring solution and supporting applications, see the Configuring the
solution section of the IBM Intelligent Water product documentation.

Managing solution applications
Configure and synchronize solution applications.

Configure and synchronize your solution application

In the Application Configuration window, select a solution application to configure.

On the Pages tab, select an application page to configure. When you have selected a page, you can
configure its user interface items.

Note: In code, the user interface items are known as root level (or parent) extensions. You can configure
the child extensions and their children, not the root level extensions. For example, in the root level
extension called Content Panel, you can configure a new data location for the child extension called Map.

Select a user interface item to configure. When you select an item, you can customize it or create a new
item based on its properties. The changes you make will be displayed on the user interface.

Create select an item to extend and click Create; note that you
can configure only the child extensions and their
children, not default root level extensions.

Delete select an item to delete and click Delete

On the Model tab, you can create and manage a model to provide the data for your solution application
to consume.

The information that is described in the following table is available for each solution.

Create click to create a model

Delete select an existing model and click to delete

Also on the Model tab, you can configure the following information for each solution application.

Basics configure basic information for a model, such as prefix,
name, description, and click to synchronize model data
with the solution application database

Asset Types view information for asset types

Asset Instances configure individual asset instances

Named Areas configure named (or boundary) area on a map

On the Services tab, you can create and manage service access for user groups that use the solution
application. You can configure the following information.

Add create service access for a user group and set the type of
access: GET (read access), PUT (write access) or POST (
insertion permission).
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Edit customize service access for a user group, such as
updating the service access URL and changing the group
name.

Remove remove service access for a user group

On the User Groups tab, you can view the user groups for the solution application.

Additional tabs may be displayed depending on your installation preferences. For example, if you have
installed all applications you can configure Maximo integration, Water Conservation, and Combined
Sewer Overflow management applications.

For more information about configuring the solution, see the Configuring the solution - Configuring a
solution application section of the IBM Intelligent Water product documentation.

Managing supporting applications
Create and manage supporting applications for a solution application. You can also define the user
interface extensions required and REST API services consumed to build your supporting application. The
supporting applications are defined and their user interface items are displayed on the status views in the
IBM Intelligent Operations for Water.

Configuring supporting applications

In the Application window, you can see the supporting applications that are installed for the solution
application. Select to Create or Delete an application, or select to view the information for each existing
application.

On the Basics tab, the information that is described in the following table is available for each
application.

Name title of the application

Description description of the application

On the Services tab, the information that is described in the following table is available for each root
extension.

Name title of the application

Description description of the application

Service URL service URL path

On the Application Extensions tab, the information that is described in the following table is available
for each application.

List of Extensions the UI extensions available for the supporting application

Description of Extensions description of the selected extension, including

v Name

v Description

v Extension details

v Dojo package name and location path

v Dojo module and configuration module

v URI pattern

v Parameters
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The administration extensions provide a plug in mechanism for an application developer to extend the
solution configuration interface. The configuration dynamically creates the specified configuration tab in
the solution configuration.

On the Administration Extensions tab, the information that is described in the following table is
available for each root level extension.

Name title of the supporting application

Description description of the supporting application

Configuration Widget description of widget settings including:

v Dojo package name and location

v Dojo module

For more information about configuring the solution, see the Configuring the solution section of the IBM
Intelligent Water product documentation.

Configuring water conservation portal definitions
When you create a water conservation portal application as part of your water solution, you define the
properties for importing and configuring data ingestion. IBM Intelligent Operations for Water requires
meter, account, and billing source data for the water conservation portal component. For example, data
sources, data transmission, measurement units, and water consumption rates must be specified for the
water conservation portal.

The water conservation portal component uses multiple heterogeneous input data sources. In a typical
deployment, static and dynamic data is gathered from household or community-based water metering
infrastructure. The meter readings are captured at specified intervals and the data that is gathered is
transmitted to wireless gateways at specified intervals and uploaded to an FTP site. The data that is
gathered from the advanced metering infrastructure is the basis for fine-grained consumption analyses by
the water conservation portal and used to improve both consumption and demand management.

Data that is gathered is extracted, transformed, and loaded to a trusted data source on the data server.
The secure data is then used by the water conservation portal to produce advanced water consumption
analysis and leak alerts. Sample data is provided to help you familiarize with the process of importing
and configuring data ingestion.

Setting water conservation portal data import properties
When you define a water conservation portal application, you define properties that determine data
import. IBM Intelligent Operations for Water uses the Tivoli Directory Integrator software to facilitate the
import and configuration of meter reading and billing data

About this task

Only authorized water conservation portal administrators can configure water conservation portal data
import properties.

Procedure
1. In the Solution Administration view, click Configuration Tools > Application Configuration and

select a solution to configure.
2. On the WCP Configuration tab, click the Property file tab.
3. Sample data is included in the property file. Modify the settings in the property file for your

deployment.

250 IBM Intelligent Water: IBM Intelligent Operations for Water Product Documentation



wcp.constant.meter-reading.cubicFeet2Gal=7.48
wcp.constant.meter-reading.deltaThreshold=10000
wcp.db.jdbc.driver=com.ibm.db2.jcc.DB2Driver
wcp.db.jdbc.url=jdbc:db2://9.110.179.205:50000/WIHDB:currentSchema=WCP;
wcp.db.password=passw0rd@
wcp.db.schema=WCP
wcp.db.tablename.billing-data=BILLING
wcp.db.tablename.meter=METER
wcp.db.tablename.meter-reading-data=METERREADING
wcp.db.username=db2admin
wcp.detailed-log=false
wcp.ftp.hostname=9.110.179.205
wcp.ftp.password=passw0rd
wcp.ftp.path.billing-data=WCP/DI/billing.txt
wcp.ftp.path.meter-reading-data=WCP/DI/meterreading.txt
wcp.ftp.port=21
wcp.ftp.username=admin

4. Click Save to save settings
Related tasks:
“Configuring data ingestion for meters” on page 13
The Tivoli Directory Integrator software is used to facilitate the import and configuration of meter
reading and billing data.

Setting water conservation portal units and rate
When you define a water conservation portal application, you define properties that determine the
consumption units and conversion rates used for data imported to the portal.

About this task

Only authorized water conservation portal administrators can configure water conservation portal data
import properties.

Procedure
1. In the Solution Administration view, click Configuration Tools > Application Configuration and

select a solution to configure.
2. On the WCP Configuration tab, click the Unit and Rate tab.
3. Specify the volume setting, currency setting, and the conversion rate.
4. Click Save to save settings
Related tasks:
“Configuring data ingestion for meters” on page 13
The Tivoli Directory Integrator software is used to facilitate the import and configuration of meter
reading and billing data.

Configuring combined sewer overflow definitions
When you create an application as part of your water solution, you define the models used in the water
solution. A model has a number of characteristics that includes a representation of asset types and
instances. An asset may contain a number of measurements and values. When configuring the model,
you must also consider the values and measurements used by assets represented in the model.

IBM Intelligent Operations for Water provides a sample combined sewer overflow application. The
definitions that are provided in that application can be modified for your deployment.

Setting combined sewer overflow values
When you configure a model that contains a combined sewer overflow application, you define the
configuration values that are used by the application. Combined server overflow configuration values
determine for example warnings, overflows, gauge types, measurements types, flow rates.
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About this task

Only authorized administrators can configure sewer overflow model properties.

Procedure
1. In the Solution Administration view, click Configuration Tools > Application Configuration and

select a solution to configure.
2. On the CSO Configuration tab, select the model and expand CSO Config values .
3. Select a value to configure and modify the value and description as required for your deployment.
4. Click Save to save settings

Setting combined sewer overflow measurements
When you configure a model that contains a combined sewer overflow application, you define the
configuration measurements that are used by the application. Combined server overflow configuration
measurements determine for example level indicators, weir heights, and formula used.

About this task

Only authorized administrators can configure sewer overflow model properties.

Procedure
1. In the Solution Administration view, click Configuration Tools > Application Configuration and

select a solution to configure.
2. On the CSO Configuration tab, select the model and expand CSO Measurement configuration .
3. Select a measurement to configure and modify the weir height and equation as required for your

deployment.
4. Click Save to save settings

Setting combined sewer overflow plant measurements
When you configure a model that contains a combined sewer overflow application, you define the plant
measurements that are used by the application. All measurements for use in a waste water treatment
plant for example may be modified for your deployment.

About this task

Only authorized administrators can configure sewer overflow model properties.

Procedure
1. In the Solution Administration view, click Configuration Tools > Application Configuration and

select a solution to configure.
2. On the CSO Configuration tab, select the model and expand Plant .
3. Select a plant to configure and modify the measurements as required for your deployment.
4. Click Save to save settings
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Chapter 11. Troubleshooting and support

To isolate and resolve problems with your IBM products, you can use the troubleshooting and support
information. This information contains instructions for using the problem-determination resources that are
provided with your IBM products, including the products from the IBM Intelligent Water Family of
solutions.

Techniques for troubleshooting problems
Troubleshooting is a systematic approach to solving a problem. The goal of troubleshooting is to determine
why something does not work as expected and how to resolve the problem. Certain common techniques
can help with the task of troubleshooting.

The first step in the troubleshooting process is to describe the problem completely. Problem descriptions
help you and the IBM technical-support representative know where to start to find the cause of the
problem. This step includes asking yourself basic questions:
v What are the symptoms of the problem?
v Where does the problem occur?
v When does the problem occur?
v Under which conditions does the problem occur?
v Can the problem be reproduced?

The answers to these questions typically lead to a good description of the problem, which can then lead
you to a problem resolution.

What are the symptoms of the problem?

When starting to describe a problem, the most obvious question is “What is the problem?” This question
might seem straightforward; however, you can break it down into several more-focused questions that
create a more descriptive picture of the problem. These questions can include:
v Who, or what, is reporting the problem?
v What are the error codes and messages?
v How does the system fail? For example, is it a loop, hang, crash, performance degradation, or incorrect

result?

Where does the problem occur?

Determining where the problem originates is not always easy, but it is one of the most important steps in
resolving a problem. Many layers of technology can exist between the reporting and failing components.
Networks, disks, and drivers are only a few of the components to consider when you are investigating
problems.

The following questions help you to focus on where the problem occurs to isolate the problem layer:
v Is the problem specific to one platform or operating system, or is it common across multiple platforms

or operating systems?
v Is the current environment and configuration supported?
v Do all users have the problem?
v (For multi-site installations.) Do all sites have the problem?
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If one layer reports the problem, the problem does not necessarily originate in that layer. Part of
identifying where a problem originates is understanding the environment in which it exists. Take some
time to completely describe the problem environment, including the operating system and version, all
corresponding software and versions, and hardware information. Confirm that you are running within an
environment that is a supported configuration; many problems can be traced back to incompatible levels
of software that are not intended to run together or have not been fully tested together.

When does the problem occur?

Develop a detailed timeline of events leading up to a failure, especially for those cases that are one-time
occurrences. You can most easily develop a timeline by working backward: Start at the time an error was
reported (as precisely as possible, even down to the millisecond), and work backward through the
available logs and information. Typically, you need to look only as far as the first suspicious event that
you find in a diagnostic log.

To develop a detailed timeline of events, answer these questions:
v Does the problem happen only at a certain time of day or night?
v How often does the problem happen?
v What sequence of events leads up to the time that the problem is reported?
v Does the problem happen after an environment change, such as upgrading or installing software or

hardware?

Responding to these types of questions can give you a frame of reference in which to investigate the
problem.

Under which conditions does the problem occur?

Knowing which systems and applications are running at the time that a problem occurs is an important
part of troubleshooting. These questions about your environment can help you to identify the root cause
of the problem:
v Does the problem always occur when the same task is being performed?
v Does a certain sequence of events need to happen for the problem to occur?
v Do any other applications fail at the same time?

Answering these types of questions can help you explain the environment in which the problem occurs
and correlate any dependencies. Remember that just because multiple problems might have occurred
around the same time, the problems are not necessarily related.

Can the problem be reproduced?

From a troubleshooting standpoint, the ideal problem is one that can be reproduced. Typically, when a
problem can be reproduced you have a larger set of tools or procedures at your disposal to help you
investigate. Consequently, problems that you can reproduce are often easier to debug and solve.

However, problems that you can reproduce can have a disadvantage: If the problem is of significant
business impact, you do not want it to recur. If possible, re-create the problem in a test or development
environment, which typically offers you more flexibility and control during your investigation.
v Can the problem be re-created on a test system?
v Are multiple users or applications encountering the same type of problem?
v Can the problem be re-created by running a single command, a set of commands, or a particular

application?
Related tasks:
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“Searching knowledge bases”
You can often find solutions to problems by searching IBM knowledge bases. You can optimize your
results by using available resources, support tools, and search methods.

Searching knowledge bases
You can often find solutions to problems by searching IBM knowledge bases. You can optimize your
results by using available resources, support tools, and search methods.

About this task

You can find useful information by searching the information center for IBM Intelligent Operations for
Water. However, sometimes you need to look beyond the information center to answer your questions or
resolve problems.

Procedure

To search knowledge bases for information that you need, use one or more of the following approaches:
v Find the content that you need by using the IBM Support Portal.

The IBM Support Portal is a unified, centralized view of all technical support tools and information for
all IBM systems, software, and services. The IBM Support Portal lets you access the IBM electronic
support portfolio from one place. You can tailor the pages to focus on the information and resources
that you need for problem prevention and faster problem resolution. Familiarize yourself with the IBM
Support Portal by viewing the demo videos (https://www.ibm.com/blogs/SPNA/entry/
the_ibm_support_portal_videos) about this tool. These videos introduce you to the IBM Support Portal,
explore troubleshooting and other resources, and demonstrate how you can tailor the page by moving,
adding, and deleting portlets.

v Search for content about IBM Intelligent Operations for Water by using one of the following additional
technical resources:
– IBM Intelligent Water Support Portal page
– IBM Intelligent Water system requirements

v Search for content by using the IBM masthead search. You can use the IBM masthead search by typing
your search string into the Search field at the top of any ibm.com page.

v Search for content by using any external search engine, such as Google, Yahoo, or Bing. If you use an
external search engine, your results are more likely to include information that is outside the ibm.com
domain. However, sometimes you can find useful problem-solving information about IBM products in
newsgroups, forums, and blogs that are not on ibm.com.

Tip: Include “IBM” and the name of the product in your search if you are looking for information
about an IBM product.

Related concepts:
“Techniques for troubleshooting problems” on page 253
Troubleshooting is a systematic approach to solving a problem. The goal of troubleshooting is to determine
why something does not work as expected and how to resolve the problem. Certain common techniques
can help with the task of troubleshooting.

Getting fixes from Fix Central
You can use Fix Central to find the fixes that are recommended by IBM Support for a variety of products,
including IBM Intelligent Operations for Water. With Fix Central, you can search, select, order, and
download fixes for your system with a choice of delivery options. A product fix for IBM Intelligent
Operations for Water might be available to resolve your problem.
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Procedure

To find and install fixes:
1. Obtain the tools that are required to get the fix. If it is not installed, obtain your product update

installer. You can download the installer from Fix Central. This site provides download, installation,
and configuration instructions for the update installer.

2. Select IBM Intelligent Operations for Water as the product, and select one or more check boxes that
are relevant to the problem that you want to resolve.

3. Identify and select the fix that is required.
4. Download the fix.

a. Open the download document and follow the link in the “Download Package” section.
b. When downloading the file, ensure that the name of the maintenance file is not changed. This

change might be intentional, or it might be an inadvertent change that is caused by certain web
browsers or download utilities.

5. To apply the fix, follow the instructions in the "Installation Instructions" section of the download
document.

6. Optional: Subscribe to receive weekly email notifications about fixes and other IBM Support updates.
Related tasks:
“Subscribing to Support updates” on page 258
To stay informed of important information about the IBM products that you use, you can subscribe to
updates.

Contacting IBM Support
IBM Support provides assistance with product defects, answers to FAQs, and helps users resolve
problems with the product.

Before you begin

After trying to find your answer or solution by using other self-help options such as technotes, you can
contact IBM Support. Before contacting IBM Support, your company or organization must have an active
IBM software subscription and support contract, and you must be authorized to submit problems to IBM.
For information about the types of available support, see the Support portfolio topic in the Software
Support Handbook.

Procedure

To contact IBM Support about a problem:
1. Define the problem, gather background information, and determine the severity of the problem. For

more information, see the Getting IBM support topic in the Software Support Handbook.
2. Gather diagnostic information.
3. Submit the problem to IBM Support in one of the following ways:

v Online through the IBM Support Portal: You can open, update, and view all of your service
requests from the Service Request portlet on the Service Request page.

v By phone: For the phone number to call in your region, see the Directory of worldwide contacts
web page.

Results

If the problem that you submit is for a software defect or for missing or inaccurate documentation, IBM
Support creates an Authorized Program Analysis Report (APAR). The APAR describes the problem in
detail. Whenever possible, IBM Support provides a workaround that you can implement until the APAR
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is resolved and a fix is delivered. IBM publishes resolved APARs on the IBM Support website daily, so
that other users who experience the same problem can benefit from the same resolution.
Related concepts:
“Known problems and solutions” on page 259
Some common problems with IBM Intelligent Operations for Water are documented, along with their
solutions or workarounds. If you have a problem with IBM Intelligent Operations for Water, review the
problem-solution topics to determine if a solution is available to the problem that you are experiencing.
The problem-solution topics are categorized according to the type of issue.
Related tasks:
“Exchanging information with IBM”
To diagnose or identify a problem, you might need to provide IBM Support with data and information
from your system. In other cases, IBM Support might provide you with tools or utilities to use for
problem determination.

Exchanging information with IBM
To diagnose or identify a problem, you might need to provide IBM Support with data and information
from your system. In other cases, IBM Support might provide you with tools or utilities to use for
problem determination.
Related tasks:
“Contacting IBM Support” on page 256
IBM Support provides assistance with product defects, answers to FAQs, and helps users resolve
problems with the product.

Sending information to IBM Support
To reduce the time that is required to resolve your problem, you can send trace and diagnostic
information to IBM Support.

Procedure

To submit diagnostic information to IBM Support:
1. Open a problem management record (PMR).
2. Collect the diagnostic data that you need. Diagnostic data helps reduce the time that it takes to

resolve your PMR. You can collect the diagnostic data manually or automatically:
v Collect the data manually.
v Collect the data automatically.

3. Compress the files by using the .zip or .tar file format.
4. Transfer the files to IBM. You can use one of the following methods to transfer the files to IBM:

v The Service Request tool
v Standard data upload methods: FTP, HTTP
v Secure data upload methods: FTPS, SFTP, HTTPS
v Email
All of these data exchange methods are explained on the IBM Support website.

Receiving information from IBM Support
Occasionally an IBM technical-support representative might ask you to download diagnostic tools or
other files. You can use FTP to download these files.
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Before you begin

Ensure that your IBM technical-support representative provided you with the preferred server to use for
downloading the files and the exact directory and file names to access.

Procedure

To download files from IBM Support:
1. Use FTP to connect to the site that your IBM technical-support representative provided and log on as

anonymous. Use your email address as the password.
2. Change to the appropriate directory:

a. Change to the /fromibm directory.
cd fromibm

b. Change to the directory that your IBM technical-support representative provided.
cd nameofdirectory

3. Enable binary mode for your session.
binary

4. Use the get command to download the file that your IBM technical-support representative specified.
get filename.extension

5. End your FTP session.
quit

Subscribing to Support updates
To stay informed of important information about the IBM products that you use, you can subscribe to
updates.

About this task

By subscribing to receive updates about IBM Intelligent Operations for Water, you can receive important
technical information and updates for specific IBM Support tools and resources. You can subscribe to
updates by using one of two approaches:

RSS feeds and social media subscriptions
The following RSS feed is available for IBM Intelligent Operations for Water: IBM Intelligent
Water RSS feed

For general information about RSS, including steps for getting started and a list of RSS-enabled
IBM web pages, visit the IBM Software Support RSS feeds site.

My Notifications
With My Notifications, you can subscribe to Support updates for any IBM product. (My
Notifications replaces My Support, which is a similar tool that you might have used in the past.)
With My Notifications, you can specify that you want to receive daily or weekly email
announcements. You can specify what type of information you want to receive (such as
publications, hints and tips, product flashes (also known as alerts), downloads, and drivers). My
Notifications enables you to customize and categorize the products about which you want to be
informed and the delivery methods that best suit your needs.

Procedure

To subscribe to Support updates:
1. To subscribe to the IBM Intelligent Operations for Water RSS feed, use the following substeps:

a. Open the link: IBM Intelligent Water RSS feed.
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b. In the Subscribe with Live Bookmark window, select a folder in which to save the RSS feed
bookmark and click Subscribe.

For more information on subscribing to RSS feeds, see the IBM Software Support RSS feeds link in the
Related information section at the end of the topic.

2. Subscribe to My Notifications by going to the IBM Support Portal and click My Notifications in the
Notifications portlet.

3. Sign in using your IBM ID and password, and click Submit.
4. Identify what and how you want to receive updates.

a. Click the Subscribe tab.
b. Select IBM Intelligent Water RSS feed and click Continue.
c. Select your preferences for how to receive updates, whether by email, online in a designated

folder, or as an RSS or Atom feed.
d. Select the types of documentation updates that you want to receive, for example, new information

about product downloads and discussion group comments.
e. Click Submit.

Results

Until you modify your RSS feeds and My Notifications preferences, you receive notifications of updates
that you have requested. You can modify your preferences when needed (for example, if you stop using
one product and begin using another product).
Related tasks:
“Getting fixes from Fix Central” on page 255
You can use Fix Central to find the fixes that are recommended by IBM Support for a variety of products,
including IBM Intelligent Operations for Water. With Fix Central, you can search, select, order, and
download fixes for your system with a choice of delivery options. A product fix for IBM Intelligent
Operations for Water might be available to resolve your problem.

Related information

IBM Software Support RSS feeds

Subscribe to My Notifications support content updates

My Notifications for IBM technical support

My Notifications for IBM technical support overview

Known problems and solutions
Some common problems with IBM Intelligent Operations for Water are documented, along with their
solutions or workarounds. If you have a problem with IBM Intelligent Operations for Water, review the
problem-solution topics to determine if a solution is available to the problem that you are experiencing.
The problem-solution topics are categorized according to the type of issue.

Cannot reinstall custom KPI model on the application server

If you cannot reinstall a custom key performance indicator (KPI) model on the application server,
uninstall the monitor models and data and then reinstall the models. For information about uninstalling a
single version of a monitor model, see the related task.
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No message is displayed when using the command line to install IBM Intelligent
Operations for Water 1.5 on top of an existing IBM Intelligent Operations for Water
deployment

Because IBM Intelligent Operations for Water is already installed, the status of all components in the
topology files is ready. Therefore, no messages from the new installation are displayed. This behavior
differs from the graphical user interface (GUI) installation, which allows separate checking to determine if
the solution is already installed.

After an IBM Installation Manager installation failed, the reinstallation attempt also
fails

If, after an IBM Installation Manager installation of IBM Intelligent Operations for Water fails and you
manually fix a problem and want to continue the installation, run the command-line installer. See the
related task for more information.

If the IBM Installation Manager installation failed because you manually canceled the IBM Installation
Manager, use the command line to continue the installation.

After a command-line installation failed, the reinstallation attempt also fails

Check the log file for a message similar to the following:
Command failed: The following error occurred while executing this line:
/opt/IBM/IOC/BA/ioc/spec/SOLUTION/portal_content/build.xml:16:
Command failed with code 1

If you want more detailed operation messages, please check
/opt/IBM/IOC/BA/ioc/log/installSolution_water_wih...log

Review the problem details and attempt to manually fix the problem. Then use the command line to
continue the installation.

If problems persist, you can take one of the following actions:
v Recover the system to the IBM Intelligent Operations Center status and then reinstall IBM Intelligent

Operations for Water.
v Contact IBM Support for help. See the related task.

The launchpad shows an authentication rejected error

This issue is environmental and not launchpad-specific. No method is currently available to suppress the
error message, but the functionality or display of the launchpad is not affected. This issue is being
addressed.

After clicking Sign in at http://app-ioc.cn.ibm.com, the following message
appears: Access Manager WebSEAL could not complete your request due to an
unexpected error.

Ensure that the amount of free disk space on the servers is sufficient.

Nothing happens when I select Add Event from the map in the IBM Intelligent
Operations for Water portal

This issue is being addressed. Until it is resolved, go to Citywide > Operator to create the event.
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After setting up the new IBM Intelligent Operations for Water 1.5 and trying to log
on through Tivoli Access Manager WebSEAL, the following message appears:
Third-party server not responding.

The portal server and the Tivoli Service Request Manager® server did not start properly. The Tivoli
Service Request Manager port conflict issue is resolved.

When I send a .csv file to the simulator in the app-ioc host, two messages with the
same title and time are displayed in My Activities portlet

Another simulator process is running on either a PuTTY or VNC client. Stop that process.

An activity does not appear in My Activities portlet, as specified in the standard
operating procedure policy, even though the Tivoli Service Request Manager
service displays as ON in the IOCControl.sh script for services status

Log on to https://event_server: :9044/ibm/console/ and restart the MXServer, or start the MXServer if
it is not running. Select Servers > Application servers > MXServer. To verify that the Tivoli Service
Request Manager cluster is running, select Servers > Clusters > TSRMCluster. If the cluster is running,
you see a green icon.
Related tasks:
“Contacting IBM Support” on page 256
IBM Support provides assistance with product defects, answers to FAQs, and helps users resolve
problems with the product.
“Deploying the solution manually” on page 8
Use the command line utility to deploy the IBM Intelligent Operations for Water solution.

Problem starting the simulator when the property file is updated with a
new JMS Queue
When you create a new JMS Queue in the Portal Server, you must update the target.queue parameter in
the simulator.properties file with a new JMS Queue. An error may be displayed in the simulator.log
file when you attempt to start the simulator. You must restart the Portal Server before you start the
simulator.

Procedure
1. Log on to WebSphere Application Server at the following URL:

https://appserver:9043/ibm/console

2. Select Servers > Clusters > WebSphere Application Server clusters.
3. Select the PortalCluster.
4. Click Stop and wait until the red icon is displayed.
5. Click Start and wait until the green icon is displayed.
6. Log off WebSphere Application Server and run the command to start the simulator.

#nohup ./run_simulator.sh > simulator.log &

Cannot select IBM Intelligent Operations for Water assets from the
Categories menu
If you cannot select IBM Intelligent Operations for Water assets from the Categories menu, check the
status of the DB2 server.
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Procedure
1. Log on to the management server as ibmadmin.
2. Type the following command:

su – ibmadmin
cd /opt/IBM/ISP/mgmt/scripts
./iopmgmt.sh status db24po topology_password

If the portal is running, you see a message similar to the following:
Executing query command....completed.
IBM DB2 Enterprise server for WebSphere Portal Extend [ on ]
Command completed successfully.

3. If the DB2 server is not running, type ./iopmgmt.sh start db24pe topology_password

Note: To check the status of all DB2 instances, type ./iopmgmt.sh status all topology_password.

Authentication mechanism not available
If you receive the HPDIA0119W Authentication mechanism is not available error message after you log
on to the WebSphere Portal, check the status of the Tivoli Directory Server and the Tivoli Directory Server
Proxy for the application server.

Procedure
1. Log on to the management server as ibmadmin and type the following commands:

su – ibmadmin
cd /opt/IBM/ISP/mgmt/scripts
./iopmgmt.sh status tds topology_password

If the server is running, a message similar to the following example is displayed:
Executing query command.....completed.
IBM Tivoli Directory Server [ on ]
Command completed successfully.

2. If the server is not running, type./iopmgmt.sh start tds topology_password

3. If the server is not running after you complete Steps 1 and 2, log on to the management server as
ibmadmin and type the following commands:
su – ibmadmin
cd /opt/IBM/ISP/mgmt/scripts
./iopmgmt.sh status tdspxyapp topology_password

If the server is running, a message similar to the following example is displayed:
Executing query command.....completed.
IBM Tivoli Directory Server [ on ]
Command completed successfully.

4. If the server is not running, type ./iopmgmt.sh start tdspxyapptopology_password

Third-party server not responding
If you receive the Third-party server not responding error message after you log on to theWebSphere
Portal portal, check the status of the WebSphere Portal.

Procedure
1. Log on to the management server as ibmadmin and type the following command:

su – ibmadmin
cd /opt/IBM/ISP/mgmt/scripts
./iopmgmt.sh status wpe topology_password

If the portal is running, a message similar to the following is displayed:
Executing query command.....completed.
IBM WebSphere Portal Extend [ on ]
Command completed successfully.
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2. If the portal is not running, type ./iopmgmt.sh start wpe topology_password.

Problem installing the model manager component
If an error is displayed stating the installation of the model manager on the host has failed
(CIYBA0241E), complete the steps in this topic.

Procedure
1. Check the error description in the log file at /opt/IBM/IOC/BA/ioc/log.
2. If the following message is displayed, you must restart the IBM Integrated Information Core model

server and resume installation:
<Operation failed:CDIMS0164E A failure occurred while parsing the RDF file. Content is not

allowed in prolog.
Fail to import rdf file: content/model/sensorMeter.rdf
[ERROR][line 31] Install Model Manager Content Failed.>

a. Go to the management server and open a terminal session. Restart the model server.
su - ibmadmin
cd /opt/IBM/ISP/mgmt/scripts/
./iopmgmt.sh stop smsclt passw0rd
./iopmgmt.sh stop smsdaaq passw0rd
./iopmgmt.sh stop smsmdl passw0rd
./iopmgmt.sh stop smsmgmt passw0rd
./iopmgmt.sh stop smsrtc passw0rd
./iopmgmt.sh start smsclt passw0rd
./iopmgmt.sh start smsdaaq passw0rd
./iopmgmt.sh start smsmdl passw0rd
./iopmgmt.sh start smsmgmt passw0rd
./iopmgmt.sh start smsrtc passw0rd

b. Go to the terminal where you ran the install command on the installation server. Run the install
command again.
cd /opt/IBM/IOC/BA/ioc/bin ./ba.sh intallSolution -s water_wih -p passw0rd

Cannot access portal
If you cannot access the portal at http://portal_URL/wpsv70/wps/myportal, check the status of the
Tivoli Access Manager WebSEAL.

Procedure
1. Log on to the application server as root and type pd_start status. The status of the Tivoli Access

Manager WebSEAL is displayed. If the Tivoli Access Manager WebSEAL is not running, type pd_start
start to start the Tivoli Access Manager WebSEAL server.

2. You can also check the Tivoli Access Manager WebSEAL status by logging on to the management
server as ibmadmin and typing the following command:
su – ibmadmin
cd /opt/IBM/ISP/mgmt/scripts
./iopmgmt.sh status tamweb topology_password

If the server is running, you see a message similar to the following:
Executing query command.....completed.
IBM Tivoli Access Manager WebSEAL [ on ]
Command completed successfully.

If the status is [ off ], type ./iopmgmt.sh start tamweb topology_password.

Authentication failed
If you receive an error 403: authenticationFailed message after you log on to the portal, check the
status of the Tivoli authorization server and the Tivoli Access Manager policy server.
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Procedure
1. Log on to the management server as root and type pd_start status. You see results similar to the

following. Ensure that the status of each component is yes.
Tivoli Access Manager servers
Server Enabled Running
-------------------------------------------
pdmgrd yes yes
pdacld yes yes
pdmgrproxyd no no

Note: pdmgrd refers to the Tivoli authorization server, and pdacld refers to the Tivoli Access Manager
policy server.
If the Tivoli authorization server and the Tivoli Access Manager policy server are not running, type
pd_start start.

2. You can also check the status of the Tivoli authorization server and the Tivoli Access Manager policy
server by typing the following commands on the management server:
./iopmgmt.sh status tamas topology_password

If the Tivoli authorization server is running, you see a message similar to the following:
Executing query command...completed.
IBM Tivoli Access Manager Authorization Server [ on ]
Command completed successfully.

su – ibmadmin
cd /opt/IBM/ISP/mgmt/scripts
./iopmgmt.sh status tamps topology_password

If the Tivoli Access Manager policy server is running, you see a message similar to the following:
Executing query command...completed.
IBM Tivoli Access Manager Policy Server [ on ]
Command completed successfully.

If the Tivoli authorization server is not running, type ./iopmgmt.sh start tamas topology_password.

If the Tivoli Access Manager policy server is not running, type ./iopmgmt.sh start tamps
topology_password.

Cannot access IBM Cognos Business Intelligence reports, and receive
error message
If you cannot access IBM Cognos Business Intelligence reports and you receive An error occurred while
retrieving content error message, check the status of IBM Cognos Business Intelligence.

Procedure
1. Log on to the management server as ibmadmin and type the following command:

su – ibmadmin
cd /opt/IBM/ISP/mgmt/scripts
./iopmgmt.sh status cognos topology_password

If IBM Cognos Business Intelligence is running, you see a message similar to the following:
Executing query command...completed.
IBM COGNOS Business Intelligence [ on ]
Command completed successfully.

2. If IBM Cognos Business Intelligence is not running, type ./iopmgmt.sh start cognos
topology_password.

KPIs are not triggered
If Key Performance Indicators (KPIs) are not triggered, check the status of the WebSphere Message
Broker.
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Procedure
1. Log on to the management server as ibmadmin and type the following command:

su – ibmadmin
cd /opt/IBM/ISP/mgmt/scripts
./iopmgmt.sh status wmb topology_password

If WebSphere Message Broker is running, you see a message similar to the following:
Executing query command....completed.
IBM WebSphere Message Broker [ on ]
Command completed successfully.

2. If WebSphere Message Broker is not running, type ./iopmgmt.sh start wmb topology_password.

Measurements in the user interface are not changing
If you know the queue manager and broker are started, are running the simulator, and are trying to
simulate measurements, but you do not see the measurements changing in the user interface, check the
status of the IBM Intelligent Operations Center XML probe and the IBM Intelligent Operations for Water
XML probe.

Procedure
1. Log on to the event server as root and check the status of the water_wih Tivoli Netcool/OMNIbus

probe and the ioc_xml Tivoli Netcool/OMNIbus probe. Type the following commands:
ps auxww |grep water_wih
ps auxww |grep ioc_xml

Note: If you cannot log on to the event server as root, log on as an administrator and use the sudo
command to issue the required commands.

2. If no processes are running, you must manually start the probes.
a. To start the ioc_xml probe, type the following command:

/opt/IBM/netcool/omnibus/probes/nco_p_xml -name ioc_xml -propsfile
/opt/IBM/netcool/omnibus/probes/linux2x86/ioc_xml.props &

b. To start the water_wih probe, type the following command:
/opt/IBM/iss/iow/omnibus/startXmlProbe.sh

Measurements are changing but KPIs and standard operating
procedures are not triggered
If measurements in the user interface are changing but Key Performance Indicators (KPIs) and standard
operating procedures do not seem to be triggering, check your Tivoli Service Request Manager password.

Procedure
1. Log on to the Tivoli Netcool/Impact administrative console at http://event_host:9080/nci/main

where event_host is the host name of the event server. Log on as the admin user with the netcool
password.

2. Click IOC Project.
3. In the Policies section, double-click the policy IOC_Sample_Password_Encoder. The policy is

opened in the Policy Editor window.
4. In the Enter Password Here field, enter the password for Maxadmin.
5. To save the policy, click Save.
6. Click the Trigger Policy icon.
7. Click Execute.
8. In the Service Status section, scroll to PolicyLogger, click View log for PolicyLogger (icon with the

down arrow).
9. In the policy logger window, locate the statement that is similar to the following statement:
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11 May 2012 14:19:12,260: [IOC_Sample_Password_Encoder][pool-1-thread-46]Parser log: {aes}FF877B74ADF4DF1C2002F94ACB38FAFF

10. Copy the encrypted Maxadmin password from the statement, for example:
{aes}FF877B74ADF4DF1C2002F94ACB38FAFF

11. In the Tivoli Netcool/Impact administrative console, in the Policies section, double-click the policy
UTILS_LIBRARY_IOC_TSRM. The policy is opened in the Policy Editor window.

12. Replace the value of MAXAdminPassword with the encrypted value that you copied in Step 10:
MAXAdminPassword = "{aes}FF877B74ADF4DF1C2002F94ACB38FAFF";

13. Click Save.
14. Return to the policy IOC_Sample_Password_Encoder that you accessed in Step 3 on page 265 and

remove your unencoded password.
You can leave the field blank or you can type a text string.

Important: Ensure that the string does not contain any spaces. Check for spaces at the beginning
and end of the string.

KPIs are displayed incorrectly in the views
If Key Performance Indicators (KPIs) are not displayed correctly in the views, ensure that the WebSphere
Business Monitor is running on the environment.

Procedure
1. Run the system verification check tool to verify the operational status of services.

a. Log on to IBM Intelligent Operations Center as a user with administrator authority.
b. Click Administration > Solution Administration

c. Click System Administration > System Verification Check and run the required tests.
2. Use the platform control tool to start the components. To start only one component, run the following

command.
IOCControl -a start -c component -p password

3. Reload the view to ensure that the KPIs are displayed correctly.

Water Administrator cannot access the Citizen: Water Conservation
view
Users that have been solely assigned the Water Administrator role cannot access the Citizen View portlet
on the Citizen: Water Conservation view. To create access for the users, you must assign the System
Administrator role to them by creating a user record in the WCP.ACCOUNT table of the Water
Conservation Portal database.

Procedure
1. Log on to the server as root and type the following command: cd /opt/IBM/iss/iow/wcp
2. Open the account.csv file and append the user information for the user(s) assigned the Water

Administration role. Ensure that the user information corresponds to the following columns in the
account table: ACCOUNT_ID (NOT NULL), ADDRESS, CITY, STATE, ZIPCODE, TYPE, EMAIL,
ROLE (NOT NULL), CLASSIFICATION. Example user information is as follows: "eharper",
"unknown", " ", "FL", "33111", "na", "eharper@cityname.com", "uadmin", "unknown".

Note: The ACCOUNT_ID is unique and that ROLE for an account is "uadmin" and "PM". The "uadmin"
role is system administrator for WCP. With this role, the user can interact with the content of the Citizen
View portlet on the Citizen: Water Conservation view, including all households and meters content.
3. Run import_users.sh to import the users. The importing tool performs validation on the new data and

will import the validated user information.
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Cannot load asset details in Maximo
A connection timeout or similar issue can occur when you try to load asset details from Maximo in IBM
Intelligent Operations for Water. To resolve the issue, first ensure that you have access to the HTTP port
of the Maximo server. Second, ensure that the Maximo server host name / IP address is defined in the
operating system on which you run your browser.

About this task

The error can occur in the Operator: Operations view, when you right-click an asset in the Details grid
and click the View [Key Measurement] Details option.

Procedure
1. Ensure that you have access to the HTTP port (default 80) of the external Maximo Server.
2. Add the line [maximo_ip] [maximo_hostname] to the hosts file in the operating system where the

browser is running. The hosts file names are as follows:
a. Linux system: /etc/hosts
b. Windows system: C:\WINDOWS\system32\drivers\etc\hosts

Troubleshooting installation problems
These topics can help you solve common installation problems such as application errors, failure to create
the configuration database, and difficulty installing on multiple servers.

The installation of the solution failed
If the install command did not complete successfully, you must check several settings and rerun the
install command.

Proceed as follows:
1. Check that the model manager is operational.
2. Ensure all the steps in the guide are completed.

Problem installing the model manager component
If an error is displayed stating the installation of the model manager on the host has failed
(CIYBA0241E), complete the steps in this topic.

Procedure
1. Check the error description in the log file at /opt/IBM/IOC/BA/ioc/log.
2. If the following message is displayed, you must restart the IBM Integrated Information Core model

server and resume installation:
<Operation failed:CDIMS0164E A failure occurred while parsing the RDF file. Content is not

allowed in prolog.
Fail to import rdf file: content/model/sensorMeter.rdf
[ERROR][line 31] Install Model Manager Content Failed.>

a. Go to the management server and open a terminal session. Restart the model server.
su - ibmadmin
cd /opt/IBM/ISP/mgmt/scripts/
./iopmgmt.sh stop smsclt passw0rd
./iopmgmt.sh stop smsdaaq passw0rd
./iopmgmt.sh stop smsmdl passw0rd
./iopmgmt.sh stop smsmgmt passw0rd
./iopmgmt.sh stop smsrtc passw0rd
./iopmgmt.sh start smsclt passw0rd
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./iopmgmt.sh start smsdaaq passw0rd

./iopmgmt.sh start smsmdl passw0rd

./iopmgmt.sh start smsmgmt passw0rd

./iopmgmt.sh start smsrtc passw0rd

b. Go to the terminal where you ran the install command on the installation server. Run the install
command again.
cd /opt/IBM/IOC/BA/ioc/bin ./ba.sh intallSolution -s water_wih -p passw0rd

Troubleshooting migration problems
These topics can help you solve common migration problems such as ...

Report data migration from an earlier version failed
If the report data migration did not complete successfully, you must check several settings and rerun the
install command.

Proceed as follows:
1. Check dojo settings.
2. Ensure Cognos data is available.

Troubleshooting configuration problems
These topics can help you solve common configuration problems.

Synchronizing the semantic model with the database failed
If the synchronizing of model data did not complete successfully, you must check several settings and
rerun the install command.

Proceed as follows:
1. Use the administrative interface options to perform this task.

Delayed response to a SPARQL query of the model
When you run a SPARQL query on a large model, there may be a delayed or no response in the IBM
Integrated Information Core administrative console.

Diagnosis and resolution

Check the systemOut.log file on the application server at /opt/IBM/WebSphere/AppServer/profiles/
iic_profile/logs/IICServer/SystemOut.log for a time out message. If there is a time out, an
informational message similar to the following may be displayed.
TimeoutManage I WTRN0124I: When the timeout occurred the thread with which the transaction is,
or was most recently, associated was Thread[WebContainer : 2,5,main].
The stack trace of this thread when the timeout occurred was:..

Because the RDF store for IIC model manager is implemented as a regular database (IICRDFDB), unlike
the Jena implementation, some standard maintenance needs to be carried out to ensure SPARQL query
performance is optimized.
1. If you have recently loaded a model into the RDF store it is recommended that you defragment the

tablespaces (REORG) and update statistics (RUNSTATS) for each table in the IIC RDF store
(IICRDFDB). This task can be performed using IBM Data Studio client, which is installed on the data
server server. If the timeout issue persists, proceed to the following steps to resolve the issue.

2. Log on to the WebSphere Application Server administrative console.
3. Go to Application servers > IICServer > Transaction server > Total transaction lifetime timeout
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4. Change the value for Maximum transaction timeout from 120 to 600.
5. Rerun the SPARQL query.

Out of memory error when loading a large model
While loading a large model, you may get an our of memory error.

Diagnosis and resolution

An error message similar to the following may be displayed.
JVMDUMP006I Processing dump event "systhrow",
detail "java/lang/OutOfMemoryError" - please wait..

To resolve the issue:
1. Log on to the data server.
2. Use the iicmodelloader.sh script to load the model.
3. If you still have issues, complete the following steps.

v Edit the inferload.sh file.
v Update the memory to a larger value. For example

java –Xmx9216M com.ibm.iss.iic.model.server.db2rdf.util.ModelReasoner $args and
java –Xmx9216M com.ibm.rdf.store.cmd.LoadRdfStore $args

Unexpected response to a query after loading a model
After loading a large model, and running a SPARQL query, you may get an unexpected response.

Diagnosis and resolution

You may receive an unexpected response after loading a model using the iicmodelloader script. The
problem may be that the cache needs to be cleared as the unexpected query results are sourced in the
cache. To clear the cache, start the IBM Integrated Information Core administrative console and enter the
command clearcache in your SPARQL query.

Troubleshooting problems during use
These topics can help you solve common problems during use.

Performance issues and slow system response to actions
If you are experiencing performance problems, you must check several settings.

Proceed as follows:
1. Refer to the performance improvement hints and tips documented in the information center.
Related concepts:
“Tuning performance” on page 215
After you complete installation of the product you can enhance the performance of the product and
configure for scalability.

Security errors in console when loading the Supervisor:Operations
view
When loading the Supervisor:Operations view in the Microsoft Internet Explorer browser, HTTPS security
errors may be shown in the console logs. This is a known issue with Internet Explorer and requires
installation of updated software that is available from the Microsoft support page.
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Procedure
1. Go to the Microsoft support website at http://update.microsoft.com and install the most recent

cumulative software.
2. Updated software to address this known issue is available at: http://support.microsoft.com/kb/

2601307/en-us?sd=rss&spid=15672.

Errors in the Firebug console when loading the Supervisor:Operations
view
When loading the Supervisor:Operations view in the Firefox browser, errors may be shown in Firebug
console.

Procedure
1. The following errors may be displayed in the Firebug console when the Supervisor:Operations view is

opened in FireFox. The errors are caused by the Sametime plugin.
scrollIntoView: TypeError: s is null

TypeError: _832(...) is undefined

2. Open the WebSphere Application Server administrative console.
3. Complete the steps to stop and restart the Sametime proxy application to remove the errors.

Screen reader does not announce time values
The screen reader does not announce time values from list boxes. You can work around this problem by
typing the time into the field in the 12-hour format.

Symptoms

If you use the JAWS screen reader to select a list box that contains time values, the reader announces
"start date and time edit combo required", followed by an announcement of the time. However, the
reader does not announce the time values that you can select from the list to enter into the field.

Resolving the problem

Use the keyboard to type a time value into the field in the 12-hour format that is required by the client
operating system.

Date and time format displayed incorrectly in the Arabic locale
In the IBM Intelligent Operations Center user interface, if you select the Arabic locale, the date and time
are formatted incorrectly.

The Dojo toolkit, which is used to implement the IBM Intelligent Operations Center user interface, does
not currently support Arabic numerals.

Data ingest issues when data is archived or removed from the WIH
reading table
When you archive, remove or change data from the WIH.READING table, the missing or revised data
may prevent features of IBM Intelligent Operations for Water from operating as expected. Perform the
steps in this topic to diagnose and resolve data ingest record issues and restore operational capabilities.

Symptoms

Following the removal of records from the WIH.READING table, for example during a purge operation,
you may find that subsequently ingested measurement readings are not added to the table.
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Diagnosis and resolution

When the first reading for a given measurement_id is added to the WIH.READING table, boundary
records are created that ensure subsequently ingested readings are successfully added to the table. If one
of these boundary records is inadvertently deleted, for example during a purge operation, no further
updates will be possible for that measurement_id.

To resolve this problem, run the following commands as user: db2inst2.
db2 connect to wihdb
db2 "call WIH.CORRECT_READING()"
db2 connect reset

Related tasks:
“Maintaining the database server” on page 217
Use this section for guidance on maintaining the health and performance of the database server.
“Configuring data ingestion for meters” on page 13
The Tivoli Directory Integrator software is used to facilitate the import and configuration of meter
reading and billing data.

Checking messages when performing data ingest to the WIH reading
table
If you have problems during the data ingestion process where messages are not reaching the
WIH.READING table and exceptions are generated, complete the steps in this topic.

Symptoms

You may have issues during the data ingestion process, where exceptions are generated and readings do
not reach the WIH.READING table.

Diagnosis and resolution

If you suspect there may be a problem with the ingestion process, check the log /var/log/messages for
related exceptions. You can also debug the issue by creating a subscription to the topic
'/water/deadmessage/topic'. For information on creating a subscription to a topic, go to the related
tutorial topic.
Related concepts:
“Subscribing to a reading message” on page 202
Complete the steps in this tutorial to subscribe to a message in IBM Intelligent Operations for Water.

Some IBM Cognos Connections menu options are not available in the
Chrome browser
Some IBM Cognos Connections menu options, that are available when you use the Mozilla Firefox
browser, are not available in the Google Chrome browser. For example, the Query Studio, Analysis
Studio, Report Studio, and Event Studio menu options may not be available in the Chrome browser. To
resolve the problem, it is recommended that you try the Firefox browser to display the menu options.

Incorrect focus position after saving a filter
When saving a filter in the filter panel, a confirmation message is displayed. The focus however does not
remain on the confirmation message box, so the screen reader can not close the message.

Symptoms

When you click Save to create a 'filter' in the filter panel, a confirmation message is visually displayed to
confirm the save action. The screen reader is informed of the save action. However the focus does not
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reside on the confirmation box so the screen reader cannot close the message at this point. The message is
encountered again in the tab sequence (for multiple messages order is preserved).

Diagnosis and resolution

If required, use the screen reader's navigation landmarks to bypass the confirmation messages.

Navigation and screen reader issues in the pagination panel
Pagination functionality in the List views is not operating as is expected when you use the screen reader.

Symptoms

On the List view, when using the pagination functionality with the screen reader enabled, the pagination
options do not behave as expected for the screen reader.

Diagnosis and resolution

The page selector 'last page' button is not announced correctly. Instead it is announced as the numerical
page positioned directly before it. In addition, the arrow navigation unexpectedly ends at the 'last page'
button as the screen reader prematurely exits forms mode. You can resume the page selector functionality
again by pressing enter to re-enter forms mode. However this may lead to confusion in the page selection
area.

As a workaround, the screen reader can filter by page by using the 'choose a specific' page function.
Furthermore the number of results can be determined using the 'no of results by page ' buttons.

Screen reader announces the wrong warning message
When warning messages are announced to the screen reader, the first warning message is looped and
subsequent warning messages are not announced.

Symptoms

When using the solution administration options, notification messages are generated to confirm if an
event has completed. For example, if you save and submit changes to the interface, a message is
generated to state if the task completed successfully or failed. The first generated message is successfully
announced to the screen reader. For subsequent messages however, they are not successfully announced
to the screen reader and only the first message is repeatedly announced.

Diagnosis and resolution

The subsequent confirmation messages display on the confirmation section, but the screen reader
announces the first message only. For every action that triggers the display of a confirmation message,
JAWS announces only the first message that was added to the section. The screen reader should close
each message/view after generation.

As a workaround, use Jawskey+F5 to open the button shortcut view and navigate to 'Close button'. Click
Enter to close the current message.

Screen reader problems encountered during form field error validation
You may encounter issues with announcements when an invalid entry is made after form input.
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Symptoms

When an invalid entry is made after a form input, an error message is announced to the screen reader in
the form the value entered is not valid Javascript colon quote quote.

Diagnosis and resolution

When you hear the error message, use the command Capslock+Tab to ensure that the form field label is
announced.

Screen reader problems on the logical map
Resolution is provided in this topic when the screen reader does not announce the logical map assets and
relationships on focus.

Symptoms

The screen reader does not announce the logical map assets and relationships on focus.

Diagnosis and resolution

In the logical map, keyboard focus and sequential navigation is achieved by using the up arrow and by
pressing the space bar.

On focus, select the Capslock+Tab key to force the announcement of the current focusable asset and its
relationship to associated assets.

Some interface controls are not available in high contrast mode
Resolution is provided in this topic for interface controls that are not displayed in high contrast mode.

Symptoms

Some graphics are not displayed correctly in high contrast mode.
v The public and private icons in the favorites filter of the Supervisor: Operation page do not display

correctly in high contrast mode.
v The Close button on the message/notification view does not display in high contrast mode

Diagnosis and resolution

To resolve this issue, the following display options are in place for high contrast mode.
v A solid/dashed box represents public/private icons.
v A box is used to indicate the presence of the Close button.

Unable to navigate to the KPI panel using keyboard entries
When you are using the keyboard to navigate the interface, you are unable to navigate to the KPI panel.

Symptoms

In the Supervisor: Status page, the KPI headings are listed and contain child KPI information. If a KPI
heading is selected, another view is created to display only the selected KPI heading and its children. In
this view, if the keyboard user chooses to tab past the children, the page refreshes and an amended tab
order prevents the user from re-entering the child KPI view.
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Diagnosis and resolution

All available information can be displayed by using the drill down function on the child element. There
is no requirement to select a KPI heading.

Exception messages displayed when running scripts to ingest water
conservation portal data
When you run the scripts when ingesting data in the water conservation portal, an exception message
may be displayed.

Symptoms

When you run some scripts to ingest data in the water conservation portal, exception messages may be
displayed in the form:
"Failed to bind to server socket: tcp://0.0.0.0:41001
due to: java.net.BindException: Address already in use"

javax.jms.JMSException: Could not create Transport. Reason:
org.springframework.beans.factory.BeanCreationException:
Error creating bean with name ’org.apache.activemq.xbean.XBeanBrokerService#0’
defined in file [/home/ibmadmin/TDI/etc/activemq.xml]:
Invocation of init method failed;
nested exception is java.io.IOException:
Transport Connector could not be registered in JMX:
Failed to bind to server socket: tcp://0.0.0.0:41001 due to:
java.net.BindException: Address already in use

.

The message may be displayed when the following scripts are used:
v /opt/IBM/water/wcp/user_import/import_users.sh

v /home/ibmadmin/TDI/run_assembly_line.sh

Diagnosis and resolution

The message indicates a socket conflict, however the data is loaded into the database as expected.
Related tasks:
“Configuring data ingestion for meters” on page 13
The Tivoli Directory Integrator software is used to facilitate the import and configuration of meter
reading and billing data.
“Importing user information” on page 12
Scripts are provided to simplify the import of data from CSV file sources into the database. Importing
LDAP authentication and authorization data is also facilitated by providing an XML file sourced in the
database.

Configured volume and currency unit settings for water conservation
portal are insufficient
IBM Intelligent Operations for Water is pre-configured with volume and currency settings for use with
the water conservation portal. If you need to change the settings, you can use the workaround in this
topic to update the pre-configured settings.

Symptoms

You may need to modify the volume and currency settings provided with IBM Intelligent Operations for
Water for use with the water conservation portal.
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Diagnosis and resolution

Complete the steps to update the global system configuration properties. In this example, the volume
unit equal to liter and price unit equal to yuan is added to the properties.
1. Log on to the data server.
2. Run the following SQL commands.

INSERT INTO WCP.VOLUME(VOLUMEUNIT,RATE,ABBREVIATION)
VALUES
(’{"group":"WCP", "key":"liter"}’,0.26,’L’);

INSERT INTO WCP.PRICE(PRICEUNIT,SIGNAL)
VALUES
(’{"group":"WCP", "key":"yuan"}’,’RMB’);

Note: In both examples, the key is used for globalization.
3. Log on to the application server.
4. Go to /opt/IBM/water/wcp to add your required keys for globalization.
5. Modify the WCP.properties file to add the key value.

gallon=gallon
liter=liter

dollar=dollar
yuan=yuan

6. Modify the WCP_**.properties file to add the key value for your specific language. For example:
gallon=key for language **
liter=key for language **

dollar=key for language **
yuan=key for language **

7. Log on to the application server and run the command:
/opt/IBM/water/apps/import.sh https://localhost:10029 $PORTAL_ACCOUNT $PORTAL_PASSWORD
/opt/IBM/water/wcp/import/WCP.properties

Replace the settings for $PORTAL_ACCOUNT and $PORTAL_PASSWORD with your account and
password.

Related tasks:
“Configuring data ingestion for meters” on page 13
The Tivoli Directory Integrator software is used to facilitate the import and configuration of meter
reading and billing data.

Recommended cache settings when using solution administration on
the Internet Explorer 9 browser
When using the solution administration options to perform application management tasks, if you are
using Microsoft Internet Explorer 9, it is recommended that you set cache settings as described in this
topic.

Symptoms

When you use the Microsoft Internet Explorer 9 you may encounter issues when using the solution
administration options. For example, some configuration changes may not be represented as expected
when you navigate between the application management tabs.

Diagnosis and resolution

Update your cache settings as follows to ensure that configuration changes are represented in the
Microsoft Internet Explorer 9 browser.
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1. Select Tools > Internet Options in the browser toolbar.
2. Click Settings in the Browser History section.
3. To specify how often the browser checks for newer versions of stored pages, select the Every time I

visit the webpage option.
4. Click OK to save settings.

Intelligent Operations for Water messages
Each message topic helps you to identify the cause of a particular error condition and recommends
actions to take to resolve the error.

To help you understand the errors that you might encounter, each message topic is divided into three
sections: the message that is displayed in the product or its logs, an explanation, and an action.

The message
Contains two identifiers, which are the error identification and associated text. The error
identification is the message ID. It is a unique number that identifies a message. A final character
of E indicates that the message resulted from an error, W indicates a warning message, and I
indicates an information message.

The explanation
Contains an additional explanation of the message.

The user response
Suggests the corrective action for resolving the error.

To help you search for information about an error message, enter the ID number of the error message in
the Search field in the information center.

Note: The topics in this section are specific to Intelligent Operations for Water. For all other messages, see
the product documentation.

CIWWC0000E Error initialize page: {0}

Explanation: The initialize page {0} has failed.

User response: Please contact the administrator.

CIWWC0001E Error loading module {0}. {1}

Explanation: The load module has failed.

User response: Please contact the administrator.

CIWWC0002E Error instantiate widget: {0}

Explanation: The instantiate widget has failed.

User response: Please contact the administrator.

CIWWC0003E Error calling widget method: {0}, on
widget {1}

Explanation: The call widget method has failed.

User response: Please contact the administrator.

CIWWC0004E Container widget cannot be dynamic:
{0}

Explanation: There is an error in the settings for the
container widget in the configuration.

User response: Please contact the administrator.

CIWWC0005E Event List viewer is unable to get the
data source configuration from the IBM
Intelligent Operations Center Rest
service with url: {0}

Explanation: The Event List failed to get data. The
IBM Intelligent Operations Center REST service failed
to retrieve the data source configuration.

User response: Please contact the administrator.

CIWWC0006E Event list viewer is unable to get data
from datasource: {0}, from url: {1}

Explanation: The Event List viewer failed to get data.
The IBM Intelligent Operations Center REST service
failed to retrieve data configuration.

User response: Please contact the administrator.

CIWWC0007E Asset layer is unable to get data, the
full url is: {0}

CIWWC0000E • CIWWC0007E
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Explanation: The asset layer failed to get data. The
IBM Intelligent Operations for Water REST service
failed to retrieve data.

User response: Please contact the administrator.

CIWWC0008E Event layer is unable to get data for
datasource: {0}, from url: {1}

Explanation: The event layer failed to get data. The
IBM Intelligent Operations for Water REST service
failed to retrieve data.

User response: Please contact the administrator.

CIWWC0009E Failed to retrieve current user profile.

Explanation: The IBM Intelligent Operations for Water
REST service cannot retrieve the current user profile.

User response: Please contact the administrator.

CIWWC0010E Event layer is unable to get data
source configuration from theIBM
Intelligent Operations Center REST
service with url: {0}

Explanation: The event layer failed to get the data
source configuration from the REST service.

User response: Please contact the administrator.

CIWWC0011E Error calling rest services for full
properties data.

Explanation: Failed to call REST service.

User response: Contact administrator.

CIWWC0020E Filter {0} save failed: {1}

Explanation: The user filter save has failed.

User response: Please contact the administrator.

CIWWC0020I Filter {0} saved successfully.

Explanation: The user saved the filter successfully.

User response: No action needed.

CIWWC0021E Failed to retrieve saved filters from
service.

Explanation: The IBM Intelligent Operations for Water
REST service failed to retrieve the saved filter.

User response: Please contact the administrator.

CIWWC0022E Failed to create new saved filter.

Explanation: Failed to invoke the create new saved
filter function.

User response: Please contact the administrator.

CIWWC0023E Failed to save filter.

Explanation: The save filter failed.

User response: Please contact the administrator.

CIWWC0024E Failed to delete saved filter.

Explanation: The delete filter has failed.

User response: Please contact the administrator.

CIWWC0035W Please select one Solution
Application.

Explanation: You must select one solution application
before performing actions.

User response: Contact administrator.

CIWWC10001I The WCP Config has been saved
successfully!

Explanation: The WCP Config is saved successfully.

User response: No action needed.

CIWWC1000E The form below is not valid. Please
correct the issues with the form and try
again.

Explanation: The form is invalid.

User response: Please contact the administrator.

CIWWC1001E The input Price Unit is not valid.

Explanation: You have entered an invalid price unit.

User response: Please contact administrator.

CIWWC1001I The extension configuration '{0}' has
been saved successfully.

Explanation: The extension configuration is saved
successfully.

User response: No action needed.

CIWWC1002E The input Price Rate is not valid.

Explanation: You have entered an invalid Price Rate.

User response: Please contact administrator.

CIWWC0008E • CIWWC1002E
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CIWWC1002I The extension configuration '{0}' has
been created successfully.

Explanation: The extension configuration '{0}' is
created.

User response: No action needed.

CIWWC1003I The extension configuration '{0}' has
been deleted successfully.

Explanation: The extension configuration '{0}' is
deleted.

User response: No action needed.

CIWWC1004I The page '{0}' has been created
successfully.

Explanation: The page '{0}' is created.

User response: No action needed.

CIWWC1005I The page '{0}' has been saved
successfully.

Explanation: The page '{0}' is saved.

User response: No action needed.

CIWWC1006I Application(s) have been included into
page '{0}' successfully.

Explanation: The application(s) is included in page
'{0}'.

User response: No action needed.

CIWWC1007W Current selected extension '{0}' does
not allow you to add child extension
configuration. Please try again.

Explanation: The extension is not a container, and
cannot add a child extension.

User response: Change the definition of the selected
extension.

CIWWC1008W Please select an extension
configuration.

Explanation: You must select an extension before
configuring the extension.

User response: Select an extension.

CIWWC1009E The form below is not valid. Please
correct the issues with the form and try
again.

Explanation: Some of the form fields have invalid
values.

User response: Please correct the issues and try again.

CIWWC1010I The page '{0}' has been deleted
successfully.

Explanation: The page '{0}' is deleted.

User response: No action needed.

CIWWC1012W Deleting a root Extension
Configuration is not allowed.

Explanation: The root Extension cannot be deleted.

User response: No action needed.

CIWWC1013W Please select a extension on the tree
view.

Explanation: You must select an extension before
configuring the extension.

User response: Select an extension.

CIWWC1014I The page extension '{0}' has had its
access settings saved successfully.

Explanation: The access settings of the page extension
are set.

User response: No action needed.

CIWWC1015I The application '{0}' has been saved
successfully.

Explanation: The application is saved.

User response: No action needed.

CIWWC1016I The application '{0}' has been created
successfully.

Explanation: The application is created.

User response: No action is needed.

CIWWC1017I The application '{0}' has been deleted
successfully.

Explanation: The application is deleted.

User response: No action is needed.

CIWWC1018W Please select an application.

Explanation: You must select the application before
you can configure one.

User response: Select an application.

CIWWC1019E Parameters field is not valid.

Explanation: The parameters field is invalid.

User response: Please check the parameters field and
input a valid value.

CIWWC1002I • CIWWC1019E
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CIWWC1020I The extension '{0}' has been saved
successfully.

Explanation: The extension is saved.

User response: No action is needed.

CIWWC1021I The extension '{0}' has been created
successfully.

Explanation: The extension '{0}' is created.

User response: No action is needed.

CIWWC1022I The extension '{0}' has been deleted
successfully.

Explanation: The extension '{0}' is deleted.

User response: No action is needed.

CIWWC1023E Please enter Range Start value or
Range End value.

Explanation: The Range Start value or Range End
value is missing.

User response: Input the correct value.

CIWWC1024E Please enter a valid Range Start or
Range End.

Explanation: The Range Start value or Range End
value is invalid.

User response: Input a valid value.

CIWWC1025E The Range Start value {0} on row {1} is
below the minimum limit of {2}.

Explanation: The Range Start value is invalid.

User response: Input the valid value.

CIWWC1026E The Range End value {0} on row {1} is
below the minimum limit of {2}.

Explanation: The Range End value is invalid.

User response: Input a valid value.

CIWWC1027E The Range Start value {0} on row {1}
exceeds the maximum limit of {2}.

Explanation: The Range Start value {0} is invalid.

User response: Input a valid value.

CIWWC1028E The Range End value {0} on row {1}
exceeds the maximum limit of {2}.

Explanation: The Range End value {0} is invalid.

User response: Input a valid value.

CIWWC1029E The Range Start ({0}) is greater than or
equal to the Range End ({1}) on row {2}.

Explanation: The Range Start value ({0}) is invalid.

User response: Input a valid value.

CIWWC1030E Please enter a valid Range Start or
Range End.

Explanation: The Range Start and/or the Range End
value is invalid.

User response: Input a valid value.

CIWWC1031E Duplicated thresholds configuration.
Only one 'ACCEPTABLE', 'CAUTION'
or 'CRITICAL' threshold configuration
allowed.

Explanation: The threshold configuration is
duplicated.

User response: Remove the duplicated threshold
configuration.

CIWWC1032E Invalid Threshold Sequence. When all
3 threshold levels are set, they must be
in the order [ACCEPTABLE, CAUTION,
CRITICAL] or [CRITICAL, CAUTION,
ACCEPTABLE].

Explanation: The Threshold Sequence is invalid.

User response: Input the correct sequence.

CIWWC1033E There is a range overlap in the
thresholds between row {0} and {1}. {2} is
less than {3}.

Explanation: The threshold ranges overlap.

User response: Input a correct range.

CIWWC1034E There is a gap in the threshold ranges
between row {0} and {1}. {2} is greater
than {3}.

Explanation: The threshold range is invalid.

User response: Input the correct range.

CIWWC1035I Test connection successful.

Explanation: The test connection is successful.

User response: No action needed.

CIWWC1035W Please select one Solution
Application.

Explanation: You must select one solution application
before performing actions.
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User response: Select a solution application.

CIWWC1036E Test connection failed: {0}

Explanation: The test connection failed.

User response: Please contact administrator.

CIWWC1036I The solution application '{0}' has been
saved successfully.

Explanation: The solution application is saved
successfully.

User response: No action needed.

CIWWC1037I The solution application '{0}' has been
created successfully.

Explanation: The solution application is created
successfully.

User response: No action needed.

CIWWC1038E Failed to start sync: {0}

Explanation: User started sync failed.

User response: Please contact administrator.

CIWWC1038I The solution application '{0}' has been
deleted successfully.

Explanation: The solution application is deleted
successfully.

User response: No action needed.

CIWWC1039I The service application '{0}' has been
saved successfully.

Explanation: The service application is saved
successfully.

User response: No action needed.

CIWWC1040E Save connection failed: {0}

Explanation: User saved connection failed.

User response: Please contact administrator.

CIWWC1040I The service application '{0}' has been
created successfully.

Explanation: The service application is created
successfully.

User response: No action needed.

CIWWC1041I The service application '{0}' has been
deleted successfully.

Explanation: The service application is deleted
successfully.

User response: No action needed.

CIWWC1042E The form below is not valid. Please
correct the issues with the form and try
again.

Explanation: The form is invalid.

User response: Enter a valid value(s) and try again.

CIWWC1043E The form is not valid. Please correct
the issues with the form and try again.

Explanation: The form is invalid.

User response: Enter a valid value(s) and try again.

CIWWC1044W Please select the service you want to
delete.

Explanation: You must select a service to delete it.

User response: Select a service to delete.

CIWWC1045W Please select the service you want to
edit.

Explanation: You must select a service to edit it.

User response: Select a service to edit.

CIWWC1046I The model '{0}' has been deleted
successfully.

Explanation: The model is deleted successfully.

User response: No action needed.

CIWWC1047W Please select a model.

Explanation: You must select a model before
performing an action.

User response: Select a model.

CIWWC1048I Success saving thresholds for the
measurement '{0}.

Explanation: The threshold is saved successfully.

User response: No action needed.

CIWWC1049E Error saving thresholds for the
measurement '{0}.

Explanation: An error occurred when saving the
threshold.
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User response: Check your input for error and try
again.

CIWWC1049I Success saving thresholds for the same
type of measurement '{0}'.

Explanation: The threshold is saved successfully.

User response: No action needed.

CIWWC1049W Please select the GROUP.

Explanation: You must select a group before
performing an action.

User response: Select a group.

CIWWC1050E Error saving thresholds for the same
type of measurement '{0}'.

Explanation: An error occurred when saving the
threshold.

User response: Check your input for error and try
again.

CIWWC1050W Please select the {0} and update
required {1}.

Explanation: You must a select an item before
updating.

User response: Select an item before updating.

CIWWC1051W Duplicate URL '{0}' and IDENTITY
'{1}', URL and IDENTITY combination
must be UNIQUE.

Explanation: The URL and IDENTITY combination
must be unique.

User response: Change URL or IDENTITY and try
again.

CIWWC1052I The service access settings saved
successfully.

Explanation: The service access setting is saved
successfully.

User response: No action needed.

CIWWC1053I The model '{0}' has been created
successfully.

Explanation: The model is created successfully.

User response: No action needed.

CIWWC1054I The model '{0}' has been saved
successfully.

Explanation: The model is saved successfully.

User response: No action needed.

CIWWC1055I The solution application '{0}' has been
saved successfully.

Explanation: The solution application is saved
successfully.

User response: No action needed.

CIWWC1056I Success saving key measurement '{0}'.

Explanation: The key measurement is saved
successfully.

User response: No action needed.

CIWWC1057E Error saving key measurement '{0}'.

Explanation: An error occurred while saving the key
measurement.

User response: Please contact administrator.

CIWWC1058E Error with form.

Explanation: The form has errors.

User response: Please contact administrator.

CIWWC1059E Error starting the synchronization
process.

Explanation: The synchronization process has some
errors.

User response: Please contact administrator.

CIWWC1060E Error polling the synchronization
request.

Explanation: The synchronization request has polling
errors.

User response: Please contact administrator.

CIWWC1061E Error starting the create solution
application process.

Explanation: The create solution application process
has polling errors.

User response: Please contact administrator.
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CIWWC1062E Error polling the create solution
application request.

Explanation: The create solution application request
has polling errors.

User response: Please contact administrator.

CIWWC1063E Error starting the delete solution
application process.

Explanation: The delete solution application process
has starting errors.

User response: Please contact administrator.

CIWWC1064E Error polling the delete solution
application request.

Explanation: The delete solution application request
has polling errors.

User response: Please contact administrator.

CIWWC1065E Please enter a valid timeout value for
measurement '{0}.

Explanation: You must enter a valid timeout value for
measurement '{0}'.

User response: Please enter a valid timeout value.

CIWWC1065I The no reading timeout value for
measurement '{0}' has been saved
successfully.

Explanation: The no reading timeout value is saved
successfully.

User response: No action needed.

CIWWC1065W If you choose this option, all
pre-configured No reading timeout will
be overwritten.

Explanation: The option overwrites the default no
reading timeout.

User response: No action needed.

CIWWC1066E The input measurement is not valid.

Explanation: The input is invalid.

User response: Enter a valid measurement.

CIWWC1066I The no reading timeout value for
measurement '{0}' has been deleted
successfully.

Explanation: The no reading timeout value is deleted
successfully.

User response: No action needed.

CIWWC1066W If you choose this option, all
pre-configured thresholds will be
overwritten.

Explanation: The option overwrites the default
thresholds.

User response: No action needed.

CIWWC1067E The Formula is not valid.

Explanation: The formula is invalid.

User response: Enter a valid formula.

CIWWC1067I The no reading timeout value for the
same type of measurement '{0}' has been
saved successfully.

Explanation: The no reading timeout value for the
same type of measurement '{0}' is saved successfully.

User response: No action needed.

CIWWC1067W If you choose this option, all
pre-configured derived values will be
overwritten.

Explanation: The option overwrites the derived
values.

User response: No action needed.

CIWWC1068E Error saving the derive value because
the input measurement and the output
measurement are the same type.

Explanation: A type error has occurred.

User response: Use a different type.

CIWWC1068I The no reading timeout value for the
same type of measurement '{0}' has been
saved successfully.

Explanation: The no reading timeout value for the
same type of measurement is saved successfully.

User response: No action needed.

CIWWC1069E Error saving the derive value because
there is more than one input
measurement.

Explanation: You have entered a duplicate input
measurement.

User response: Enter a different input measurement.
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CIWWC1069I Success saving derive value '{0}'.

Explanation: The derived value is saved successfully.

User response: No action needed.

CIWWC1070E Error saving the derive value because
there exists a loop circuit for the input
measurement and the output
measurement.

Explanation: A loop circuit has occurred.

User response: Please contact administrator.

CIWWC1070I Success deleting derive value '{0}'.

Explanation: The derived value is deleted successfully.

User response: No action needed.

CIWWC1071I Success saving derive value '{0}' for all
instances with the same type.

Explanation: The derived value for all instances with
the same type is saved successfully.

User response: No action needed.

CIWWC1072I Success deleting derive value '{0}' for
all instance with the same type.

Explanation: The derived value for all instances with
the same type is deleted successfully.

User response: No action needed.

CIWWC1073I Error generating Logical Map '{0}'.

Explanation: The Logical map cannot be generated.

User response: Please contact administrator.

CIWWC1074I The named area '{0}' has been saved
successfully.

Explanation: The named area '{0}' is saved
successfully.

User response: No action needed.

CIWWC1075I The named area '{0}' has been created
successfully.

Explanation: The named area '{0}' is created
successfully.

User response: No action needed.

CIWWC1076I The named area '{0}' has been deleted
successfully.

Explanation: The named area '{0}' is deleted
successfully.

User response: No action needed.

CIWWC1077W Please select a named area.

Explanation: You must select a named area.

User response: Select a named area.

CIWWC1078E The named area name should not
exceed {0} characters. {1}

Explanation: The value has too many characters.

User response: Reduce the number of characters.

CIWWC1079E The named area description should
not exceed {0} characters.

Explanation: The value has too many characters.

User response: Reduce the number of characters.

CIWWC1080E There are insufficient points in this
named area. Please add at least {0}
points to the named area.

Explanation: You must have the requisite number of
points in the named area.

User response: Add points in the named area.

CIWWC1081I Service Access Deleted. URL = {0}
GROUP = {1}.

Explanation: The service access was deleted.

User response: No action needed.

CIWWC1082I There is no physical relationship
between node {0} and node {1}.

Explanation: No physical relationship exists between
two nodes.

User response: No action needed.

CIWWC1083I {0} is out of range.

Explanation: The data is out of range.

User response: Enter the correct data in the range.

CIWWC1084E The latitudes and longitudes that you
have supplied are not valid.

Explanation: The latitudes and longitudes are invalid.
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User response: Enter the correct latitudes and
longitudes.

CIWWC1085E This Named Area is new and cannot
be reset to any former state.

Explanation: You cannot reset the new named area to
a former state.

User response: No action needed.

CIWWC1086E The map is in create mode. Please
finish creating the current area before
trying to create another. Double-click on
the location of the last point of the area
to finish drawing an area on the map.

Explanation: The map is in create mode. You cannot
create another area until you finish creating the current
area.

User response: Double-click on the location of the last
point of the area to finish drawing an area on the map.
Then, you can create another area.

CIWWC1087E A new Named Area is being created.
You cannot reset new areas.

Explanation: You cannot reset a named area while a
new named area is being created.

User response: Reset the named area after the new
area is created.

CIWWC1088I All named areas have been
successfully reloaded.

Explanation: All named areas are reloaded
successfully.

User response: No action needed.

CIWWC1089E There was an error when attempting
to save the named area '{0}'.

Explanation: The named area failed to save.

User response: Please contact administrator.

CIWWC1090E The number of points in this named
area have exceeded the maximum
allowed number of {0} by {1} points.

Explanation: The named area has more points than
allowed.

User response: Please do not add a point.

CIWWC1091E The solution application ID already
exists.

Explanation: The solution application ID is duplicated.

User response: Remove duplicated IDs.

CIWWC1092E The form below is not valid. Please
correct the issues with the form and try
again.

Explanation: The form is invalid.

User response: Correct the mistakes in the form and
try again.

CIWWC1093W Length of {0} reached Max Limit of
{1}.

Explanation: The length of the value is greater than
the maximum limit.

User response: Correct the length.

CIWWC1094W Please select the permission to make
http {0} requests to this service.

Explanation: You must select the permission before
making requests to the service.

User response: Select a permission.

CIWWC1095E The Application ID already exists.

Explanation: The application ID is duplicated.

User response: Remove the duplicated ID.

CIWWC1096E You cannot delete this supporting
application '{0}' as it is already included
in an Application solution.

Explanation: You cannot delete the supporting
application.

User response: Do not delete the supporting
application.

CIWWC2000E The input Volume Unit is not valid.

Explanation: You have entered an invalid Volume
Unit.

User response: Please contact the administrator.

CIWWC2001I The Property file has been saved
successfully!

Explanation: The Property file is saved successfully.

User response: No action needed.
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CIWWC2037I Start sync successful.

Explanation: User started the sync successfully.

User response: No action needed.

CIWWC2039I Save connection successfully.

Explanation: User saved connection successfully.

User response: No action needed.

CIWWC1CSO001I Configuration value \"{0}\" saved
successfully.

Explanation: Configuration value is saved
successfully.

User response: No action needed.

CIWWC1CSO002I CSO measurement \"{0}\" saved
successfully.

Explanation: The Combined Sewer Overflow (CSO)

measurement is saved successfully.

User response: No action needed.

CIWWC1CSO003I Create plant \"{0}\" successfully.

Explanation: You created the plant successfully.

User response: No action needed.

CIWWC1CSO004I The plant \"{0}\" is deleted
successfully.

Explanation: You deleted the plant successfully.

User response: No action needed.

CIWWC1CSO005I The plant \"{0}\" saved
successfully.

Explanation: You saved the plant successfully.

User response: No action needed.

Log files
To troubleshoot a problem in IBM Intelligent Operations for Water, you might need to analyze log files on
several systems on the IBM Intelligent Operations Center servers.

See the related link for a list of the log files that are available for each of the IBM Intelligent Operations
Center servers.
Related information:
IBM Intelligent Operations Center server log files
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM web sites are provided for convenience only and do not in
any manner serve as an endorsement of those web sites. The materials at those web sites are not part of
the materials for this IBM product and use of those web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
Department T81B F6/Building 503
4205 S. Miami Boulevard
Durham NC 27709-9990
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Trademarks
IBM, WebSphere, DB2, Rational, Cognos, Jazz, Netcool, Tivoli, ibm.com, Passport Advantage, Smarter
Cities, Sametime, and Redbooks are trademarks of the IBM Corporation in the United States, other
countries, or both.

Microsoft, Internet Explorer, Windows, and the Windows logo are trademarks of Microsoft Corporation in
the United States, other countries, or both.
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Pentium is a registered trademark of Intel Corporation or its subsidiaries in the United States and other
countries

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Adobe, Acrobat, Portable Document Format (PDF), and PostScript are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States, other countries, or both.

Oracle, Javascript, and Java are registered trademarks of Oracle and/or its affiliates.

ArcGIS, EDN, StreetMap, @esri.com, and www.esri.com are trademarks, registered trademarks, or service
marks of Esri in the United States, the European Community, or certain other jurisdictions.

Other names may be trademarks of their respective owners. Other company, product, and service names
may be trademarks or service marks of others.
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Readers’ Comments — We'd Like to Hear from You

IBM Intelligent Water
IBM Intelligent Operations for Water
Product Documentation
Version 1 Release 6

We appreciate your comments about this publication. Please comment on specific errors or omissions, accuracy,
organization, subject matter, or completeness of this book. The comments you send should pertain to only the
information in this manual or product and the way in which the information is presented.

For technical questions and information about products and prices, please contact your IBM branch office, your
IBM business partner, or your authorized remarketer.

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any
way it believes appropriate without incurring any obligation to you. IBM or any other organizations will only use
the personal information that you supply to contact you about the issues that you state on this form.

Comments:

Thank you for your support.

Submit your comments using one of these channels:
v Send your comments to the address on the reverse side of this form.
v Send a fax to the following number: 1-800-227-5088 (US and Canada)

If you would like a response from IBM, please fill in the following information:

Name Address

Company or Organization

Phone No. Email address
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